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Version 5 

Embroidery Software Manual 

 

The contents of this manual and the associated software are the property of DRAWSTITCH LTD. 
No parts of this publication or the accompanying software may be reproduced, adapted, copied or 
distributed, transmitted, transcribed, stored in a retrieval system or translated into any human or 
computer language, in any form or by any means, electronic, mechanical, magnetic, manual, or 
otherwise, or disclosed to any third party.  

 

Trademarks: DRAWings, Creative DRAWings and DRAWstitch names and logos are trademarks 
and/or registered trademarks of DRAWSTITCH LTD. All other trademarks are the property of their 
respective owners. All rights reserved.  

 

Important: 

Your use of Creative DRAWings software (“the Software”) is subject to the DRAWSTITCH 
LIMITED End-User License Agreement (EULA). To view the EULA, please refer to Help > About 
dialog of the Software. 

 

Notice, Warranties and Disclaimers: 

All information is provided "as is" without warranty of any kind, either express or implied, including, 
but not limited to, the implied warranties of merchantability, fitness for a particular purpose, or non-
infringement. DRAWSTITCH LTD assumes no responsibility for errors or omissions in the 
information, or software, or other documents, which are referenced by or linked to this manual. 

References to corporations, their services and products, are provided "as is" without warranty of 
any kind, either express or implied. In no event shall DRAWSTITCH LTD or its officers, employees 
or affiliates be liable for any special, incidental, indirect or consequential damages of any kind, or 
any damages whatsoever, including, without limitation, those resulting from loss of use, data or 
profits, whether or not advised of the possibility of damage, and on any theory of liability, arising 
out of or in connection with the use or performance of this information.  

The information contained in this manual is provided for informational purposes only, and while 
DRAWSTITCH LTD is confident in its accuracy, please note that this manual could include 
technical or other inaccuracies or typographical errors. Changes are periodically added to the 
information herein; these changes will be incorporated in new editions of this manual without prior 
notice.  
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DRAWSTITCH LTD may make improvements and/or changes in the product(s) and/or the 
program(s)/software described in this manual at any time. 

 

Printing:  

You may print out this Software Manual provided that:  

(a) You print out a single copy of the Manual for your personal use;  

(b) You do NOT remove or alter the copyright notices or other means of identification or 
disclaimers as they appear in this Software Manual;   

(c) You do NOT systematically make printed or electronic copies of the Software Manual for any 
purpose; 

(d) You do NOT display or distribute any part of the Software Manual on any electronic network, 
including without limitation the Internet and the World Wide Web;  

(e) You do NOT use all or any part of the Software Manual for any commercial use. 

 

DRAWstitch Ltd.  

www.drawstitch.com/Creative 

Contact DRAWstitch Ltd.  

info@drawstitch.com 

 

Copyright © 2006-2011 DRAWstitch Ltd. All rights reserved. 

 

Last update, May 2011  

 

  

http://www.drawstitch.com/Creative
mailto:info@drawstitch.com


Creative DRAWings Embroidery Software Manual 
 

3 Chapter 1 - Welcome to Creative DRAWings   DRAWstitch Ltd.  
  

CONTENTS 
CHAPTER 1 - WELCOME TO CREATIVE DRAWINGS ............................................................................... 9 

INTRODUCTION ................................................................................................................................ 9 

OFF TO A FAST START .................................................................................................................. 9 

WHAT IS NEW IN CREATIVE DRAWINGS 5 ....................................................................................... 10 

ONLINE RESOURCES ...................................................................................................................... 11 

CREATIVE DRAWINGS HELP .......................................................................................................... 12 

CREATIVE DRAWINGS AND WINGS MODULAR 5.00 .......................................................................... 12 

CREATIVE DRAWINGS SAMPLES .................................................................................................... 12 

CHAPTER 2 - QUICK START ................................................................................................................ 14 

INTRODUCTION .............................................................................................................................. 14 

CREATING YOUR FIRST EMBROIDERY ............................................................................................... 14 

SCAN A DESIGN AND EMBROIDER IT ................................................................................................. 20 

GET IMAGE FROM WEBCAM ............................................................................................................ 27 

IMPORT A STITCH FILE AND EMBROIDER IT ........................................................................................ 34 

CREATE A DESIGN FROM SCRATCH .................................................................................................. 42 

WORKSPACE TOUR ........................................................................................................................ 47 

INTRODUCTION .......................................................................................................................... 47 

START-UP WIZARD ..................................................................................................................... 48 

WORKSPACE COMPONENTS ........................................................................................................ 49 

CUSTOMIZING CREATIVE DRAWINGS WORKSPACE ....................................................................... 55 

USING TOOL WINDOWS ............................................................................................................... 56 

CHAPTER 3 - WORKING WITH FILES .................................................................................................... 60 

INTRODUCTION .............................................................................................................................. 60 

VECTOR AND BITMAP DESIGNS ....................................................................................................... 60 

CREATING DESIGNS ....................................................................................................................... 61 

ARTWORK SOURCES ...................................................................................................................... 62 

FROM FILE (VECTOR OR BITMAP) ................................................................................................ 63 

FROM EMBROIDERY .................................................................................................................... 65 

FROM SCANNER ......................................................................................................................... 65 

FROM WEBCAM ......................................................................................................................... 67 

NEW GRAPHIC ........................................................................................................................... 70 

LOADING DESIGNS ......................................................................................................................... 70 

OPEN DIALOG BOX .................................................................................................................... 71 

SAVING DESIGNS ........................................................................................................................... 73 

SAVE AS DIALOG BOX ................................................................................................................. 74 

EXPORT DESIGN ............................................................................................................................ 74 

EXPORT TO EDITOR .................................................................................................................... 74 

EXPORT EMBROIDERY IMAGE ...................................................................................................... 75 

EXPORT VECTOR FILE ................................................................................................................ 77 

EXPORT TO QUILT - DXF ............................................................................................................. 77 

SCANNING IMAGES ........................................................................................................................ 78 

CAPTURING FROM WEBCAM ............................................................................................................ 82 

IMPORTING BITMAPS ...................................................................................................................... 84 

OPEN AS BACKDROP .................................................................................................................. 85 

BACKDROP PROPERTIES ............................................................................................................ 86 

TRACE (CONVERT TO OUTLINES).................................................................................................. 87 

OPEN AS CROSS-STITCH ............................................................................................................ 89 

OPEN AS PHOTO STITCH ............................................................................................................. 90 

IMPORT EMBROIDERY FILES ............................................................................................................ 90 



Creative DRAWings Embroidery Software Manual 
 

4 Chapter 1 - Welcome to Creative DRAWings   DRAWstitch Ltd.  
  

CONVERT TO VECTOR DESIGN .................................................................................................... 92 

IMPORT NGS EMBROIDERY FILE ................................................................................................... 93 

PRINTING ...................................................................................................................................... 93 

PRINT DESIGN ............................................................................................................................ 94 

PRINT ARTWORK ....................................................................................................................... 98 

SEND OPTION ................................................................................................................................ 99 

RECENTLY USED FILE LIST .............................................................................................................. 99 

AUTO-BACKUP MECHANISM ............................................................................................................ 99 

CHAPTER 4 - MAKE SELECTIONS ...................................................................................................... 101 

INTRODUCTION ............................................................................................................................ 101 

SELECT WITH MOUSE (CLICK) ....................................................................................................... 101 

RECTANGLE SELECTION  ......................................................................................................... 101 

LASSO SELECTION  ................................................................................................................. 102 

INVERT SELECTION ...................................................................................................................... 102 

SELECT ALL ................................................................................................................................ 102 

SELECT NONE ............................................................................................................................. 103 

SELECT BY STITCH TYPE .............................................................................................................. 103 

SELECT / VIEW OVERLAPPING ORDER OF VECTOR DESIGN ............................................................... 104 

SELECTIONS BY COLOR ................................................................................................................ 104 

SELECTIONS IN SEQUENCE MANAGER ............................................................................................ 105 

CHAPTER 5 - VIEW YOUR DESIGNS ................................................................................................... 106 

INTRODUCTION ............................................................................................................................ 106 

ZOOM IN  ............................................................................................................................... 106 

ZOOM OUT .................................................................................................................................. 106 

ZOOM PREVIOUS  .................................................................................................................... 106 

ZOOM ALL  ............................................................................................................................. 107 

ACTUAL SIZE ZOOM  ........................................................................................................... 107 

HAND TOOL (PAN)  .................................................................................................................. 107 

MEASURE TOOL  ..................................................................................................................... 107 

VIEW 3D PREVIEW ....................................................................................................................... 107 

VIEW OUTLINE DESIGN ................................................................................................................. 108 

VIEW STITCHES ........................................................................................................................... 108 

VIEW STITCH POINTS ................................................................................................................... 109 

THICKNESS VIEW ......................................................................................................................... 109 

SET LIGHT SOURCE ...................................................................................................................... 110 

VIEW RULER ............................................................................................................................... 111 

VIEW GRID ................................................................................................................................. 111 

VIEW HOOP ................................................................................................................................ 111 

VIEW ACTIVE DESIGNS (WINDOWS) ............................................................................................... 112 

SLOW REDRAW (SHIFT+F11) ....................................................................................................... 112 

ADD GUIDELINES ......................................................................................................................... 114 

HORIZONTAL GUIDELINES ......................................................................................................... 114 

VERTICAL GUIDELINES ............................................................................................................. 115 

DIAGONAL GUIDELINES............................................................................................................. 115 

GUIDELINE OPTIONS ................................................................................................................. 115 

WORKING WITH GUIDELINES ...................................................................................................... 116 

CHAPTER 6 - DESIGNING TOOLS ...................................................................................................... 118 

INTRODUCTION ............................................................................................................................ 118 

TOOLS TOOLBAR ......................................................................................................................... 118 



Creative DRAWings Embroidery Software Manual 
 

5 Chapter 1 - Welcome to Creative DRAWings   DRAWstitch Ltd.  
  

DRAWING TOOLS ......................................................................................................................... 118 

CREATE FREEHAND SHAPES ..................................................................................................... 119 

CREATE BEZIER SHAPES .......................................................................................................... 121 

CREATE OUTLINE SHAPES ........................................................................................................ 122 

INSERT SHAPES ........................................................................................................................... 125 

CREATE ELLIPSES.................................................................................................................... 125 

CREATE PIES .......................................................................................................................... 127 

CREATE TRAPEZOIDS AND PARALLELOGRAMS ............................................................................ 129 

CREATE STARS ....................................................................................................................... 132 

CREATE POLYGONS ................................................................................................................. 136 

CREATE RECTANGLES .............................................................................................................. 139 

DESIGN TOOLS' OPTIONS .............................................................................................................. 141 

ADD NEW OBJECTS AS CLONES ..................................................................................................... 142 

ARRAY TOOL (CIRCULAR-RECTANGULAR) ...................................................................................... 145 

RECTANGULAR ARRAY .............................................................................................................. 146 

USING RECTANGULAR ARRAY ................................................................................................... 148 

CHANGE THE RESOLUTION OF THE ARRAY .................................................................................. 150 

CIRCULAR ARRAY ..................................................................................................................... 152 

USING CIRCULAR ARRAY .......................................................................................................... 153 

CHANGE THE ORIENTATION OF COPIES AND CREATE MIRRORED OBJECTS ...................................... 158 

AUTO BORDER ............................................................................................................................ 159 

WORKING WITH TEXT ................................................................................................................... 161 

TO ADD TEXT ........................................................................................................................... 161 

SELECTING TEXT ..................................................................................................................... 162 

CHANGE FONT AND SIZE .......................................................................................................... 163 

EDIT TEXT SHAPE .................................................................................................................... 163 

TEXT ON PATH ......................................................................................................................... 164 

REMOVE TEXT FROM PATH ........................................................................................................ 166 

INSERT SYMBOL .......................................................................................................................... 166 

CHAPTER 7 - TRANSFORMATIONS .................................................................................................... 169 

INTRODUCTION ............................................................................................................................ 169 

POSITIONING OBJECTS ................................................................................................................. 169 

MOVE AN OBJECT(S) ................................................................................................................ 169 

MOVE A SHAPE WHILE DRAWING IT ............................................................................................. 170 

MOVE OBJECTS WITH ARROW KEYS ........................................................................................... 170 

MOVE AN OBJECT WITH X AND Y COORDINATES .......................................................................... 170 

ALIGNING, DISTRIBUTING AND AUTO-SIZING OBJECTS ...................................................................... 171 

ALIGNING OBJECTS .................................................................................................................. 172 

AUTO-SIZING OBJECTS ............................................................................................................. 174 

DISTRIBUTING OBJECTS ............................................................................................................ 175 

RE-ORDER OBJECTS .................................................................................................................... 176 

SEQUENCE MANAGER .................................................................................................................. 177 

RE-SEQUENCE ITEMS ............................................................................................................... 178 

DUPLICATING AND DELETING OBJECTS........................................................................................... 181 

CUTTING, COPYING AND PASTING .............................................................................................. 181 

PASTE SPECIAL ........................................................................................................................ 182 

DUPLICATING A DESIGN ................................................................................................................ 183 

DELETE OBJECTS ..................................................................................................................... 183 

SIZING AND SKEWING OBJECTS ..................................................................................................... 183 

SIZE OBJECTS .......................................................................................................................... 183 

SKEWING OBJECTS .................................................................................................................. 185 



Creative DRAWings Embroidery Software Manual 
 

6 Chapter 1 - Welcome to Creative DRAWings   DRAWstitch Ltd.  
  

ROTATING AND MIRRORING OBJECTS ............................................................................................. 186 

ROTATING OBJECTS ................................................................................................................. 186 

MIRRORING OBJECTS ............................................................................................................... 188 

REPEAT TRANSFORMATION .......................................................................................................... 190 

CLEAR TRANSFORM ..................................................................................................................... 190 

GROUPING OBJECTS .................................................................................................................... 191 

GROUP OBJECTS ..................................................................................................................... 191 

ADD OBJECT TO A GROUP ......................................................................................................... 191 

DELETE AN OBJECT FORM A GROUP .......................................................................................... 192 

EDIT AN OBJECT FORM A GROUP ............................................................................................... 192 

UNGROUP OBJECTS ................................................................................................................. 192 

COMBINING AND BREAKING APART OBJECTS................................................................................... 192 

INTERSECTION AND WELD ............................................................................................................ 193 

REMOVE OVERLAPS ..................................................................................................................... 195 

TRIMMING OBJECTS ..................................................................................................................... 195 

CONVERT OUTLINE TO OBJECT ..................................................................................................... 197 

UNDO ......................................................................................................................................... 197 

REDO ......................................................................................................................................... 198 

COLOR MANAGEMENT .................................................................................................................. 198 

THREAD PALETTE TOOLBAR ...................................................................................................... 198 

COLOR PALETTES .................................................................................................................... 199 

CHANGE COLORS ..................................................................................................................... 199 

EDITING DEFAULT COLOR PALETTE (RGB) ................................................................................. 201 

SELECTIONS BY COLOR ............................................................................................................ 202 

IMPORTED VECTOR DESIGNS ..................................................................................................... 203 

CROSS-STITCH DESIGNS ........................................................................................................... 203 

EDIT PALETTE ............................................................................................................................. 203 

THREADS TO USE ..................................................................................................................... 204 

PALETTE ................................................................................................................................. 204 

COLOR REDUCTION AREA ......................................................................................................... 205 

CHANGE HOOP ............................................................................................................................ 207 

CHAPTER 8 - NODE EDITOR ............................................................................................................. 213 

INTRODUCTION ............................................................................................................................ 213 

WHAT IS A NODE ......................................................................................................................... 213 

CUSP NODES ........................................................................................................................... 213 

SMOOTH NODES ...................................................................................................................... 214 

CURVE OBJECTS ......................................................................................................................... 214 

EDIT SHAPE NODES ..................................................................................................................... 214 

SELECT NODE(S) ..................................................................................................................... 214 

MOVE NODE(S) ........................................................................................................................ 215 

USING CONTROL HANDLES OF A NODE ........................................................................................ 215 

ADD A NODE ............................................................................................................................ 216 

DELETE A NODE ....................................................................................................................... 217 

TO LINE ................................................................................................................................... 217 

TO CURVE ............................................................................................................................... 217 

SELECT ALL AND SELECT POLYLINE ........................................................................................... 218 

CLOSE OUTLINE ....................................................................................................................... 218 

JOIN NODES............................................................................................................................. 218 

SPLIT OUTLINE ......................................................................................................................... 219 

AUTO REMOVE OVERLAP ........................................................................................................... 219 

CHAPTER 9 - EMBROIDERY TRANSFORMATIONS................................................................................. 221 



Creative DRAWings Embroidery Software Manual 
 

7 Chapter 1 - Welcome to Creative DRAWings   DRAWstitch Ltd.  
  

INTRODUCTION ............................................................................................................................ 221 

STITCH TYPES – EMBROIDERY TYPES ............................................................................................ 221 

SATIN STITCH TYPE .................................................................................................................. 221 

RUNNING STITCH TYPE ............................................................................................................. 221 

SATIN SERIAL STITCH TYPE ....................................................................................................... 222 

STEP STITCH TYPE ................................................................................................................... 222 

ROW FILL STITCH TYPE ............................................................................................................. 222 

APPLIQUÉ................................................................................................................................ 222 

CROSS-STITCH EMBROIDERY TYPE: ........................................................................................... 223 

PHOTO-STITCH EMBROIDERY TYPE ............................................................................................ 223 

NET FILL EMBROIDERY TYPE ...................................................................................................... 224 

SELECT FABRIC ........................................................................................................................... 224 

OBJECT PROPERTIES ................................................................................................................... 227 

FILL ........................................................................................................................................... 227 

NONE ..................................................................................................................................... 227 

SATIN ..................................................................................................................................... 227 

SATIN STITCH TYPE OPTIONS ..................................................................................................... 229 

STEP ...................................................................................................................................... 231 

STEP STITCH TYPE OPTIONS ...................................................................................................... 233 

ROW FILL ................................................................................................................................ 234 

ROW FILL STITCH TYPE OPTIONS ............................................................................................... 236 

APPLIQUÉ................................................................................................................................ 237 

CROSS-STITCH ........................................................................................................................ 238 

PHOTO-STITCH ........................................................................................................................ 240 

NET FILL ................................................................................................................................. 240 

OUTLINE ..................................................................................................................................... 242 

NONE ..................................................................................................................................... 242 

RUNNING ................................................................................................................................ 242 

SATIN SERIAL .......................................................................................................................... 244 

DIVIDE AND DIRECTIONS TOOLS .................................................................................................... 246 

DIVIDE .................................................................................................................................... 246 

DIRECTIONS ............................................................................................................................ 247 

DESIGN PROPERTIES ................................................................................................................... 247 

GENERAL ................................................................................................................................ 247 

OPTIMIZER .............................................................................................................................. 248 

CHAPTER 10 - EMBROIDERY SEQUENCE ........................................................................................... 255 

INTRODUCTION ............................................................................................................................ 255 

AUTOMATIC EMBROIDERY SEQUENCE............................................................................................ 255 

ENABLE AUTO-SEQUENCE ........................................................................................................ 255 

SEQUENCE TOOL ..................................................................................................................... 256 

SEQUENCE MANAGER - AUTO .................................................................................................... 257 

MANUAL EMBROIDERY SEQUENCE ................................................................................................ 257 

DISABLE AUTO-SEQUENCE ....................................................................................................... 257 

SEQUENCE MANAGER - MANUAL ................................................................................................ 259 

CHAPTER 11 - SETTINGS ................................................................................................................. 260 

INTRODUCTION ............................................................................................................................ 260 

OPTIONS .................................................................................................................................... 260 

GENERAL ................................................................................................................................ 260 

TOOLS .................................................................................................................................... 260 

MONITOR ................................................................................................................................ 261 

VIEW ...................................................................................................................................... 262 



Creative DRAWings Embroidery Software Manual 
 

8 Chapter 1 - Welcome to Creative DRAWings   DRAWstitch Ltd.  
  

3D PROPERTIES ....................................................................................................................... 263 

PRINTING ................................................................................................................................ 264 

CREATIVE DRAWINGS 3D CONFIG ............................................................................................... 264 

SECURITY KEYS .......................................................................................................................... 266 

CHAPTER 12 - CREATING EMBROIDERY DESIGNS ............................................................................... 268 

INTRODUCTION ............................................................................................................................ 268 

SETTING UP THE WORKSPACE....................................................................................................... 268 

CUSTOMIZE 3D SETUP ............................................................................................................. 268 

CHANGE TOOLBAR ICONS ......................................................................................................... 268 

SET MONITOR SIZE ................................................................................................................... 269 

SET MEASUREMENT SYSTEM ..................................................................................................... 269 

CREATING AND EDITING EMBROIDERY DESIGNS .............................................................................. 269 

IMPORT EMBROIDERY FILE ........................................................................................................ 270 

SELECT HOOP .......................................................................................................................... 270 

CHANGE FILL ........................................................................................................................... 271 

CHANGE OUTLINE .................................................................................................................... 272 

REMOVE OVERLAPS AND MAKE TRIMS ........................................................................................ 273 

CHANGE DIRECTION AND DIVIDE OBJECTS .................................................................................. 274 

SETTING UP EMBROIDERY PARAMETERS ........................................................................................ 274 

SELECT FABRIC........................................................................................................................ 274 

SELECT THREAD COLORS.......................................................................................................... 275 

OPTIMIZE THE DESIGN .............................................................................................................. 276 

CHANGE SEQUENCE ................................................................................................................ 277 

EMBROIDERY PROCESS ............................................................................................................... 279 

EXPORT DESIGNS..................................................................................................................... 279 

SAVING DESIGNS ..................................................................................................................... 279 

USE OF PRINTOUT .................................................................................................................... 280 

APPENDIX A - CREATIVE DRAWINGS TIPS ....................................................................................... 282 

CREATIVE DRAWINGS QUALITY HINTS .......................................................................................... 282 

PRINTING AND EMBROIDERING ...................................................................................................... 283 

COLOR CHANGES ........................................................................................................................ 284 

APPENDIX B - TOOLBARS ................................................................................................................ 286 

APPENDIX C - QUICK REFERENCE CARD ........................................................................................... 288 

APPENDIX D - TROUBLESHOOTING ................................................................................................... 291 

INSTALLATION PROBLEMS ............................................................................................................. 291 

CBU FAILURE WHEN LAUNCHING CREATIVE DRAWINGS ............................................................... 291 

CREATIVE DRAWINGS QUITS AND GENERATES A VISUAL C++ RUNTIME ERROR ............................. 291 

UNHANDLED EXCEPTION .............................................................................................................. 291 

CREATIVE DRAWINGS FAILS TO LAUNCH ...................................................................................... 292 

VERIFYING VIDEO CARD MEMORY ................................................................................................ 294 

UPDATING THE VIDEO DRIVER ...................................................................................................... 294 

INSTALLING DIRECTX ................................................................................................................... 294 

INDEX ............................................................................................................................................ 295 

 
  



Creative DRAWings Embroidery Software Manual 
 

9 Chapter 1 - Welcome to Creative DRAWings   DRAWstitch Ltd.  
  

Chapter 1 - Welcome to Creative DRAWings 

Introduction 
Creative DRAWings is an embroidery software which will excite your creativity because it‟s easy 
to learn and easy to use! With only a few minutes of hands-on instruction, it‟s possible for anyone 
-- regardless of skill level -- to produce a high-quality design. It‟ll be clean of wild stitches and 
ready to be sewn out on your embroidery machine. 

Almost any clipart or photo can be imported and be instantly converted into a flawless embroidery 
file. That‟s because Creative DRAWings is not static software which just converts images to 
stitches. The revolutionary and professional DRAWstitch® technology has been incorporated into 
Creative DRAWings to work the miracles that you‟ll see it perform – almost as fast as the blink of 
an eye.  

Creative DRAWings is much more than a digitizing software. It‟s an interactive product which 
almost “thinks” for you and helps release your creativity. A big plus for Creative DRAWings is that 
it doesn‟t require you to keep buying expensive add-on digitizing packages as you advance in skill.  

Instead of having to learn complicated production techniques, Creative DRAWings does most of 
the work for you – almost instantly! That‟s because Creative DRAWings is a wonderful new 
embroidery software created for home use at a very reasonable price, yet powerful enough for the 
professional shop. Creative DRAWings will allow you to file your digitized images in most of the 
world‟s most popular embroidery formats.  

We want you to enjoy embroidering and not agonize over perplexing software programs that 
plague the sewing market today. We want you to really USE Creative DRAWings. Many 
embroidery programs are so frustrating because of their “steep-learning curve.”  The learning is 
almost endless, and you almost drown in the need for more software!  

Off to a FAST START 

To demonstrate the “low-learning curve” of Creative DRAWings, here‟s a sample lesson in 
creating your first design:   

1. Creative DRAWings opens up with the New Design dialog. Click on Next. 

2. Artwork source box or dialog will appear. Click on New graphic, and then click on Next. 

3. The Fabric dialog appears. Select your fabric choice and click on Finish.  

4. A blank screen will appear: your creativity takes over here! 

5. Click on Create, and then click the Freehand Shapes icon on the left side of the screen. 

(An icon will identify itself if your mouse hovers over the icon a few seconds.)  

6. Draw a free-hand shape – like jagged sun rays -- and be sure to close the shape by joining 

the ends. A little white box will appear when the ends are joined. Click on Stitch to instantly 

preview your first embroidery design. Presto: Your free-hand design is ready to be stitched 

out in the correct color and matched to the available thread colors. You‟re on your way!  

7. Now modify your design:  click on the Create mode. Then below, click on the Edit Shape 

Nodes and stretch and pull on a node by holding your left mouse down. Click on Stitch.  

See how quickly your revamped design is changed to stitches?  The nodes of an object are 

the tiny circles that are spread along an object‟s outline. The line between two nodes is 

called a segment. Moving an object‟s segments lets you make coarse adjustments to the 
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object‟s shape; while changing the position of its nodes lets you fine-tune the shape of the 

object. 

8. All of the designing in Creative DRAWings is done with the tools which you will find within 

this Create mode. Almost any imported clipart or hand-drawn image can be designed and 

sewn out in this software. 

9. When you are finished designing, click on the Stitch mode. You can modify the stitch types 

and select a specific fabric with the correct density, pull compensation, and underlay 

(stiffening material called stabilizer placed under fabric). The changes are made almost as 

fast as you can click, and they‟re accurate and clean -- ready to be sewn out.  

See what we mean about Creative DRAWings being powerful, but not complicated? 

With Creative DRAWings you can preview the embroidery image in 3D and print a full-color proof 
sheet, which will even count the stitches, tell you how much thread is needed, and what type of 
stabilizer to use. 

Now, aren‟t you happy and thrilled that you have this powerful Creative DRAWings at your 
fingertips? Your embroidery machine will be happy, too, with clean, sharp, and exact sew-outs. 

What is new in Creative DRAWings 5 

Creative DRAWings 5 includes new features and enhancements that will make your work easier. 
● New Auto-border tool with Satin serial and Running stitch types 

Add border to imported embroidery files or to multiple selected objects easily and decorate 
by choosing from hundreds of styles and patterns. 

● Manual embroidery sequencing with the use of Sequence manager 

Creative DRAWings now has the ability to re-sequence objects manually by using the 
Sequence manager. By click and dragging objects on the Sequence manager, the stitches 
are recalculated automatically and new embroidery sequence is created based on the 
changes you make. 

● Print the artwork of the design you have created 

With Creative DRAWings you have the ability to print any artwork you want on a special 
paper for textile printing and for promoting your company.  

● Export the designs to Quilt and to DXF file formats 

Create designs easily and export them to your Quilt frame machine by using any of the 
available file formats.  

● Add new objects as clones 

By using this option, any created duplicate of an object is marked as a clone of the initial 
object. If you reshape any of the clones all other clones are reshaped too creating unique 
and beautiful embroidery results 

● Open multiple designs in tabs 

Creative DRAWings, now opens the designs in multiple tabs instead of multiple instances 
that helps you work faster and with less resources used. 

● New thread color palette  

The new thread color palette can save you time and effort with its efficiency and usability.  
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● Create embroidery designs by capturing images from the webcam  

Use the webcam of your pc to capture images and convert them to Cross-stitch, Photo-
stitch and standard embroidery or use it as backdrop image to create your embroidery 
design from scratch. 

● Improved embroidery image Export the 3D realistic embroidery preview to 

embroidery look image and use it for textile printing or for promoting your work.  

Select “File>Export>To image…”. At the bottom of the dialog you will find the available 
options. Use .PNG files for transparent background. 

● Support for newer versions of .AI vector file format. 

The importer of .AI vector files has been improved and now you can load newer versions of 
illustrator files. 

● Fully customizable workspace according your preferences. Adjust it once and lose 

no time while creating embroidery designs. 

You can reposition the toolbars and dock able rollups by click and dragging them. Also at 
the end of each toolbar you have some options that allow you to select which tools you 
want to view. 

● Circular Array tool 

Circular Array tool is a great way to create stylish design arrays easily, without losing the 
ability to edit the design. Any change you are making on a single object is automatically 
applied in the entire array. 

● Slow redraw - Embroidery machine simulation 

With the slow redraw utility you can simulate the way the design will be embroidered 
without having to do that on the machine. Also you have the ability to simulate your 
machine speed and the movement of the needle carrier.  

● Rectangular Array/Kaleidoscope 

With the advanced Rectangular array you have the ability to rotate and mirror the copies of 
the array without losing the ability to edit them and create easily unique designs. Also, you 
have the ability to create clones that will copy any transformation that you are doing on the 
source design. 

● Convert images to photo-stitch automatically 

Convert any image you have to Photo-stitch with CMYK (Cyan, Magenta, Yellow and 
Key(Black)) colors automatically. A step by step wizard can convert your image to photo-
stitch and give you a representation of it by combining four different layers of colored satin 
bars. The results are great with chromatic realism on the embroidery result. 

● Net fill embroidery type is added 

With the Net fill you can create perfect laces and fill holes that where produced from cut 
fabric. It can be very useful for embroidery designs that are sewed on soluble material. 

Online resources  

More information about Creative DRAWings including tutorials, demos and frequently asked 
questions are at the official site of Creative DRAWings: www.drawstitch.com/Creative.  

http://www.drawstitch.com/creative/
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Creative DRAWings Help 

Need more instructions? Help is at hand! Comprehensive information about the features in the 
software is displayed in the Help viewer provided by your operating system: Microsoft HTML Help. 
You can access information in any of the following four ways from the Help menu or by pressing 
F1 shortcut key: 

1. The table of contents enables you to see all of the information organized by subject. Click 

top-level entries to view subtopics. 

2. The index allows you to look up specific terms or concepts in alphabetical order. Type is a 

word or phrase. 

3. Search allows you to find any character string or word anywhere in the text of the Help 

system. 

4. Show help on is another way to access help for a specific tool, area, or function in 

Creative DRAWings.  

Show help on can be activated from the Help menu, or by clicking on the  icon in the 
standard toolbar or by pressing the Shift+F1 shortcut key. When you activate Show help on, the 
mouse pointer turns to a pointer with a question mark. Click on any function you want in Show 
help on and the subject will be displayed.     

Creative DRAWings and Wings modular 5.00  

Here‟s why Creative DRAWings is so powerful: It includes a portion of Wings modular, one of the 
world‟s leading professional digitizing embroidery software programs. The two programs 
communicate to give you professional results – even on the first try.  

You can export Creative DRAWings designs for further editing into Wings‟ modular or open 
existing embroidery designs such as .dst. Wings‟ modular Basic module, is included in the 
Creative DRAWings package. It is a fully working Professional embroidering software split into 
modules. It includes 14 modules which are activated separately.  

Basic module is the first and most important module because contains the basic parts of the 
software. Basic module includes the standard interface, scaling design capabilities, simple design 
editing, fully functional stitch editor, image database management and all supported floppy 
formats. It also includes many connection abilities that allow you to connect the software with your 
embroidery machine. You can read more about Wings’ modular Basic module inside the Basic 
module manual that is also included or from the Help > Contents menu in the Basic module 
Contents tab book.  

http://www.wingsmodular.com/  

When you have created an embroidery design in Creative DRAWings, you can instantly call up 
Wings module from the menu File>Export>To Editor ** … or by pressing the shortcut key Ctrl+E 
and make any modifications you like. The original design in Creative DRAWings will remain 
unchanged for future use. (** The > means “then click on” as in click mouse on File, then click on 
Export, then click on To Editor. This shortened version using > will be used in giving directions in 
this manual.) 

For more information about what exciting things you can do with the Wings software, refer to 
Wings module 5 Basic module manual.  

Creative DRAWings Samples 

http://www.wingsmodular.com/all_modules/connect.htm
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Creative DRAWings includes sample designs for you to work with and produce embroidery 
designs while you are learning the software. After installing the software, the designs will be 
copied into your hard disk so you have direct access to them. To find the designs, click on Start 
button, then position the mouse over Programs menu to open it, expand Creative DRAWings 
subfolder and select Creative DRAWings samples to open the samples folder. You will find 200 
vector file designs with .cmx extensions that can be imported into Creative DRAWings and 
converted to stitches. Also, you will find 204 embroidery file designs with .ngs extensions that can 
be imported into Creative DRAWings and create new ones based on them. The stitch folders in 
.ngs files can be opened with the Wings‟ modular 5 software included in Creative DRAWings. 
The designs in .ngs files contain readymade embroidery designs. After saving them to the file 
format which your machine supports, you can embroider them directly with your embroidery 
machine. You can save them to the file format you want through Creative DRAWings or Wings‟ 
modular 5 software.  

There are more designs in .ngs file format but they are located in the installations CD of Wings‟ 
modular software inside the Designs folder. There you will find nearly 3000 embroidery designs 
ready to sew out. 
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Chapter 2 - Quick start 

Introduction 

In this chapter we will learn how to create an embroidery design quickly, using the design of 
Creative DRAWings 5. By the end of this chapter you will be able to embroider a sample design, 
use an old stitch file to create a new embroidery design, convert a bitmap image (picture) to a 
finished embroidery piece and create a design from scratch by using the available tools. We will 
also present the available ways to import artwork from a Webcam snapshot or a Scanner device. 
In addition, you will become familiar with the working space of Creative DRAWings.  

Creating your first embroidery 

This is a step-by-step tutorial to guide you in creating your first design with Creative DRAWings.  

1. Start Creative DRAWings 5 application by double clicking on shortcut icon that you 

will find on your Desktop.  

2. Creative DRAWings application will open and the starting dialog named New Design will 

appear. 

 
Figure 2.1: Starting dialog 

3. Select the Create new option and click Next> button. 

4. The Artwork source dialog will appear (Figure 2.2) 

5. Select the From File option. 

6. Click on the browse button  at the right to import the design you want to embroider.  
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Figure 2.2: Starting dialog - 2

nd
 page  

7. The Open dialog box will appear (Figure 2.3) from where you can find the design you want 

to embroider. 

 
Figure 2.3: Open design dialog 

8. Click on My documents folder at left side of the dialog. 

9. Then find and double click on the Embroidery designs folder  

10.  Inside Embroidery designs folder you will find another folder called Creative DRAWings 

samples. Double click on it. 

11. Inside the Creative DRAWings samples folder you will find ready-made Vector (clipart) 

designs that you can import into Creative DRAWings and convert them to stitches. You 

can select to embroider any of them but for our example we will use the ASC_00179.cmx 

file as it is shown in the Figure 2.3  

12. Select it and click the Open button.  
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13. The Artwork source dialog will appear once more (Figure 2.2) with the design you have 

selected under From file field.  

14. At the Hoop section of the same dialog, you can select the hoop which you will embroider 

your design on. If the hoop your machine supports does not exist in the list select one with 

similar dimensions. You can create your custom hoops easily inside Creative DRAWings. 

(Information on adding specific hoops will be covered later in the manual.) 

15. After selecting the Hoop, click Next> to continue. 

16. The Fabric dialog will appear (Figure 2.4). Expand the Embroidery normal category from 

the list at the left by clicking on the + icon next to it. 

17. Select the Fabric similar with the one you will actually use to embroider the design. For 

example, select Craft Fleece fabric.  

 
Figure 2.4: Select fabric dialog 

18. After selecting the Fabric, choose the color from the list at the middle of the dialog. For 

example, select gray color.  

19. Click Next> button to continue. 

20. The Color reduction (number of threads) dialog (Figure 2.5) will appear where you can 

select the Thread palette.  

21. Click on the arrow of Palette and the drop-down menu will show the threads available. 

22. Select the brand-name threads you want to use by clicking on the list. For example, select 

Gunold Poly thread. 

23. The colors of the design you are importing will automatically be assigned to the closest 

thread color of the Gunold Poly thread palette.  
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Figure 2.5: Color reduction dialog 

24. In Color reduction dialog you can see that the design has 7 colors in Threads to use. You 

can reduce the number of colors in the design by moving the arrow to the left.  Click Finish 

to end the process and convert the imported design to stitches.  

25. The design will appear in the working area filled with stitches (Figure 2.6). 

 
Figure 2.6: The imported design converted to stitches 

26. Your 3D design will be positioned at the center of the hoop which you selected from the 

starting dialog.  

27. There are many available changes to do on the artwork or on the stitches of the design 

inside Creative DRAWings but we will not explain them now in this section. The design 
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which was produced here can be embroidered as is without any problem. The important 

thing right now is that you can see what this fantastic software can do by sewing out your 

first embroidery design. 

28. Before embroidering, save your design to the embroidery file format which your machine 

supports. Select File menu, Save as option.  

29. The Save As dialog will appear. Select a location to save all your embroidery files. For 

example, file to My documents> Embroidery designs. You can also save designs directly 

to a floppy disk or to your memory card. 

  
Figure 2.7: Save As dialog box 

30. In the File name field, give your design a name. For example, type    My first Embroidery. 

31. Then click on the arrow of Save as type drop-down menu to view the available file-type 

options. Select any that your embroidery machine reads. For example, if you have 

“Brother” embroidery machine you have to select the .pes or .pec embroidery file format. 

Always remember to save your design in .draw file format before saving it to any 

embroidery machine‟s file format. This file format holds all design information that is 

necessary to re-use this design without any loss.  

32. Once you are ready, click Save. The design will be saved in the location you chose with the 

name you gave to it. If you have saved the design directly to a floppy disk, a thumb drive, or 

to your hard drive, you are ready to download it to your embroidery machine‟s memory card 

and sew it out. Otherwise you have to: 
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A. Open Windows Explorer,  

B. Browse to the location you saved it,  

C. Right click on the file and from the right click menu expand the Send to submenu  

D. Save to a 3.5 Floppy disk (A:) or to a thumb drive 

E. Then the design can be downloaded to your embroidery machine‟s memory card to 

be sewn out. (Note: in big commercial machines, the file can be downloaded directly 

to the machine‟s memory. 

33. After saving the design, make a printout so you can set the functions of the embroidery 

machine correctly and sew it out without any problem. 

34. To do that, from File menu select Print option.  

 
Figure 2.8: Printout of the design 

35. The Print preview dialog of the design will appear where all the information you need is 

listed to embroider the design correctly. If you have a printer you can press OK button and 

make a Printout of the design. If you do not have a printer or don‟t want to print it, you can 

save it as an image file and view it with the standard image viewer of Windows.  

36. To save the Printout to as image file, you have to click on the Save to JPG button. 

37. The Save printout as dialog will appear where you have to:  

A. Specify the location you want the image to be saved. 

B. Type the File name you want the image to have  

C. Click on Save button. 

D. You can view the saved image by double clicking on it.  
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38. All the information you need in order to embroider a design is listed in the Printout, 

including the embroidery design‟s sequence (1-2-3 order of sewing out), the color changes, 

the number of stitches, and much more useful information. 

39. You are ready -- Download the file to your embroidery machine, use the Printout as your 

guide to set up your machine, and embroider the design you have just created. 

Scan a design and embroider it  

Sometimes we may find a design in a magazine or a flyer which you would like to embroider but 
don‟t realize how easy it is to acquire the image. If your computer has a scanner installed, you can 
scan and import almost any design you want to embroider. 

Important: The design which you desire to convert to stitches must be compatible for embroidery 
and must be able to be filled with stitches. Photos from your camera cannot be easily filled with 
stitches. Later, you‟ll learn to Trace your photos and then fill with stitches.  

Follow these steps to convert a Bitmap (picture) images to an embroidery design with your 
scanner: 

1. Turn on the scanner and place the image in it. 

2. Open Creative DRAWings by double clicking on the desktop icon  

3. Creative DRAWings application will open and the starting dialog New Design will appear. 

 
Figure 2.9: Starting dialog 

4. Select the Create new option and click Next> button. 

5. The Artwork source dialog will appear. (Figure 2.10) 

6. Select the Get image from scanner. 

7. At the Hoop section of the same dialog, you can select the hoop that you will embroider 

your design on. If the hoop your machine supports don‟t exist in the list, select one with 

similar dimensions. You can create your custom hoops easily inside Creative DRAWings 

later. 
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Figure 2.10: Starting dialog - 2

nd
 page  

8. Click Next> button to continue. 

9. The Image Scan dialog appears.  

 
Figure 2.11: Image scan dialog 

10. The Image Scan dialog helps you scan the image you want to embroider and import it into 

Creative DRAWings. If your scanner is correctly installed, all you have to do is press the 

Preview button.  

11. The design will be scanned and the image will appear in Preview. You can specify the 

exact image to want to embroider in Preview by drawing a rectangle with your cursor. Only 

the area inside the rectangle will be embroidered.  

12. If the design in the Preview is what you want to embroider, press the Scan button to 

continue.  

13. Then you will be asked to save the design on your hard disk. The Save As dialog will 

appear. 
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Figure 2.12: Save as dialog 

14. Select My documents icon from the left side and then double click on the Embroidery 

designs folder. 

15. In the File name field, type a name for your image. 

16. Select Save button to save the scanned image. The scanned image is saved as bitmap 

image (like photo) with .jpg file extension.   

 
Figure 2.13: Artwork image dialog 

17. The Artwork Image dialog will appear providing four conversion options. 

a. Open as Backdrop: This option can import the image into Creative DRAWings 

without any changes. The image is used as a reference to create an embroidery 

design from scratch. You select and draw freehand what objects you want in your 

design. 

b. Trace: This option will guide you to convert the Bitmap (picture) image that you are 

importing to a Vector (clipart) based image which will be filled with standard 

embroidery (Satin, Step, Satin serial or Running stitches). Tracing a Bitmap image is 
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not an easy procedure; therefore you must be careful with the images which you are 

tracing. They must be clear so that they can be actually embroidered. (Such image is 

the one that it is shown at Figure 2.14) 

c. Open as Cross stitch: This option imports the image as it is and fills it with cross-

stitches (X‟s). This is the easiest way to fill a Bitmap (picture) image with stitches 

and it is the best choice for images which cannot be embroidered with standard 

embroidery stitches.  

d. Open as Photo stitch: This option will convert the imported image from scanner into 

a Photo stitch design. 

18. In our example we will select Trace option and press the Next> button.  

 
Figure 2.14: Trace image dialog 

19. Trace Image dialog will appear with the scanned image. In the Preview area you can see 

how the result of the traced picture will look like. The Vector (clipart) design from tracing 

the scanned image is the same image you see in the Preview of the Trace Image dialog. 

What you see is what you get. And with Creative DRAWings it‟s what will be . . . when 

sewn out.  

20. You can also adjust the traced result by changing the available options which are listed at 

the left side of the dialog.  

a. You can change the size of the Trace result by adjusting the Scale image option. 

b. You can set how exact the traced image will be to the scanned image by adjusting 

the Accuracy value. 

c. You can select the number of colors for your traced image by adjusting the Color 

limit value. 

d. And you can remove the background color that the scanned Bitmap images usually 

have by using the Use background option. 

e. Any changes you make to these options are automatically adjusted by Creative 

DRAWings and shown in Preview. We will learn of these options more in the next 

chapter. 

21. Use the default options for this example and press the Trace button. 
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22. The Fabric dialog will appear (Figure 2.15). Expand the Embroidery Normal category from 

the list by clicking on the + icon next to it. 

23. Select the fabric that is similar with the one you will actually use to embroider the design. 

For example, select Craft Fleece fabric.  

 
Figure 2.15: Select fabric dialog 

24. After selecting the Fabric, choose the Color for your fabric from the boxes in the middle. 

For example, select gray color.  

25. Click Next> button to continue. 

26. The Color reduction dialog (Figure 2.16) will appear where you can select the Thread 

palette you will use.  

27. Click on the arrow of the Palette drop-down menu and the available thread manufacturers 

will appear. 

28. Select the brand-name thread you want by choosing it from the list. For example, select 

Gunold poly. 

29. The colors of the design you are importing will automatically be assigned to the closest 

thread color of the Gunold poly in the Thread palette  
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Figure 2.16: Color reduction dialog 

30. In the same dialog you can see that your design has 10 different colors of thread. The 

number of colors can be reduced now by sliding the Threads to Use arrow to the left. Color 

reduction can also be applied later inside the software. The reduction of colors from 10 to 

let‟s say 8 won‟t affect the design much, but the embroidery time will be reduced. Take 

some time and use the slider of Threads to use. Finally click Finish to end the process 

and convert the imported design to stitches.  

31. The design will appear in the working area filled with stitches (Figure 2.17). 

 
Figure 2.17: The traced image converted to stitches 

32. The design will be positioned at the center of the hoop you selected in the starting dialog.  
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33. Many changes can be made in the design which was produced by scanning the Fish image. 

We will not take the time here to explain them, but we must say that the Traced design 

must be edited to increase its quality and to prepare it for embroidery. By increasing the 

quality of the Vector artwork you automatically increase the quality of the embroidery 

design.  

34. When finished editing your design, you can proceed to the embroidering process. Save the 

design to any embroidery file format that your machine can read. Select from File menu the 

option Save As.  

35. The Save As dialog will appear. Select a location to save all your embroidery files. For 

example, file to My documents> Embroidery designs. You can also save designs directly 

to a floppy disk or to your memory card. 

 
Figure 2.18: Save As dialog box 

36. In the File name field, name your design file. For example, type Mysecond Embroidery. 

37. In the Save as type box, click on the drop-down arrow to select an embroidery format for 

the saved design. You must always use the ones that are suitable for your embroidery 

machine. For example, if you have “Brother” embroidery machine you have to select the 

.pes or .pec embroidery file format.  

 

38. When finished with the design, click Save. The design will be saved in the location you 

chose with the name you gave to it. If you have saved the design directly to a floppy disk, a 

thumb drive, or to your hard drive, you are ready to download it to your embroidery 

machine‟s memory card and sew it out. Otherwise you have to: 

A. Open Windows Explorer,  

Always remember to save the design in .draw file format before saving it to any embroidery 
machine‟s format. This format holds all design information and can be used easily again and 
again to reproduce any embroidery machine file. 
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B. Browse to the location you saved it,  

C. Right click on the file and from the right click menu expand the Send to submenu  

D. Save to a 3.5 Floppy disk (A:) or to a thumb drive. 

E. The design can be downloaded to your embroidery machine‟s memory card to be 

sewn out. (Note: in big commercial machines, the file can be downloaded directly to 

the machine‟s memory). 

39. After saving the design, make a printout so you can set the functions on the embroidery 

machine correctly and then sew it out without any problem. 

40. To do that, from File menu select Print option.  

41. The Print preview dialog of the design will appear with all the listed information you need 

to embroidery the design correctly. If you have a printer you can press OK button and make 

a Printout of the design. If you do not have a printer or you do not want to print it, you can 

save it as an image file and view it with an image viewer. 

42. To save the Printout to as image file, you have to click on the Save to JPG button. 

43. The Save printout as dialog will appear where you have to  

A. Specify the location you want the image to be saved, 

B.  Type the File name you want the image to have  

C. Click Save button. 

D. You can view the saved image simply by double clicking on it.  

44. All the information you need is listed in the Printout, including the embroidery design‟s 

sequence (1-2-3 order of sewing out), the color changes, the number of stitches, and much 

more useful information. 

45. You are ready -- Download the file to your embroidery machine, use the printout as your 

guide to set up your machine, and embroider the design you have just created. 

Get image from Webcam 

Another way to acquire an image from a magazine or a flyer or from a drawing you have created 
on a page is by using any webcam that is attached on your pc. If your computer has a webcam 
installed (most modern laptops have a webcam already installed), you can capture a snapshot 
image and import almost any design you want to embroider. 

 

Follow these steps to convert a Bitmap (picture) images to an embroidery design with your 
Webcam: 

1. Start Creative DRAWings application by double clicking on shortcut icon that you will find 

on your Desktop.  

2. Creative DRAWings application will open and the starting dialog named New Design will 

appear. 

Important: The design which you desire to convert to stitches must be compatible for 
embroidery and must be able to be filled with stitches.  
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Figure 2.19: Starting dialog 

3. Select the Create new option and click Next> button. 

4. The Artwork source dialog will appear (Figure 2.20) 

5. Select the Get image from webcam option. 

6. At the bottom of the dialog you can select a Hoop to be used for the design. If you can find 

any Hoop that is compatible to your machine select one with similar dimensions. You can 

also create custom hoops easily.  

 
Figure 2.20: Starting dialog - 2nd page  

7. Click Next> button to continue. 

8. The webcam Preview dialog appears.  
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Figure 2.21: Image scan dialog 

9. The webcam Preview dialog helps you capture the image you want to embroider and 

import it into Creative DRAWings. If your webcam is correctly installed, all you have to do 

is press the Capture button and take a snapshot of the design you want.  

10. The design will be captured and the image will appear in Preview area. You can specify the 

exact image to want to embroider (crop image) in Preview by drawing a rectangle with your 

cursor. Only the area inside the rectangle will be embroidered. We will leave it as it is. 

  
Figure 2.22: Image scan dialog 

11. If you are not satisfied with the image you captured you can click on the Capture new 

button and take a new snapshot. 

12. If the design in the Preview is what you want to convert, press the Save button to continue.  

13. Then you will be asked to save the design on your hard disk. The Save As dialog will 

appear. 
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Figure 2.23: Save as dialog 

14. Select Documents icon from the left side and then double click on the Embroidery 

designs folder. 

15. In the File name field type a name for your image. 

16. Select Save button to save the scanned image. The captured image is saved as bitmap 

image (like photo) with .jpg file extension.   

 
Figure 2.24: Artwork image dialog 

17. The Artwork Image dialog will appear providing four options. 

a. Open as Backdrop: This option imports the image into Creative DRAWings without 

any changes. The image is used as a reference to create an embroidery design from 

scratch. You select and draw freehand what objects you want in your design. 

b. Trace: This option will guide you to convert the Bitmap image that you are importing 

into a Vector design that will be filled with stitches. Tracing a Bitmap image is not an 
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easy procedure; therefore you must be careful with the images which you are tracing. 

They must be clear and ones that can be actually embroidered.  

c. Open as cross stitch, this option will convert the webcam snapshot into a cross stitch 

design. 

d. Open as photo stitch, using this option you can convert the design into Photo stitch 

design. 

18. In our example we will select the Trace option and press the Next> button.  

 
Figure 2.25: Trace image dialog 

19. The Trace Image dialog will appear with the captured image imported. In the Preview on 

the right you can see what the traced result of the Bitmap (picture) image will look like. The 

Vector (clipart) design from tracing the scanned image is the same image you see in the 

Preview of the Trace Image dialog. What you see is what you get. And with Creative 

DRAWings it‟s what will be embroidered.  

20. You can also adjust the traced result by changing the available options which are listed at 

the left side of the dialog.  

a. You can change the size of the Trace result by adjusting the Scale image option. 

b. You can set how exact the traced image will be to the scanned image by adjusting the 

Accuracy value. 

c. You can select the number of colors for your traced image by adjusting the Color limit 

value. 

d. And you can remove the background color that the scanned Bitmap images usually 

have by using the Use background option. 

Any changes you make to these options are automatically applied and shown in the 
Preview area. We will refer to these option in more detail in the next chapter. 

21. Change the Color limit to 15, and press the Trace button. 



Creative DRAWings Embroidery Software Manual 
 

32 Chapter 2 - Quick start   DRAWstitch Ltd.  
  

22. The Fabric dialog will appear (Figure 2.26). Expand the Embroidery Normal category from 

the list by clicking on the + icon next to it. 

23. Select the fabric that is similar with the one you will actually use to embroider the design. 

For example, select Craft Fleece fabric. 

  
Figure 2.26: Select fabric dialog 

24. After selecting the Fabric, choose the Color for your fabric from the boxes in the middle. 

For example, select gray color and Click Next> button to continue. 

25. The Color reduction dialog (Figure 2.27) will appear to select a Thread palette to be used 

for the design.  

26. Use Palette drop-down menu to review the available thread manufacturers and select one 

that you prefer. For example, select Gunold Poly. 

27. The colors of the converted design will be automatically assigned to the closest thread color 

of the Gunold Poly in the Thread palette.  

  
Figure 2.27: Color reduction dialog 
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28. In the same dialog you can see that your design has 10 colors of thread. You can reduce 

the available colors, using the Threads to use slider. Click Finish to end the process and 

convert the imported design into stitches.  

29. The design will appear in the working area filled with stitches (Figure 2.28). 

     
Figure 2.28: The traced image filled with stitches 

30. The design will be positioned at the center of the selected hoop.  

31. We can use the option Backdrop -> Hide from View menu to hide the backdrop that has 

been also imported, in order to work easier with the actual design. 

  
Figure 2.29: Remove unneeded objects and hide backdrop image 

32. Now we are ready to edit and save the design.  

33. You can make a printout so that you can set the functions on the embroidery machine 

correctly and then sew it out without any problem. 

34. To do that, from File menu select Print option.  
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35. The Print preview dialog of the design will appear with all the listed information you need to 

embroider the design correctly. If you have a printer you can press OK button and make a 

Printout of the design. If you do not have a printer or you do not want to print it, you can 

save it as an image file and view it with an image viewer.  

  
Figure 2.30: Printout dialog box 

36. To save the Printout to as image file, you have to click on the Save to JPG button. 

37. The Save printout as dialog will appear where you have to  

A. Specify the location you want the image to be saved, 

B. Type a File name you want the image to have  

C. Click on Save button. 

D. You can view the image you have saved by double clicking on it.  

38. All the information you need is listed in the Printout, including the embroidery  sequence 

the color changes, the number of stitches, and much more useful information. 

39. You are ready – Load the file to your embroidery machine, use the printout as your guide to 

set up your machine, and embroider the design you have just created. 

Import a stitch file and embroider it  

Creative DRAWings gives you the ability to import stitch files (.dst, .pes, .hus, .M3, .ngs, etc.) 
and work with them. You can change colors, move and slant stitch objects, add new embroidery 
objects by designing them from scratch, or copying and pasting them from a different source. You 
can also convert the Stitch objects into Vector (clipart) objects which will allow you to change 
their stitch types and shapes.  

This is a step-by-step tutorial to guide you on importing a Stitch file inside Creative DRAWings, 
change colors, add text and produce a new embroidery design based on an old design.  



Creative DRAWings Embroidery Software Manual 
 

35 Chapter 2 - Quick start   DRAWstitch Ltd.  
  

1. Start Creative DRAWings application by double clicking on this shortcut icon  on 

your Desktop.  

2. Creative DRAWings will open with the starting dialog of New Design. 

 
Figure 2.31: Starting dialog 

3. Select the Create new option and click Next> button. 

4. The Artwork source dialog will appear (Figure 2.32) 

5. Select the From Embroidery option at the top of the dialog. 

6. Click on the browse button  at the right to import the Stitch file design you want to 

embroider.  

 
Figure 2.32: Starting dialog - 2

nd
 page  

7. The Open dialog box will appear (Figure 2.33) and you can find the design you want to 

embroider. 
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Figure 2.33: Open design dialog 

8. Click on My documents folder at left side of the dialog. 

9. Find and double click on the Embroidery designs folder.  

10. Inside Embroidery designs folder, you will find another folder called Creative DRAWings 

samples. Double click to open it. 

11. Inside the Creative DRAWings samples folder you will find .ngs stitch files which you can 

import into Creative DRAWings. You can import any of them, but for our example we will 

use the CDW0004.ngs file as it is shown in the Figure 2.34  

12. Select it and click the Open button.  

13. The Artwork source dialog will appear once more (Figure 2.32) with the design you 

selected under From file field.  

14. At the Hoop section of the same dialog, you can select the hoop that you will embroider 

your design on. If no hoop that your machine supports exists in the list, select one with 

similar dimensions. You can create your custom hoops easily (Information on adding 

specific hoops will be covered later in this manual.) 

15. After selecting the Hoop, click Next> to continue. 

16. The Fabric dialog will appear (Figure 2.34). Expand the Embroidery Normal category from 

the list at the left by clicking on the + icon next to it. 

17. Select the Fabric that is similar with the one you will actually use to embroider the design. 

For example select Craft fleece fabric.  
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Figure 2.34: Select fabric dialog 

18. After selecting a Fabric, choose a color from the list at the middle of the dialog. Click Next> 

button to continue. 

19. The Color reduction (number of threads) dialog (Figure 2.35) will appear where you can 

select your Thread palette. Use Palette drop-down menu to select any of the available 

thread manufactures palette. For example, select Gunold Poly thread. 

20. The colors of the design you are importing will automatically be assigned to the closest 

thread color of the Gunold Poly in the Thread palette.  

 
Figure 2.35: Color reduction dialog 

21. In the same dialog you can also reduce the number of the design colors. Our design has 7 

different colors of thread. The number of colors can be reduced now, or later inside the 

software. Click Finish to end the process and convert the imported design into stitches.  

22. The design will appear in the working area filled with stitches (Figure 2.36). 
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Figure 2.36: The imported design converted to stitches 

23. We can change the colors of the hearts and add some text to the imported design. You can 

make many changes to the embroidery design, but we will not cover that in this tutorial. The 

available tools that Creative DRAWings includes are presented thoroughly in following 

chapters.  

24. To change the color of each heart, select a heart by left clicking on it and then left clicking 

on the color you want from the Thread palette bar at the bottom of the screen. The Thread 

palette is split to two parts; the part on top where all the available colors of the Gunold 

Poly thread colors are listed and the bottom part where the 7 currently used colors on the 

design are listed. 

25. Change the objects colors by following the steps above, and then produce the design 

shown in Figure 2.37 

26. Now we will add some text to the design. 

27. Activate the Text tool by left clicking on the  icon located on the Tools toolbar at the left 

side of the screen. 

28. Left click on the position you want the text to be placed and a blinking line will appear which 

allows you to insert your text. 
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Figure 2.37: We changed the colors of the imported stitch file 

29. Type “I love you.”  You can change the Font by selecting a different one from the Font 

name drop-down menu on top of the screen. You can also change the Font size by typing 

its dimensions.  (Figure 2.38). If you want the text to be Bold or Italic, click on one. 

 
Figure 2.38: Tool options bar – Text options 

30. For this tutorial, the options were made as shown in Figure 2.38. If you‟ve been following 

this tutorial on your screen, left click on the Rectangle selection tool  from Tools 

toolbar to confirm our changes. 

31. Select the Text object by clicking on it. 

32. Change its Fill color by clicking on the yellow color and set its Pen (outline) color to None 

by holding the Shift key pressed and left clicking on the None color icon. The None 

color icon will change to this  and the Pen color will be removed from the Text object.  

33. The design should look like Figure 2.39.  
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Figure 2.39: The design with some text added. 

34. Now we are ready to embroider the design.  

35. To proceed to the embroidery process you have to save the file to the embroidery file 

format your machine can read. To do that you have to select the File menu and then the 

Save as option. (Figure 2.40).  

 
Figure 2.40: Save As dialog box 

36. Use Save as type drop down menu to select one of the available embroidery type files to 

export the design. For example, if you have Brother Embroidery machine you have to select 

the .pes or .pec embroidery file format. 

37. In the File name field that is located at the bottom of the dialog type the name you want the 

design to have. For example, type MyEmbroiderydesign. 

38. Remember to save your design in .draw file format before saving it to any embroidery 

machine‟s format, because this is the file format which Creative DRAWings uses to store 

all design information. 

39. When finished with the design, click Save. The design will be saved in the location you 

chose with the name you gave to it. If you have saved the design directly to a floppy disk, a 

thumb drive, or to your hard drive, you are ready to download it to your embroidery 

machine‟s memory card and sew it out. Otherwise you have to: 

a) Open a windows explorer,  

b) Browse to the location you have save it,  

c) Right click on it and from the right click menu expand the Send to submenu  

d) Save to a 3.5 Floppy disk (A:) or to a thumb drive  
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e) Then your design can be downloaded to your embroidery machine‟s memory card to be 

sewn out. (Note: in big commercial machines, the file can be downloaded directly to the 

machine‟s memory). 

40. After saving the design, make a printout so you can set the functions on the embroidery 

machine correctly and then sew it out without any problem. 

41. To do that, from File menu select Print option.  

42. The Print preview dialog, offers all the information that is needed in order to embroider the 

design correctly. Press OK button to create the Printout of the design. If you do not have a 

printer or you do not want to print it, you can save it as an image file and view it with an 

image viewer.  

 
Figure 2.41: Printout of the design 

43. To save the Printout to as image file, you have to click on the Save to .jpg button. 

44. The Save printout as dialog will appear where you have to specify the location you want 

the image to be saved, 

A. Specify the location you want the image to be saved  

B. Type the File name you want the image to have 

C. Click on Save button 

D. You can view the image you have saved by double clicking on it.  

45. All the information you need is listed in the Printout, including the embroidery sequence of 

the design (1-2-3 order of sewing out), the color changes, the number of stitches, and much 

more useful information. 

46. You are ready. Download the file to your embroidery machine, use the printout as your 

guide to set up your machine, and then sew out the design you have just created. 
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Create a design from scratch 
Creative DRAWings provides the ability to create an embroidery design from scratch by using all  
available designing tools and your creativity. With the designing tools that the software includes 
you can create any embroidery design you want easily and quickly. In this section we will show 
you how to create a design step by step.  

1. Start Creative DRAWings application by double clicking on shortcut icon  that you 

will find on your Desktop.  

2. Creative DRAWings application will open and the starting dialog will appear. 

 
Figure 2.42: Starting dialog 

3. Select Create new option and click Next button. 

4. The New design dialog will appear (Figure 2.43) 

5. Select the New graphic option that is located at the bottom of the dialog. 

 
Figure 2.43: Starting dialog - 2

nd
 page  
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6. At the Hoop section of the same dialog, you can select the hoop that you will embroider 

your design on. If the hoop your machine supports does not exist in the list select one with 

similar dimensions. You can create your custom hoops easily inside Creative DRAWings. 

7. After selecting the hoop you want Click Next> button to continue. 

8. The Select Fabric dialog will appear (Figure 2.44). Expand the Embroidery normal 

category from the list at the left by clicking on the + icon next to it. 

9. Select the fabric that is similar with the one you will actually use to embroider the design. 

For example select Craft Fleece fabric.  

 
Figure 2.44: Select fabric dialog 

10. Select a color for the fabric that your fabric has from the color list at the middle of the dialog. 

For example select gray color.  

11. Click Next> button to continue. 

12. The workspace will appear with the selected hoop at the center but without any design in it. 

13. We will create a flower by using the available designing tools of Creative DRAWings. From 

the Tools toolbar that is located at the left side of the working space, and holds all the 

designing tools select the ellipse tool . The ellipse tool is above the Text tool . If a 

different shape is visible at that position, click on the small arrow at the bottom right of the 

icon to expand it and then select the ellipse tool that will appear. 

 

14. With the ellipse tool selected, draw an oblong shape like a petal, by click and dragging with 

the mouse on the working area (Figure2.45).The oblong shape that you create will 

automatically be filed with Satin stitches and have a running outline. If the shape you 

created is big, it will be filled with Step stitches.  

15. The shape will be filled with the default Fill color and the default Outline/Pen color. To 

change the Fill color you have to select the shape/object and Left click on the color you 
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want from the Thread palette toolbar at the bottom of the screen. To change the 

outline/Pen color you have to hold the Shift key pressed from the keyboard and then left 

click on the color you want.  

 
Figure 2.45: Draw an oblong shape 

16. In our case we do not want the shape to have any outline/pen color. We will hold Shift key 

pressed and then click on the None color icon . The outline will be removed from the 

shape and the None color icon will change to  icon, which means that our shape does 

not have any outline color. 

17. Select the shape by clicking on it.  

18. At the middle of the selected shape you will see a small cross. This is the rotation center of 

the design. Click and drag it to the bottom of the shape and position it outside of the shape. 

This will allow us to rotate the shape based on a different rotation center. 

 
  Select shape – Move Rotation center– Rotate from top-right corner and duplicate 

19. Position the mouse on the top right corner until you see the rotation icon, which is a curved 

arrow.  

20. Click and drag the clockwise and the object will start rotating. At the point that the original 

shape ends, Right click once while keeping the Left click pressed, to activate the 

Duplicate function. The cursor will change to this icon . When you are ready release 

Rotation center 

Rotation center 

Rotate and 
Duplicate 
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the left click to Duplicate the object. The duplicated object will appear at the position you 

rotated.  

21. To avoid doing that again and again until you draw all petals of the flower, you can simply 

select the Repeat last transform option from the Edit menu. This option will redo your last 

transformation, based on the last inserted petal, as many time you want. The result is 

shown on Figure 2.46. 

 
Figure 2.46: Apply Repeat last transform option 

22. Now we will design the center of the flower.  

23. Select the Ellipse tool , once more, from the Tools toolbar. 

24. By click and dragging on the center of the petals, draw a circle. If you hold the Ctrl key 

pressed while dragging with the mouse diagonally, guidelines will appear that help you 

draw the shape based on them. By dragging based on the diagonal guideline you can draw 

a perfect circle. (Figure 2.47) 

   
Figure 2.47: Draw a circle – remove outline - change color 

25. If the circle you created is not exactly at the center of the petals you can move it by click 

and dragging it to the position you want.  

26. Select the circle you created, change its color to Yellow and remove its outline by 

following the same procedure we described on 15 and 16 steps. (Figure 2.47) 

27. Your flower is ready to be embroidered.  

28. To avoid losing you work you have to save the design in .draw file format that makes it fully 

editable inside Creative DRAWings. To do that you have to select the File menu and then 

the Save as option.  
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Figure 48: Save As dialog box 

29. The Save As dialog will appear. Find the location you want the file to be saved. For 

example, inside the Embroidery designs folder that is located inside My documents 

folder. If you want you can save the design directly to your floppy disk or your memory card 

that your machine reads. 

30. In the File name field that is located at the bottom of the dialog type the name you want the 

design to have. For example, type Mydesign. 

31. Then click on the Save as type drop down menu arrow to view the available file type 

options. Select the .DRAW type which is the first on the list. The .DRAW file format is the 

file format that Creative DRAWings supports and holds your artwork together with your 

stitches. Click Save button to continue.  

32. If you want to embroider the design you have to save it also to the file format your 

embroidery machine reads. For example, if you have Huqsvarna embroidery machine you 

have to select the .Hus or .Vip embroidery file format.  

33. After saving the design, make a printout so you can set the functions on the embroidery 

machine correctly and then sew it out without any problem. 

34. To do that, from File menu select Print option.  

35. In appearing Print preview dialog we can find all necessary information in order to 

embroider the created design correctly. If you have a printer you can press OK button and 

make a Printout of the design. If you do not have a printer or you do not want to print it, you 

can save it as an image file and view it with an image viewer program.  
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Figure 2.49: Printout of the design 

36. To save the Printout as image file you have to click on the Save to JPG… button. 

37. The Save printout as dialog will appear where you have tο:  

 Specify the location to save the file. 

 Type a filename for the file. 

 Click on Save button 

 In order to view the saved image you have to simply double click on the created file. 

38. All the information you need is provided in the Printout including the Embroidery sequence 

of the design, the color changes the number of stitches and many more useful information. 

You are ready. Load the file to your embroidery machine, use the printout as your guide to setup 
your machine and embroider the design you have just created. 

Workspace tour 
The main application window (Figure 2.50) consists of a variety of menus, toolbars, wizards and 
dialog windows. All these together with the design tabs are called a workspace. A workspace is 
any combination of the above components. The way that the workspace components and windows 
are placed is fully customizable. When opening the application for the first time all these tools are 
placed by default in a way to help you focus on your task (creating, editing and viewing designs). 
Make any arrangement on workspace components in order to have a workspace that matches 
your personal preferences. More information about customizing workspace will be provided later 
on this chapter. Some of the workspace components are available only in Create mode and some 
of them change inside stitch mode because they have dynamic contents.  

Introduction 

Take some time using all the available workspace components. As you are getting more familiar 
with the tools and their usage you will improve your productivity. Let‟s take a look at the tools and 
their default placement. This is the main application window of Creative DRAWings. 



Creative DRAWings Embroidery Software Manual 
 

48 Chapter 2 - Quick start   DRAWstitch Ltd.  
  

 
Figure 2.50: Creative DRAWings application window 

Start-up wizard 

The application always starts with a wizard (Figure 2.51) prompting you to create a New design or 
load an existing. Use any of the provided options and follow the instructions and easily start a new 
design from scratch or based on various sources of artwork. You can also edit and reuse any of 
your existing designs. 

1. Select Create new and then press Next to proceed. 

  
Figure 2.51: Step 1 Start-up wizard 

2. Select any artwork source, a hoop for the new design and press Next to proceed.  

Create new design 
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Figure 2.52: Step 2 Start-up wizard select artwork source 

The usage and the customization of each artwork source will be described thoroughly into 
separate sections later on this chapter. In order to open a design select Open existing and 
then press Browse to locate your design. You can also open with a single click one from the 
list with recently used designs. 

 
Figure 2.53: Start-up wizard load existing design 

Follow the options of the wizard to create a new design or open an existing. At the final dialog of 
the wizard press Finish. The design area will appear blank, with an existing design or with a 
provided artwork. 

Workspace components  

We will now describe the available workspace components and the ways to customize them. On 
the top area of the application window you can see the Title bar, the Main Menu bar, the 
Standard toolbar, Draw-Stitch toolbar and Tool options pane. On the left side of the application 
window you can see Tools toolbar. You can also see the Thread palette and the Status bar at 
the bottom area of the window. On the right side of the design area you can see Object 
properties pane.  Object properties toolbar is a context sensitive bar because it provides 
properties for the object you have selected. Each object might have different properties depending 

Select open existing design 

Browse your computer to 

locate existing designs 

Select any of the recently used designs 
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on its size and shape. While using the application there are also some transparent dialogs that 
appear on top of the design area. Let‟s take a closer look at all these components. 

 
Figure 2.54: workspace components 

Main menu bar  

Under the title bar is located the Main menu bar. This bar provides access to most of the 
commands that control the main functionality Creative DRAWings. It consists of several menus, 
click on any of them (for example, File, Edit, View, Tools) to see the included menu commands. 

 
Figure 2.56: Main menu bar 

Icon Toolbars 

In any windows application there are usually a number of icon toolbars. They have shortcuts to 
dialog boxes or actions. Click on any icon of the program‟s toolbars to see the performed action. 
You can also pause your mouse over any of the icons and a popup containing information about 
the action will appear.  

Sequence 
manager 

Object properties 

Tool options bar 



Creative DRAWings Embroidery Software Manual 
 

51 Chapter 2 - Quick start   DRAWstitch Ltd.  
  

 
Figure 2.57: Icon toolbars (Standard, Align and DRAW-Stitch bar) 

These 3 bars that are highlighted on the above figure are the Standard, the Align and the Draw-
Stitch bar. In case that any of these bars is not visible you bring it up using the respective options 
of menu View  Toolbars section.  This way you can select which toolbars will appear on 
workspace and which will not. On above figure you can see all the icons toolbars enabled and 
appearing on the workspace. 

1. Standard toolbar, this toolbar is a collection of buttons that serve as shortcuts for the basic 

functionality of the application. Most of these icons implement the same functionality in the 

majority of windows applications. If you are familiar to any windows application, you have 

used many times, tools such as new design, open design, Save, Cut or Paste. Besides 

these basic file operations, in Standard toolbar, you can select zoom preset, use shaping 

tools (Weld, Trim, and Intersect), Select Fabric and Thread manufacturer palette.  

 
Figure 2.58: Standard toolbar 

2. Align bar, this icon toolbar is located at the top area of the applications workspace and 

contains aligning, distributing and auto-sizing tools.  

 
Figure 2.59: Align bar 

3. DrawStitch bar,  using this toolbar you can toggle between the available design modes. 

Creative DRAWings software has two important working modes, the Create and the 

Stitch mode. We can design anything we like in Create mode and Convert the design into 

stitches in Stitch mode. The Create mode is mainly for creating and editing the artwork. In 

Stitch mode you can convert the artwork to stitches and make the final adjustments. 

Different controls and options are available in any of the two modes. By pressing DRAW 

icon  or by using Ctrl+1 keyboard shortcut you enable Create mode. In order to switch 

to Stitch mode you must press Stitch icon  or Ctrl+2 keyboard combination. 

 

 

 

4. Tool options pane is a context sensitive toolbar. Depending on the tool you have selected 

from the toolbox the property bar changes accordingly. It also contains controls that you 

Draw mode 

Stitch mode 
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can use to change the properties of the selected object. Some of the available tools have 

extra parameters that appear on the Tool options toolbar, every time you select them. 

 
Figure 2.60: Tool options pane 

5. Tools toolbar, this toolbar contains shortcuts for most of the viewing and designing tools. 

Selection modes (Rectangle and Lasso), Edit shape nodes mode, View port presets 

(Zoom in, Zoom back, Zoom all, Pan), Slow redraw, create Freehand shapes or insert 

Shapes, use Text, Array tool (Circular, Rectangular), auto border tool and Auto-

sequence. The tools and their usage will be described later on a separate section each. 

 

 
Figure 2.61: Tools toolbar 

Design area  

The heart of Creative DRAWings software is the design area. All the tools, menus and functions 
exist to provide functionality useful during designing process. The design area is the rectangular 
area inside Creative DRAWings application window. This area is used for creating and editing 
designs. Any tool you are using from any toolbar affects the creation inside the design area. You 
can have many loaded designs in the same window. Every design has its own design area. 
Multiple designs are can be loaded in different tabs. By pressing on any of these tabs you can 
select which design you want to be visible. At the top and left side of the working area you will find 
the Ruler that can help you make precise changes to your design.  

Various view port shortcuts 

Rectangle and Lasso selection modes 

Insert shapes 

Insert Text  

Circular- Rectangular array 

Create Freehand shapes 

Slow redraw 

Ruler 

Edit shape nodes 
mode 

Auto border  

Auto-sequence 

Divide 

Directions 
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Figure 2.62: Design tabs 

 
Figure 2.63: Design area and Design tabs 

Window handling  

By pressing on the top of any tab you can select the active tab. Another way to select the design 
that you want to be active is by selecting from the dropdown list that exist on the right side of the 
design area. From the appearing list, select using your mouse one of the designs. Click on the 
design you like, the selected design will appear inside the design area. 

 

Figure 2.53: Select active design from list 

Context menus  

The term context menu (shortcut menu or pop-up menu) is commonly used for menus which pop 
up when right clicking on an item inside the design area, offering a list of options. The available 
options vary depending on the context of the action and the item selected. For example different 
options appear when right clicking on a design object than when clicking on the same object in 
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Edit shape nodes mode. The available context menus of Creative DRAWings are hierarchically 
organized, allowing navigation through different levels of the menu structure. 

 
Figure 2.64: context menus 

The context menu of the previous figure (Figure 2.64) is available only when right clicking on an 
object in object editing mode. Some of the applications functionality can only be revealed by 
specific context menus that are available inside the Creative DRAWings design area. This kind 
of logic separates the available actions for each type of object. Select any object, right click on it 
and select a function from the appearing menu, just like that you can perform a number of 
designing tasks. 

Thread palette  

At the bottom of the screen we have the onscreen Thread palette bar from where you can select 
and set colors on the designs. You can either have RGB colors or colors from thread 
manufacturers‟ color palettes. The Thread palette is divided to two parts: available colors on the 
top area and the colors that are currently used in the bottom area. Thread palette is available 
only when using Create mode. 

 
Figure 2.65: Thread palette 

Status bar  

The status bar displays information about selected objects (such as Width, Height, and Number 
of stitches). It also displays information while transforming objects about angle etc, information 
that assist in more accurate transformations. 

 
Figure 2.66:Status bar 

Floating dialogs 

There are various dialogs that contain tools or visual assistance to be used while designing. 

1. Object properties 
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The object properties pane contains all the properties that can be customized in the 

embroidery aspect of the design. It is consisted of two tabs Fill  and Outline . You can 

view the Object properties pane both in Create and in stitch  mode of Creative 
DRAWings. Using the provided options you can change the stitch type of the design easily by 
just clicking on it. The Object properties pane contains all available parameters for each 
stitch type. You can see and change the parameters of selected objects. Just click on a 
parameter to change its value. When selecting an object the object properties pane, shows the 
properties of the selected object. Every stitch type has a different set of parameters. The 
available parameters and the proper way of affecting them will be described later on this 
manual, in a different section. If object properties window isn‟t visible you can activate it by 
selecting from View menu  Toolbars item and then sub item Object properties. You can 
also use the shortcut key Alt + Enter to show-hide the pane. 

2. Sequence manager 

This tool provides a graphical representation of the embroidery sequence. There are signs to 

separate the different types of objects (Embroidery, appliqué). It is often needed to change this 

sequence, in order to improve embroidery quality. Any item you select on sequence manager 

gets selected on the working area. Sequence floating dialog can be opened in case that it is 

closed using Sequence manager option from the View menu, Toolbars section. The extra 

ability of this tool is that you can re-arrange the sewing order for the current design, and select 

an object. Therefore you can organize the sequence of embroidery production in the way you 

prefer. 

There are also some floating dialogs that appear only to help us during design process. These 
dialogs are Apply array, Set light source, Slow redraw. More information about the usage of 
Object properties, Sequence manager and all other floating dialogs will be provided into 
separate sections. 

Customizing Creative DRAWings workspace 

We have described the workspace components and the purposes that they serve. Spend some 
time using them in order to understand how they work. At first you must be trying to sort out which 
tools are important to you, in order to have them in first sight. You can rearrange workspace 
components in order to serve your personal preferences and make a version of the perfect 
working environment for you.  

 

Take in consideration that the screen space depends on the screen resolution. If you have a 
large resolution it means more available space. So first of all set the best resolution that fits to 
your screen. Start Creative DRAWings software, make a few shapes, use some properties, add 
more shapes, and view the design objects in sequence manager. If the design space is not 
enough and the tools are crowded you must organize available tools.  

To give you complete control over the size and position of the elements in the workspace, 
Creative DRAWings lets you move, resize, dock and auto hide most of the workspace 
components and make visible only the elements that you want to view. You can attach or dock 
tool windows to make more space visible. You can also partially conceal tools as tabbed 
documents along the edge of the workspace and then switch back. The exact size and shape of 
the tools and windows depend on how you have configured your designing environment to look 
like. 

DRAWings will remember the place that you last placed any workspace component. 
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Using tool windows 

Once a tool window is floating it has a title bar like the one in the following figure (figure 2.67). By 
double clicking on its title bar, it gets docked in the last position that it was docked. You can also 

close this tool window by pressing the close  button in the upper right corner of the window. 

Double click on the title bar to undock the pane. You can also close it by pressing the Close  
button in the upper-right corner of the window. You can set the window in auto hide mode by 

pressing this pushpin . Finally by right clicking on the title bar you can select a state for the 
dialog (Floating, Docking, Auto hide, Hide).You can always open any closed window again later 
by selecting the appropriate command on the View menu. 

    
Figure 2.67: Object properties window handling 

Moving tool windows  

To move one of the tool windows, simply click the title bar and drag it to a new location.  

Move Object Properties tool window: 

1. If the Object properties pane isn‟t visible, select from View menu, Toolbars item, Object 

Properties sub-menu item. Object properties pane will appear. 

2. Double-click the title bar of Object Properties pane to display the pane as a floating 

(undocked) window. 

3. Using Object Properties title bar, drag the pane to a new location inside the application 

window, but don‟t dock it. See how easily you can affect the position of the available tools. 

Resize tool windows  

If you want to see more of a tool window, simply drag one of its borders to view more content. 

Resize Object Properties pane: 

Resize the Object Properties pane to have a better view of the available parameters. Point your 
mouse to the lower-right corner of the Object Properties window until the pointer changes to a 
double-headed arrow (the resizing pointer). Drag the lower-right border of the window down and 
to the right to enlarge the window. The same way, you can resize any tool window from any of its 
edges. You can work more quickly and with more clarity of purpose in a bigger window. Feel free 
to move or resize any tool window when you need to see more of its contents. 

Docking Tool Windows 

Dockable windows are advantageous because they always remain visible. (They don‟t become 
hidden behind other windows.) If a tool window is floating over the design area, you can return it to 
its original docked position by double-clicking the window‟s title bar. (Notice that you can use the 
same technique to undock a docked window. Double-clicking a title bar works like a toggle, a state 
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that switches back and forth between two standard positions). You can also attach or dock a 
floating tool in a different place.  

You can dock windows by using docking guides, as shown in the figure below. Docking guides 
are icons that appear on the surface of the application window when you move a window or tool 
from a docked position to a new location. Because the docking guides are associated with shaded, 
rectangular areas of the application window, you can preview the results of your docking 
maneuver before you actually make it. 

 
Figure 2.68: Docking handles 

In case that you want to dock into a place where there other tools docked while you point over this 
control you can see how the control will be docked. Only then extra docking guides appear to help 
you decide how to place the window relative to the other docked window. 

 

 

Dock to the upper part Dock to the right side 
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Dock on the left side  Dock on the bottom area 

Dock the Object Properties window 
1. Verify that the Object Properties window (or another tool that you want to dock) is floating 

over the design area in an undocked position. 

2. Drag the title bar of the Object Properties tool window to the top, bottom, right, or left edge of 

the design area. While dragging, take care to drag the mouse pointer over one of the docking 

guides (small arrows) on the edges of the Creative DRAWings window or the collection of 

four docking guides (called a diamond guide) in the center. As you move the mouse over a 

docking guide, the Properties window snaps into place, and a blue shaded rectangle indicates 

how your window will appear when you release the mouse button. There are several valid 

docking locations for tool windows, so you might want to try two or three different spots until 

you find the one that looks right to you.  

3. Release the mouse button to dock the Object Properties window. The window snaps into 

place in its new home. 

4. Try docking the object Properties window several more times in different places to get the feel 

of how docking works.  

You can always adjust the size of docked windows by simply dragging one of its borders to view 
more content. 

Hiding Tool Windows (Auto hide)  

If you want an option somewhere between docking and closing a window, you might try auto 
hiding a tool window at a side of the application window by clicking the tiny Auto Hide pushpin 
button on the right side of the tool‟s title bar. When you auto hide a window, you‟ll notice that the 
tool window remains visible as long as you keep the mouse pointer in the area of the window. 
When you move the mouse to another part of application window, the rollup slides out of view. 
To restore a window that you have auto hidden, click the tool tab at the edge of the application 
window or hold your mouse over the tab (You can recognize a window that is auto hidden 
because the pushpin in its title bar is pointing sideways.)  

The benefit of enabling auto hide, of course, is that the process frees up additional design area 
while the hidden window is also quickly accessible. 
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Press the pushpin to go into Auto 
hide mode 

Object properties pane is hidden on the 

side of the window and becomes visible 
only when you place the mouse over it. 

Object properties rollup is viewable, you 

can press the pushpin once more to turn 
into docked mode again 

Use the Auto Hide feature (Hide Object Properties tool window) 

1. Locate the Auto Hide pushpin button  on the title bar of the Object Properties pane. 

The pushpin is currently in the down, or pushed in, position, meaning that the window is 

pinned open (Auto hide is disabled). 

2. Click the Auto Hide button, Object Properties tool window slides off the screen and is 

replaced by a small tab named Object Properties at the edge of the application window. 

You can also use a right-click on the title bar and select Auto Hide in order to auto hide a 

tool window. 

3. Hold the mouse pointer over this Object Properties tab (You can also click the tab if you 

like) and the Object Properties tool window immediately slides back into view. 

4. Click elsewhere inside the application window and it will disappear again. 

5. Finally, bring out the object Properties window again and then click the pushpin button 

 on the title bar. Object Properties returns to its familiar docked position and you can 

use it without worrying about it sliding away. 

Tool windows that have Auto Hide enabled temporarily slide into view when the window has 

focus. To hide the window again, select an item outside of the current window. Once the window 

loses focus, it slides back out of view.  
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Chapter 3 - Working with files 

Introduction 

This chapter describes how Creative DRAWings will open almost any type of file you wish to 
import. This is the secret of the powerful Creative DRAWings, almost any type of artwork can be 
imported and quickly converted into embroidery designs.   

You can easily import clipart, edit them using Create mode, then convert them into an embroidery 
design using Stitch mode.  

Another great feature is that you can import pictures and convert them immediately to Cross 
stitch or Photo stitch designs. Photos or printed pictures can be, converted to outlines (vector 
artwork),  Cross stitch or Photostitch designs ready to be embroidered. What used to take 
hours and hours to cross-stitch by hand (making design by using X’s) takes seconds in Creative 
DRAWings. You can also automatically Trace the imported picture (bitmap) and convert it to a 
clipart (vector) design with stitches of your choice.  

You can also import any stitch file that has been created using another embroidery program. This 
is a fantastic feature allowing you to give life to old designs. Just import your old design in 
Creative DRAWings and it‟s ready to be modified.  

Creative DRAWings uses for created design the .draw file format. Any design you create must be 
saved first into that format in order to keep all design information. Then at any time you can 
redesign the file, change stitches, colors, and threads and then export it into a totally new 
embroidery file.  Select an embroidery file format that your embroidery machine uses (.sew .jef 
.pes .hus, etc) and export the design.  Stitch files created by Creative DRAWings can be 
embroidered by almost all home and commercial embroidery machines, including ones using .dst.  

Vector and Bitmap designs 

Creative DRAWings can import and use as artwork Vector and Bitmap graphics. These graphic 
files can be converted into stitches or used as backdrops.  

Vector graphics: Vector designs are created as collections of lines. Vector designs are 
images/drawings generated from mathematical descriptions that determine the position length and 
direction in which lines are drawn. They vector files types that can be recognized and used by 
eXPerience® are:  

 Corel Graphics (*.CMX) 

 Encapsulated Postscript (*.EPS)  

 Enhanced windows metafile (*.EMF) 

 Scalable vector graphics (*.SVG)  

 Adobe Illustrator (*.AI) 

 AutoCAD (*.DXF)   

 Windows metafile (*.WMF) 

All these types of files can be directly imported into Creative DRAWings, which recognizes and 

visualizes all mathematical descriptions that determine the position, length and direction in which 

lines-shapes are drawn. They can be converted directly into stitches or used as backdrop. 

Bitmap graphics, which are mainly photographs, are saved in .bmp, .jpeg, .gif, or .jpg) files 
formats. Bitmap graphics (Images) are made of patterns of individual dots or pixels. The shapes 
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that they contain cannot be easily resized. The bitmap file formats that Creative DRAWings 
supports are as follows: 

 Bitmap files (*.BMP,*.DIB,*.RLE) 

 Jpeg file (*.JPG, *JPEG, *JPE,*JFIF) 

 Gif file (*.GIF) 

 Tiff file (*.TIF,*.TIFF) 

 Png file (*.PNG) 

 Icon file (*.ICO) 

 Photoshop (*.PSD) 

Bitmap graphics can be directly converted to "Cross stitch" or "Photostitch" embroidery design, or 
else they can be traced. This process turns the bitmap into a Vector design so it can be 
embroidered. We can also use it as a backdrop and design o top of it. 

Now that you‟ve learned that Vector means clipart and that Bitmap means a photograph or 
picture, we‟ll use the graphics terms of Vector and Bitmap as you familiarize yourselves with 
them. 

There are more file formats which can include Vector and Bitmap graphics but you can only import 
by copying and pasting them or by importing them from the application you are using. This 
process of acquiring files from different graphics software will be described later on.  

Creating designs 

As we have already mentioned in workspace tour Creative DRAWings starts with a wizard to 
help you create new designs, using various sources of artwork. We can create and handle many 
files at the same time. Every created or opened design opens in a new tab. When opening a new 
design, a new tab appears next to the previous and you can switch between them by clicking on 
their filename. You can also use Ctrl+Tab keyboard combination in order to move to the next tab 
or Ctrl+Shift+Tab to move to previous tab.   

 
Figure 3.1: Design tabs 

To create a new design in Creative DRAWings, choose from File menu > New design option. 

You can also press Ctrl+N keyboard shortcut or the new design icon . A wizard named New 
design (Fig. 3.2) will appear, asking if you want to open a new design or open an existing one. 
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Figure 3.2: New design dialog 

If you select to create a new design then artwork source dialog appears. In this dialog you have 
six possible options to acquire artwork. 

 
Figure 3.3: Artwork source dialog 

First select an artwork source and at the end of the dialog you can select a Hoop to preview you 
design on. You can leave it as it is, or if you decide later you need another size of hoop, click on 
Tool >Change hoop to select the correct size. If you do not want a hoop, click None hoop. After 
you select a source of artwork, a hoop and the desired design mode you are ready to proceed.  

Artwork sources 

 From File, use any Vector or Bitmap file as artwork for a new or an existing design.  

 From Embroidery, import an embroidery file.   

 From scanner, get image from scanner. 

 From webcam, get snapshot from webcam. 
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 From clipboard, paste artwork data from many windows applications and convert directly 

into stitches. 

 From scratch, use your inspiration to create a design from scratch. 

From file (Vector or Bitmap)   

Using this option you can browse inside your computer, find a vector or bitmap design and use it 

as design artwork. Click on the  icon to find the vector or bitmap design. The Open dialog box 
will appear, assisting you to select the file you desire. More information about supported vector or 
bitmap files is provided in section Vector and Bitmap files previously in the chapter. 

Bitmap files  

If the selected file is a Bitmap, a dialog will appear providing various conversion options. There 
are four options as shown in the figure below: Open as Backdrop, Trace (convert  to outlines), 
Open as Cross stitch and Open as photo stitch. We will just refer to these options and we will 
describe them in detail later in this chapter.  

 Open as backdrop: Using this option the selected bitmap will be inserted into the background 

of the new design so that it is used as guide to draw the embroidery design manually on top of 

it. 

 Trace (Convert to outlines): This option will convert the Bitmap into vector outline and it will 

be filled with stitches. 

 Open as Cross stitch: This option will convert the Bitmap design to a perfect Cross stitch 

embroidery design.  

 Open as Photo stitch: Finally using this option we can convert the bitmap file directly into 

photo stitch. 

 
Figure 3.4: Artwork image dialog 

Select one of the conversion options and click Next. Select fabric dialog will appear to choose a 
Fabric and a color for the fabric. Make your selections and click Next>.  
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Figure 3.5: Select Fabric dialog 

Color reduction dialog, will appear to select the number of Threads you want and the Palette of 
thread you prefer. Any change you make is previewed immediately on the screen behind the 
dialog box. 

 
Figure 3.6: Color reduction dialog 

You can reduce the number of threads from 7 to 4, for example, without changing the hue of the 
design drastically. Experiment by clicking on the arrow and moving it to different numbers of color 
threads. This dialog allows a complicated design of many threads to be reduced for easier sew-
outs on a single-needle machine. Click on Palette and the dropdown menu offers a variety of 
thread manufacturers. Select Madeira Classic, for example, and you‟ll see the Madeira thread 
number listed. Your supplier stocks the Madeira thread by this number. Click Finish to continue. 
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Creative DRAWings window will appear and Create mode is enabled.  where you can modify 
your embroidery design. 

From embroidery 

With the From embroidery option you can import a stitch file format like “.ngs”, “.dsz”, “.pes”… 
inside Create mode of Creative DRAWings as it is and if you want convert them to Vector 
artwork. With this tool you can import your readymade embroidery designs, make any changes 
you want, add new artwork and embroider them again as new. To the imported embroidery design 
you can convert a part of it or the entire design to vector artwork, and then edit the artwork freely 
by using the available vector design editing tools.   

 
Figure 3.7: Import from embroidery file 

Like other features of Creative DRAWings Stitch files can only be imported from the starting 
dialog of Creative DRAWings, which is New design. Select Create new and highlight Browse, 
then click the Next. When the 2nd dialog Artwork source (Fig. 3.6) opens, click on From 

embroidery, then click on the Browse  icon. Go to your embroidery files and click on the 
design you want to import. You‟ll see your file listed under From embroidery. Now you‟re ready to 
import, so click on the Next . You will be asked to select the Fabric and the Color of it and click 
Finish to view the imported embroidery file.  

You can read more about how to Import an embroidery file and if you want convert it to vector 
artwork later in this chapter. 

From scanner 

With the Get image from scanner option, you can scan a design and import it into Creative 
DRAWings.  The imported design is a bitmap image. It can be handled in the same way as bitmap 
images. Used as a Backdrop, Traced and filled with normal stitches (Satin, Step, Running 
stitches, etc.), or converted to a Cross stitch or Photo stitch design. 

Place your image in the scanner and click Next>. The Image scan dialog will appear with several 
options. Through the Image scan dialog you can scan the design you want and make some 
adjustments. The available scanning options are described thoroughly later in this chapter. The 
dialog of the following figure will appear. 
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Figure 3.9 Image scan dialog 

If you want to see your image before scanning, click on Preview mode. Each time you change an 
option from the Image scan dialog, you can preview it by clicking the Preview button for the 
updated image. When you‟re satisfied with the image, click the Scan tab. Your image will appear 
with a Save as dialog, asking where you want to save it -- in your files or on a disk. When the 
design is saved, the image is automatically loaded inside Creative DRAWings. You‟ll be asked 
how you want the image opened: as a Backdrop, converted to a Vector design in Trace, as a 
Cross stitch or as Photo stitch.  

 
Figure 3.10: Image scan dialog 

Open as Backdrop will import the Bitmap image as a blank backdrop so you can manually draw 
your embroidery design.  

Trace (Convert it to outlines) will convert the Bitmap to a Vector design so it can be filled with 
normal stitches (Satin, Step, Row Fill, Running). There are more instructions on how to Trace a 
bitmap later in this chapter. 

The Open as Cross stitch option will convert the bitmap design to a perfect cross-stitch 
embroidery design.  

The Open as Photo stitch option will convert the bitmap design to a photo stitch embroidery 
design.  
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Select one of the three options, then click Next> button.  

 
Figure 3.11: Select Fabric dialog 

In the next dialog, Fabric, you can select the correct fabric and choice of color. Click Next>. The 
Color Reduction dialog will appear. Select how many colored threads you want and click Finish. 
If your design has 20 colors, you can reduce it to 10 without too much loss in contrast. The 
reduction eliminates 10 changes of threads and saves time if you have an embroidery machine 
with a single needle. 

 
Figure 3.12: Color reduction dialog 

As you make changes in the dialog box, you can see the image changing in Preview. When 
satisfied with your design, click Finish. Creative DRAWings window will open in Stitch mode, 
where you can further modify your embroidery design if you wish. 

From Webcam 
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With the Get image from Webcam option, you can take a snapshot with your webcam and import 
it to Creative DRAWings as a bitmap image. The imported bitmap image can be used as a 
Backdrop or opened in Trace and filled with normal outline stitches (Running, Satin Serial, 
Appliqué) , opened as cross stitch or photo stitch design.  

Plug your webcam on the PC, select the Get image from Webcam option and click Next>. The 
webcam Preview dialog will appear with several options. 

Through the webcam Preview dialog you can take snapshots of anything you want and make 
some adjustments to the image. The options and their functionality is described later on this 
chapter. 

 
Figure 3.15: Image scan dialog 

In the Preview area you will view live the picture of your webcam. You can make the adjustments 
on the webcam until you capture the snapshot image you want. 

Each time you change image Resolution or Properties the live image changes accordingly. 
When you‟re satisfied with the image, click the Capture button. The image you captured will 
appear in the preview area showing you the result of your capture. If you do not like the snapshot 
you can take a new one by clicking once more on the Capture New button. The previous taken 
image will be lost and the camera will become live again, ready for a new snapshot. Once you are 
ready click again on Capture to take the picture. If you are satisfied click on the Save… button to 
save the image on your hard disk. When the design is saved, the image is automatically loaded 
inside Creative DRAWings prompting you to the import dialog. You‟ll be asked how you want the 
image to be opened: as a Backdrop, converted to a Vector design in Trace, opened as cross stitch 
or photo stitch.  

 
Figure 3.16: Image scan dialog 
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Open as Backdrop will import the Bitmap image as a blank backdrop so you can manually draw 
your embroidery design.  

Trace (Convert it to outlines) will convert the Bitmap to a Vector design so it can be filled with 
normal stitches (Satin, Step, Row Fill, Running). There are more instructions on how to Trace a 
bitmap later in this chapter. 

The Open as Cross stitch option will convert the bitmap design to a perfect cross-stitch 
embroidery design.  

The Open as Photo stitch option will convert the bitmap design to a photo stitch embroidery 
design.  

Select one of the four options, then click Next> button.  

 
Figure 3.17: Select Fabric dialog 

In the next dialog, Fabric, you can select the correct fabric and choice of color. Click Next>. The 
Color Reduction dialog will appear. Select how many colored threads you want and click Finish. 
If your design has 20 colors, you can reduce it to 10 without too much loss in contrast. The 
reduction eliminates 10 changes of threads and saves time if you have an embroidery machine 
with a single needle. 
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Figure 3.18: Color reduction dialog 

As you make changes in the dialog box, you can see the image changing in Preview. When 

satisfied with your design, click Finish. Creative DRAWings window will open in Create mode , 
where you can further modify your embroidery design if you wish. 

New graphic 

New graphic allows you to manually draw a design and edit it using Create mode. Click 
on Next>, which takes you to Fabric so you can select the correct fabric and color. Click on 
Finish, Creative DRAWings window will open in Create mode where you can manually create 

the design you want. When finished, click on Stitch or select stitches option from View 
menu and the design will instantly be transformed into embroidery stitches. 

Loading designs 

The program allows you to open only .draw file designs. All the other vector / bitmap files have to 
be imported from the From file option that you will find in the starting dialog of the software or by 
copy and pasting it inside the Create mode of the software. 

You can load an existing design in many ways. First by using Open existing option of Create new 
design dialog of the startup wizard. We can also press Ctrl+O keyboard shortcut once the main 

application window is loaded, and finally by pressing Open icon  in main toolbar. We‟ve 
already discussed Create New dialog, using this dialog we can select whether we will load a 
design or if we will open an existing. In Open Existing, you also get two options:  Browse your 
files and disks for a design or you can click on a List of recently opened files. When you click on 
an existing Creative DRAWings file (.draw) it will open in a new design tab inside Creative 
DRAWings window.  
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Figure 3.20: New design dialog 

When you choose Open Existing, here‟s the step-by-step procedure to follow: You can either 
Browse your files and disks by clicking on Next > or open a List of recently opened designs by 
clicking on Finish. When you Browse a file, you‟ll see it in Preview at the bottom of the dialog. 
Click on Open tab and the design will appear in a new design tab.  

In the starting dialog‟s List, you can view the last several Creative DRAWings files you have 
saved or recently opened. To open one of these files, double click on it or click the Finish tab. If 
the file name you want is not listed, select Browse > Finish and an Open dialog box will appear. 
After locating your file, click the Open tab and a new window will appear where you can modify 
your design, and then save it. 

Notice: If a Data Loss Warning appears, this means that you are trying to open a .draw file that 
was created from a previous version of Creative DRAWings or DRAWings 4 embroidery 
software. 

 
Figure 3.21: Data Loss Warning 

If you attempt to open the design Creative DRAWings will try to open it inside Create mode but 
you might lose some information of the .draw artwork (that existed inside the old DRAW mode). 
Therefore, every time you want to open a .draw file from a previous version of Creative 
DRAWings, you should save it with a new file name so the original file to remain unchanged. By 
following this procedure, you will be able to work with different versions of Creative DRAWings 
and avoid losing your artwork.   

Open Dialog Box 

Using Open dialog, you can load an embroidery design from your .draw file or import from a disk 
or the internet. This Open dialog -- a normal Microsoft Windows Explorer function – appears in 
any way we try to load a .draw design. The same dialog appears when selecting other sources of 
artwork. The same dialog appears but different files are supported in every operation.  
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When Open dialog appears on the top line you can see Look in: which has a drop-down menu of 
files to open any .draw file or a Vector design supported in your computer (in artwork source 
dialog). Click on the downward arrow to expand your selection. Every time you return to the Open 
dialog, the program will show the folder you last opened.  To find a design, you have to select its 
location in Look In. If you have your files on a CD, click on the drive and you can bring in your 
.draw designs or even supported Vector designs.  

Remember: All new imported designs are brought into Creative DRAWings through the Look in 
field.  

Example: 

Say you want to load a design in C:\Designs\Women directory. 

Click on the Look in field and click on the C: hard-disk drive. The Look in field shows C: <Name 
of the disk> and the File list will show the contents of the hard disk C:. 

In the file list, double click on the folder Designs. The Look in field shows Designs and the file list 
will show the contents of the C:\Designs folder. 

In the file list double click on the folder Women. The Look in field shows Women and the file list 
will show the contents of the C:\Designs\Women folder. 

Double click on the design you want to load. On the right side of the Look in field are two more 
buttons that help you change which folder you are searching through. 

When you click on any file design, an image of the file will be displayed as a Preview at the 
bottom of the dialog box. This image helps you select the design you want without having to recall 
the file name or number. 

 
Figure 3.22: Open dialog 

Go to last folder visited 

When you want to see previous files that you‟ve opened, click on the back arrow, which is the left-
facing icon on the right of Look in. Keep clicking until you return to the design you want. In the 
given example, when you are in the C:\Designs\Women and you press the back button, in the 
File list you will view the contents of the C:\Designs folder. The second time you will press the 
back button you will view the contents of the hard disk C: and the third time you‟ll see the contents 
of your designs directory.  

Up one level 

Clicking on this Up One Level icon will take you back to the folder preceding the subfolder that 
your saved design opened in.  
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Example: Say your file open dialog shows the C:\Creative DRAWings\designs directory and you 
want to find a design which is in C:\Creative DRAWings\men. 

Press the Up one level button and the Look in field will show the C:\Creative DRAWings 
directory. 

In the File list, double click on C:\Creative DRAWings\men. The list shows the designs or the 
sub-folders that the current folder contains. Where you select your designs depends upon where 
you have saved them. 

 Create new folder 

With this button you can create a new subfolder in the current folder. When this button is pressed, 
a folder named New Folder appears in the File list area. The name of the folder remains 
highlighted allowing you to rename it by writing in a new title. 

 View options 

With this button you can specify the way that the sub-folders and the designs will be viewed in the 
File list. The possible options are: 

Thumbnails, Tiles, Icons, List, and Details. 

On every design you select from the File list, the name or number is written in the File name field. 
In the Preview box, you‟ll see your image. If you can‟t find the design you specifically wanted but 
know the name, just type it in and press the Open button. 

In the Files of type’s field you can select specific embroidery files names like .jpeg for example, 
and only those files will be visible in the File List area. If you want to see all the files, no matter the 
file type, you can select the All Files option. Click on the down arrow and you‟ll see the big list of 
files that Creative DRAWings will accept besides the default .draw files. 

Saving designs 

When you create a design in Creative DRAWings you can save it in many different file formats. 
The standard saving format is .draw and it is the only format that Creative DRAWings can read 
and load and all design information is kept all other formats aren‟t lossless.. The other file formats 
which Creative DRAWings can open and convert to .draw are: 

 Wings Systems (“.ngs”) 

 SEF xp (“.sef”) 

 Tajima (“.dst”, “.dsz”, “.dsb”) 

 Tajima TBF (*.tbf) 

 SWF (“.sst”) 

 Pfaff (“.ksm”,”.pcs”, “.pcm”) 

 Singer (*.xxx) 

 Happy (“.tap”) 

 Bernina / Melco expanded (“.exp”) 

 Brother/Baby Lock/Bernina (“.pec”, “.pes”) 

 Husqvarna (“.hus”) 

 Husqvarna Viking (“.vip”) 

 Viking Designer 1(“.shv”) 

 Janome (“.jef”, “.sew”) 

 Janome JEF+ (“.jef+”) 
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 Juki(“.M3”) 

 Toyota(“.10O”) 

 QuiltCAD (*.hqf) 

 PC Quilter (*.txt) 

 Statler Stitcher(*.qli) 

 Mitshubishi HD (“.1??”) 

 Barudan FDR (“.U??”) 

 ZSK TC(*.Z??) 

Except from .ngs, these are mainly embroidery machine file formats. You can load them from any 
digitizing software that supports them or from the embroidery machine which will embroider your 
design. The .ngs is a powerful file format that can be processed from some of the leading 
digitizing software packets in the market (eXPerience®, Wings’ modular®). Also all the formats 
can be opened with the powerful Wings’ modular, which is included in this copy of Creative 
DRAWings. 

With the ability to save designs in several formats, you can easily put them on a floppy disk or CD 
and then download them to your embroidery machine. 

Save As dialog box 

The Save As dialog box is similar with the Open dialog box that we described previously. If you 
need more information about how to find your files through the Save As dialog box, refer to Open 
dialog box description. 

To save a new Creative DRAWings design you must follow these steps: 

1. Choose File > Save As or click on the Save icon or click on the shortcut key Ctrl+s. 

The Save As dialog box appears. Click on the arrow in Save in to choose a location on 

your hard drive, or to a disk.  

2. Give your design a File name and then choose Type of File, such as .draw. (Note: If you 

want to have access and edit your designs with Creative DRAWings, always save them in 

.draw format.) 

3. Then click on Save. Any additional modifications you make to the design can be saved by 

simply clicking on Save or Ctrl+S. Your design will be added to the File list in the folder you 

selected to save it in, plus you can see the names of previous designs.  

The File list area shows the designs that the current folder contains. If you click on a design, its 
name will appear in the File name field and information about that design can be viewed at the 
bottom of the Save as dialog. 

Export design 
You can export any design you create in many embroidery formats, in embroidery image, to 
quilt, to a vector file to be used by another program. Another very powerful capability is that we 
can export the design to the provided editor.  

Export to editor 

A portion Wings‟ modular is included together with Creative DRAWings to provide more editing 
and exporting capabilities. You can export your embroidery designs from Creative DRAWings to 
Wings’ modular to make some simple modifications on the designs. Click on File> Export> To 
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editor or use the Ctrl+E shortcut keys. Wings’ modular will open automatically with the exported 
design inside. There you can do more editing on the design and see how it will look embroidered. 
The options and capabilities of wings‟ modular are presented thoroughly in the manual that 
accompanies the software. 

Export embroidery image 

In this chapter we will analyze the way that you can export the embroidery image of the design you 
have created. You can export the design you are viewing as viewed in 3D preview of Stitch mode 
to four different image file formats. The embroidery images that will be produced can be used for 
graphics designing, envelop decoration, creation of birthday cards, brochure creation and 
generally advertising material that are based on embroidery or not.    

In order to export the embroidery design to bitmap file you have to follow the steps below: 

1. From File > Export select To image… option or press Ctrl, Shift and E shortcut keys 

(Ctrl+Shift+E) together from the keyboard. 

2. The dialog that will appear is a standard Save as windows dialog from which you can 

browse and find the location you want to save the design, 

3. Find the location you want the file with the embroidery effect to be saved, 

4. Type the name you want the exported file to have in the File name field 

5. Select the file you want to save the design from Save as type drop down menu. The 

options you have are Tiff (*.tif), PNG (*.Png), Jpeg (*.jpg, *.jpeg) and Bitmap (*.Bmp). 

6. Click Save button and you are ready. 

There are some more adjustments that you can do on the dialog window before exporting the 
design that will be described below. After making the adjustments you want (DPI, Fabric and 
Backdrop options), you can click the save button that will export the file in the location you have 
specified with the name you wanted. 

Change image resolution 

You can adjust the resolution of the produced image by changing the DPI (Dot Per Inch) value. 

 
Figure 3.23: Set DPI value 

 

The resolution of an image is measured by the number of dots per Inch that it consists of when it is 
printed.  The DPI value that you will choose affects the image quality. The DPI value that you can 
enter in the DPI field can vary from 60 to 600. Generally images that are created only to be 
displayed on computer monitors are 72 or 96 dpi and images that are created for the internet are 
72 dpi. In addition images created for printing on desktop printers are between 150 to 300 dpi, 
while images for professional printers are usually 300 dpi or higher.  

You can produce images with embroidery effect with the dpi resolution you prefer by simply adding 
the DPI value in the field. We propose for better embroidery effect results to set the dpi value more 
than 150 dpi. With resolution near to 160 dpi you will be close to the real dimensions of the design 
and you will get a proper representation of the embroidery effect by avoiding re-sampling the 

Dots per inch: measurement of the scanning resolution of an image or the quality of an 
output device. DPI expresses the number of dots a printer can print per inch, or that a 
monitor can display, both horizontally and vertically. 
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original image. For textile printing it is better to use the highest possible resolution of 600 dpi for 
more realistic results.  

Include fabric option 

With the Include fabric option you can decide whether you want the exported image from 
Creative DRAWings to have fabric background or not. With a fabric background you could have a 
realistic preview of the design with the selected fabric. The preview will look very much alike to 
how the design will be embroidered on the actual fabric. 

 
Figure 3.24: Include fabric option 

If Include fabric option is selected, the fabric that was selected in the creation of the embroidery 
design will be added as a background in the exported image. The color and type of the fabric is 
the same with the one that was set in the embroidery design. According your fabric selection from 
the Select Fabric option of the standard toolbar you will get the respective fabric as background in 
your image. If none fabric is selected then only the color of the fabric will appear, without any 
actual fabric.  

If they Include fabric option is not selected, the embroidery effect image will not have a fabric 
background. For Bitmap, Jpeg and Tiff files the background will be a solid black color and for 
PNG files will be transparent.  

Include backdrop option 

In some cases that we are digitizing based on a backdrop it would be very useful to export the 
design with the used backdrop. This way we can review the design in comparison to the design 
source in order to improve any aspect of the design we like.  

 
Figure 3.25: Include backdrop option 

If this option is selected the Backdrop that is included in the design will be exported to the image 
as seen on screen. In order to be able to export the backdrop, the desired backdrop must be 
visible in 3D preview. In any design we may have one or backdrops if we want to export the design 
to image we any of them we must first enable "Use in 3D preview" option of Backdrop properties 
dialog. 

Exported images 

The images that will be exported from Creative DRAWings can be used as artwork in various 
graphics designing projects. The embroidery image artwork can be used from embroiderers to 
present their work or promote it. They can print it on any fabric to visualize the actual size of their 
work or create brochures with their designs. It can be also used to make combinations of printed 
embroidery effect on a T-shirt together with actual embroidery. This is a new trend in the market 
that combines both embroidery and printing on garments. 

In addition, embroidery images can be used also for decoration of envelops, birthday cards, 
business cards or any other graphics creation that could have embroidery look images on (view 
figures below). 
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Figure 3.26:         Envelop decoration Birthday card decoration 

Use your imagination and create the artwork you want with embroidery images that Creative 
DRAWings exports. Embroidery images of Creative DRAWings will enhance your work. 

Export Vector file  

When you create a Vector design in the Create mode of Creative DRAWings you have the 
option to export it to a special folder and keep it as a Vector file. You can also save it as an 
embroidery file and to sew it out. The exported Vector file can be used for printing purposes or for 
creating combinations of embroidery and textile printing on garments. 

To save your design as a Vector, you will save it in Scalable Vector Graphics -- SVG -- file by 
following these steps: 

1. Select File menu, 

2. Expand Export submenu, 

3. Select the To SVG option. Another way to activate To SVG option directly is by pressing 

Alt and E shortcut keys (Alt+E) together from the keyboard. 

4. The Save As dialog will appear  

5. Type the name of the file in the File name field  

6. Find the location you want the design to be saved 

7. Click the Save button to save the design in SVG file format. 

Once the SVG file is saved, you can edit it in any Vector design editor. The design can also be 
imported back into Creative DRAWings and edited in the Create mode a second time. By 
keeping the artwork separately, it‟s ready to use again if you need to create a similar embroidery 
design.  

Note: Inside SVG files, only vector designs can be stored and not bitmap design. If you use a 
Bitmap backdrop to create the Vector design and try to export the bitmap to SVG, the 
Bitmap will be lost. Only Vector artwork will be saved.   

Export to Quilt - Dxf 

Creative DRAWings software has the ability to save files for Quilt Frame machines. You can 
create a design for quilting and once you are ready you can export it to Quilt data file that you can 
load and use to your Quilt Frame machine.  

To Save the file do the following: 

1. Select File menu 

2. Expand Export submenu 
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3. Select the To Quilt… option. The Quilt Save as dialog will appear. 

4. From Save as type area select Quilt data. 

 
Figure 3.27: Select location for Quilt data  

5. Type the name of the file in the File name field  

6. Find the location you want the design to be saved 

7. Click the Save button to save the design in Quilt data (.qdata) file format. 

Now you can load the file to your Quilt Frame machine and start Quilting. 

Using this export tool you can export your design to DXF (AutoCAD) format. This is a vector 
format that can be used for presentations or used in Laser cutters or Quilt machines. To export a 
design to (DXF) file format you have to follow the steps listed above but in Save as type section 
you must select Dxf file.  

Scanning images 

Previously in the chapter we presented that we can import artwork through a connected scanner 
using Get image from scanner option of artwork source dialog. In this section we will analyze the 
options and capabilities Image scan dialog. Select the Get image from scanner option and click 
Next> button. The Image scan dialog will appear that allows you to scan an image.  
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Figure 3.28: Image scan dialog 

In the Image Scan dialog you can scan the design you want and make some adjustments from 
the options in the dialog or by checking preferences in the scanning software. 

 The options that are available in the Image scan dialog are the following: 

 Select scanner button   

With the Select scanner button, you can select the scanner you want to use. By clicking 
the Select scanner tab the Select source dialog appears where all the available scanners 
are listed. Select one and then click Select to continue or Cancel if you do not want to 
make any change. If there is no scanner installed or currently active, you will not see any 
scanner listed in the Select source window.  

 Preview button   

By clicking Preview, you can see the image you want to scan. Place your design in the 
scanner and press Preview. When the scan is finished, your design will appear in Preview. 
If you like what you see, press Scan tab to import your design. If you want to correct the 
design, then you can adjust the image in the options available. Press Preview again before 
you Scan.  

 Type of image  

 

Figure 3.29: Type of image 
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With the Type of Image option, you can scan and import images in your choice of hues and 
shades: Color, Gray scale, or Black & White. By scanning in the Color option, the final 
image will look like the original design.   

Your scanner will easily convert a color design into a Gray Scale or a Black & White 
design that can be imported by clicking on your choice.  The Gray Scale will be filled with 
different tones of grays. By selecting the Black & White option the image will be scanned 
with more contrast.  When you select any of the three scanning options, you can see what 
the scanned image will look like by clicking Preview. 

 Scan quality 

 
Figure 3.30: Scan quality 

With the Scan quality option you can select the characteristics that you want your image to 
have. The Scan option is a drop-down menu with three different image options: High, 
Medium and Low. The three options mean exactly what they signify:  

 High quality has the highest quality and the file size of the image will be the largest. 

 Low quality has the lowest quality (but still very useable) and the file size is the 

smallest.  

 Medium will produce an image quality between the other two. 

Every time you select a different option you can see how it affects         the scanned image 
by clicking the Preview button.  

 Brightness 

 
Figure 3.31: Brightness 

With the Brightness option you can brighten the image, you can click and drag the track-
bar to the right you can increase the brightness of the scan. Dragging the mark to the left 
decreases the brightness. You can also make fine adjustments in Brightness by using the 
arrow keys on your keyboard.  

 Contrast 

 
Figure 3.32: Contrast 

With the Contrast option you can change the contrast of the image by clicking on and 
dragging the track-bar. Dragging the mark to the right increases the contrast and dragging it 
to the left decreases the contrast in the scan. You can also make fine contrast adjustments 
by using the arrow keys on your keyboard.  

 Image size 
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Figure 3.33: Image size 

With the Image size option you can enlarge or reduce the image you are scanning. The 
initial value of the image size is 100%, which is its original size. You can enlarge the 
scanned image by typing a larger value (more than 100) to the Image size field or shrink it 
by typing a smaller value (less than 100) to the Image size field. You can also use the up 
and down arrows in the box to change the image value by 1% each time an arrow is 
clicked. Hold down on the arrow to change values faster. The enlargement or shrinkage of 
the image will be made in the final output of the scanned image. 

 Original size in mm 

 
Figure 3.34: Original size in mm 

With the Original size in mm you can view the actual size of the image measured in 
millimeters. This option is not editable and its value changes automatically. The dimensions 
of the image are shown as Width X Height (e.g. 150 x 180). This value changes if you 
select to scan a specific area of the image you are previewing. The selected area on the 
Preview area will be the new size of the image.  

 Advanced Scan button  

With the Advanced Scan tab you can use the default software of your scanner to import 
the image instead of using the scanner in Creative DRAWings. If you are accustomed to 
scanning with your printer‟s software, you can normally use it. To activate the default 
scanning software of your scanner, click on the Advanced Scan tab. Every time you scan 
from now on, your own scanner dialog will appear. Make your adjustments and press the 
Scan tab. Then you‟ll be asked to save the image to a file on your hard disk, which will 
allow the software to import it and automatically create a design inside Creative 
DRAWings. If you decide not to use the default scanning software, you can press the 
Cancel tab to exit and return to Image scan dialog.  

 Preview area 

By pressing the Preview you can decide if the image needs any adjustments prior to 
scanning it. Another useful feature of Preview is its ability to zero in on a specific portion of 
the image that you want to scan. This way you only scan the portion of the image you want 
to embroider. Select the portion you want to scan by making a rectangle selection on the 
Preview area. Click and drag the rectangle and this portion will automatically be prepared 
for scanning. If you want to deselect the rectangle you have selected, simply click once in 
Preview. Once you‟re satisfied with the image, press Scan.  

 Scan button   

Pressing the Scan tab starts the scanning process, which will import the selected image 
into Creative DRAWings.  The scanning will include the adjustments you have made on 
the Image Scan dialog. When completed, you will be asked to save the image to Creative 
DRAWings.   
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 Exit button   

With the Exit tab you can close the Image Scan dialog and return to the Artwork source 
dialog and choose a different way to create an embroidery design.  

Some of the above options might not be available to your scanner. If you see an option disabled, 
this means that this option is not supported from the driver of the scanner.  

After scanning the image you will be prompted to save it as bitmap file on your hard disk. The 
image will be imported automatically inside Creative DRAWings prompting you for more actions.  

Capturing from webcam 
Creative DRAWings software gives you the ability to capture snapshots from your webcam and 

convert them into embroidery. This is a unique and flexible feature that allows you to capture any 

image you want from the webcam of your PC and convert it in embroidery design. We have 

previously presented the whole procedure, at this point we will analyze in detail the options of the 

dialog that is used to get images from webcam. 

Plug your webcam on the PC (if it is external), select the Get image from Webcam option and 
click Next>. The webcam Preview dialog will appear with several options. Through the webcam 
Preview dialog you can take snapshots of anything you want and make some adjustments to the 
image.  

 
Figure 3.35: Image scan dialog 

In the Preview area you will view live the picture of your webcam. You can make the adjustments 
on the webcam until you capture the snapshot image you want. 

The options you can adjust are the following: 

● Device  

From the Devise drop down menu you can select the Webcam of your pc. You might have 
more than one Webcams attached on your PC and you want to switch between them. To do 
that you have to click on the drop down menu and select the Webcam Device you want to use. 
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● Resolution  

From the Resolution drop down menu you can select the image size that your Webcam will 
capture. You can switch between the available resolutions by clicking on the drop down menu 
and selecting the one that meat your preferences. Higher resolution images include more 
details; therefore it is better to select the highest resolution from the dropdown menu to capture 
your images. 

● Properties  

By clicking on the Properties… button you can adjust the properties of you webcam. The 
properties of every webcam are not the same, therefore the option that you will see after 
clicking on the Properties… button, are based on your webcam‟s features. Please refer to the 
manual of your webcam for more information about adjusting these options. Usually the 
options that you can adjust are Brightness, Contrast, Saturation, Sharpness, White Balance 
and many more.  

● Capture  

By clicking the Capture button you can take a snapshot of the image that you are viewing in 
the preview of the webcam. The image will freeze allowing you to decide if you want to save it 
or not. If you do not like the captured image and you want to capture a new one you have to 
click on the Capture New button that will discard the previous snapshot and will allow you to 
take a new one. Once you are ready to make a new capture click once more on the Capture 
button and a new snapshot will be made. 

● Save…  

If you are satisfied with the image you have captured, you can save it by clicking on the 
Save… button. You will be prompt to a Save as dialog(this is a standard Save as dialog of 
windows), where you can find a preferred location to save the captured image. The saved 
image will be automatically imported to the software ready to be converted.   

● Close  

By clicking on the Close button you can close the Webcam Preview dialog and select a 
different way to import a design into the software. The Close button closes the dialog and 
returns to the Artwork source dialog. 

● Info 

  

Every time you are making an action in the Webcam Preview dialog the Info box shows useful 
information about the action that is taking place. It also shows information about extra actions 
that you can make in the dialog such as cropping the image you have captured. 

The webcam Preview dialog gives you the ability to make the needed adjustments on the 
captured image and produce the result you prefer. If you are satisfied with the captured image 
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click on the Save… button to save the image on your hard disk. When the design is saved, the 
image is automatically loaded inside Creative DRAWings prompting you to the import dialog. 
You‟ll be asked how you want the image to be opened: as a Backdrop or converted to a Vector 
design in Trace. 

Cropping the captured image 
In the Webcam Preview dialog you have also the ability to crop the captured image and use only 
a part of it. This is very easy to do it by following the steps below: 

1. From the webcam preview dialog make the appropriate adjustments and prepare the 

scene you will capture.  

2. Once you are ready click on the Capture button to take a snapshot. 

3. To Crop the captured image you can simply draw a rectangle area on the captured image 

by covering the area you want to keep. To draw the rectangle area you have to click and 

drag with the mouse on the captured image diagonally. While dragging you will view a 

rectangle to be drawn on the image with a light blue color.  

 
Figure:3.36 Crop area of captured image 

This will be the area of the image that will be kept if you save the design. The rest of the 
image will be discarded. If you want to define a different crop area you can draw a new 
rectangle that will be the new Crop area (The previous defined crop area will be 
automatically canceled). 

4. If you are satisfied with crop area you can click on the Save… button to save the cropped 

image 

5. After saving the cropped image it will be automatically imported in Creative DRAWings to 

be converted to stitches.  

With the cropping option you do not need to straggle capturing exactly the area you want to 
convert to stitches but you have the ability to capture a general image and then keep only the area 
you need by simply cropping it.  

Importing bitmaps 

Bitmap files can be imported into Creative DRAWings three different ways: They can be imported 
as bitmap Backdrop, can be Traced and imported as a Vector design, can be converted to Cross 
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stitch or Photo stitch design. All four ways are accessible from the starting dialog of Creative 
DRAWings software.  

1. Select Create new option from the starting dialog,  

2. click Next> button,  

3. click on the  icon to find the bitmap design you want to import,  

4. select Open button  

5. click Next> button,  

6. The dialog with the three options below will appear. 

 
Figure 3.37: Artwork Image dialog 

In this section we will describe the conversion options of bitmap files.  

Open as Backdrop 

By opening Backdrop you can import a Bitmap image and use it as the guideline image to draw 
an embroidery design. This option is very useful for complex Bitmap images that cannot be easily 
Traced or you want to embroider a part of them. This option also allows you to create the design 
exactly in the way you want to be embroidered. Also, it is very useful to professional digitizers.  

Select the option and click Next> to import it to Creative DRAWings. Select the Fabric and the 
color you want from the next dialog and click Finish.  

The Bitmap image you imported will appear in the Create mode as a backdrop which can‟t be 
edited. You can import only one bitmap backdrop inside Creative DRAWings. If you want to 
import multiple backdrops you will have to use an image editor and make the multiple images a 
single image by combining them and then import the combined image as a backdrop into Creative 
DRAWings as a .draw file.  

There are some useful options that you can use to handle the imported backdrop images. Those 
are located under the Backdrop submenu of View menu and are the following: 

Hide (Alt + 1)  
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By clicking on Hide – or press Alt + 1 shortcut key – you can hide the imported backdrop. The 
Hide option can help you view the embroidery design you have created without confusing it with 
the backdrop image at the back. 

Below embroidery (Alt +2)  

With this option checked you can make the backdrop visible and position it below the design you 
are creating. Whenever you import a Bitmap image as backdrop, Creative DRAWings 
automatically positions the image under the embroidery design. Also, another way to enable this 
option is by pressing the Alt + 2 shortcut keys from the keyboard. 

Washed-out (Alt +3)  

With this option checked you can make the backdrop colors appear Washed-out. This means that 
the colors of the backdrop will have lighter tones. This is very helpful when you are trying to draw a 
shape that will have the same color with the backdrop image. Also, another way to enable this 
option is by pressing the Alt +3 shortcut keys from the keyboard. 

Above embroidery (Alt + 4)  

With this option checked you can position the backdrop image to appear above the design you 
have created. This is very helpful. You‟ll be able to view the backdrop image and be able to design 
the objects that will be on top of larger objects you have already designed.  Also, another way to 
enable this option is by pressing the Alt + 4 shortcut keys from the keyboard. 

Backdrop Properties 

The Properties option is available only if you have inserted a backdrop Bitmap in the working 
area. By selecting the Properties option from the View menu a 3D pop-up dialog appears on the 
working area with various options related with the already inserted backdrop.  

 
Figure 3.38: Backdrop properties  

The Backdrop Properties dialog includes the following options: 

 Straighten, using this useful option you can straighten a scanned bitmap. Select the 

Straighten option and view the cursor changing shape. To straighten your Bitmap, click 

the mouse twice to make two points which will become a virtual straight line that your 

design will adjust to. For example, if you make a diagonal straight line on the Bitmap, 

Creative DRAWings will rotate the Bitmap and turn the diagonal straight line into a 

horizontal straight line. You can apply the Straighten bitmap option as many times as 

needed to bring the backdrop bitmap to the straight position. 

 Scale bitmap, using Scale track-bar you can change your Backdrop Bitmap 

proportionally. Drag the track-bar to the left to reduce the image and drag it to the right to 

enlarge the Backdrop.  
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Figure 3.39: Scale backdrop 

You can reduce the image to a minimum 50% from its initial size and enlarge the image 
with a maximum 300%. The scale tool is very useful in helping you change the size of the 
Backdrop image without the interference of any other software. Therefore, you do not need 
editing software for Bitmaps to adjust the size of your Backdrops.  

 Rotate bitmap, using this tool you can rotate your image freely by clicking and dragging the 

indicator either way. This tool helps to straighten your backdrop image before starting to 

draw the embroidery design. The rotation circle always opens up at the zero position.  

 
Figure 3.40: Rotate backdrop 

This tool can help you straighter your backdrop image before starting drawing the 
embroidery design based on it.  

 Below embroidery: By pressing this button you can make the backdrop visible and 

position it Below the embroidery you are creating. This option is enabled by default 

whenever you import a Bitmap image as backdrop and positions the image under the 

embroidery design. Also, another way to apply this option is by pressing the Alt + 2 shortcut 

keys from the keyboard. 

 Washed-out: By pressing this button you can make the backdrop colors appear Washed-

out. This means that the colors of the backdrop will have lighter tones. This is very helpful 

when you are trying to draw a shape (with any of the available drawing tools) that will have 

the same color with the backdrop image. Also, another way to apply this option is by 

pressing the Alt +3 shortcut keys from the keyboard. 

Above embroidery: By pressing this button you can position the backdrop image to appear 
above the embroidery design you have created. This is very helpful in order to view the 
backdrop image and be able to design the objects that will be on top of larger objects you 
have already designed.  Also, another way to apply this option is by pressing the Alt + 4 
shortcut keys from the keyboard. 

After adjusting your backdrop and you do not need the Backdrop Properties window to appear 

you can close the dialog by clicking on the close icon  or minimize it by clicking on the minimize 

icon . The minimize icon will make Backdrop properties to disappear and leave the title bar to 
float on the working area.  

 
Figure 3.41: Minimize backdrop properties dialog 

If you need the Backdrop properties window again, click once on the minimized title bar and 
you‟re ready to make more adjustments. 

Trace (convert to outlines) 
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Creative DRAWings includes a powerful tool called Trace which allows you to convert Bitmap 
artwork into a Vector design. The Vector can then be converted into a normal embroidery design. 
Very important: Before converting the Bitmap into a Vector, save and rename the original for 
future use.  By selecting the Trace option and clicking Next> the Trace Image dialog will appear.  

 
Figure 3.42: Trace Image 

The Trace Image dialog box can be enlarged so the adjustments will be easier to observe. Click 
on box, hold down on the bottom right corner of it and pull diagonally to fill up the screen, or make 
as large as you want it. The Trace tab has some options that can help you produce the results you 
want. Those are: 

Scale image: 

 
Figure 3.43: Scale image 

The Vector design in Trace Image will always open at the default 100% -- the original size of the 
Bitmap. To enlarge or reduce the Vector size, click first on Scale Image, then type in a new value 
above or below the 100% option. You can also change the Vector image size by clicking on up-or-
down arrows (hold down for a speedy change). No matter how you do it, the scaling will always be 
proportional to all dimensions of the design: A 35mm x 60mm design will become a 70mm x 
120mm design while you‟re adjusting it in Trace Image. Any change in values is automatically 
changed in Preview. 

Accuracy:  

 
Figure 3.44: Accuracy  

The Accuracy option lets you choose how much detail of the original artwork will be in your final 
embroidery design. Click on the box to edit this option, which will open with a default Value 5. If 
you want your embroidered design to appear as the artwork, click up to Value 8 – the highest 
degree of accuracy. A Note of Caution:  Depending upon your design, a Value 8 may not produce 
results best for embroidering because of excessive details. On the other end of the Accuracy 
scale, a Value 1 option may not have enough details to please you. You‟ll find that the Accuracy 
value varies greatly among bitmap images, so you must try different Accuracy values to get the 
preferred result. Each time you change a value, you can see it in Preview. 



Creative DRAWings Embroidery Software Manual 
 

89 Chapter 3 - Working with files   DRAWstitch Ltd.  
  

Color limit:  

 
Figure 3.45: Color limit 

The Color limit box gives you a choice of how many threat colors you want in your Traced image. 
Click on the box. It always opens with a value of the maximum number of colors, but there are 
several factors to be considered. If you have a 6-needle embroidery machine, you may want to 
change the Value 6 with six threads. The number of threads affects the way the Bitmap image will 
be converted to Vector design. In the Preview, you can view any value changes. Another Option: 
You can go ahead and create your vector design with 20 colors and then reduce the number 
inside Creative DRAWings. Having a file of all 20 colors gives you the option of later sewing your 
design commercially. Or . . . when you step up to your own big-time machine, you‟ll have the files 
ready! 

Use background:  

 
Figure 3.46: Use background 

With Use background option you can make the color/object that you will choose from the 
Preview area transparent. This is an easy way to remove a specific color/object from the Bitmap 
image. To edit this option, click the checkbox next to it. Move the mouse cursor over the Preview 
and it will automatically change to an eyedropper tool. The color that you will select from the 
preview area with the eyedropper tool will automatically become transparent and will fill the color 
tab next to the Use background option. Only one color object will become transparent from the 
design. You can make a different color transparent by selecting a different color with eyedropper 
tool from the design.  

Open as Cross-stitch  

By selecting the Open as Cross stitch option, you can convert the bitmap image to a perfect 
Cross stitch design. The conversion is made automatically by clicking the Next> button in the 
dialog. The Cross-stitch will be created inside the design area, where you can make the 
adjustments.  

In the Create mode of Creative DRAWings you cannot edit the actual bitmap image but you can 
resize and change the position of the Cross-stitch design. If you want to edit the actual bitmap 
image you have to use a Bitmap editing software and then import the edited bitmap back to 
Creative DRAWings to view the results. By editing the bitmap you can increase the quality of the 
embroidery result. 

In the Create mode you can increase the detail of the cross-stitch design by increasing the size of 
the bitmap or decreasing the size of crosses. This will result in a high detailed cross-stitch design 
that will be closer to the actual image view. To increase the size of the bitmap inside Creative 
DRAWings you have to select the Cross-stitch design, and then resize it by click and dragging the 
corner handles of the bitmap or the handles at the middles of each side. The bitmap will be resized 
and the cross-stitches will be recalculated. By increasing the size of the bitmap you automatically 
increase the number of cross-stitches that will be placed on it; therefore the quality of the 
embroidery design. 

You can also move the cross-stitch design and position it exactly in the location you want it to be. 
To do that you have to select the cross-stitch design and by click and dragging on it move it to the 
position you want it to be.  
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In the stitch mode of Creative DRAWings you can edit the cross-stitches by setting the Cell size 
of each cross-stitch, changing the number of times each cross-stitch will be embroidered and 
selecting which parts of the design you want to embroider and which not. All this options are 
located on the Object properties toolbar that appears at the right side of the application window. 
The same options are available in the Create mode, if Stitches, 3D preview and Object 
properties options from View menu are enabled. 

More about how to edit Cross-stitch designs you will find in the Embroidery transformations 
chapter. 

Important: Creative DRAWings can import only Bitmap images that have been created with 
RGB (Red, Green, and Blue) colors. Any Bitmap that was created with CMYK (Cyan, Magenta, 
Yellow, and Black) will not convert properly. 

Open as Photo stitch 

By selecting the Open as Photo stitch option, you can convert the bitmap image to a perfect 
Photo stitch design. The conversion is made automatically by clicking the Next> button in the 
dialog. The Photo-stitch will open inside Creative DRAWings where you can make the 
adjustments.  

Photo-stitch is another alternative you have when it comes to filling bitmap images with stitches. 
It consists of 4 stitch layers that have different colors. Each thread color layer is one of the 
CMYK(Cyan, Magenta, Yellow and Black) color model. First the Magenta color is embroidered, 
then the Cyan color, the Yellow color follows and finally comes the Black color. These colors 
cannot be changed and you must use them exactly as they are embroidered, if you want to 
produce accurate Photo-stitch results.  

In the Create mode of Creative DRAWings you cannot edit the actual bitmap image but you can 
resize and change the position of the Photo-stitch design. If you want to edit the actual bitmap 
image you have to use a Bitmap editing software and then import the edited bitmap back to 
Creative DRAWings to view the results. By editing the bitmap you can increase the quality of the 
embroidery result. 

You can increase the embroidery result of the Photo-stitch design by adjusting the image contrast. 
By increasing the contrast of the image you will get thicker satin bars in the darker areas of the 
photos and add detail to the final embroidery. Also, some adjustments to the image size might 
needed to get more detail to your photo-stitch. To increase the size of the bitmap inside Creative 
DRAWings you have to select the Photo-stitch design, and then resize it by click and dragging the 
corner handles of the bitmap or the handles at the middles of each side. The bitmap will be resized 
and the Photo-stitch will be recalculated. By increasing the size of the bitmap you automatically 
increase the area that will be covered from the satin bars that will lead to detail increase.  

The photo-stitch object gives you the ability to adjust the satin bars‟ Width and the Density of 
each satin bar for more accurate results. With the Width value you can set the distance that two 
satin bars will have between them and with the Density value you can set the density that each 
satin bar will have when it passes over dark areas. By adjusting those two values you can get 
more detailed photo-stitch results.  

Important: Creative DRAWings can import only Bitmap images that have been created with 
RGB (Red, Green, and Blue) colors. Any Bitmap that was created with CMYK (Cyan, Magenta, 
Yellow, and Black) will not convert properly. 

Import embroidery files 

One of the importing abilities, as we have already mentioned, is that we can import any 
embroidery design we like. Creative DRAWings will convert Stitch file formats like .ngs or .dsz 
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or .pes into Vector designs. Using this ability you can import your ready-made embroidery 
designs, convert them to Vector designs, make any changes you desire, and embroider them 
again.  

 
Figure 3.47: Import from embroidery dialog 

In order to use this ability we must select From embroidery option, from the artwork source 

dialog of startup wizard. Select this option use browse  icon to select an embroidery file to 
import. 

you can import any supported embroidery file into Creative DRAWings. You can save it without 
changes, or you can create a new .draw file. You will be able to make some limited adjustments 
on the imported embroidery files, like adding new objects or text, and then save it as a new 
embroidery design.  

You can only import an embroidery design from the opening dialog of Create new in Creative 
DRAWings. Make sure Browse is highlighted, then click Next>. In the next dialog Artwork 

source, select From embroidery option, and then click on the browse  icon to reach the 
embroidery file you want to import. 

From the standard Open dialog that appears, you can find the Stitch file you want to import and 
click the Open tab. You can import one of the following files: 

 Wings Systems (“.ngs”) 

 Tajima (“.dst”, “.dsz”, “.dsb”) 

 Tajima TBF (*.tbf) 

 SEF xp (".sef ") 

 SWF (“.sst”) 

 Saurer (*.SAS) 

 Pfaff (“.ksm”,”.pcs”, “.pcm”) 

 Singer (*.xxx) 

 Happy (“.tap”) 

 Melco expanded (“.exp”) 

 Brother/Baby Lock/Bernina (“.pec”, “.pes”) 

 Husqvarna (“.hus”) 
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 Husqvarna Viking (“.vip”) 

 Viking Designer 1(“.shv”) 

 Janome (“.jef”, “.sew”) 

 Janome JEF+ (“.jef+”) 

 Juki(“.M3”) 

 Toyota(“.10O”) 

 Artista(*.art) 

 QuiltCAD (*.hqf) 

 PC Quilter (*.txt) 

 Statler Stitcher(*.qli) 

 Mitshubishi HD (“.1??”) 

 Barudan FDR (“.U??”) 

 ZSK TC(*.Z??) 

The Stitch file you have selected will appear in the From embroidery import field. Click Next> to 
import your file in the Create mode. Creative DRAWings will prompt you to the next dialog to 
select the Fabric and Color for your design.  Click Finish and view the imported embroidery 
design. If you want another file, click on the browse icon and select another Stitch file.  

To the imported embroidery design you can change the colors of the objects, and make some 
simple transformations such as rotation, skew, move and delete objects.  

 

Figure 3.48: Auto density adjust 

To apply Auto density adjust option you have to select the stitch object you want to resize (Auto 
density adjust will appear at the bottom of Object Properties toolbar), make sure that the 
checkbox of the option is checked and then resize the stitch object by dragging any corner handle. 
While dragging with the mouse, on the Status bar (is located at the bottom of the application) you 
can view the percentage of resize that you are making.   

To be able to have full editing abilities you have to convert the stitch objects to vector objects that 
will give you the ability to make any changes you want on the design. 

Convert to Vector design 

As we have already mentioned you can import your old embroidery files and convert them to 
vector designs. You can convert the entire embroidery designs or a part of them. You can import 
them as we have already mentioned in previous section. In this case after their conversion you 
can use them as a normal design and edit in Create mode of Creative DRAWings.  

To convert the imported embroidery artwork to Vector design, select the entire design with Ctrl+A 
keys. Right click on the design and from the pop-up menu select the Convert to Curves option or 
press Ctrl+Q at the same time. The embroidery design will be automatically converted to fully 
editable Vector artwork which can be edited. You can also convert only an object or two. Creative 
DRAWings takes you one giant step beyond the normal Convert to Curves of software 
programs. Its new approach to imported embroidery allows you to have Stitch objects together 
with Vector objects in the same file. You can convert specific parts of the embroidery design to 
Vector artwork, make the changes in those objects, and then embroider them and keep the rest of 
the embroidery design unchanged. Choose Stitch objects in a design and convert them to Vector 
artwork. Select the artwork and from the right click menu, select the Convert to Curves option. 
This combination allows you to have Stitch and Vector objects in the same file.  
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Figure 3.49: Embroidery file to Vector file 

In such cases you may don‟t want to view both stitch and vector objects. You can disable Stitches 
option of View menu to temporary hide all stitch objects. You can also hide all vector artwork by 
disabling Outline design option of View menu. In this case if stitches option is enabled you can 
only see the available stitch objects. Using these View options you will be able to edit your Stitch 
and Vector objects easier.  

The new produced Vector design is fully editable, which means you can make as many changes 
as you want on the design. You can add or remove objects or designs and give them stitches by 
clicking on the Stitch mode. The former Vector design will be filled with stitches ready to be 
embroidered again. By editing your imported embroidery files you can give life to your old designs. 
Your creativity is only limited by you -- not by Creative DRAWings. 

Import ngs embroidery file 

The reason Creative DRAWings is so powerful: the default ngs embroidery files of Wings’ 
modular software is at your fingertips. The designer included much of the professional Wings’ 
program into Creative DRAWings.  

Besides stitch data, ngs files contain the outline data of the design. The most powerful embroidery 
file formats such as .dst, .sst, .exp, etc. can hold only stitch data and not outline data. This is 
important because outline data allow you to change the artwork and recalculate the embroidery 
result.  

If you import an embroidery file inside Creative DRAWings, it will not have any outline data 
imported unless the file has an .ngs extension. The outline data of the imported ngs file will be 
automatically recognized from the software and will be imported as Vector data. Therefore, the 
Vector artwork of the embroidery design will be directly editable in the Create mode of Creative 
DRAWings.  Some ngs files may only contain stitch data.  This can happen if you open a .dst file 
for, example, which holds only stitch data and then save it as .ngs file format. For the ngs file to 
hold the outline data, it must be either be saved directly from Creative DRAWings or Wings’ 
modular as a ngs file or it must be created inside Wings’ modular from scratch. 

Printing  
Creative DRAWings provides extensive options for printing your designs. You can print the 
design with together with much information that is useful for embroidery process or Print the 
artwork of the design in order see clearly the artwork without any other information. 
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Print design  Print artwork 

Print design 

The printout of the design provides information needed to evaluate before sending a design for 
production or to a customer to see if this is what he likes. To print a design from your screen, 

press the print  icon on the standard toolbar or from the menu File > Print option or press the 
Ctrl + P shortcut keys from the keyboard. The following dialog will appear, you can see a preview 
of the printout of a design. 

 
Figure 3.50: Creative DRAWings Printout 

In print preview window, we can see a preview of the design together with provided information. 

On the right part we can see various customization of the printout. These customizations are: 

 We can use Setup button in order to select and customize the properties of the printer that 

we are going to use.  

 We can also use Save to JPG option in case that we don‟t want to print it, but we want to 

save it for later reference or to review on our computer monitor.  

 In section Print we can select which parts we want to be visible. Click on any of the 

checkboxes in order to enable/disable visible items.  

Printer Setup 

Printer Items 

Tiled printout 
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 If you want this selection of visible items to be the default for any design, you can use save 

defaults button.  

 Finally in tiled printout section we can customize some aspects of the print, number of 

pages, orientation, and scale. We can also set number of stitches that we want to be 

visible on the print preview. 

Print items 
In this section of the printing dialog you can specify which information you want your printout to 
include. Every item of the printout can be enabled or disabled by clicking on the square on the left 
of its description. If the item is enabled the changes can be viewed on the preview area. 

 Header 
The header is at the top of the page, showing the size, color changes, number of stitches, 
quantity of thread needed, the colors of the design, and their position. 
 

 

  

Figure 3.51: Header 

 Color changes 

The box shows the sequence of the color changes. This information is really useful in case 

the design will be saved in a file format which uses “stop” instead of color-change 

command. 

 
Figure3.52: Color changes 

 Sequence icons 

The sequence icons are at the bottom of the page. They show parts of the design split with 
a special function like color change, appliqué, or stop. Also in the bottom of the icon you 
can view the name of the color that should be used, plus comments. 

 
Figure 3.53: Sequence icons 

 Information 

Information is at the bottom of the page. The information area lists and describes the 

components of your embroidery design. The information is sent from the program to the 

component presets you have selected. 

 
Figure 3.54: Information 

 Company name 

Size Yarn 

Color changes 
Color changes 

Number of stitches 

Creation date 
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The company name, which is at the top of the printout, can be changed by using the 
Printing tab of the Tools > Options dialog. 

 
Figure 3.55: Company name 

 Orientation 

The orientation is the icon shown with the "R" character at the top right corner of the 

printout. This is important because it shows how the printed page should be put on the 

embroidery machine to identify the starting point of the design. 

 
Figure3.56: Orientation 

 Binder space 

This option makes the necessary margin (on the left side of the page) in case you want to 
put the printout in a folder. 

 Stitch count 

The number of stitches in your design can be viewed at the header of the printout. This 
Stitch count is important for commercial use when the number of stitches is used to 
calculate the embroidery price. 

 
Figure 3.57: Stitch count location 

 Start point 

This option shows or hides the starting point of the design, marked with the  icon. 

 3D-preview 

Displays the stitch design in 3D-preview mode.  

                         
Figure 3.58:                3D-preview Enabled                           3D-preview disabled 

 Fabric 

Hides or Shows the fabric behind the design. 

Stitch count 
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Figure 3.59: Without fabric – With fabric 

 Design date 

The date that the design was created can be viewed at the top left of the printout.  

 
Figure 3.60: Design date location 

 Hoop 

Hides or Shows the embroidering area (doted line) of the selected hoop with a dashed line 
around the design. If your design is position outside this line you will have problems 
embroidering the design on a hoop that has the same dimensions (You might damage your 
machine). 

Tiled printout 

This section manages the way that your design will be printed. When the printout dialog is called 
up, the first two fields indicate the number of pages needed for printing: 'X' for horizontal and 'Y' for 
vertical; the number of designs printed on each page can be changed by using the arrows on the 
right hand side or with the mouse wheel. The changes you make can be viewed on the print 
preview as you make them. 

 
Figure 3.61: Tiled printout 

The Portrait option specifies how the design is positioned on the page. If it is enabled, then the 
design is printed vertically as a portrait. If disabled, then the design is printed horizontally as a 
landscape.  

The Scale field shows if the design will be depicted smaller than its actual size and the percentage 
of the reduction. The first time that the printing dialog is used, Creative DRAWings finds the best 
way to show the design in actual size with the least number of pages.  

To automatically restore the parameters indicated at the beginning of this process you could click 
on the AutoFit tab. If your design is previewed in more than one page, you can print them, cut the 
border of the page, which is already marked, and tape them to have your design complete.  

Creation date 
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Finally at the bottom of the right area of Print preview dialog there is a control that you can use in 
order to set the number of stitches that you want to be viewable in the respective area of the 
printout. Click on the editable area and type the value you want to appear in Printout. 

 

Print Artwork  

With Creative DRAWings you have the ability to print any artwork you want on a special paper for 
textile printing. Then you can iron the paper on the fabric and apply the design on the fabric. You 
can also combine textile printing with redwork embroidery and create unique and stylish designs 
on garments.  

To print the artwork of the design you have created or imported inside Creative DRAWings you 
have to select the Print Artwork option from File menu. The Print Preview dialog will appear that 
includes all the options that you can adjust to prior printing the artwork. 

 
Figure 3.62: Print artwork preview  

As we have described in previous section the printout and the visible items can be customized.  

 Select a printer 

 Save into JPG file  

 Select printed items 

 Customize orientation and number of pages. 

 

The only addition is that you can create Mirrored printouts easily. Mirrored option allows you 
to make a Mirror of the artwork you want to print in order to make it proper for textile printing or 
any demonstration purpose.  
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Figure 3.63: Normal Printout         Mirrored Printout. 

Send option 

With this option you can send a .draw file of Creative DRAWings by e-mail. Click on File> Send. 
When the Send option is selected, Creative DRAWings  finds the default program that you use 
for e-mails and opens a new window. It saves the current design in the .draw format in your 
temporary directory, and inserts this .draw file as attached. Type in the e-mail address, add any 
text, and send it. 

Recently used file list 

Click on File to find the list of designs that you recently opened. The lower half of the dropdown 
contains links to your last-accessed files. If you click on a link, the design will open in a new 
Creative DRAWings window and the opened file will be placed on the top of the recently used 
File list. 

Auto-backup mechanism  

Creative DRAWings software has two security features to help you avoid losing your work from a 
possible systems crash.  The first is the Failure Recovery feature and the second is the Auto-
backup feature of the embroidery designs.  

 Failure Recovery: This feature is activated automatically when an illegal operation is made 

in the software. Immediately the Failure Recovery tool is activated to baffle the termination 

of the program.  

 
Figure 3.64: Failure Recovery dialog 

When this Failure Recovery dialog box appears, click Yes and the software will continue 
functioning. If you click No, the Creative DRAWings software will be terminated 
immediately without asking you to save your design. If the Failure Recovery box appears 
while designing, it is better to save your design by clicking Yes, then restart Creative 
DRAWings. This mechanism secures your work.   
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 Auto-backup: Another feature that Creative DRAWings has to protect your valuable work 

is the Auto-backup feature. Creative DRAWings automatically saves your designs after 

every change. The Auto-backup works even if you have not saved your design at all. If the 

software locks up for whatever reason, your work will not be lost in most cases. When you 

open the software again, the designs before the lock-up will be recovered. This mechanism 

will protect you from losing your work.  

Note: As another safety feature, always keep in mind the importance of saving your designs 

frequently.      
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Chapter 4 - Make selections   

Introduction 

In this chapter we will learn how to select objects in a design and how to modify them. To make 
changes in your embroidery design, select an object by clicking on it, and then applying the stitch 
type you prefer. The standard selection tools in are rectangle selection and the lasso selection. 
You can use the selection tools from Tools toolbar, using the mouse (click) and the functions in 
the edit menu. 

Select with mouse (click)  

Complex embroidery designs consist of many objects, with each having different stitch types and 
colors. You can make changes in any object or portion of a design by clicking on it. If you have 
several of the same objects, hold Shift and you can make multiple object selections and give them 
the same colors and patterns. 

If you accidentally cover a smaller object entirely with a larger object, it can easily be retrieved. 
Creative DRAWings will “dig up” objects buried under one or more objects. Instead of having to 
remove layers of objects in a frantic search, simply select the entire area of objects with your 
mouse (the cursor is the Rectangle selection), hold down on Alt key, and left click on the 
highlighted area. If at first you don‟t see the object you want, continue to hold down the Alt key 
and click again and again. When the object you want appears, click on it and pull it off.  

 
Figure 4.1: Selection information rectangle 

Every time you select an object in the embroidery design, a selection rectangle appears that 
shows the current selected object. This is helpful for not losing your current selection when you 
have to work on a complex design. Also, whenever you pass the cursor over the selected object, 
the dimensions of the selection rectangle appear on each side. 

Rectangle selection  

The Rectangle selection icon is the top one in the toolbar on the left side of your screen. With 
this default selection tool, you can make multi-object selections in Creative DRAWings. If you 
want to select a particular object in a design, click on that object. You can draw a rectangle around 
your entire design by clicking and dragging the mouse from the corner of the screen over your 
design. All the objects that are completely within this rectangle will be selected.  
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The whole design can also be selected by holding down the Alt key and dragging the Rectangle 
over just a small portion of your design. This is an easier way to select objects which are large and 
have irregular shape. 

You can activate the Rectangle Selection tool by clicking on the icon of the standard toolbar. If 
the Rectangle selection tool is your default selection tool, you can activate it by pressing the 
Space bar. 

 

Lasso selection  

This Lasso tool is the top icon  in the toolbar on the left side of your screen. Hold down on 
Rectangle Selection tool, and pull out to activate the Lasso tool. With this tool active you can 
make multi-design object selections. If you want to select an object in a design, click on it. You can 
also select by clicking and dragging the mouse on the screen to draw a freehand selection line 
around the objects of the design. All the objects that are completely within this area will become 
selected. By holding down ALT key, you can select most of a design by lassoing only a small 
portion of the design. The Alt key gives you power to select a design in a hurry without having to 
lasso the entire design.  Once you create the Lasso selection all objects inside the lines will 
become selected.   

You can activate the Lasso selection tool by clicking on the icon of the standard toolbar. If the 
Lasso selection tool is your default selection tool, you can activate it by pressing the Space bar. 

Note: You can change the default selection tool from the Tools tab of the Options dialog box that 
is located under the Tools menu. Currently the default is the Rectangle selection tool but 
you can set the Lasso tool as the default selection tool. 

Invert selection 

Using this option from the Edit menu, you can invert the object selection, select all unselected 
objects, and vice versa.  

      
           Figure 4.2: Selection             Invert Selection 

This option is useful when you want to select a larger portion of a design. Select a small object or 
group of what you don‟t want, then choose Invert selection to capture the larger portion. You‟ve 
selected the portion you want in this reverse process. 

Select all  

Using this option from the Edit menu, or by clicking the shortcut key Ctrl+A, you can select all the 

objects in the design.  

Note: 
You can change the default selection tool from the Tools tab of the Options dialog box that is located 
under the Tools menu. You can set the Lasso tool as the default selection tool. 
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   Figure 4.3: None selected                    Select all 

This option is useful when you want to modify all the objects of your design at the same time. Any 

change will be applied on all selected objects at the same time.  

Select none 

You can have none selections, whenever you click with your mouse on the fabric and outside of 

any design you have created. This function is the opposite of Select all function where you are 

selecting all the designs in the working area. It is useful when you want to clear your current 

design selections to make a new selection  

Select by stitch type 

With this option you can make selections according to stitch types. Click on Fill or Border/Pen

 icon of Object properties toolbar and Add to your selection all embroidery objects of a 

specific stitch type. After making the selection you want, you can make any embroidery 

adjustments to your entire selection. All the changes that you will make will be applied in all 

selected objects. 

 
Figure 4.4: Select by stitch type 

It is possible, also, to Remove from your Selection all objects of a specific stitch type by right 

clicking on Fill or Border/Pen  icon of Object properties toolbar and selecting the stitch 
type you want to be removed. All objects of the selected stitch type will be automatically removed 
from your selection.  

In addition, you can Add/Remove objects, of a specific stitch type, to/from your selection by right 
clicking directly on the stitch type in the Object properties toolbar. This option will add/remove all 
the object of the stitch type you have selected.  
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Figure 4.5: Add/Remove to/from selection 

This selection tool will help you to make selections easier, especially to a big complicated object, 
and apply your embroidery changes to your entire selection.  

Select / View overlapping order of vector design  

The Stitch or Create mode of Creative DRAWings includes the selection/viewing ability that 
Creative DRAWings has in the designing order of the Vector design. The order of objects sews 
out is nearly the same order as the objects were designed. If you have imported a ready-made 
Vector design, the order will be the nearly the same with the order the designer created the 
design. If you have created the design from scratch, the order will be nearly the same as the order 
of creation.  

By clicking Ctrl+Home, Ctrl+End, Tab and Shift + Tab shortcut keys, you can navigate between 
the objects of the design. The shortcut key has the following functionality: 

 Ctrl+Home: By pressing the Ctrl+Home key on the keyboard, the first object of the design 

will be selected. This object is the first of the vector design.  

 Ctrl+End: By pressing the Ctrl+End key on the keyboard, the last object of the design will 

be selected. This object is the last of the vector design. 

 Tab: By pressing the Tab key on the keyboard the next object of the design will be 

selected. If we have not made any selection, the first object of the design will be selected. 

Each time we press the Tab key a different object will be selected, which is the next in the 

designing order of the vector design. If we continue pressing the Tab key, we will continue 

changing objects, until we reach the last object of the design. 

 Shift + Tab: By pressing the Shift + Tab keys on the keyboard the previous object of the 

design will be selected. If we have not made any selection, the last object of the design will 

be selected. Each time we press the Shift + Tab key a different object will be selected, 

which is the previous in the designing order of the vector design. If we continue pressing 

the Shift + Tab key, we will continue changing objects, until we reach the last object of the 

design. 

This selection/viewing ability is very useful when you want to know how the vector design was 
created and make the needed adjustments to produce the embroidery sequence you prefer.  

Selections by color  
Thread palette toolbar includes the ability to select objects by color. This option is very useful 
when you want to make a change to all objects that have the same color. You can select them and 
then make the change you want. You can change colors or stitch types to all objects, apply a 
different style or apply any other option you want. You can select object by Fill color, by Pen 
(outline) color or simply by color.  

To select the objects by color you have to right click on the color you want from those that are 
listed on the currently used area and from the right click menu, expand the Select by submenu, 
select one of the three available selection options: Fill color, Pen color and Any color. 
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Figure 4.6: Select by color right click menu 

If you select Fill color option, all objects that have the fill color you right clicked on will be 
selected.  

If you select Pen color option, all objects that have the Pen (outline) color you right clicked on will 
be selected.  

If you select Any color option all objects that have Fill or Pen (outline) color you right clicked on 
will be selected.  

Any change you make on the selected objects, affects all objects.  

Selections in sequence manager 
Sequence manager is a visual assistance tool that provides a graphical representation of the 
embroidery sequence. The functionality and capabilities of sequence manager are described later 
in this manual. At this point we will mention only the selection capabilities that it implements.  

Place the mouse anywhere over any item of the Sequence manager, you can see an highlighted 
outline appearing around this item. The highlighted item looks like on top of the other items, 
revealing that it is currently selected. Click on any item and it gets selected.  You can see the 
specific item selected in the design area with a highlight rectangle around it. We can also select 
multiple sequence items by holding Ctrl and clicking on the items to be selected.  
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1 sequence item selected Multiple sequence items selected 

Chapter 5 - View your designs   

Introduction 

In this chapter you will learn the different ways to view your designs. You will learn how to Zoom 
your designs, Measure them or Move them around the design area. Also, you will learn how to 
change View modes in your designs. The default view mode is 3D preview, but you can unclick 
3D and you‟ll see only the stitches of the embroidery design or the outline of the Vector objects. In 
addition, you will learn how to add hoop and guidelines in the design together with how to enable 
and disable the Grid and the Ruler of the working area.   

Zoom in  

By using this tool you can enlarge the portion of your design to check on details. Select the Zoom 
tool from the Tools toolbar and the cursor will become a magnifying glass. Then, click at the point 
from where you want the new view port to start and drag the mouse holding the left button. The 
area you marked will be the new view port. Also, you can activate the Zoom from the menu View > 
Zoom >In or by clicking the shortcut Z. Either way, the cursor will turn into a magnifying glass.  

 

Figure 5.1:   Rectangle Zoom area                           New view port 

Another way to zoom in your design is by using your wheel mouse  . If you click anywhere on 

the screen and rotate the wheel forward , you will see your design zooming in (getting larger). 

Zoom out 

To Zoom out your design, use your mouse wheel . If you click anywhere on the screen and 

rotate the mouse wheel backwards , you will see your design zooming out (getting smaller).  

Another way to Zoom out your design is to Zoom previous 

Zoom previous  
Using this option you can get the previous Zoom view of your design. The new view port will be 

the same as it was before the last zoom-in. You can activate Zoom previous from the Tools 
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toolbar by click and drag on the Zoom In tool  and selecting the Zoom Previous

 option. By doing that the Zoom Previous tool will become the current on Tools Toolbar and 

you can change it by following the same procedure. Another way that you can activate the Zoom 

Previous option is by selecting the View > Zoom >Previous option from the menu or by clicking the 

shortcut key F3. Another way to Zoom previous your design is to Zoom out.  

Zoom all  

Using this option you can view the whole design fitted into the visible screen. You can activate the 
zoom-all function from the standard toolbar, from the menu View > Zoom >All or by clicking the 
shortcut key F4. If you have a multi-functional keyboard, make sure that F keys are not locked.  

Actual size Zoom  

Clicking on this button in the standard toolbar, you can view the current design in actual size. Also 
by clicking on the arrow at the right of this icon, you can select one of the zoom presets. The zoom 
presets that you can choose from are 25%, 50%, 75%, 100%, 125%, 150%, 200%, 250%, 300%, 
400%, 500% and 600%.  

If you set the exact size of your monitor, from the Monitor tab of the Options dialog box under the 
Tools menu, every time that you will select the 100% of the zoom presets you will view the design 
in its actual size. You can also activate the 100% zoom by pressing the Shift + 1 shortcut keys.  

Hand tool (pan)   

This tool lets you move a design around your screen like you would move a paper around on a 
desk with your hand. You can activate the Hand tool (pan) function in Create or stitch mode 
from the Tools toolbar or by pressing the H shortcut key. The cursor will change to a hand like the 
one on the icon and you can use it by clicking and dragging on the screen. In stitch mode you 

have to click on the  icon that you will find on the Tools toolbar. 

Another way to Pan the working area is by pressing the middle click of the mouse (or the mouse 

wheel). The mouse cursor will change to a four directional arrow  that shows that you can 
move the working area to all directions. To move the working area you have to move the mouse 
slowly to the direction you want. The view port will move, showing you the design to the direction 
that you are moving the mouse. To close the mouse pan tool, press once more on the middle 
mouse wheel. 

Measure tool  
The measure tool calculates the distance between any two points in the work area. You can 
activate the measure tool function from the Tools toolbar or by pressing the F9 shortcut key. With 
this tool you will be able to measure any time you need to know the size of your embroidery 
design, or any portion of it.  

View 3D preview 
You can enable 3D preview option from View menu or by pressing P key on your keyboard. If the 
3D preview selection is checked, the design will be visible in 3D. By enabling 3D preview, you can 
have a realistic 3D preview of how the design will look like when it will be embroidered on the 
selected Fabric. The stitching style, the color of stitches and the way which the design will be 
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sewed give you the perception of a real embroidered result. In the 3D preview the threads are 
much thicker than in the stitches view. The 3D preview of the design can be enabled-disabled 
both in Create or Stitch modes.   

 
       Figure 5.2: 3D preview mode 

If you are working in a close-up zoom, the stitches and the gaps between them may be displayed 
larger on the screen, but in reality the gaps are too fine to view them. In the Preview area, the 

Fabric and its Color can be changed from the Select fabric  button on the standard Toolbar or 
from the menu Tools > Select fabric option. The only option that is not available in 3D mode is 
stitch points view. 

View outline design 

You can access Outline Design from View menu. With this option enabled, you can view the 
outline in the Preview when you deactivate 3D preview. 

 
Figure 5.3: Outline preview 

With the 3D preview option enabled, the outline will not be clearly visible because it will be located 
behind the embroidery design. The Outline View is useful when you want to change the Vector 
artwork of the design. This view also makes it easier to see all of the parts in the design and to 
make adjustments.  

View stitches 

You can enable stitches option of View menu or by pressing G key on your keyboard. When this 
option is enabled, the Stitches of the design are visible. 
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Figure 5.4: Stitches preview mode 

With this option enabled in Create or stitch modes, you can view the direction, the density, and 
the style of stitches in the overall design. A change in the design has an impact on the way that 
the stitches will be placed. All the recalculations are automated, which means that no further 
action is required on your part. You can view the stitches of the design and edit the shape of the 
object at the same time.  

View Stitch points 

You can enable Stitch points from View menu. While Stitch points is active, 3D preview will be 
disabled. To activate this option you have to disable 3D preview option first.  

 
Figure 5.5: Thread penetration point view 

Stitch points are the points where the machine‟s needle bores the fabric. With this view, you can 
distinguish the stitch length, density, and bore points.  

Thickness view 

This option is very useful in order to create professional looking designs. Stitches that fall on top of 
other stitches don‟t create nice embroidery. We may intentionally want to let this happen in order 
to create a special effect. But in the majority of cases we want to know if more than one layer of 
stitches fall, one on top of the other, in order to prevent this.  

You can enable this option by using the respective option of View menu. When this option is 
enabled 3D preview is disabled. In order to return to the previous view of the design you must 
disable this option.  

In Thickness view we can see the design items painted in various colors according to the 
embroidery that is placed on top of it. When only a layer of embroidery falls on a part, we can see 
this part with green color, 2 layers of embroidery-yellow color, 3 layers of embroidery-orange color 
and too many layers of embroidery-red color. This way we can easily find and correct all the areas 
that have too much overlapping stitches. 
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Figure 5.6:        Overlapping objects                                         Thickness View 

Set light source  
You can activate Set light source from View menu. The Adjust light dialog will appear from where 
you can change the light source of the embroidery‟s 3D preview. The option of Set light source 
becomes available only if you are working in 3D preview mode (ViewPreview 3D). It is a 3D tool 
that gives you the ability to illuminate your design from different angles. 

 
Figure 5.7: Light source globe 

If you activate the Set light source, the Adjust light dialog will appear with a 3D ball in it. The light 
source changes by moving the crossed lines to the position you want the light to come from or by 
click and dragging on the ball to the position you want the light to be. The yellow crossed lines 
show where the new light source will be and the blue their initial position.  

Another option that you can adjust in the dialog is the Intensity of the light that illuminates the 
threads. By click and dragging the Intensity bar to the left the light decreases and to the right the 
light increases. Select the amount of light you want to illuminate your embroidery designs and click 
OK button to apply the changes you have made to the dialog.  

The best way to make the adjustment accurately is by having an embroidery design loaded prior 
activating the Set light source option. Any change you are making inside the Adjust light dialog 
it is immediately previewed on the design allowing you to make accurate adjustments. 

We can also use Save as default option in order to save current light source as the default for 
every design. Once a default value is selected and saved as default it will be used for every new 
design. You can also use Reset to default in order to reset the light source to the default value. 



Creative DRAWings Embroidery Software Manual 
 

111 Chapter 5 - View your designs   DRAWstitch Ltd.  
  

View Ruler  

You can enable/disable Ruler from View menu. Check the Ruler selection in order for the Ruler to 
become visible around the working area.  

 
Figure 5.8: Ruler 

The Ruler appears at the left and top sides of the working area. It is transparent and becomes 
solid only if you place the mouse on it. The ruler shows the values of virtual X and Y axes based 
on centimeter or on inch values. The 0 on X axis and the 0 on Y axis in the starting point of the 
axes. The values on the ruler are changing based on the zoom you are using to view the design.  

The ruler can help you draw, size and align the objects precisely and create the design you want.    

In case you select "US" measurement system, from ToolOptionsGeneral tab the ruler will 
show information in US(inches) and not Metric. 

View Grid  

You can enable-disable Grid from Tools menu. Check the Grid selection and it‟ll appear in the 
working area. The Grid appears as small symmetrical dots across the working area in vertical and 
horizontal lines. If you have the Ruler option enabled from the View menu, the horizontal lines will 
be aligned on the ruler values allowing you to draw, size, and align the objects precisely.  

 
Figure 5.9: Grid 

The values of the Grid changes with the values of the Ruler and both change with Zoom in or 
Zoom out. Therefore, it is better to have the Ruler option enabled while working with the Grid. 
Also, it is good practice to use Zoom presets (100%, 200%, etc.) while designing based on a Grid 
to create precise adjustments. 

View Hoop 
When creating a design we may select to use a hoop to preview the design on or not. At any point 

we can change the selected hoop or add one using change hoop icon  or by using Change 
Hoop option from Tools menu.  
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In order to temporary hide the selected hoop we can enable-disable hoop option of view menu. If 
this option is deselected the hoop is not visible. If it selected then it is visible. In case this option is 
disabled it means that no hoop is selected for the design so you must select a hoop.  

The Hoop in Creative DRAWings is very useful because it will make sure that the design which 
you are creating will fit on your embroidery machine hoop. There is a variety of hoops from which 
you can select and you can even add your own. More information about how to work with hoops 
you can find at Chapter 7 in the Change hoop section. 

View active designs (Windows) 
Windows tool, is a supportive tool, located under Window menu, where you can view all the 
designs that are currently loaded. Some extra window handling and file saving functionality is also 
provided. By selecting Windows option of Window menu you activate the dialog that is shown in 
the following figure. 

   
Figure 5.10: Windows dialog 

In section Select window you can select any window that you like to be active. Highlight 
workspace.draw and then you have a number of choices provided. Make this design active by 
pressing activate. The dialog closes and the selected design is the active design in the design 
area.  

You can also save loaded designs. Select any design from select window list, then press Save 
button. If the selected design has been previously saved, it will be saved into the same location, 
otherwise it will prompt you for a location to save.  

Finally you can select to close designs. Select a design and by pressing Close you close the 
selected design. If the design hasn‟t been saved previously you will be prompted to Save or 
Discard the design.  

In any of the above operation you can select more than one designs by pressing Ctrl and then by 
clicking one by one the designs that you want to select.  

Slow redraw (Shift+F11) 
A very valuable step before turning on your embroidery machine in order to embroider for first 
time, any of your designs is a simulation like process. Slow redraw provides an automated way to 
simulate the embroidery process. Move through objects stitches and preview the placement of 
every stitch. It‟s a good chance to correct any detail on your design. 
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You can enter slow redraw mode by using Shift+F11 keyboard shortcut or by pressing slow 

redraw icon  on tools toolbar. While using Stitch mode, you can also use the arrow keys on 
your keyboard in order to navigate through objects-stitches. The Right and Left arrow keys are 
simulating the design stitch by stitch and the Up and Down keys object by object.  

 
Figure 5.11: Slow redraw dialog 

In order to start Slow redraw, press its icon  on Tools toolbar. The following dialog appears on 
top of the design area.  

Slow redraw dialog consists of 5 parts 

 Title bar, provides window handles 

 Simulation speed track bar, adjust simulation speed 

 Start-Stop simulation 

 Move through objects-stitches 

 Simulation view options 

We will describe each part and its description on the following sections. 

Title bar, On the top of the dialog you can see its title bar.  

The title bar contains some controls to help manage the position and the size of the dialog. Click 
and drag on the title bar in order to move the dialog in any place you like. 

Help , click on this icon the cursor turns into a question mark. Click on any of the components of 
the dialog and the available help about the control will appear.  

Minimize , Press this icon to minimize the dialog. It stays at the same place but in minimized 
state. Press it again in order to view the dialog in full mode. 

Close , Press on this icon to close the current dialog. 

Simulation speed, On this part you can see and adjust the simulation speed. Click and drag this 
track bar to select the speed of the simulation. 

 

The machine speed that you select on the track bar shown in 

numeric format. 

 

Simulation speed track bar, Select the speed of the simulation. It 

looks like you are selecting your embroidery machines speed. 

Simulation speed can between 100 and  9900 RPM 

Start-Stop simulation  

 

Start the simulation, if simulation has been stopped you can resume 
from where you have stopped. 

 

Stop the simulation. 



Creative DRAWings Embroidery Software Manual 
 

114 Chapter 5 - View your designs   DRAWstitch Ltd.  
  

Move through objects-stitches  

In this part you can move through object-stitches using the navigation buttons     

 . These buttons help you to select the object or the stitch that you want.  

 

Design start, go to the first stitch of the design. 

 

Previous object, go to the first stitch of the design. 

 

Previous stitch, move to previous stitch. 

 

Next stitch, go to next stitch  

 

Next object, move to the first stitch of the next object  

 

Design end, go to last stitch of design  

Simulation view options  

At the bottom part of the dialog you can select the view mode of slow redraw 

 

Preview simulation with the frame moving, as it is in real embroidery 
process. 

 

Preview simulation with the head of the embroidery machine moving. 

Using Slow redraw 
Press Start button to begin the visual simulation. In case that no object-stitch is selected, the 
simulation will start from the start of the design. You can stop the simulation by pressing Stop 
button or press Esc key on your keyboard. After stopping the simulation, you can always start over 
and continue from the stitch you left the simulation.  

Use the track-bar on the upper part of the dialog to adjust simulation speed. While using the track-
bar you can see the selected speed above the track bar.   

You can always use move through object-stitches buttons together with slow redraw tool in 
order to navigate through object/stitches.  

Finally with the button at the bottom the dialog you can switch between Move head or Move 
frame mode. By default the dialog starts in Move head mode. When move head is pressed you 
can see the head of the embroidery machine moving along the design simulating the embroidery 
process. In case you select Move frame, the head stays at the same place and the design 
(Frame/hoop) moves in such a way in order to pass under the head to be embroidered.   

Add Guidelines  

When you are creating a design in Creative DRAWings it is sometimes useful to add a guideline 
to help in aligning the objects. The three guidelines in Creative DRAWings are Vertical, 
Horizontal, or Diagonal. To make the lines visible, go to View> and check Guideline options. If 
the option is unchecked, the guidelines will not be visible on the working area.  

 

Figure 5.12: Guidelines menu 

Horizontal Guidelines 
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To add a Horizontal Guideline, left click on the Horizontal ruler and drag a dotted line down to 
the position you want in your working area. You can also get a Horizontal line with a right click on 
the Vertical Ruler> Add new guide> Horizontal Guideline. The Horizontal Guideline will be 
inserted exactly in the position you right clicked on the Ruler. You can reposition your inserted 
Horizontal Guideline by clicking and dragging it to where you want it, or you can drag is back to 
hide behind the Ruler. 

Vertical Guidelines 

To add a Vertical Guideline, left click on the Vertical Ruler and drag a dotted line over to the 
position you want. You can also get Vertical Ruler by right clicking on Horizontal Ruler> Add 
new guide> Vertical. The Vertical Guideline will be inserted exactly in the position where you 
right clicked on the Ruler. You can reposition the inserter Vertical Guideline by clicking and 
dragging it to the position you want, or you can hide it behind the Vertical Ruler again  

Diagonal Guidelines 

To add a Diagonal Guideline, right click on the Ruler and when the pop-up Add new Guide 
appears, select Diagonal option. The Diagonal Guideline will be inserted exactly in the position 
where you right clicked on the Ruler. You can reposition the inserter Diagonal guideline by 
clicking and dragging it from the middle to the position you want. If you position the mouse over 
the diagonal guideline far from its center, the cursor will change to rotation icon allowing you to 
rotate the diagonal guideline by clicking and dragging it. The guideline will rotate by displaying the 
current angle next to the cursor.  

 

Figure 5.13: Diagonal Guideline during rotation 

If you hold the Crtl key pressed while rotating the guideline, it will snap on every 22.5o to make 
precise rotation of the guideline.  

Guideline options 

Guidelines have some options which are useful in creating and editing embroidery designs. You 
can adjust the Guideline options before or after adding lines on the working area. To adjust the 
Guideline options, right click on the Ruler and left click on one of the options: Guidelines 
visible, Snap enabled, Lock guidelines.  

 
Figure 5.14: Guideline options dialog 

From the Guideline options dialog, you can set the following options: 
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Guidelines visible: With this option, you can choose to have the guidelines visible or not. To 
make the guidelines visible, click View> Guidelines visible. To confirm the changes, press the 
OK button and the changes will be applied immediately.  

Snap enabled: With this option, the objects of a design will align automatically to a guideline. To 
make your objects snap to the guidelines, check the Snap enabled option. By default the Snap 
enabled option is disabled. To confirm the changes you made press the OK button and the 
changes will be applied immediately. 

Lock guidelines: With the Lock guidelines option, you can lock the guidelines. The accidental 
movements of guidelines will be avoided. If you keep the Lock guidelines option unchecked, you 
will be able to move or add guidelines on the working area. To confirm the changes you made 
press the OK button and the changes will be applied immediately. 

Hoop guidelines are permanently locked and cannot be unlocked.  

Change Color: From the Color list at the right side of the dialog you can select the color of the 
guidelines. If the color you prefer is not on the list, you can find it by double clicking on any color. A 
graduated color image will appear. 

 
Figure 5.15: Choose color 

Select the color you want and click on OK button to confirm your selection. The color you selected 

will take the place of the color you double clicked on the Color list. To confirm the changes you 

made press the OK button. The color of the guidelines, which will become the color you selected, 

is very useful when the Fabric color is similar with the color of guidelines. 

Working with guidelines 

All inserted guidelines inside the software have snapping and aligning abilities that can be found 

very useful when you are designing inside Creative DRAWings. All objects can snap on 

Horizontal and Vertical guidelines that you have placed on the working area while moving the 

objects towards them. This is very useful when you want to align the objects of the design to 

specific position and makes you life easier while designing. Also, it is possible to do the opposite 

and move the Horizontal and Vertical guidelines towards the objects and be able to snap on its 

edges/sides. Finally, the guidelines have snapping abilities based on the Grid of the working are 

that allows you to position them exactly where you want them.  

The snapping and aligning abilities of the Guidelines are the following: 

If you click and drag any Horizontal/ Vertical and Diagonal guidelines towards a selected object, 

they will snap on every control handle that the object has on its selection rectangle. 
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Figure 5.16: Guidelines Snap on Handles 

If you hold the Alt key from the keyboard pressed while dragging Horizontal and Vertical 

guidelines, they will snap on every step of the Grid(if the Grid is enabled from View>Grid menu 

option).  

     
Figure 5.17: Guidelines will snap on every step of the Grid 

If you hold the Ctrl key from the keyboard pressed while dragging Horizontal and Vertical 

guidelines, they will snap on every one millimeter movement. 

     
Figure 5.18: Guidelines snap on every one millimeter movement 

Also, if you hold the Ctrl key from the keyboard pressed while rotating Diagonal guidelines, they 

will snap on every 22.5o degrees. 

      
Figure 5.19: Diagonal Guidelines snap on every 22.5

o
 

Finally If you hold the Shift key from the keyboard pressed while dragging Horizontal and 

Vertical guidelines, all snapping abilities will be canceled. The guidelines will not snap at all and 

you will be able to move them freely. 

All this snapping and aligning abilities can help you create perfect designs. 
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Chapter 6 - Designing tools  

Introduction 

In this chapter we will learn about the Designing tools of Creative DRAWings and how to use 

them to create Vector designs which can be converted into stitches. The designing tools can be 

found only inside Create mode of Creative DRAWings. The available Designing tools are the 

Freehand tool, the Bezier tool, the Outline shape tool (digitizing tool), the Create shapes tool, 

the Text tool and the Insert symbol tool. By combining these powerful designing tools you can 

create outstanding designs.  

Tools toolbar 
The most important designing elements in Creative DRAWings are in the Tools toolbar at the left 
side of your screen (inside Create mode). You can change the toolbar‟s location by clicking and 
dragging it to a location you prefer. 

All the designing tools of Creative DRAWings are found in these Tools icons. Several tools have 

fly-outs which are activated by clicking on the little black arrows on the icons. The tool which you 

click on will become active and will replace the previous option in the Tools toolbar. Four of the 

tools have extra icons on the fly-outs of the Tools toolbar. 

 
Figure 6.1: Tools toolbar 

The Tools toolbar changes according which design mode you are currently viewing. The Tools 

toolbar in the Create mode include all tools that are available in the Stitch mode and some 

designing tools (only inside Create to stitch mode combination). Some tools appear only if the 

Stitches (option Stitches form View menu is enabled) are visible on the design.   

The available tool categories that exist on Tools toolbar are the following: 

● Selection tools 

● Shape editing tool  

● Zoom tools 

● Stitch editing tools 

● Measure tool 

● Designing tools 

● Shape insertion 

● Text insertion 

● Array tool  

● Auto border  

In this section we will analyze only the designing tools that are available in the Tools toolbar such 

as Designing and Shape insertion tools.   

Drawing tools 
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On Tools toolbar there are three available designing tools. These are Create Freehand shapes, 

Create Bezier shapes and Create Outline shapes. Only one of the 3 tools can be active on the 

toolbar each time. Click and hold on the current tool icon  in order to view all items. While 

holding left key pressed, you can move the cursor on top of the tool that you want to select. 

Release the mouse and it is selected. The tool is now active; use it to design any shape you like. 

The selected tool has become the current one and you can use it to create the shape you want. 

Create Freehand shapes 

With the Freehand tool  you can design simple lines or complete shapes. In order to create 

simple lines, select the freehand tool  or press the F5 key. Now that the tool is active, click 

once on the working area. This is the starting point of the line. Click once more to define the end of 

the line. By following the same steps you can add more lines and create the design you want.  

If you want you can continue the straight line you have created by inserting another straight line 

that will start from the start/end of the existing line. To do that you have to position the cursor over 

the ending/starting point of the existing line and see the cursor image changing. This change of 

the cursor informs you that you can continue designing a line from that point. Click to set the 

starting point of the line to be the same with the starting/ending point of the current line and then 

click on the position you want the line to end. By following the same steps you can continue 

entering straight lines at the end of the same shape and if you want make it a closed shape by 

connecting the last node with the first node.  

 

Figure 6.2: Connected lines - Freehand curve - Straight line - Closed shape 

Using the Freehand tool you can also make freehand designs like those you are drawing on a 

piece of paper. To do that you have to click and drag with the mouse on the working area until you 

have created the shape you want. You can create a closed shape by click and dragging with the 

freehand tool and end at the same point you have started. A closed shape will be created with fill 

and outline color. If the design you have created does not have a fill color this means that it is an 

open shape (line art design) or its fill color property in Thread palette toolbar is set to none.  

When you have finished one object you can continue creating the second one and so forth, but all 

of them will be part of the same object (all object will be joined/combined). This means that every 

shape you are creating without ending the designing process (by right clicking once) of the object 

will be member of the same object even if those objects are totally different. If you do not want 

them to be joined/combined you can select the objects with any selection tool and from the right 

click menu select Break apart option that will separate the designed objects. 

If you want to create objects as different entities you have to create the first object with the 

Freehand tool and then right click once to end the creation of the first object. The created object 

will be highlighted and you will be able to continue by designing the second object. Important to 

remember is that whenever you want to end the creation of an object you have to right click once. 

To completely end the designing process with the Freehand tool you have to select any selection 
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tool from the Tools toolbar. In same way as with lines you can continue with another part on 

previous item by placing the mouse over the start-end point of the previous one. The cursor 

changes somehow to reveal that you can continue the shape.  

The way that the Freehand tool works it is helpful to create holes inside the shapes you are 

creating. For example if you want to create a wheel shape you have to draw the outer circle and 

then draw the inner smaller circle. 

 
Figure 6.3:     Closed shape               Design hole              freehand hole created 

When the designing of the inner circle is finished, a hole will be created inside the bigger circle. 

This functionality is very helpful when you are drawing shapes over a bitmap backdrop.  

While using Freehand tool to create a freehand shape you can hold the Shift key down to make 

the curves you are drawing smoother. This ability helps to make the design easier. 

If you hold the Ctrl key pressed while drawing with Freehand tool, guidelines will appear on every 

22.5 degrees of the X and Y axes. When you press the Ctrl key the object automatically 

moves/snaps on the closest guideline. While drawing, the object it will snap on the guidelines, 

allowing you to draw the curve object along the guidelines. The guidelines that appear have as 

center the point from where the freehand curve you are drawing starts. 

If you hold the Alt key pressed while drawing with Freehand tool, vertical and horizontal guidelines 

will appear on X and Y axes that will snap on the lineation of the Ruler when the Grid is enabled. 

While drawing the curve object it will snap on the guidelines, allowing you to draw straight lines 

along the guidelines. When you press the Alt key the object automatically moves/snaps on the 

closest vertical and horizontal lineation of the ruler. From that point you can draw a line to the 

position you want based on the ruler. The Alt key will work even if the ruler is disabled.   

Also, when you select the Freehand tool, the smoothness level option appears on Tools 

options bar. With this tool you can set the smoothness level of the freehand artwork that you will 

create. The scale of smoothness level option is from 0 to 10 and can be adjusted by entering the 

value you want on the respective field or by using the increase/decrease arrows next to the field. If 

you set the smoothness level value to 0 the freehand curves that you will draw will have a lot of 

nodes and its curvature will not be so smooth.  

 
Figure 6.4: Freehand – Smoothness Level 

Smoothness  
Level 10 

Smoothness  
Level 0 
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On the other hand if you set the smoothness level value to 10 the freehand curves that you will 

draw will have the minimum nodes needed and its curvature will be smooth. Middle range values 

have average smoothing effect on the drawn curves. The Smoothness level options must be set 

before the creation of the curve you want to use. 

Finally, while drawing a shape and you make a mistake, you can press the Backspace button 
from the keyboard and delete the last inserted section until the previous node. If you want you can 
delete more of the design by pressing the Backspace button again. You can continue drawing the 
shape from that point and finish the shape you want to create. 

Create Bezier shapes 

With the Bezier designing tool  you can create shapes where you can handle better the 

curvature of each segment easier by adjusting the control handles of each inserted node.  

To draw a curve you have to select the Bezier tool from tools toolbar or by pressing the Shift + F5 

shortcut keys from the keyboard, define the first node by clicking on the working area once, move 

the mouse to the position you want the second node to be placed and by click and dragging at that 

position you can define the second node and adjust the curvature of the segment by moving the 

control handles of the node. Release the mouse button to confirm the segment you have added 

and continue with the next one by following the same procedure.  

 
Figure 6.5: Bezier tool 

If you want to add a straight line you have to define the first node or continue from an existing one 

and then the second node by clicking once more to the position you want. A straight line will be 

inserted connecting the two nodes. You can continue the shape by either inserting straight lines or 

curves. 

You can create a closed shape by connecting the last node with the first node you have inserted.  

While creating a shape you can end the design by right clicking once and continue with the next 

shape that will belong to the same object. This means that the first shape you have created 

together with the second shape that you will create will belong to the same object. This ability is 

very useful when you want to create embroidery designs, because it is really easy to create holes 

in any shape that will not be filled with stitches. For example if you want to create a wheel shape 

you have to draw the outer circle and then draw the inner smaller circle. When the designing of the 

inner circle is finished, a hole will be created inside the bigger circle. This effect is very useful also 

when you want to create a design based on bitmap backdrop.  

If you have created such an object and you want to separate it to its sub-shapes you have to 

select it with any selection tool and from the right click menu select Break apart option. The 

complex object will be separated to its sub-objects and you will be able to edit them separately. 

Control  
Handles 

Node 

Segment 
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In addition, if you want each closed shape or line art shape you are creating to be a separate 

object you have to right click once to end the designing process of the closed shapes and twice for 

the line art shapes. After ending the first shape you can continue with inserting the second that will 

be a separate object. You can continue the same process and add more objects that will shape 

your design. 

While inserting nodes with Bezier tool and you think you made a mistake you can delete as many 

nodes as you think you need to by pressing the Backspace form the Keyboard. Each time the 

Backspace is pressed the last node that was inserted is deleted. You can continue designing the 

object from the node you want.  

Another useful ability that Bezier tool has is that you can move the position of the last inserted 

node during designing.  To do that you have to hold the Shift key down after inserting the last 

node and while you are moving the control handles of the node, you can move the node to the 

position you prefer. By releasing the shift key you will be able to adjust the control handles of the 

node once more from its new position. All the adjustments must be made by keeping the left 

mouse click continually pressed. 

If you hold the Ctrl key pressed while drawing with Bezier tool, guidelines will appear on every 

22.5 degrees of the X and Y axes. When you press the Ctrl key the object automatically 

moves/snaps on the closest guideline. While drawing, the object it will snap on the guidelines, 

allowing you to draw the curve object along the guidelines. The guidelines that appear have as 

center the point from where the Bezier curve you are drawing starts. 

If you hold the Alt key pressed while drawing with Bezier tool, vertical and horizontal guidelines 

will appear on X and Y axes that will snap on the lineation of the Ruler when the Grid is enabled. 

While drawing the curve object it will snap on the guidelines, allowing you to draw straight lines 

along the guidelines. When you press the Alt key the object automatically moves/snaps on the 

closest vertical and horizontal lineation of the ruler. From that point you can draw a line to the 

position you want based on the ruler. The Alt key will work even if the ruler is disabled. 

Finally, with the Bezier tool you can continue the line art you are creating from the first or last 

node. You can do that when you have created a line art/curve shape and you have right clicked 

once to end the creation of the shape (If you right click twice you end the designing process of the 

object, and you cannot continue the line art shape). To do that you have to position the cursor over 

the ending/starting point of the existing curve and see the cursor image changing.  

 
Figure 6.6: First part - Second Part – Closing shape - Filled with color - Fill stitches  

This change of the cursor informs you that you can continue designing a curve from that point. 

Click to set the starting point of the curve to be the same with the starting/ending point of the 

current line/curve and then click on the position you want the line/curve to end. By following the 

same steps you can continue entering lines/curves at the end of the same line art shape and if you 

want make it a closed shape by connecting the last node with the first node.  

Create Outline shapes 
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The create Outline tool  (Digitizing tool) is based on the Bezier tool with the difference that the 

lines that you are creating are by default curve based. With the outline tool you can draw lines and 

curves by specifying their nodes and altering the curvature of their segments by adjusting their 

control handles. 

 
Figure 6.7: Outline tool 

To draw a curve you have to select the Outline tool  from the Tools toolbar or by pressing the 

Ctrl + F5 shortcut keys, define the first node by clicking on the working area once, move the 

mouse to the position you want the second node to be placed and by click and dragging at that 

position you can define the second node and adjust the curvature of the segment by moving the 

control handles of the node. Release the mouse button to confirm the segment you have added 

and continue with the next one by following the same procedure.  

If you want to add a straight line you have to define the first node or continue from an existing 

one and then by holding the Shift key down, the second node by clicking once more to the 

position you want. A straight line will be inserted connecting the two nodes. You can continue the 

shape by either inserting straight lines or curves. 

 
Figure 6.8: To draw straight lines hold Shift key pressed 

You can create a closed shape by connecting the last node with the first node you have inserted.  

While creating a shape you can end the design by right clicking once and continue with the next 

shape that will belong to the same object. This means that the first shape you have created 

together with the second shape that you will create will belong to the same object. This ability is 

very useful when you want to create embroidery designs, because it is really easy to create holes 

in any shape that will not be filled with stitches.  

Control  
Handles 

Node 

Segment 

Hold Shift Key 
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Figure 6.9: Closed shape - Design hole     -    Close hole shape  -        Hole created 

For example if you want to create a wheel shape you have to draw the outer circle and then draw 

the inner smaller circle. When the designing of the inner circle is finished, a hole will be created 

inside the bigger circle. This effect is very useful also when you want to create a design based on 

bitmap backdrop.  

If you have created such an object and you want to separate it to its sub-shapes you have to 

select it with any selection tool and from the right click menu select Break apart option. The 

complex object will be separated to its sub-objects and you will be able to edit them separately. 

In addition, if you want each closed shape or line art shape you are creating to be a separate 

object you have to right click once to end the designing process of the closed shapes and twice for 

the line art shapes. After ending the first shape you can continue with inserting the second that will 

be a separate object. You can continue the same process and add more objects that will shape 

your design. 

While inserting nodes with Outline tool and you think you made a mistake you can delete as many 

nodes as you think you need to by pressing the Backspace form the Keyboard. Each time the 

Backspace is pressed the last node that was inserted is deleted. You can continue designing the 

object from the node you want.  

Another useful ability that Outline tool has is that you can move the position of the last inserted 

node during designing.  To do that you have to hold the Shift key down after inserting the last 

node (If you press the Shift key before inserting the last node it will insert a Cusp node and draw a 

straight line) and while you are moving the control handles of the node, you can move the node to 

the position you prefer. By releasing the shift key you will be able to adjust the control handles of 

the node once more from its new position. All the adjustments must be made by keeping the left 

mouse click continually pressed. 

If you hold the Ctrl key pressed while drawing with Outline tool, guidelines will appear on every 

22.5 degrees of the X and Y axes. When you press the Ctrl key the object automatically 

moves/snaps on the closest guideline. While drawing, the object it will snap on the guidelines, 

allowing you to draw the curve object along the guidelines. The guidelines that appear have as 

center the point from where the Outline curve you are drawing starts. 

If you hold the Alt key pressed while drawing with Outline tool, vertical and horizontal guidelines 

will appear on X and Y axes that will snap on the lineation of the Ruler when the Grid is enabled. 

While drawing the curve object it will snap on the guidelines, allowing you to draw straight lines 

along the guidelines. When you press the Alt key the object automatically moves/snaps on the 

closest vertical and horizontal lineation of the ruler. From that point you can draw a line to the 

position you want based on the ruler. The Alt key will work even if the ruler is disabled. 
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Finally, with the Outline tool you can continue the line art you are creating from the first or last 

node. You can do that when you have created a line art shape and you have right clicked once to 

end the creation of the shape (If you right click twice you can end the designing process of the 

object, and you cannot continue the line art shape). To do that you have to position the cursor over 

the ending/starting point of the existing curve and see the cursor image changing. This change of 

the cursor informs you that you can continue designing a line from that point. Click to set the 

starting point of the line to be the same with the starting/ending point of the current line/curve and 

then click on the position you want the line/curve to end. By following the same steps you can 

continue entering lines/curves at the end of the same line art shape and if you want make it a 

closed shape by connecting the last node with the first node. 

By using the available designing tools you can draw the embroidery designs you want, based on a 

backdrop bitmap or on your designing abilities.  

Insert shapes 
From the tools toolbar you can select and insert shapes that will help you create embroidery 
designs easier. The available shape tools are Create Ellipses, Create rectangles, Create Pies, 

Create Stars, Create Polygons and Create Trapezoids/Parallelograms.  

 
Figure 6.10: Shapes fly out 

From the available tools only one can be active on the Tools toolbar each time. To view all the 

available shape tools click on the current shape tool and hold while moving the mouse over all 

available shape tools. The selected designing tool will become the current one and you can use it 

to insert the specific shape on the working area.  

Create Ellipses 

The Create Ellipse tool  allows you to design ellipses that will be filled with stitches. You can 

create any ellipse shape but also circles and complex shapes by combining elliptic shapes. To 

create an ellipse shape you have to select the Ellipse tool  from the Tools toolbar or by 

pressing the F7 shortcut key from the keyboard and by click and dragging diagonally on the 

working space, draw the ellipse shape you want. By releasing the mouse click the shape will be 

placed on the position you have designed it.  

By holding the Ctrl key pressed while drawing a shape, guidelines will appear on every 22.5 

degrees of the X and Y axes, with center the point you click and dragged to draw the circle. By 

click and dragging diagonally you can draw a Circle. Also, by click and dragging with the mouse 

based on the guidelines you can draw perfect oblong ellipses. While drawing the object, it will 

snap on the guidelines, allowing you to draw the shape along the guidelines.  

 

Guidelines 
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Figure 6.11: Hold Ctrl key and guidelines will appear on every 22.5 degrees 

By holding the Alt key pressed while drawing an ellipse, vertical and horizontal guidelines will 
appear on X and Y axes that will snap on the lineation of the Ruler when the Grid is enabled. 
When you press the Alt key the object automatically moves/snaps on the closest vertical and 
horizontal lineation of the ruler. From that point you can draw the object to the position you want 
based on the ruler. The Alt key will work even if the ruler is disabled.   

 
Figure 6.12: Hold Alt key - Horizontal and Vertical guidelines appear 

By holding the Shift key pressed while drawing an ellipse the center of the ellipse will change and 

become the point from where you started drawing the ellipse.  

You can also use combination of keys that will have combined effect. For example, by holding 

both Ctrl and Shift key pressed while drawing an ellipse, the center of the shape will be the point 

from where you started drawing the shape (as well as the center of the guidelines) and the shape 

will be a Circle. This is helpful when you know the center of the design and you want to add a 

Circle that will have as center specific point.  

There are some more editing abilities that ellipse tool has and they are available in Node editing 

mode . You can change an ellipse shape you have created by selecting it and then selecting 

the Edit shape nodes option  from the Tools toolbar, to change to node editing mode. On the 

outline of the selected ellipse will appear two handles, one positioned on the middle of the ellipse 

and the second one on the top right border of the shape. 

 
Figure 6.13: Hold Alt key - Horizontal and Vertical guidelines appear 

By click and dragging the handle of the top right part of the ellipse you can change the size of the 

ellipse shape freely to all dimensions or based on guidelines by using the Ctrl, Alt or Shift keys 

(Ctrl, Alt or Shift keys has the same functionally that we described previously in this section). 

Also, by click and dragging the handle from the center of the shape you can change the position of 

the ellipse freely or based on guideline by using the Ctrl and Alt keys.  

Notice: If you have converted the ellipse shape to curves by selecting the respective option of the 

right click menu, the Vertical and Horizontal handles will not be available in Node editing mode.   

Handles 

Vertical 
Guideline 

s 

Horizontal 
Guideline 
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Create Pies 

The Create Pie tool  allows you to design ellipses and pie shapes that will be filled with 

stitches. You can create any ellipse/circle shapes, pie shapes and complex shapes by combining 

them. To create an ellipse you have to select the Pie tool from the Tools toolbar or by pressing 

the Shift+F7 shortcut keys from the keyboard and by click and dragging diagonally on the working 

space, draw the Pie shape you want. By releasing the mouse click the shape will be placed on the 

position you have designed it.  

By holding the Ctrl key pressed while drawing a shape, guidelines will appear on every 22.5 

degrees of the X and Y axes, with center the point you click and dragged to draw the Pie. By click 

and dragging diagonally you can draw a Circle based Pie. Also, by click and dragging with the 

mouse based on the guidelines you can draw perfect oblong pie shapes. While drawing the object, 

it will snap on the guidelines, allowing you to draw the shape along the guidelines.  

 
Figure 6.14: Hold Ctrl key and guidelines will appear on every 22.5 degrees 

By holding the Alt key pressed while drawing a pie, vertical and horizontal guidelines will appear 
on X and Y axes that will snap on the lineation of the Ruler when the Grid is enabled. When you 
press the Alt key the object automatically moves/snaps on the closest vertical and horizontal 
lineation of the ruler. From that point you can draw the object to the position you want based on 
the ruler. The Alt key will work even if the ruler is disabled.   

 
Figure 6.15: Hold Alt key - Horizontal and Vertical guidelines appear 

You can also use combination of keys that will have combined effect. For example, by holding the 

Shift key pressed while drawing a pie the center of the ellipse will change and become the point 

from where you started drawing the ellipse.  

By holding both Ctrl and Shift key pressed while drawing a pie, the center of the shape will be the 

point from where you started drawing the shape and the shape will be a Circle based pie. This is 

helpful when you know the center of the design and you want to add a Pie shape that will have as 

center a specific point.  
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You can change the shape of a pie object you have created by selecting it and then selecting the 

Edit shape nodes option  from the Tools toolbar, to change to node editing mode. On the 

outline of the selected pie, four handles will appear, one positioned at the center of the design, 

one on the Vertical axis, one on the Horizontal axis and the other on the top right corner of the 

object.  

 
Figure 6.16: Three Pie Handles 

By click and dragging the handle of the Vertical or Horizontal axes you can change the shape of 

the Pie. By dragging the handles to the right or to the left you can increase or decrease the 

opening of the Pie. You can use any of the two handles to do that. If you hold the Ctrl key while 

dragging a handle, the mouse will snap on every 22.5o degrees allowing you to make precise 

changes on the Pie shape.   

            
Figure 6.17: Drag to left to close Pie shape  -  Drag to right to open shape 

By click and dragging the handle of the corner you can change the size of the Pie shape freely or 

based on guidelines by using the Ctrl or Alt keys (Ctrl, Alt keys has the same functionally that we 

described previously in this section). If you hold the Shift Key pressed during the resizing process 

the Pie will be resized proportionally and become a Circle or Pie based on a circle.  

By changing the position of those three handles you can make precise changes on the size and 

shape of the pie you have created. 

By click and dragging the handle that is located at the center of the design you can move the 

object to the position you want.  

You can also define the starting and ending position of the Pie‟s angle by specifying them on the 

Tool options toolbar. If you select the Ellipse/Pie object in Node editing mode or in object editing 

mode, two options will appear on the Tool options toolbar related with the Pie object. Those 

options are the Start angle and the Stop angle. 

Handles 
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With the Start angle you can define the starting position of the angle that 

the Pie is making based on virtual X and Y axes. The value of the Start angle is in degrees; 

therefore, if the Start angle value is 90 the starting position of the angle will be the top point of the 

pie, which is also the initial position of the Vertical handle (the same with 90o degrees on X and Y 

axes). You can change the value of the filed by selecting the current value and typing a new one. 

Then press the Enter key from the keyboard to confirm the new value. The change will be applied 

immediately on the shape. Also, you can increase or decrease the value by pressing the arrow 

buttons next to the field respectively.  

With the Stop angle you can define the ending position of the angle that the 

Pie is making based on virtual X and Y axes. The value of the Stop angle is in degrees; therefore, 

if the End angle value is 360 the starting position of the angle will be the top point of the ellipse, 

which is also the initial position of the handle (the same with 360o degrees on X and Y axes). The 

Stop Angle value changes, while changing the position of the Horizontal handle. You can change 

the value of the filed by selecting the current value and typing a new one. Then press the Enter 

key from the keyboard to confirm the new value. The change will be applied immediately on the 

shape. Also you can increase or decrease the value by pressing the arrow buttons next to the field 

respectively. 

Notice: If you have converted the pie shape to curves by selecting the respective option of the 

right click menu, the handles will not be available in Node editing mode. 

Create Trapezoids and Parallelograms  

The Create Trapezoids/Parallelograms tool allows you to design rectangles and 

Trapezoid/Parallelogram shapes that will be filled with stitches. You can create rectangle/square 

shapes, Trapezoid/Parallelogram shapes and complex shapes by combining them. To create a 

Trapezoid/Parallelogram shape you have to create a rectangle shape first, on which the 

Trapezoid/Parallelogram will be based. To create a rectangle you have to select the 

Trapezoids/Parallelograms tool  from the Tools toolbar or by pressing the Shift + F6 

shortcut keys from the keyboard and by click and dragging diagonally on the working space, draw 

the rectangle shape you want. By releasing the mouse click the shape will be placed on the 

position you have designed it.  

By holding the Ctrl key pressed while drawing a shape, guidelines will appear on every 22.5 

degrees of the X and Y axes, with center the point you click and dragged to draw the rectangle. By 

click and dragging diagonally you can draw a Square. Also, by click and dragging with the mouse 

based on the guidelines you can draw perfect parallelepiped that you can convert to 

Trapezoid/Parallelogram shapes later. While drawing the object, it will snap on the guidelines, 

allowing you to draw the shape along the guidelines.  
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Figure 6.18: Hold Ctrl key and guidelines will appear on every 22.5 degrees 

By holding the Alt key pressed while drawing a rectangle, vertical and horizontal guidelines will 
appear on X and Y axes that will snap on the lineation of the Ruler when the Grid is enabled. 
When you press the Alt key the object automatically moves/snaps on the closest vertical and 
horizontal lineation of the ruler. From that point you can draw the object to the position you want 
based on the ruler. The Alt key will work even if the ruler is disabled.   

When you press the Alt key the object automatically moves/snaps on the closest vertical and 
horizontal lineation of the ruler. From that point you can draw the object to the position you want 
based on the ruler. The Alt key will work even if the ruler is disabled.   

 
Figure 6.19: Hold Alt key - Horizontal and Vertical guidelines appear 

By holding the Shift key pressed while drawing a rectangle the center of the rectangle will change 

and become the point from where you started drawing the rectangle.  

By holding both Ctrl and Shift key pressed while drawing a rectangle, the center of the shape will 

be the point from where you started drawing the shape and the shape will be a square. This is 

helpful when you know the center of the design and you want to add a Trapezoid/Parallelogram 

shape that will have as center a specific point.  

There are some more editing abilities that Trapezoid/Parallelogram tool has and they are available 

in Node editing mode . You can change a rectangle shape you have created to 

Trapezoid/Parallelogram by selecting it and then selecting the Edit shape nodes option  from 

the Tools toolbar, to change to node editing mode. On the outline of the selected rectangle will 

appear four handles, one positioned at the center of the design, one on the top left corner of the 

object, one on the top right corner of the object and one on the bottom left corner of the object.  
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Figure 6.20: Four handles of Trapezoids/Parallelograms 

By click and dragging the handle of the top left corner to the right, you can transform the 

rectangle to a Trapezoid shape. While dragging both top corners are moving towards to the 

center of the top side, creating a perfect Trapezoid. If you drag the top left handle until the middle 

of the top side you will create a triangle. Therefore with this tool you can create also triangle 

shapes.  

      
Figure 6.21: Drag top left corner handle to the right to create Trapezoid 

You can also change the rectangle to Trapezoid by adjusting the Slant value from the Tool 

options toolbar. If you select the rectangle object in Node editing mode the Slant options 

 will appear on the Tool options toolbar. Also, the same option will appear if 

you select the rectangle object in Object editing mode (when you make a rectangle\lasso 

selection) together with some other useful sizing and positioning options. By changing the slant 

value you can specify the percentage of distance that the top left corner will have from its starting 

position. The Slant is a percentage value that can take values from 0 to 100. The 0 value will have 

as result the rectangle to remain unchanged. The 100 value will have as result a triangle because 

the two corner handle will be positioned at the middle of the top side. Therefore, to create a 

Trapezoid you have to insert values from 0 to 100. Also you can increase or decrease the value by 

pressing the arrow buttons next to the field respectively. 

By click and dragging the handle of the bottom left corner to the right, you can transform the 

rectangle to a Parallelogram. While dragging the handle both bottom left and top right corners are 

moving towards the opposite corners creating a perfect Parallelogram.  

Handles 
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Figure 6.22: Drag bottom left corner handle to the right to create Trapezoid 

You can switch between Trapezoid and Parallelogram by checking Trapezoid checkbox 

 from the Tool options toolbar and the opposite to switch back to Parallelogram. If 

you select the Trapezoid object in Node editing mode the Trapezoid option  will 
appear on the Tool options toolbar. Also, the same option will appear if you select the rectangle 
object in Object editing mode (when you make a rectangle\lasso selection) together with some 
other useful sizing and positioning options.  

By click and dragging the handle of the top right corner you can change the size of the 

Rectangle/Trapezoid/Parallelogram shape freely or based on guidelines by using the Ctrl, Alt or 

Shift keys (Ctrl, Alt or Shift keys has the same functionally that we described previously in this 

section). If you hold the Shift key pressed during the resizing process and shape is a rectangle, 

will be resized proportionally and become a square. If you hold the Shift key pressed during the 

resizing process the Trapezoid/Parallelogram will be resized proportionally based on the initial 

shape.  

By click and dragging the handle that is located at the middle of the design you can move the 

object to the position you want.  

Notice: If you have converted the Rectangle/Trapezoid/Parallelogram shape to curves by 

selecting the respective option of the right click menu, the handles will not be available in Node 

editing mode but you will be able to edit the nodes of the shape directly. 

Create Stars  

The Create Star tool  allows you to design Star shapes that will be filled with stitches. You can 

create any star shapes, complex shapes by combining them. To create a star you have to select 

the Create Star tool  from the Tools toolbar or by pressing the „S‟ shortcut key from the 

keyboard and by click and dragging diagonally on the working space, draw the star shape you 

want. By releasing the mouse click the shape will be placed on the position you have designed it.  

By holding the Ctrl key pressed while drawing a star, guidelines will appear on every 22.5 degrees 

of the X and Y axes, with center the point you click and dragged to draw the star. By click and 

dragging diagonally you can draw a Star with equal dimensions to all its rays. Also, by click and 

dragging with the mouse based on the guidelines you can draw stars with various shapes. While 

drawing the object, it will snap on the guidelines, allowing you to draw the shape along the 

guidelines.  
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Figure 6.23: Hold Ctrl key and guidelines will appear on every 22.5 degrees 

By holding the Alt key pressed while drawing a star, vertical and horizontal guidelines will appear 
on X and Y axes that will snap on the lineation of the Ruler when the Grid is enabled. When you 
press the Alt key the object automatically moves/snaps on the closest vertical and horizontal 
lineation of the ruler. From that point you can draw the object to the position you want based on 
the ruler. The Alt key will work even if the ruler is disabled.   

 
Figure 6.24: Hold Alt key - Horizontal and Vertical guidelines appear 

By holding the Shift key pressed while drawing a Star the center of the star will change and 

become the point from where you started drawing the star.  

By holding both Ctrl and Shift key pressed while drawing a star, the center of the shape will be 

the point from where you started drawing the shape and the shape will be a perfect star. This is 

helpful when you know the center of the design and you want to add a Star shape that will have as 

center a specific point.  

There are some more editing abilities that Star tool has and they are available in Node editing 

mode . You can change a star shape you have created by selecting it and then selecting the 

Edit shape nodes option  from the Tools toolbar, to change to node editing mode. On the 

outline of the selected star will appear four handles, one positioned at the center of the design, 

one on the Vertical axis, one on the top right corner of the object and one between two rays at 

the top left quarter of the shape.  
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Figure 6.25: Four handles of Star objects 

By click and dragging the handle of the Vertical axis you can change the angle of the star by 

rotating it clockwise (CC) or anti-clockwise (ACC). By dragging the handle to the right you can 

rotate the Star shape clockwise. On the other hand by dragging the handle to the left you can 

rotate the shape anti-clockwise. If you hold the Shift key while dragging, the mouse will snap on 

every 22.5o degrees allowing you to make precise rotations.   

 
Figure 6.26: CC Rotation      –           ACC Rotation           –  Shift 22.5

o
 snap Rotation 

By click and dragging the handle of the corner you can change the size of the star shape freely. If 

you hold the Shift Key pressed during the resizing process the star will be resized proportionally 

and become a perfect star.  

By click and dragging diagonally the handle between the two rays at the top left quarter of the 

shape you can change the size of all rays at the same time. Mainly you can change the distance of 

the ray (the base) from the center of the design.  

    
Figure 6.27: Change size of rays Increase depth – Decrease depth 

By changing the position of those three handles you can make precise changes on the size and 

shape of the star you have created. 

Handles 
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By click and dragging the handle that is located at the middle of the design you can move the 

object to the position you want.  

You can also define the size of ray, the number of rays and the starting angle of the Star from the 

Tool options toolbar. If you select the star object in Node editing mode three options will appear 

on the Tool options toolbar related with the Star object. Also, the same option will appear if you 

select the star object in Object editing mode (when you make a rectangle\lasso selection) together 

with some other useful sizing and positioning options. Those options are the Number of rays, the 

Ray size and the Start angle. 

 
Figure 6.28: Tool options - Number of rays, Ray size, Start angle 

With the Number of ray’s  value you can set the number of rays you want 

the selected star object to have. The default value of rays is 6; therefore when you insert a star 

shape on the working area, it always comes with 6 rays.  

 
Figure 6.29: 3 Rays    –        9 Rays            –           5 Rays         –         16 Rays 

The minimum value of Number of ray‟s option is 3, because with less than 3 rays we cannot create 

a star object, and the maximum value is 16. You can change the value of the filed by selecting the 

current value and typing a new one. Then press the Enter key from the keyboard to confirm the 

new value. The change will be applied immediately on the shape. Also you can increase or 

decrease the value by pressing the arrow buttons next to the field respectively.  

With the Ray size  you can define the percentage distance between the 

center of the Star shape and the line that connects two sequential ray vertexes of the star. 

Therefore the 0 value is the center of the Star and the 100 value will be on the line that connects 

two sequential ray vertexes. If you set the Ray value to 100 the star will become a polygon. You 

can change the value of the filed by selecting the current value and typing a new one. Then press 

the Enter key from the keyboard to confirm the new value. The change will be applied immediately 

on the shape. Also you can increase or decrease the value by pressing the arrow buttons next to 

the field respectively. By adjusting this value you can set the exact dimensions you want the star 

object to have.  

With the Start angle  you can define the starting position of the angle that 

the star is making based on virtual X and Y axes. The value of the Start angle is in degrees; 

therefore, if the Start angle value is 90 the starting position of the angle will be the top point of the 

ellipse, which is also the initial position of the handle (the same with 90o degrees on X and Y 

axes). You can change the value of the filed by selecting the current value and typing a new one. 
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Then press the Enter key from the keyboard to confirm the new value. The change will be applied 

immediately on the shape. Also you can increase or decrease the value by pressing the arrow 

buttons next to the field respectively. 

Notice: If you have converted the star shape to curves by selecting the respective option of the 

right click menu, the handles will not be available in Node editing mode. 

Create Polygons 

The Create Polygon tool  allows you to design Polygon shapes that will be filled with stitches. 

You can create any polygon shape and complex shapes by combining many polygon shapes. To 

create a polygon you have to select the Create Polygon tool from the Tools toolbar or by 

pressing the „Y‟ shortcut key from the keyboard and by click and dragging diagonally on the 

working space, draw the polygon shape you want. By releasing the mouse click the shape will be 

placed on the position you have designed it.  

By holding the Ctrl key pressed while drawing a polygon, guidelines will appear on every 22.5 

degrees of the X and Y axes, with center the point you clicked and dragged to draw the Polygon. 

By click and dragging diagonally you can draw a Polygon with equal dimensions to all its sides. 

Therefore depending on its sides you can create a perfect hexagon a perfect pentagon and so 

forth. Also, by click and dragging with the mouse based on the guidelines you can draw different 

variations of polygons. While drawing the object, it will snap on the guidelines, allowing you to 

draw the shape along the guidelines.  

 
Figure 6.30: Hold Ctrl key and guidelines will appear on every 22.5 degrees 

By holding the Alt key pressed while drawing a polygon, vertical and horizontal guidelines will 
appear on X and Y axes that will snap on the lineation of the Ruler when the Grid is enabled. 
When you press the Alt key the object automatically moves/snaps on the closest vertical and 
horizontal lineation of the ruler. From that point you can draw the object to the position you want 
based on the ruler. The Alt key will work even if the ruler is disabled.   

Guidelines 
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Figure 6.31: Hold Alt key - Horizontal and Vertical guidelines appear 

By holding the Shift key pressed while drawing a Polygon the center of it will change and become 

the point from where you started drawing the polygon.  

By holding both Ctrl and Shift key pressed while drawing a Polygon, the center of the shape will 

be the point from where you started drawing the shape and the shape will be a perfect Polygon. 

This is helpful when you know the center of the design and you want to add a polygon shape that 

will have as center a specific point.  

There are some more editing abilities that Polygon tool has and they are available in Node editing 

mode . You can change a polygon shape you have created by selecting it and then selecting 

the Edit shape nodes option  from the Tools toolbar, to change to node editing mode. On the 

outline of the selected polygon will appear three handles, one positioned at the center of the 

design, one on the Vertical axis and one on the top right corner of the object. 

 
Figure 6.32: Three handles of Polygon objects 

By click and dragging the handle of the Vertical axis you can change the angle of the polygon by 

rotating it clockwise or anti-clockwise. By dragging the handle to the right you can rotate the 

Polygon shape clockwise. On the other hand by dragging the handle to the left you can rotate the 

shape anti-clockwise. If you hold the Shift key while dragging, the mouse will snap on every 22.5o 

degrees allowing you to make precise rotations.   

   
Figure 6.33: CC Rotation         –        ACC Rotation         –  Shift 22.5

o
 snap Rotation 
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By click and dragging the handle of the corner you can change the size of the polygon shape 

freely. If you hold the Ctrl Key pressed during the resizing process the polygon will be resized 

proportionally and become a perfect polygon.  

By changing the position of those two handles you can make precise changes on the size, shape 

of the polygon and rotate it also. 

By click and dragging the handle that is located at the middle of the design you can move the 

object to the position you want.  

You can also define the number of sides and the starting angle of the Polygon from the Tool 

options toolbar. If you select the polygon object in Node editing mode two options will appear on 

the Tool options toolbar related with the Polygon object. Also, the same option will appear if you 

select the polygon object in Object editing mode (when you make a rectangle\lasso selection) 

together with some other useful sizing and positioning options. Those options are the Number of 

sides and the Start angle. 

 
Figure 6.34: Tool options - Number of sides, Start angle 

With the Number of side’s value you can set the number of sides you 

want the selected polygon object to have. The default value of sides is 6; therefore when you 

insert a polygon shape on the working area, it always comes with 6 rays. The minimum value of 

Number of side‟s option is 3, because with less than 3 sides we cannot create a polygon object, 

and the maximum value is 16. You can change the value of the filed by selecting the current value 

and typing a new one. Then press the Enter key from the keyboard to confirm the new value. The 

change will be applied immediately on the shape. Also you can increase or decrease the value by 

pressing the arrow buttons next to the field respectively.   

 
Figure 6.35: 3 Sides    –        9 Sides            –           5 Sides         –         16 Sides 

With the Start angle you can define the starting position of the angle that 

the Polygon is making based on virtual X and Y axes. The value of the Start angle is in degrees; 

therefore, if the Start angle value is 90 the starting position of the angle will be the top point of the 

polygon, which is also the initial position of the handle (the same with 90o degrees on X and Y 

axes).  You can change the value of the filed by selecting the current value and typing a new one. 

Then press the Enter key from the keyboard to confirm the new value. The change will be applied 

immediately on the shape. Also you can increase or decrease the value by pressing the arrow 

buttons next to the field respectively.   

Notice: If you have converted the polygon shape to curves by selecting the respective option of 

the right click menu, the handles will not be available in Node editing mode. 
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Create Rectangles 

The Create rectangle tool  allows you to draw rectangle shapes that will be filled with stitches. 

You can create any rectangle shape but also squares and complex shapes by combining 

rectangle shapes. To create an ellipse shape you have to select the Rectangle tool  from the 

Tools toolbar or by pressing the F6 shortcut key from the keyboard and by click and dragging 

diagonally on the working space, draw the rectangle shape you want. By releasing the mouse click 

the shape will be placed on the position you have designed it.  

By holding the Ctrl key pressed while drawing a shape, guidelines will appear on every 22.5 

degrees of the X and Y axes, with center the point you click and dragged to draw the rectangle. By 

click and dragging diagonally you can draw a Square. Also, by click and dragging with the mouse 

based on the guidelines you can draw perfect parallelepiped shapes. While drawing the object, it 

will snap on the guidelines, allowing you to draw the shape along the guidelines.  

 
Figure 6.36: Hold Ctrl key and guidelines will appear on every 22.5 degrees 

By holding the Alt key pressed while drawing a rectangle, vertical and horizontal guidelines will 

appear on X and Y axes that will snap on the lineation of the Ruler when the Grid is enabled. 

When you press the Alt key the object automatically moves/snaps on the closest vertical and 

horizontal lineation of the ruler. From that point you can draw the object to the position you want 

based on the ruler. The Alt key will work even if the ruler is disabled.  

 
Figure 6.37: Hold Alt key - Horizontal and Vertical guidelines appear 

By holding the Shift key pressed you can draw a rectangle from its center outward while drawing a 

rectangle. When you press the Shift key the center of the design changes and become the point 

from where you started drawing the rectangle.  

By holding both Ctrl and Shift key pressed while drawing a rectangle, the center of the shape will 

be the point from where you started drawing the shape and the shape will be a Square. This is 
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helpful when you know the center of the design and you want to add a Circle that will have as 

center specific point. 

There are some more editing abilities that rectangle tool has and they are available in Node 

editing mode . You can round the corners of a rectangle or square you have created by 

selecting it and then selecting the Edit shape nodes option  from the Tools toolbar, to change 

to node editing mode. On the top side of the selected rectangle will appear three handles, one 

positioned on the left corner, one on the middle and one on the Right corner. By click and dragging 

the handle of the left corner you can round the corners of the rectangle.  

 
Figure 6.38: Four handles of Rectangles 

By click and dragging the handle of the left corner you can round the corners of the rectangle. The 

roundness applies to all four corners of the rectangle.  

    
Figure 6.39: Drag left handle to add roundness 

You can also define the roundness of the rectangle from the Tool options toolbar. If you select 

the rectangle object in Node editing mode the Roundness options will 

appear on the Tool options toolbar. Also, the same option will appear if you select the rectangle 

object in Object editing mode (when you make a rectangle\lasso selection) together with some 

other useful sizing and positioning options. By changing the roundness value you can increase the 

roundness of the rectangle‟s corners. The Roundness is a percentage value that can take values 

from 0 to 100. The 0 value will have as result normal corners and no roundness. The 100 value 

will have round corners to their full extend. Therefore, by giving a specific value you can produce 

the result you want. Also you can increase or decrease the value by pressing the arrow buttons 

next to the field respectively.   

By click and dragging the handle of the top right corner you can change the size of the Rectangle 

shape freely or based on guidelines by using the Ctrl, Alt or Shift keys (Ctrl, Alt or Shift keys has 

Handle
s 
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the same functionally that we described previously in this section). If you hold the Shift key 

pressed during the resizing process the shape will be resized proportionally and become a square.  

By click and dragging the handle that is located at the middle of the design you can move the 

object to the position you want.  

Notice: If you have converted the rectangle shape to curves by selecting the respective option of 

the right click menu, the handles of the top left and right corner of the rectangle will not be 

available in Node editing mode.   

Design tools' options 
Tool options pane, provides immediate access to the properties of every object. Using the 
available controls we can customize the properties of every object. The pane is content sensitive; 
it shows the properties of the selected object. The same usability exists also while designing. 
Select a design tool and before you start designing, you can see a set of options appearing on tool 
options pane. These options can be customized either before using the tool or afterwards. Not all 
design tools have customizable options.  

In case that the pane is not visible you can re-enable it by pressing Tool options option of menu 

ViewToolbars. Whenever you select an object or a tool that has options such as Text tool the 

Tools options toolbar is updated to show the additional options that are available for the selected 

object or tool. There is a basic set of options that appears for all objects (figure). The standard 

options that will appear when you select an object are: 

 The X and Y position of the object in the design area based on the Ruler 

 The dimensions of the selected object (Width and Height) 

 The Horizontal - Vertical scale of the object  

 If Scaling operations will be proportional or not.  

 Duplicate object.  

 Mirror the object, based on the X or Y axis.  

 Rotate the object.  

 The thickness of the border.  

 
Figure 6.41: Tool Options pane 

There are also some options that appear only for specific types of objects. If you create a free 

hand design or insert a star shape for example, you will view some extra options appearing on the 

Tool options toolbar. Each of these options contains numerical values that can be changed 

according to your needs. In this section we will discuss the standard options that appear for all 

objects. The special options that each design tool provides are analyzed separately in the section 

that describes any of the design tools. 
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Extra options for Star shape Extra options for freehand design 

By changing the X and Y values you can reposition the object inside the design area. The X and 

Y axes are based on the X and Y rulers that exists on the Left and Top sides of the design area. 

The position of the selected object is calculated based on its center. Therefore any inserted value 

in the X and Y fields will define the position you want the center of the object to be located in the 

design area. In order to change these values, type the value you like in the respective fields and 

then press enter or click outside of the field. The change is automatically previewed in the design 

area. You can also use the arrows next to the fields to change the values.  

By changing the Width and Height values you can change the dimensions of the selected object. 

The values represent the exact dimensions of the object and not the approximate dimensions that 

you are viewing on the selection rectangle whenever you select an object. To change the Width 

and Height values, you have to click inside the relative field and then type the value you like. Press 

Enter from the keyboard or click outside the field to confirm the value you have entered. Also you 

can increase or decrease the value by pressing the arrow buttons next to the field. In case that the 

option proportional is checked and you select to scale one dimension the program automatically 

adjusts the other dimension in order to keep the same analogy between the horizontal and the 

vertical size. 

The next 2 fields (Scale X-Y (%))provide the capability to scale the object by a providing a 

percentage of scale according to the initial size. You can scale the object according to the X 

dimension or according to Y dimension. In case that the option proportional is checked and you 

select to scale one dimension the program automatically adjusts the other dimension in order to 

keep the same analogy between the horizontal and the vertical size. 

Duplicate object, press this button and an exact duplicate of the object will be created slightly 

moved from the initial object.  

Mirror object, the next 2 buttons can be used to Mirror the original object based on the Horizontal 

or Vertical axis. It is like flipping the object around a horizontal or vertical axis that is located on the 

horizontal or vertical center of the object.  

Rotate object, using this filed you can set a number in degrees to rotate the selected object. Type 

a numeric value or use the arrows next to the field to specify one, press enter or click out of the 

control. The object is automatically rotated clockwise for the degrees that you have specified. 

The last option you can adjust is the Outline thickness. By changing this value you can add an 

outline on the selected object or change the width of an existing outline.  If the value of the Outline 

width field is 0 means that the selected object does not have a border. By changing the value to 

any value greater than 0, an outline will be added to the object with the specified width. You can 

change the value of the Outline thickness by highlighting the current value and then typing the 

new one. The old value will disappear and the new one with take its place once you press Enter 

key from the keyboard or click outside the field. The value change affects the outline of the 

selected object. Also you can increase or decrease the value by pressing the arrow buttons next to 

the field respectively.  If you want you can remove the border of the selected object by changing 

the Outline thickness value to 0. 

Add new objects as clones  
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A very useful capability for making designs with repeated shapes is Add new objects as clones. 
You can enable this option using Add new objects as clone’s option of Edit menu. When this 
option is enabled, any created duplicate of an object is marked as a clone of the initial object. If 
you reshape any of the clones all other clones are reshaped too.  

You can create clones in various ways. The easiest way is by selecting one or more object and the 

press  button on Tools options pane.  

The other way is, while moving or transforming any object (resize, rotate, slant) you can right click 
and create a duplicate of the original object. This object has been created, leaving the original 
object impact. 

Let‟s make a brief example of how it this function works.  

1. Create a new design by pressing new design   icon 

2. Press create ellipse   tool  

3. Click and drag on the design area, to create an ellipse   

4. Now the newly created object is selected. 

5. Enable Add new objects as clone’s option of Edit menu. 

6. Move the rotation center simply by click and drag it, in order to rotate the object relative 

to another point. 

 

7. Place your mouse over the upper right corner, a rotate handle will appear.  

 

8. Click and drag to rotate the ellipse to the position you like, before you release the mouse 

Right click in order to create a duplicate.   

9. Press Ctrl+R to repeat this transformation and create more clones  

10. Once you have created the clones you like you can now take advantage of the clone 

editing.  

11. You can now edit the shape of any clone (Node editing mode) and all other clones will 

be affected as well. This way you can improve the pattern in an aspect that you didn‟t 

imagine at first.  

Notice the highlighted rectangle around the object. On the corners and at 
the center of the sides there are some highlighted bullets that can be used 
to transform the object.  

 

The rotation center is a small cross that is located at the center of the 
object 
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This is a created ellipse. Once you have created the 

ellipse make sure that Add new objects as clones of 

layout menu is selected.  

 

Use any of the transform handles that appear while an 

object is selected to transform it and by right clicking 

create a clone of the first object.  

 

Create as many clones as you like by applying Repeat 

last transform option from "Edit" menu.  

 

In node editing mode, select any of the clones. Reshape 

the object using Edit nodes mode, any change you make 

is immediately applied to all other clones 
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The flower like shape has changed 

 

We have changed with a couple of clicks all these flower 

petals and created a different version of the flower. 

Once you have created cloned objects you can access some extra functionality that is located on 
the right click menu, in order to better control these items.  

Select all clones  
You can select all clones by using Select all clones option of Clones submenu that appears 
when right clicking on any of the clones. Now you move all of them or apply a change on all of 
them. 

Detach from clones  
Another useful option is that you can select one or more of the clones and detach it from the other 
clones by selecting Detach from clone’s option of Clones submenu that appears when right 
clicking on any of the clones. The detached clone will no longer inherit the changes that are 
applied to any of the clones. It is a normal object now.  

 
Figure 6.42: Available clone management options 

Array tool (Circular-Rectangular) 

Using Array tool we can create Rectangular or Circular arrays. These arrays are clones 
of the whole design or of a selected portion. Basically we select one or more objects and by 
multiplying them along the design area we can create unique formations.  An extension of this tool 
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is that it can be used together with object cloning. This means while applying the array we have 
the ability to mark these copies, of the original object, as Clones. In case that you need to reshape 
the initial object again, you can reshape it and all clones will be affected as well. 

You can find both Rectangular and Circular array shortcut icons on Tools toolbar that is located 
on the left side of the application window.  

 

Only one of them can be immediately accessed by a single click. The one that is available appears 
on the toolbar and can be used by a single click. In order to see both tools, click and hold on the 
icon. Holding left key pressed, move your mouse over the one that you want to use. Once it is 
highlighted, release the mouse and it is activated. The tool that has been selected is also visible 
on tools toolbar, in order to able to access it the next time by a single click. Once you have 
enabled the tool you must select one or more objects to be used for. Click on an object or click 
and drag with your mouse to make a selection of the desired objects. Once you select an object 
you can see virtual preview of how the array will be. You can also see a floating window that has 
appeared on top of the design area. While using array tool this dialog is always visible. 

 In case you have selected by accident an object, but you want to use the array tool on another 
you can press select another shape button and now you can select the object(s) for the array 
once more. When you are satisfied by the appearance of the array, press Apply rectangular-
circular array button in order to apply the array.  

 
Figure 6.43: Apply array dialog 

Before applying the array you can customize the number of copies, the orientation of copies and-
or mirror some of the clones. The customizations can be done in 2 ways, visually by using the 
mouse and by numeric values by adjusting the respective options that appear on tool options 
pane. The available properties and the way to customize the array differ in Rectangular and 
Circular arrays so we will describe the procedure separately for each type. 

Rectangular array  

As you can see on the figure below for rectangular arrays we can adjust: 

 Number of Horizontal – Vertical copies 

 Horizontal – Vertical spacing  

 Clone objects if possible  

 

 

 

 

 

Figure 6.44: Customize rectangular array 

Adjust the spacing between 
Horizontal and Vertical copies 
 

Select Horizontal and Vertical copies 

If this option is enabled, you can reshape any object 
from the array and all the clones will be reshaped too. 
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You can also adjust the orientation of the copies and-or select the copies you want to be mirrored.  

Number of Horizontal and Vertical Copies  
In these two fields you can specify the number of copies that you want to be created in the 
horizontal axis and in the vertical axis.  

Horizontal and Vertical spacing  
In this field you can specify the distance between the horizontal and the vertical copies of the array 
that will be created. 

Clone objects if possible 
If this option is enabled, the copies of the original object will be clones. This means that we can 
reshape them all together by simply reshaping one of them. This option can save us a lot of time 
and it is also a tool that can produce unique embroidery designs. Any shape transformation you 
make, on any of the cloned copies, is applied to all of them immediately.  

In order to change the shape of all objects you have to follow the steps bellow 

1. Select any of the cloned objects. 

2. Click on Edit shape nodes mode on Tools toolbar (F10 keyboard shortcut), to switch to 

Edit Shape nodes mode  

3. Reshape the object by click and dragging the node segments to the direction you want.  

4. The reshaping has been automatically applied to all clones. 

There is also the functionality to select all clones and to detach one or more clones.  More 
information about Cloned objects can be found in Add new objects as clones section. 

   

An array with cloned objects 
Select any of the clones and 

select Edit shape nodes mode 

Edit the shape of any clone and any 

clone will be reshaped too 

 

In some cases while in preview array mode you can get carried away and think that you can use 
other tools or change design mode. The array hasn‟t been applied until you press Apply array 
button. Anyway if you by mistake try to select any other design tool or change design mode 
before you have applied the array, a warning about applying array will appear. At this point if you 
don‟t want to apply the array yet, select No and you are brought back to the state before the array. 
If you select Yes the array will be applied with its current configuration.   
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Figure 6.45: Apply array  

Using Rectangular array  

Step 1. Create a design to multiply and then press Rectangular array. 

 

Step 2. You are in preview array mode, your selection has been multiplied, the array hasn‟t been 
applied yet, it is a just preview. Customize the dimensions and the distance for your array. 

  

Step 3. Select number of horizontal and vertical copies. The preview is automatically updated  

Customize the dimensions of the array, the distance 
and whether you like the objects to be clones or not. 
 

You selection has been multiplied visually, no actual change 
has been applied, it is a preview a how the array will be. 

You are in preview array mode 

4 

5 

3 

2 

Create a design that you want to multiply 

Click on Rectangular array 
icon 

1 
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Move array 

The first upper left copy is actually the initial object. The control handle that is on top of it can be 
used to move the whole array to another place.  Only the part that is visible on the preview will 
remain after we apply the operation. 

                                                

The preview is updated immediately 

 

Select number of horizontal and vertical copies and 
increase horizontal and vertical space. 

Notice:  
The customizations of the number of horizontal and vertical copies and 
the distance between them can also be done using various mouse and 
keyboard combinations.  The handles that appear on any of the copies, 
while in preview mode, can be used for this purpose. 
 

Use this control handle to 
move the whole array. 

This is the preview of 
the array has moved.  

6 

7 
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Change horizontal and vertical distance 

Move any of the control handles besides the top left one and you change the horizontal and 
vertical distance. See figure below. 

  

 

If you hold Ctrl key while changing horizontal and vertical distance, the horizontal and vertical 
distance is kept the same.  

Change the resolution of the array 

You can visually change the resolution of the array, the number of horizontal and vertical copies. 
Click and drag any of the control handles holding Shift and the number of horizontal and vertical 
copies changes immediately according to the direction you have dragged the mouse. The distance 
between the copies remains the same. Take this in consideration while dragging; you have to drag 
for a distance such as the distance between the copies, in order to create another row or Colum.   

 

 

Change the orientation of copies and create mirrored objects  

 A very nice way to create unique patterns in your designs is by using different orientation or use 
mirrored copies in arrays. If you place your mouse over any of the control handles these 2 handles 

appear . These handles appear highlighted not only on the current clone but also on every 2 
clones to any dimension (Horizontal-Vertical).  It is like a 2x2 table pattern, the clone after the next 
of the clone horizontally and vertically is affected.  

Rotate copies   

The first handle is a rotate handle . Change the orientation of the clones with 90o degrees step. 
With a simple left click you rotate the clone 90 degrees. Click once more to rotate again.  

By moving any of these nodes we have 
completely changed the horizontal and 
vertical distance. 

 

Drag any of the control handles horizontal, vertical or 
diagonal, holding Shift to create rows and columns.  
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Place your mouse over any of the 

control handles; you can see all the 

affected copies with a highlighted 

handle over them. 

Click once on the rotate handle 

and the copies are rotated 90 

degrees 

Click again and they are rotated 

again 90 degrees. 

Mirror copies  

Next to the rotate handle there is a mirror handle , place your mouse over it. On this copy and 
on all other affected copies the same handle appears highlighted. Click once to Mirror all these 
copies.  

 

 

Place the mouse over any of the control handles, 

all the affected copies are highlighted too. 

Left click once and all affected copies have been 

mirrored. 

You can mirror any copy in any state. Rotate any copy and then apply mirror, now it is mirrored 
vertically. The mirror is applied based on the horizontal center of the selected object. 

 

 

Place the mouse over any of the control handles, Left click once and all affected copies have been 
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all the affected copies are highlighted too. mirrored. 

Circular array 

The Circular array tool, works in the same as the rectangular, creates copies of the initial design, 
but the copies are placed on an arc-circle, instead of a rectangle. Select one or more objects that 

you want to multiply and then press Circular array icon  that is located on Tools toolbar. Once 
you press Circular array icon you can see a virtual preview of how the array will be. On tool 
options toolbar you can customize, as you can see on figure below, the properties of the array. A 
virtual circle is created and the center of the circle is automatically placed at the center of the 
circle. Later in this section we will present how to change the virtual center and the size of the 
circle. 

 Start-End angle 

 The angle between the copies  

 The number of copies  

 If the object will be clones  

 The rotation that the clones will be applied. 

 

 

 

 

 

Figure 6.46: Customize circular array 

Select start/end angle  
With this option you can specify where the copies of the selected object(s) will be placed on the 
arc/circle. It is like selecting a part or whole circle to be filled with copies of the initial object. When 
setting Start-End angle the Step count option is also changing accordingly based on the size of 
the arc.  

Step angle  
In this field you can specify the angle step (degrees) that each copy of the circular array will be 
placed on. For example if you type 15o degrees, every copy of the circular array will be placed on 
the arc with 15o degrees between them, until the end of the specified "start/end angle". The Step 
angle that you will specify affects also the number of object/design copies that will be added on 
the Circular array. The Step angle and the Step count options are connected and the value 
specified in the first options affect the value of the second and the opposite. The valid values of 
Step angle option is from 0o to 359o. 

Step count  
In this field you can specify the number of copies that you want to be placed in the circular array, 
between the specified start-end angles. For example if you set Step count to 5 copies, it will 
place 5 copies of the selected object(s) on the specified start/end angle by adjusting the Step 
angle accordingly. The step count that you specify affects also the angle step (degrees) that 
each copy of the circular array will be placed on. The Step angle and the Step count options are 

Set Start-End angle of circular array 

If this option is enabled, you can reshape any object from 
the array and all the clones will be reshaped too. 
 

Set the Step angle between the copies 
and the number of the copies 
 

Clockwise placement or not. 
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connected and the value specified in the first options affect the value of the second and the 
opposite. Also the value of Step count from the size of "start/end angle" that you have specified. 

Clockwise  
With this checkbox you can specify if you want the circular array to be created clockwise or 
anticlockwise. If the Clockwise option is checked, (this is the default option) then the 
objects/designs will be placed on the circular array with clockwise order and the opposite if it is 
not.  

Clone objects if possible 

If this option is enabled, the copies of the original object will also be clones. This means that we 
can reshape them all together by simply reshaping one of them. This option saves us a lot of time 
and it is also a tool that can produce unique embroidery designs. Any shape transformation that 
you will make on any of the cloned objects/designs will be applied to all of them immediately.  

In order to change the shape of all objects you have to follow the steps bellow 

1. Select any of the cloned objects. 

2. Click on Edit shape nodes mode on Tools toolbar (F10 keyboard shortcut), to switch to 

node editing mode  

3. Reshape the object by click and dragging the node segments to the direction you want.  

4. To view the changes you made applied on all objects, you have to click back to Edit 

objects option of Modes toolbar. 

   

An array with cloned objects 
Select any of the clones and select 

Edit shape nodes mode 

Edit the shape of any clone and 

any clone will be reshaped too 

Using Circular array  

Step 1. Create a design to multiply and then press Circular array icon to enter Preview array 
mode. 

 

Step 2. You are in preview array mode, your selection has been multiplied, the array hasn‟t been 
applied yet it is a just preview. Customize the dimensions and the distance for your array. 

Create a design that you want to multiply. 

Click on Circular array icon. 

2 

1 
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Step 3. Select number of horizontal and vertical copies. The preview is automatically updated  

 

  

Let‟s make a brief description of the way that these mouse and keyboard combinations work. All 
the operations that we will describe below can only be used before we apply the array. The center 
of the array is by default on the center of the axis (0,0). 

All the copies of the array, while in preview array mode, have a control 
handle on top of them. These control handles can be used to adjust the 
properties of the array in the same way that we adjust them using tool 
options toolbar. The usage of the mouse and some keyboard 
combinations can provide extra functionality in some cases.  

This is the center of the circular array. 

The preview is updated immediately 
 

Select the Start-End angle in order to fill the 
whole circle and set number of copies 

6 

7 

Customize the Start-End angle, the Step angle, the 
number of copies, If the copies will be applied 
Clockwise and whether they will be clones or not. 
 

You selection has been multiplied visually, no 
actual change has been applied, it is a preview 
of how the array will be. 

You are in preview array mode. 

3 

4 

5 
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The first copy, that is actually the initial object, is placed on the start 

angle. It has a small rectangle around it, in order to be easily 

separated from the others. The control handle that is located on top of 

it is the only handle that can move the whole array to a new place. 

Initial object - node 

When moving this first node of the array, you can easily change the position of the arc-circle that 
the array will be applied on and the distance from the rotation center. The rotation of the initial 
object is the same; the only thing that changes is the placement of the arc.  

 

 

 

 

If we Hold Ctrl key while moving the first node, the movement of the array snaps on every 15 
degrees. Hold Alt key and the movement snaps on the grid. If we hold Shift key, while moving the 
first node the arc doesn‟t change and only the distance from the rotation center.  

Change distance between copies (Angle)  

In any movement of the first node the distance between the copies is left unchanged (Step angle).  
In case that we want to change the distance (Step angle) between objects we have to move any 
other node. If we move any other node the distance between the copies will change and the end 
angle will change accordingly, so that the same number of copies fits, with the new distance 
between the copies.  The arc has changed so that the number of copies and the distance between 
them can fit on it. If we reduce the distance the arc will shrink too.  

The whole array has moved. 
The start-end angle changes and so does 
the distance from the rotation center 
 

Start angle moved 

End angle moved 

Start angle  

End angle  

Initial place of the array. 
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If we Hold Ctrl key while adjusting the distance between the copies, the distance snaps every 15 
degrees. This is very assistive in having more accurate angle changing.  

Change number of copies  

In any of the above cases the number of copies doesn‟t change only the angle between the 
copies. While changing the angle there is an easy way to leave the angle the same and based on 
this angle to increase or decrease the number of copies. Select any of the control handles, hold 
Shift key and move to the direction you like. Move your mouse circular and you we will see that 
copies are created on the circle towards the direction you are moving. If you move backward 
copies are removed. The distance between then doesn‟t change, it is the same as it was at the 
start of the operation.  In reality while holding Shift you define with the mouse the arc that the 
array will be placed on. The start angle stays the same and moving your mouse you define the 
end angle. You must take in consideration that you must move the mouse clockwise or not 
according to what has already been selected for the array on tool options toolbar. 

Move array center  

The rotation center of the array is by default set to the center of the axis (0,0). According to our 
design we may need to move the rotation center and its distance from our design in order to 
create the pattern we like for the array. If we move the array center we can see that the whole 
array is moved to a new position without changing the angle of arc or rotation of the items. When 
we press Apply array it will be placed in the position that is defined by the preview.  

End angle moved 

Move any node, except from the first, to change 
the distance between the copies. 
 

The angle between the copies has changed and so 
has the end angle. 
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Initial array 
Moved array (Holding Shift), the array is the same into 

a new position 

If we move the center of the array Holding Shift, the position of the initial object and the size of 
the arc remain the same, but the rotation of the copies and the placement of the arc, changes 
according to the new center. While moving the rotation center we can also move it closer to the 
initial object. In order to move the rotation center, we have to hold Shift key while moving the 
rotation center node. 

 

 

  
 

 

Change the rotation  

The direction that the array is created is usually clockwise. You can reverse this direction easily by 
leaving unchecked the Clockwise option on tool options toolbar. Another way to change the 
direction is by clicking on the round arrow that appears when placing the mouse over the rotation 
center.  Click once and the direction of the array becomes anti-clockwise.  Click once more and it 
is reversed once more. 

Move rotation center  

Moving the rotation center we dynamically change the distance 
from the center, the position of the arc and the rotation of the 
copies.  

 

The Start angle has moved according to the new center 

The End angle has moved according to the new center 

The rotation center has moved holding shift key 
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Click on this small round arrow and the direction of the array is reversed. 

Change the orientation of copies and create mirrored objects  

 A very nice way to create unique patterns in your designs is by using different orientation or use 
mirrored copies in arrays. If you place your mouse over any of the control handles these 2 handles 
appear . These handles appear highlighted not only on the current clone but also on every 2 
clones, It is like a x2 pattern, and on every 2 clones the one is affected.  

Rotate copies   

The first handle is a rotate handle . Change the orientation of the clones with 90o degrees step. 
With a simple left click you rotate the clone 90 degrees. Click once more to rotate again.  

 
  

Place your mouse over any of the 

control handles; you can see all the 

affected copies with a highlighted 

handle over them.  

Click once on the rotate handle 

and the copies are rotated 90 

degrees 

Click again and they are rotated 

again 90 degrees. 

Mirror copies  

Next to the rotate handle there is a mirror handle , place your mouse over it. On this copy and 
on all other affected copies the same handle appears highlighted. Click once to Mirror all these 
copies.  

Start point 

The direction is anti-clockwise 

The rotation is clockwise 

Starting from the 
initial object 

1 

2 

3 

Click on this arrow 4 

5 
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Place the mouse over any of the control handles, all 

the affected copies are highlighted too. 

Left click once and all affected copies have been 

mirrored. 

 

You can mirror any copy in any state. Rotate any copy and then apply mirror, now it is mirrored 
vertically. The mirror is applied based on the horizontal center of the selected object. 

  

These 2 copies have been rotated We will mirror this rotated version 

Auto border 
Auto border tool is a very useful tool for creating automatic borders. With this tool you can add a 
running or satin border to one or more objects in the design. In order to use Auto border tool you 
must first select one or more objects that you want to apply auto border. Then you can activate 
Auto border function in 3 ways:  

 Press on Auto border icon  that is located on tools toolbar 

 Select the appropriate option of right click menu  

 Use  Auto Border option of Tools menu.  

The following dialog box will appear. 
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Figure 6.47: Auto border and Cut dialog 

In Auto Border dialog box you can define the Stitch type,  the Position and the number of 
repeats of the border. 

 Stitch type: In this choice set you can define the stitch type of the Auto border. You can 

select between Satin serial and Running stitch type. For Satin serial you can also adjust 

the width you want the satin to have.  

 Position of border: In this choice you can set the position you want the border to be 

placed. You can choose between To the inside and To the outside. Both options, if you 

do not enter a specific value in the Distance field, will be placed in the same position.  The 

value that will be entered in the Distance field is in millimeters, defines the distance 

between the default position of the border and the new position, inside or outside the object, 

of the border. 

 Number of repeats: in this field you can define a number of repetitions for the auto border. 

Any distance that you define in distance field will be the distance between the repetition of 

the auto border.  

Let's see an example we have created the 

flower of the following figure.  
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We selected to create 3 satin border 

repeats in distance 3mm. 

 

See these 3 created satin bars, in a 

distance from the initial flower.  

 

Any insert auto border or any repetition is a separate object and can be handles and edited as any 
object. Edit it's shape, it's properties, transform and move in any way you like. 

Working with text 
In this section we will analyze all the Text art abilities that the software has. Inside Creative 
DRAWings you can add text in different languages and convert them to stitches. Creative 
DRAWings supports most existing languages and allows you to create Text Art designs easily. All 
the fonts that are installed in windows are available and can be used inside Creative DRAWings. 
You can even copy and paste Text from any text editor inside Creative DRAWings and convert it 
to stitches.  

To add text 

To insert text in the working area you have to select the Text tool  from the Tools toolbar or by 

pressing the F8 shortcut key from the keyboard and then click on the position you want the text to 

be placed on the working area. The Text cursor will appear waiting from you to type the text you 

want to convert to stitches. While the Text cursor is active you can even paste any text that it is 

copied on the clipboard. To paste the text you have to select the Paste option from Edit menu or 

by selecting the respective option from the right click menu. The pasted text will be inserted 

allowing you to edit it further. The small dash on the Test cursor shows the horizontal axis where 

the text will be placed and the direction of the text.  
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Figure 6.48: Inserted text  

If you are writing from left to right the dash will be at the right side of the Text cursor. On the other 

hand if you are writing from Right to Left the Text cursor will be at the left side. While Text cursor is 

still active you can delete or type more text to the same Text object and make paragraphs by 

pressing Enter key from keyboard. To confirm the inserted text you have to select the Selection 

tool from the Tools toolbar or any other tool.  

If you have the 3D preview of stitches enabled you will view the Text filled with stitches, otherwise 

you will view the vector artwork of the Text design.  

Selecting Text 

Creative DRAWings Text tool works like an ordinary text editor and allows you to type and edit 
the inserted text similarly. Therefore the selection options you have, while working with text, are 
similar with those of an ordinary text editor. To edit the text of a Text object you have to select it 
and then select the Text tool from the tools toolbar. The Text object will become editable allowing 
you to select the text you want to edit. You can select the text you want to edit by using the mouse 
or by using the arrow keys or by using the Ctrl + Home and Ctrl +End keys from the keyboard.  

To select the text by using the mouse you have to click on the position from where you want the 
selection to start and then select the characters by click and dragging with the mouse until the 
character you want. Then you can type a different text that will replace the specific selected 
characters. 

To select the text by using the arrow keys, you have to click on the position you want the selection 
to start and by holding the Shift key pressed start pressing the arrow key that shows the direction 
where the characters you want to select are located. Keep pressing the arrow key until all the 
characters you want are selected. By holding both Shift and Ctrl keys from the keyboard pressed, 
you can select the text word by word. Each time that you will press the arrow key, a word will be 
selected instead of a character. Then you can type a different text that will replace the specific 
selected characters. 

To select the text by using the Ctrl +Home and Ctrl +End keys from the keyboard you have to 
click on the position you want the selection to start and by holding the Shift key pressed, press the 
Ctrl +Home or Ctrl +End Key from the keyboard according the direction you want to make a 
selection. If you want to select the characters to the right, you have to press the Ctrl +End key 
from the keyboard. All characters between the cursor and the end of the line will be selected. If 
you want to select the characters to the left you have to press the Ctrl +Home key from the 
keyboard. All the characters between the cursor and the beginning of the text will be selected. 
Then you can type a different text that will replace the specific selected characters. 

The selected text can be also copied, cut and deleted by selecting the respective options from the 
right click menu.  
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Figure 6.49: Right click menu options  

Change Font and Size 

You can edit the Inserted Text easily by selecting the Text tool and then the Text object. The Text 

art object will become active with the Text cursor appearing between the letters of the Text object. 

While the text object is active you can change the Font name and the Font size from the Tool 

options toolbar. Also, you can make the text Bold or Italic.   

 
Figure 6.50: Tool options – Font size, Font name, Bold, Italic  

To change the Font name you have to click on the drop down menu on Tool options and select 

the Font you want. The Font will change on the text allowing you to visualize how the embroidery 

will look like with a different font.  

To change the Font size you have to select the value of the Font size field and type a new one. 

To confirm the change you have to press the Enter key from the keyboard. The size of the 

selected Text will change on the working area.  

You have also the option to make the inserted text Bold or Italic (or Bold and Italic) by checking 

respective checkbox of Tools options toolbar. Any change it is directly applied on the inserted 

Text.  

Edit Text shape 

In Edit shape nodes mode you can edit more the text objects. You have the ability to change the 

position of each Text character and create complex Text artwork.  

Select the text art design and then click on the Edit shape nodes option from the Tools toolbar. 

In node editing mode at the bottom left of each character a handle appears that allows you to 

change the position of each character. To change the position of a character you have to click and 

drag its handle to a new position. You can continue and move any character to the position you 

want and create a text art design. The ability to change the position of each character is available 

only if the text object is not converted to curves. If the Text object has been converted to curves 

from the respective option of the right click menu or it was inserted as artwork, then you will not 

have the ability to change the position of each character in node editing mode. The characters will 

be treated as curve objects and not as Text objects.   

Another way to separate the characters and deal with them as separate objects by converting the 

Text object to curves and then breaking the curve objects apart. To do that you have to select the 

text object, right click on it and from the right click menu that will appear select Convert to curves 

option. Then right click once more on the object and form the right click menu, select the Break 

apart option. The text object now is split to its characters and can be handled as any curve object.  
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Text on path 

With the text tool you can also add text on a path that you have created. The text that will be 

added on the path will follow its curvature and create a text art design. To add a text on path, first, 

you have to create the path you want the text to be placed on by using any of the drawing tools 

such as freehand or outline tools. Then you have to insert the Text that you want to be placed on 

the path on the working area by using the Text tool from the Tools toolbar. Make the needed 

adjustments on the text object by changing the Font size and type from the tool options bar to 

make it proper for placing it on the path you have created. Also, you can adjust the curvature of 

the path you have created in Node editing mode by clicking on the Edit shape nodes  from 

the Tools toolbar. Adjustments on both Text and curve objects can be made, also, after placing the 

Text on path.  

Before applying the text on a path you have to make sure that the text is a text object and it is not 

converted to curves. Otherwise the Apply path option will not be available.  

   
Figure 6.51: Apply path procedure 

To place the text on the path you have to select them both by making multi selection, right click on 

them and from the right click menu select the Apply path option. The Text object will be placed on 

the path and follow its curvature. The two objects will become one but they can be edited 

separately. This means that you can edit the Text and the curve object as you did before applying 

the Apply path option.  

 
Figure 6.52: Edit text on a path 

To edit the text that is on the path you have to select the Text on path object and select the Text 

tool from Tools toolbar that will make the Text editable. You can change the type, the size, the 

style (bold or italic) and add or delete text to the existing text object from the tool options bar. The 

additional option you have on Text on path objects is that you can change the Text placement, 

the Text alignment, the Offset and the Direction of the text on the path.  

Text placement: You can change the text placement by selecting any of the four prefix text 

positions from the Text placement drop down menu of the tool options toolbar. The four options 

define the position that the path (curve) will have on the Text on path object and are the following: 

 
Figure 6.53: Text Placement 
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● Baseline (Default): The Baseline option is the default option and positions the text on the 

curve having characters such as small „g‟ to expand under the curve.  

 
Figure 6.54: Baseline 

● Bottom: The Bottom option positions the text over the curve completely. The curve (path) will 

be position at the bottom of the text. The characters such as small „g‟ will be positioned over 

the curve completely.  

 
Figure 6.55: Bottom 

● Ascent: The Ascent option positions the text exactly under the curve, having the capital letter 

or characters such as „h‟, touching the curve from below. The curve line is positioned over 

exactly over the text. 

 
Figure 6.56: Ascent 

● Top: The Top option positions the text under the curve by keeping a small distance from the 

curve.   

 
Figure 6.57: Top 

Text alignment: You can change the Text alignment by selecting any of the three prefix text 
positions from the Text alignment drop down menu of the tool options toolbar. The three options 
define the alignment of the Text on a path or a shape object and are the following: 

● Left: The Left option is the default option and sets the Text on path to start from the Left side 

of the path. 

 
Figure 6.58: Left Alignment 

● Right: The Right option sets the Text on path to start from the Right side of the path. 

 
Figure 6.59: Right Alignment 

● Center: The Center option centers the Text on the path. 
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Figure 6.60: Center Alignment 

Offset: The Offset numerical field specifies the distance of the Text from its current position. The 
default offset value is zero and you can change it by either typing a new value in the field, and 
then press enter key from the keyboard to apply it, or use the arrow buttons next to the field to 
increase or decrease the current value. The Offset value can take positive or negative values and 
move the Text on the path accordingly.  

Reverse Direction: When you place Text on a path or on a shape the text takes the direction of 
the path. If the path was drawn from left to right, then the Text will be also placed from left to right 
and over the path. On the other hand if the path was drawn from right to left then the Text will be 
also placed from right to left but will be positioned below the path.  

  
Figure 6.61: Path right to left  -  Path left to right 

When the path or the shape was designed from right to left and the text you have placed on 
appears in the opposite way from what you expected, you can simply check the Reverse 
direction checkbox and the text will appear in the way you wanted to be.  

You can also edit the curve that the text was placed one. To edit the curve (path) you have to 
select the Edit shape nodes option from the tools tab and edit its nodes. Any change you are 
making on the curve (path), affects also the way the Text is placed on the curve.  

Remove text from path 

If you have Text placed on a path you can easily remove it by right clicking on it and selecting the 
Clear path option from the right click menu that will appear. The Text will be removed from the 
path (curve object) and will lose its curvature. The Text object will keep its attributes (Font type, 
size, style etc.) and it will position on a virtual straight line which is the default position of every text 
you are inserting on the working area.  

The curve (path) object where the Text was placed on will remain as it was before applying the 
text on path option.  

 

Insert symbol 

Inside Creative DRAWings you can also insert symbols that can be also converted to stitches 

(This option is available only inside Create mode). There are many symbols you can import in 

Creative DRAWings and convert them to stitches. Symbols are ready made artworks that have 

various shapes that also vary depending on the Font type you are using. Each font type includes 

its own list of symbols that are based on the artwork of Font.  

To insert a symbol inside Creative DRAWings you have to select the Insert symbol option from 

Tools menu or press the Ctrl and F11 shortcut keys (Ctrl+F11) together from the keyboard. The 

Insert symbol dialog will appear where all symbols of a specific font will be listed. You can 
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navigate yourself between the symbols by scrolling with the scroll bar at the right side of the 

dialog. Once you have found the symbol you want to use you have to select it and click the Insert 

button.  

 
Figure 6.62: Insert symbol dialog 

By clicking the Insert button the cursor changes to cross, allowing you to insert the selected 

symbol on the working area and the Insert symbol dialog disappears making more working space 

visible.  

       
Figure 6.63: Horizontal placement with 5,33 mm width – Placed on an angle with 5,33 width  

To insert the selected symbol on the working area you have to click and drag with the mouse 

specifying the width of the symbol and the angle you want to have from the horizontal axis. After 

releasing the mouse click the symbol appears on the working area with the default fill and outline 

colors and the Insert symbol dialog turned back on. You can insert as many symbols you want by 

following the same steps. 

While dragging with the mouse useful information appear next to the cursor such as the Width 

and Angle. If you hold the Ctrl key pressed while dragging, the cursor will snap on every 22.5o 

degrees allowing you to insert the symbol on a specific angle.  

You can also change the symbols list you are viewing by changing the Font type. On top of Select 

Symbol dialog you can view the current font that you are using. You can change the font by 

clicking on the current font and from the list that will appear select a different one. The symbols will 

change accordingly allowing you to insert new symbols on the working area.  

If you want to close the Insert symbol dialog you have to click on the close icon . You can also 

minimize it by clicking on the hide icon . The minimize icon will make Backdrop properties to 

disappear and leave the title bar to float on the working area.  

 
Figure 6.64: Minimize backdrop properties dialog 
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You can maximize the dialog by clicking once more on the show  icon. 
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Chapter 7 - Transformations  

Introduction 

In this chapter we will learn all available transformation tools that you have to change the objects 

of the designs. You will learn how to reposition objects how to reorder them and how to 

duplicate and delete them. Also, we will show you how to change the shape of the objects. You 

will learn object sizing, skewing, rotating and mirroring and some special functions such as 

Trim, Intersection, Weld, Combine and group that can be applies on multiple objects. Finally, 

we will learn how to use the color manager and adjust the colors of the objects.  

Positioning objects  

In Creative DRAWings you can position the object by dragging them to their new position, by 

using the arrow keys from the keyboard and by specifying their horizontal and vertical position on 

the working area. The different ways to position an object can help you work easier and more 

precisely. These abilities are available only inside Create mode and inside the stitch mode.  

Move an object(s) 

You can move an object or a multiple selection of objects by clicking and dragging them in their 

new position. By releasing the left mouse click the object(s) are placed in the position you want 

them to be. By zooming in the object you can make even more precise movements of objects. 

If you hold the Ctrl key pressed while moving an object, guidelines will appear on every 22.5 

degrees of the X and Y axes. While moving the object it will snap on the guidelines, allowing you 

to make accurate movements along the guidelines.  

 

Figure 7.1: Hold Ctrl key and guidelines will appear on every 22.5 degrees 

The guidelines that appear have as center the point you click and dragged to move the object. If 

you want to move the object by using the guidelines but based on its center, you have to move the 

center handle outside of the shape and then move the object by click and dragging the design 

from the center of the object while having the Ctrl key pressed.   

 

If you hold the Alt key pressed while moving an object, vertical and horizontal guidelines will 
appear on X and Y axes that will snap on the lineation of the Ruler when the Grid is enabled. 
While moving the object it will snap on the guidelines, allowing you to make accurate movements 
along the guidelines.  

Guidelines 
 

Guidelines 
Center 
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Figure 7.2: Hold Alt key - Horizontal and Vertical guidelines appear 

When you press the Alt key the object automatically moves/snaps on the closest vertical and 
horizontal lineation of the ruler. From that point you can move the object to the position you want 
based on the ruler. The Alt key will work even if the ruler is disabled and the Grid enabled.   

Move a shape while drawing it  

You can also move a shape object while drawing it. This is an ability that you have when you are 
inserting any of the readymade shapes (Ellipses or Rectangles) in the Create mode of Creative 
DRAWings. While drawing a shape (after selecting the respective tool) by click and dragging you 
can change its position by holding also the right click of the mouse pressed. The shape object will 
start moving, allowing you to reposition it. If you release the right click without releasing the left 
click also, the shape will stop following the movement of your mouse but continue changing the 
shape of the object you want to create. If you release both mouse clicks, the object shape will be 
positioned on the working area by having the shape you gave to it.  

This is very useful because you can reposition the shape you want and place it exactly where you 
want it during the designing face, without having to do that afterwards.  

Move objects with arrow keys 

The position of an object can be also changed by using the Arrow keys from the keyboard. To 
move objects you have to select them and then click on the arrow key that has the direction you 
want to move them. You can move the objects until you are satisfied with the position that objects 
have.  

Every time you click on the arrow key, the object(s) moves 1mm to the direction of the arrow. If 
you hold the Ctrl key pressed and then press the arrow key, the object(s) will move 5mm to the 
direction of the arrow. Finally, if you hold the Shift key pressed and the press the arrow key, the 
object(s) will move 0,10mm to the direction of the arrow. By using the arrow keys and its 
combinations you can position the object(s) exactly in the place you want. 

You can change the movement step (distance) of the arrow keys from the Tools tab of Options 
dialog that you will find under Tools menu. In the tools tab you will find the Selection movement 
step option, where you can define the distance you want the selected object to move every time 
you press the arrow keys. The value that you will enter will also change the movement of objects 
when you are holding the Ctrl key pressed. The movement of objects when you hold the Ctrl key 
pressed will be multiplied with the value you have defines in the Selection movement step. For 
example, if you have set the Selection movement step to be 3mm, the movement while holding the 
Ctrl key pressed will become 3mm multiplied with 5mm, which is the default movement, equals 
15mm movement. 

Move an object with X and Y coordinates 

Vertical 
Guideline 

s 

Horizontal 
Guideline 

 

Snap 
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Another way to change the position of a shape, which is also the most accurate one, is to move an 

object based on its X and Y coordinates. When you select an object its coordinates appear on the 

Tool options toolbar.  

 
Figure 7.3: X & Y coordinates  

Tool options is a proprietary toolbar that holds the options of the selected object. In order to 

change the position of the object you have to change its coordinates, X and Y and place new ones 

based on the ruler of the working area. From the Ruler you can find the exact portion you want the 

design to be placed and enter the respective values. The ruler is defining virtual X and Y axes and 

that is why you can enter negative numbers as values to X and Y fields.  

Aligning, distributing and auto-sizing objects 

Creative DRAWings lets you precisely align objects in the design you are creating. You can align 
objects with each other, and position them exactly where you want them to be. It also, lets you 
distribute the objects automatically and make their sides appear at equal intervals vertically or 
horizontally. In addition, gives you the ability to automatically size the objects based on the 
dimensions of a specific object. All this options are accessible from the Align toolbar that can 
become visible by selecting the respective option from View menu. These abilities, also, are 
available only inside Create mode and inside the stitch mode that is combined with Create.  

 
Figure 7.4: Align bar 

The alignment and the auto-sizing of objects is made based on the last selected object or on the 
highlighted object (the highlighted object has magenta outline). If you make multiple selection of 
objects by holding the Shift key pressed each time you add an object to your selection the last 
object that you will select, will be the one where the alignment will be based on. If you make a 
lasso or rectangle selection, the highlighted object, with magenta outline, will be the one where the 
alignment will be based on.  

For example: If you have three objects like those in the figure below and you make a rectangle or 
lasso selection, the one that will have magenta outline will be the object that the align bar tools will 
use to align/auto-size the other two objects. As you can see from the figure below the Triangle is 
the highlighted object. The highlighted object is automatically selected and there is no way to 
specify which one will be highlighted inside a rectangle/lasso selection.  

   
Figure 7.5: Rectangle / Lasso selection and the Highlighted object. 

Magenta 
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To specify the highlighted object you have to select the objects one by one while holding the Shift 
key pressed. Each time you click on an object, it will be added to your selection. The last object 
that you will select will be the object where the align bar tools will be based on.  

Therefore, in our example, if we want the highlighted object to be the rectangle, we have to select 
the triangle first, hold the shift key down, then select the star object, keep the Shift key 
pressed and select the rectangle object which will be the highlighted one. View the figures 
below. 

   
Figure 7.6: Define the highlighted object by making a multiple selection  

Then you can apply any option from the Align bar based on the rectangle.  

Aligning objects 

The first six buttons of the Align bar are the available aligning options of the software. By default 
the Align options are disabled and they become available only if you select two or more objects. If 
you select only one object the options will remain disabled. After selecting the objects you have to 
select the alignment option you want to apply on them based on the highlighted object. 

The Alignment options you have are the following: 

o Align Left : To apply Align Left option at list two objects must be selected. After selecting 

the objects you want to align click on the Align Left icon from the Align bar or by pressing the 

„L‟ shortcut key from the keyboard. The selected objects will be aligned left, based on the 

highlighted object.  

  
Figure 7.7: Align left based on the Triangle 

o Align Right : To apply Align Right option at list two objects must be selected. After 

selecting the objects you want to align click on the Align Right icon from the Align bar or by 

pressing „R‟ shortcut key from the keyboard. The selected objects will be aligned Right, based 

on the highlighted object. 

  

Figure 7.8: Align Right based on the Rectangle 

o Align Centers Vertically : To apply Align Centers Vertically option at list two objects 

must be selected. After selecting the objects you want to align click on the Align Center 
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Vertically icon from the Align bar or press the „C‟ shortcut key from the keyboard. The 

centers of the selected objects will be aligned vertically (on the vertical axis), based on their 

center of highlighted object. 

     

Figure 7.9: Align Center Horizontally based on the House drawing 

o Align Centers Horizontally : To apply Align Center Horizontally option at list two objects 

must be selected. After selecting the objects you want to align click on the Align Center 

Horizontally icon from the Align bar or press the „E‟ shortcut key from the keyboard. The 

selected objects will be aligned vertically, based on the center of highlighted object. 

     
Figure 7.10: Align Center Vertically based on the House drawing 

o Align Top : To apply Align Top option at list two objects must be selected. After selecting 

the objects you want to align click on the Align Top icon from the Align bar or press the „T‟ 

shortcut key from the keyboard. The selected objects will be aligned Top, based on the 

highlighted object. 

 

 

  Figure 7.11: Align Top based on the Star 

o Align Bottom : To apply Align Bottom option at list two objects must be selected. After 

selecting the objects you want to align click on the Align Bottom icon from the Align bar or 

press the „B‟ shortcut key from the keyboard. The selected objects will be aligned Bottom, 

based on the highlighted object. 

Highlighted 
Object 

 

Highlighted 
Object 

 

Highlighted 
Object 

 

Align Center 
Vertically 

 

Align Center 
Horizontally 

 



Creative DRAWings Embroidery Software Manual 
 

174 Chapter 7 - Transformations   DRAWstitch Ltd.  
  

 

 

Figure 7.12: Align Bottom based on the Triangle 

Auto-sizing objects 

On the align bar there are three available Auto-sizing tools. By default the Auto-sizing options 
are disabled and they become available only if you select two or more objects. If you select only 
one object the options will remain disabled. After selecting the objects you want to auto-size you 
have to select the sizing option you want to apply on them based on the highlighted object. 

o Make same width : To apply Make same width option at list two objects must be 

selected. This option allows you to make the selected objects to have same width with the 

highlighted object that it is also included in the selection. After selecting the objects you want 

to have the same width, click on the Make same width icon  from the Align bar or press 

the Shift + W shortcut keys from the keyboard. The selected objects will be resized and have 

the same width with the highlighted object. 

  

Figure 7.13: Make same width based on the Circle 

o Make same height : To apply Make same height option at list two objects must be 

selected. This option allows you to make the selected objects to have same height with the 

highlighted object that it is also included in the selection. After selecting the objects you want 

to have the same height, click on the Make same height icon  from the Align bar or 

press the Shift + H shortcut keys from the keyboard. The selected objects will be resized and 

have the same height with the highlighted object. 

  
Figure 7.14: Make same height based on the Circle 

o Make same size : To apply Make same size option at list two objects must be selected. 

This option allows you to make the selected objects to have same size with the highlighted 

object that it is also included in the selection. After selecting the objects you want to have the 

same size/dimensions, click on the Make same size icon  from the Align bar or the Shift 
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+ S shortcut keys from the keyboard. The selected objects will be resized and have the same 

dimensions with the highlighted object. 

   
Figure 7.15: Make same height and width based on the Circle 

Distributing objects 

On the align bar there are two available Distributing tools. By default the Distributing options are 
disabled and they become available only if you select three or more objects. If you select only one 
or two objects the options will remain disabled. After selecting the objects you want to make their 
sides appear at equal intervals vertically or horizontally, you have to select the distributing option 
you want to apply on them and it will be applied immediately. While distributing objects the 
highlighted object it is ignored because it does not affect the functionality of the options. The 
available distributing options are the following: 

o Equal horizontal spacing : When this option is applied on the selected objects, the 

horizontal distance between objects becomes equal. Therefore this options places equal 

horizontal intervals between the selected objects. To apply this option, select the objects you 

want and then click on the Equal horizontal spacing icon  from the standard toolbar or 

the Shift + C shortcut keys from the keyboard.  

   
Figure 7.16: Equal horizontal spacing between objects 

o Equal Vertical spacing : When this option is applied on the selected objects, the vertical 

distance between objects becomes equal. Therefore this options places equal vertical 

intervals between the selected objects. To apply this option, select the objects you want and 

then click on the Equal vertical spacing icon  from the standard toolbar or the Shift + E 

shortcut keys from the keyboard. 

   
Figure 7.17: Equal Vertical spacing between objects 
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By aligning, distributing and auto-sizing objects you can create your designs even easier and 
quicker.  

Re-order objects 

In the Create mode of Creative DRAWings you can change the order of objects. You can change 
their order by bringing one to front and send another to back. The re-ordering you are making is 
for the vector design mainly. The final embroidery sequence is only based on the design and it is 
not identical with the order that the vector design was created. 

There are four available reordering options which are To front one, To back one, To front of 
design, To back of design. To apply any of the reordering options to the object(s) you have to 
select it and then right click on it in order the popup menu to appear. From the right click menu 
expand the Order submenu and select any of the four reordering options. 

 To front one: With this option you can move the selected object forward one position. If the 

selected object is positioned at the top of the design then the To front one option will not 

be available. Another way to apply this option directly is by pressing Page-Up shortcut key 

(PgUp) together from the keyboard. 

 To back one: With this option you can move the selected object behind one position. If the 

selected option is the last object of the design, this option will not be available. Another way 

to apply this option directly is by pressing Page-Down shortcut key (PgDn) together from 

the keyboard. 

 To front of the design: With this option you can move the selected object(s) to be in front 

of all other objects of the designs. Another way to apply this option directly is by pressing 

End shortcut key (End) together from the keyboard. 

 To back of the design: With this option you can move the selected object(s) to be behind 

of all other objects of the designs. Another way to apply this option directly is by pressing 

Home shortcut key (Home) together from the keyboard. 

For example, in the figure below we have five circles; and the blue circle is at the lowest level, the 
red to the next level, the green to the next level, the purple to the next level and the brown at the 
top level. In order to change the order of the circles we have to select the blue one and from the 
right click menu select Order > To front of the design option.  

             
               Initial position     -    Blue “To front of the design”  -   Brown “To back of the design” 

  

Figure 7.18:   Green “To back one”   -   Red “To front one” 
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Immediately the circle at the lowest level goes to the highest level. We can do also the opposite by 
selecting another circle (Brown object) and from the right click menu select Order > To back of 
the design option. 

This option sends the circle to the lowest level of the design. If we want to change an object one 
level, upwards or downwards we can do it by selecting the object (Green object) and again from 
the right click menu select Order > To back one option. 

The green circle will be re-ordered under the red circle that is one level down. We can do the 
opposite to the red circle by bringing it one step forward. The red object will be positioned over the 
purple object and under the blue object 

When we finish reordering the design we can go to the stitch mode to see how the embroidery 
design will look like or enable the Stitches option from the View menu inside the Create mode.  

The reordering tools can help you create exactly the design you want to embroider.  

Sequence manager  
Sequence manager provides a graphical representation of the embroidery sequence and an easy 
way to change the embroidery sequence. Sequence manager is a transparent floating dialog that 
appears on top of the design area (Figure 7.18). All the design items are represented as icons of 
the items to be embroidered. All these items have a number, in the lower left corner, which reveals 
their position in the embroidery sequence. They also have an icon on the lower right corner to 
reveal the type of the item. You can see the icons and the type of the objects that they represent in 
the following table. 

 

Normal stitch objects(Running, Satin serial, Step, Row 
Fill) 

 

Imported Cross-stitch or Photo-stitch 

 

Appliqué objects 

 

Imported artwork from stitch files 

As we can see in the following figure the first item to be embroidered is at the bottom of sequence 
manager and the last is at the top.  

 

 

Auto-sequence is enabled Auto-sequence is disabled 

Figure 7.19: Sequence manager floating dialog 

At this point we must mention that a very special tool of Creative DRAWings, the Auto-
sequence. This tool affects the way that the design items can be viewed on sequence manager. 
When Auto-sequence is enabled the program automatically decides the sequence of all stitch 
objects, so you don‟t have any control of the sequence of the design items via sequence manager 
in this case. The only items that are separated are appliqué and imported stitch files. As you can 
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see on the figure above, when Auto-sequence is enabled, the first item is a normal stitch object, 
the second item is an appliqué object and at the end there is a normal stitch object. The program 
uses intelligent mechanisms and automatically decides the sequence of the stitch items which 
means that you don‟t have any kind of control in the order that they will be embroidered using 
sequence manager. When Auto-sequence is enabled you can easily separate normal stitch 
objects from appliqué objects or imported stitch files and change the ordering between them.  

If you want to have full control of the ordering of all stitch objects you can disable Auto-sequence. 

This can be easily done by pressing Auto-sequence icon  on Tools toolbar. Once Auto-
sequence is disabled all design items become separate icons on sequence manager. This can be 
clearly seen in figure 7.18. At the left part, where Auto-sequence is disabled, you can see that all 
design items have separate icons. In the right part where Auto-sequence is disabled every design 
item has a separate sequence item. By clicking and dragging any item you can change their order. 
You have the full control of the embroidery sequence all the intelligent mechanisms have been 
disabled.  

More information about the usage and customizations of the Auto-sequence is provided in 
chapter Embroidery sequence.  

Re-sequence items  

Using sequence manager you are able to easily see all the designs objects. When Auto-sequence 
is enabled all design items are organized into one sequence item and only appliqué or imported 
stitch objects are separated into different icons. This way you can separate, appliqué and 
imported stitch data from normal stitch objects and change the order between them easily in 
case that is needed.  

As we can see on the following design, these 3 steps objects will be embroidered as shown n 
sequence manager. We have intentionally placed the pink object below the red one; the pink 
object is not visible at all now. We will move the red object to be embroidered first. See in figure 
7.20 how the visible items and the how the appearance of the design has changed.  

  
Figure 7.20: Sequence manager 

Let‟s see how easily we can change this sequence. We will place the mouse over the red object, 
in sequence manager, so that it gets highlighted. Now click and drag the object to the lower part of 
sequence manager so that is placed before all stitch objects. Simply by click and drag you can 
move any sequence item. Now as you can see on the figure below how the appearance of the 
flower has changed. The pink object is on top of the red and it is now visible. We have also 
created a satin outline object with 2 repeats using auto border tool and placed after the appliqué 
object. More information about auto border tool is provided in a separate section.  
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Figure 7.21: Appliqué object re-sequenced 

If we disable the Auto-sequence all the design objects will be separated into sequence items. Now 
we must define the order of all objects in order to embroider them any way we like. In the same 
way, by clicking and dragging we can reorder all design objects. The only difference is that we can 
select more than one sequence items, by holding Ctrl key and clicking on the items that we want 
to select. This way we can change the order of more than one sequence items at once.  

 

Sequence manager appears be default on the right area of the window on top of the design area. 
In case that it isn‟t visible or you have closed it by mistake you can always reactivate the sequence 
manager by selecting the respective option of View menu, Toolbars item. If you place the mouse 
anywhere over the Sequence manager you can see an outline appearing around it. Place your 
mouse over any item of the sequence and you can see it appearing like highlighted and on top of 
the other items, revealing that it is currently selected. If you click on any item of the sequence 
manager it gets selected and you can see it inside the design area with a highlight rectangle 
around it. 

As we have already mentioned by click and drag you can move any sequence item up or down to 
change its place in the embroidery sequence. 
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The sequence manager window appears floating over the design area. Although you can select 
where it will be placed and you can easily customize its size. 

You can also use this icon  to select a view mode for sequence manager. You can toggle 
between two modes, one that shows the object with a best fit on the icon of sequence manager 
and one that show the actual size of the object into the design. 

  

Icons with actual size Icons in best viewable 

If you want to close the Sequence manager dialog you have to click on the close icon . In case 
that you have closed sequence manager you can reactivate it using the respective option of view 
menu. You can also minimize it by clicking on the hide icon . The minimize icon will make 
Sequence manager to disappear and leave its title bar floating over the design area. You can 
maximize the dialog by clicking once more on the show icon . 

 
Figure 7.22: Minimize backdrop properties dialog 

Place your mouse over the title bar of sequence manager and a move handle appears. Click and 
drag in order to place Sequence manager wherever you like.  

 

Move sequence manager 
1. Place the mouse over its title bar 
2. A move handle appears 
3. Click and drag to move the sequence wherever you like. 

 

In case that not all sequence items can be seen with the current 
size of the window, a horizontal scrollbar appears.  
Use this scrollbar to see al sequence items. 
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In order to have larger sequence icons and have a better view of 
sequence items you can resize vertically the window 
Place your mouse over any of the horizontal edges, a resize 
handle appears. Click and drag towards any of the provided 
directions, the window is enlarged and the size of icons has 
changed accordingly. 

 

In the same way you can change the height of the dialog. 

 

You can also enlarge diagonally to both dimensions. 

The extra ability of this tool is that you can re-arrange the sewing order for the current design, and 
select one or more objects in the design area. This way you can organize the sequence of 
embroidery production in the way you prefer.  

We can also change the sequence of design items using Order options that appear on right click 
menu. These ordering options will be described in a separate section. In order to clearly watch the 
embroidery sequence you can use slow redraw tool. 

Duplicating and deleting objects  

In Creative DRAWings you can duplicate and delete objects with various ways. There are menu 

options to do that, mouse combinations and keyboard shortcuts. We will learn all of them and you 

can use any that fits most, your designing style. The only objects that you cannot apply the 

duplicate and delete options are stitch objects. Also, duplicate and delete are available only 

inside Create mode and inside the stitch mode that is combined with Create mode.  

Cutting, copying and pasting  

You can Cut or Copy an object or multiple objects to clipboard and paste them in the design area. 
The objects can come from any bitmap or vector designing application. You can copy or cut an 
object from another application and paste it in the Create mode of Creative DRAWings.   
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You can Cut an object by selecting the respective option from the Edit or the right click menu 
and by pressing Ctrl + X or Shift+Delete keys from the keyboard. The selected object will be 
placed to the clipboard and will be removed from the working area. In order to make it appear 
again you have to paste it in the location you want. 

You can Copy and object or multiple objects by selecting the respective option from the Edit or 
the right click menu and by pressing Ctrl + C or Ctrl+Insert keys from the keyboard. The 
selected object(s) will be copied to the clipboard but will leave the object unchanged. The copied 
object can be used as many times as we want by pasting it on the working area.  

You can Paste an object only when you have anything inside the clipboard. If the clipboard is 
empty, the Pasting function is disabled. You can paste a design that it is on the clipboard by 
selecting the respective option from the Edit or the right click menu or by pressing Ctrl + V or 
Shift+Insert keys from the keyboard. The object(s) that were on Clipboard will appear on the 
working area without being removed from the clipboard. The items on clipboard will stay there until 
something else is placed. Remember that only the last item stored in the Clipboard will be pasted 
in the working area, all the previous will be lost. 

Paste special 

With the Paste special option that you can activate from Edit menu you can specify how you want 

to paste items by selecting options in the Paste Special dialog box. The Paste Special dialog 

includes various options that you can adjust before pasting the object on the design.  

 

Figure 7.23: Paste Special 

● Source: The Source field displays the format, path, and name of the file from which you cut or 

copied vector, bitmap or text artwork. 

● Paste: The Paste option inserts or embeds the clipboard contents at the insertion point in the 

format you select in the As box. 

● Paste link: The Paste link option inserts the clipboard contents and creates a link to the source 

file for the data. This is an advanced way of pasting objects inside Creative DRAWings it is 

available only when the clipboard contents come from an application that supports linking. Be 

sure to save the source file in the source application before you link it to Creative DRAWings. 

● Display as icon: This option is available only if the contents of the clipboard support linking. The 

Display as icon option displays the linked or embedded object as an icon inside the software. To 

open or edit the object that was paste in the working area you have to double-click the icon. 
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● Result: In the Result area, you can view the effect of the selected options. Please read the 

description of each option carefully, because it will help you decide which on you will use.  

Once you have decided the way you will paste the objects inside Creative DRAWings you click 

OK button to complete the paste.  

Duplicating a design 

There is also a way to create duplicates of selected objects without using the clipboard and the 

Copy, Paste tools. In order to do that you have to select the object(s), click and drag it to the 

location you want to be placed, right click once without releasing the left click to activate the 

Duplicate function and then release the left click to insert the duplicated object. To understand that 

the duplicate function was activated you will see the cursor changing to  icon. When the 

duplicate function is enabled you can disable it by right clicking once more. The duplicate function 

is faster than Copy and Pasting and more precise because you duplicate the design exactly in the 

position you want it with two mouse clicks. 

Another easy way to duplicate the selected objects is by clicking on the Duplicate button  
that appears on the Tool options bar. By clicking the Duplicate button the selected objects are 
automatically duplicated and are placed exactly over the source objects. When you duplicate 
objects they always appear selected which allows you to move them easily to a different location 
by click and dragging with the mouse. This is the easiest way to move duplicate design to a 
different location and separate them from the original ones. If you want them to be exactly over the 
source objects, you can simply deselect them and they will remain in place. 

Delete objects 

To delete any selected object(s) you can either press the Delete key form the keyboard, or select 
Delete from the right click menu option. The selected objects will be removed from the design and 
can be recalled only by selecting the Undo from the standard toolbar.  

Sizing and skewing objects 
In Creative DRAWings you can size and skew the objects proportionally by preserving their 
aspect ratio or by change their dimensions/shape in the way you want. You can change the size of 
the object by specifying the dimensions of the object or by changing the object directly. These 
abilities are available only inside Create.  

Size objects 

When you select an object a selection rectangle appears around the shape. At the corners and at 

the middles of each side there are transformation handles that allow you to change the size of the 

object. If you position the mouse cursor exactly over the resize handles, the cursor will change to a 

two sided arrow that will show you the resizing directions. By click and dragging the transformation 

handles you can enlarge, shrink or stretch the object to the directions that the arrows show. If you 

click and drag the corner handle you can resize the object proportionally. On the status bar at the 

bottom of the screen you can view the percentage of resizing that you are making.  

If you hold the Ctrl key pressed while sizing an object, the object will be sized proportionally and 

snap on every 25%. While sizing the object you can view the proportional change of the 

dimensions on the Status bar at the bottom of the application window. If you try to enlarge an 

object while holding the Ctrl key pressed, its size will increase with 25% step (125%, 150%, 175% 
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etc.). The same step appears when you shrink an object. This ability allows you to make accurate 

changes on the shape and produce the result you prefer. Also, if you drag a handle to the opposite 

direction, until you see the proportional change on the status bar reaches the -100%, you will have 

produce the exact mirror of the object.  

   
Figure 7.24: Hold Ctrl key and proportionally resize with 25% step 

If you hold the Shift key pressed, while resizing the object from any corner handle, you can 

Enlarge/Shrink proportionally the design to all dimensions based on the initial center of the 

design. 

 

Figure 7.25: Hold Shift key - Enlarge/Shrink proportionally the design 

By holding both Ctrl and Shift keys pressed, while resizing the object from any corner handle, you 

can Enlarge/Shrink proportionally the design to all dimensions based on the initial center of the 

design and keep the original shape at the same time. 

If you hold the Alt key pressed while sizing an object from the corner handles you will be able to 

resize the object freely, without keeping any proportion of its initial shape.  

  
Figure 7.26: Hold Alt key – resize the object freely 

25% 
enlargement 
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Therefore, by holding the Alt key pressed while resizing you can not only resize the object but 

reshape it also.  

The handles at the middle of each side can be used to Stretch the design to the directions that the 

arrows show.  

If you hold the Shift key pressed, while resizing the object from any corner handle, you can 

Stretch proportionally the design to two dimensions based on the initial center of the design. 

    
Figure 7.27: Hold Shift key - Enlarge/Shrink proportionally the design 

Another way to resize an object is by specifying the exact dimensions you want to have on the 

Tool options toolbar. When you select an object all related options appear on the Tool options 

toolbar.  

 
Figure 7.28: Width and Height of the shape  

There are listed also the Width and Height of the object which you can change by inserting new 

ones. Select the values inside the field and then type the new value you want to have. Press enter 

to confirm the value or click outside the field. The change you made it is applied immediately on 

the object. This is a useful way to change the dimensions of an object or an entire design because 

you can do that precisely.  

The same sizing abilities apply to Cross-stitch objects. You can select any Cross-stitch object and 

re-size it applying any method we described above. By changing the size of Cross-stitch objects 

you can increase or decrease the number of crosses in the design. More crosses in the design 

increase the quality of the cross-stitch embroidery result.  

Skewing objects 

At the middles of each side there are transformation handles that allow you to skew the objects. If 

you position the mouse cursor near the handles, the cursor will change to a two sided half arrow 

that will show you the skewing directions. By click and dragging the transformation handles you 

can skew the object to the directions that the arrows show. 
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Figure 7.29: Skew horizontally and Vertically  

By default the center of the design is located at the center of the object and all skewing 

transformations are made based on this. You can change the skewing center by click and 

dragging it to the position you want, even outside of the design. By positioning the center of the 

design outside of it you can skew the design based on the new center.  

      
Figure 7.30: Skew based on Skewing Center 

If you hold the Shift key pressed, while skewing the object, the center of the design will change 

automatically and will be positioned at the opposite side, based on which the skewing will be 

made.   

 
Figure 7.30: Hold Shift key - Skew based on the opposite side 

Rotating and mirroring objects  

Creative DRAWings allows you to rotate and mirror the designs you are creating easily. You can 

rotate and mirror the design by click and dragging the rectangle selection handles to the position 

you want.  

Rotating objects 

When you select an object a selection rectangle appears around the shape. At the corners there 

are transformation handles that allow you to rotate the object. If you position the mouse cursor the 

handles, the cursor will change to a semi-circle arrow that will show you that you can rotate the 

design. By click and dragging the transformation handle you rotate the design clockwise or 

Skewing 
Center 

 

Skewing 
Center 
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anticlockwise. The rotation of the design is made based on the center of the design. The rotation 

center of the design is by default at the center of the design but you have the ability to change its 

position. Select the rotation center and move it to position you want the rotation center to be. If you 

want you can move it outside of the design. Once you have moved the rotation center you can 

rotate the design based on the new rotation center.  

    
Figure 7.31: Clockwise rotation   –  Anticlockwise Rotation with different rotation center 

If you hold Ctrl key pressed while moving the rotation center, guidelines will appear on every 22.5 

degrees of the X and Y axes based on the position you have moved it from. While moving the 

rotation center it will snap on the guidelines, allowing you to make accurate movements along the 

guidelines. The guidelines that appear have as center the point you click and dragged to move the 

rotation center.   

If you hold the Alt key pressed while moving the rotation center, vertical and horizontal guidelines 

will appear on X and Y axes that will snap on the lineation of the Ruler when the Grid is enabled. 

While moving the rotation center it will snap on the guidelines, allowing you to make accurate 

movements along the guidelines. When you press the Alt key the rotation center automatically 

moves/snaps on the closest vertical and horizontal lineation of the ruler. From that point you can 

move the rotation center to the position you want based on the ruler. The Alt key will work even if 

the ruler is disabled.    

If you hold the Shift key pressed, while rotating the object, the center of the design will change 

automatically and will be positioned at the diagonally opposite rotation handle, based on which the 

rotation will be made.  

 

Figure 7.32: Hold Shift key - Rotation based on the opposite rotation handle 

If you hold the Ctrl key pressed, while rotating the object, guidelines will appear on every 22.5 

degrees of the X and Y axes based on the rotation center of the design. While Rotating the object, 

it will snap on the guidelines, allowing you to make accurate rotations along the guidelines. If you 
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have changed the rotation center of the object the guidelines will start from the new position of the 

rotation center.  

 
Figure 7.33: Rotate objects precisely  

You can also rotate the objects you have created precisely by defining the exact rotation degrees 

on the Tool options toolbar. To do that you have to select the object you want to rotate, change the 

rotation center by dragging it to the position you prefer, type the exact degrees you want to rotate 

the design in the Rotate field from Tool options toolbar and press Enter key from the keyboard to 

apply the rotation. The object will be rotated the exact degrees you have defined.  

The Rotate option can take values from 0o to 360o if you want to rotate the design anti-clockwise 

and from -0o to -360o if you want to rotate the design clockwise. Besides inserting the degrees  

Mirroring objects 

Mirroring an object in Creative DRAWings is similar with resizing procedure. Select an object in 

order the rectangle selection handles to appear at the corners and on each sides. If you position 

the mouse cursor exactly over the resize handles, the cursor will change to a two sided arrow that 

will show you the resizing directions. In order to mirror the design you have to drag the 

transformation handle all the way to the opposite direction until the complete mirror of the design 

appear on the working area. According the mirroring you want to do, you have to drag the 

respective handle that will give you the mirroring you want. You can mirror the design Vertically, 

Horizontally and Diagonally.  

Horizontally, by dragging the handles of the vertical sides to the direction you want the mirror to 

be made.  

 

Figure 7.34: Mirror Horizontally 

Vertically, by dragging the handles of the horizontal sides to the direction you want the mirror to 

be made. 
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Figure 7.35: Mirror Vertically 

Diagonally, by dragging the corner handles the direction you want the diagonal mirror to be made. 

 

Figure 7.36: Mirror Diagonally 

If you want in place mirroring of the object you have to hold Shift key pressed during the mirroring 

process. The object will mirror based on the center of the design and not on the opposite 

side/handle of the design. 

 
Figure 7.37: Mirror while holding shift key pressed 

To all above cases, if you want to make accurate mirroring you have to hold the Ctrl key from the 

keyboard pressed during the mirroring process. By holding the Ctrl key pressed the mouse will 

snap on every 25% of the mirroring movement allowing you to make an identical object mirror. 

Because you are dragging the transformation handle to the opposite side of the object, the 

percentage movement starts from 100% (original shape), decreases with 25% step until 0, and 

then increases with negative values until -100% which is the perfect mirror of the object. The 

percentage changes are shown on the Status bar that is located at the bottom of the application 

window and the negative numbers show that you are in the Mirroring process.    
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Also, you can make accurate mirroring by changing the Width and Height values from Tool 

options toolbar. This can be done by inserting negative size values to the respective size fields. 

 To mirror the shape you want based on the vertical axis you have to insert a minus in front of the 

current Width value and then press Enter key. The shape will be mirrored horizontally by keeping 

the same dimensions. You can mirror the design horizontally to the preferred width by changing 

also (except the sign) the width value.   

To mirror the shape you want based on the horizontal axis you have to insert a minus in front of 

the current Height value and then press Enter key. The shape will be mirrored vertically by 

keeping the same dimensions. You can mirror the design vertically to the preferred height by 

changing also (except the sign) the height value.   

To mirror the shape diagonally you have to insert negative values on both Width and Height 

values of Tools options toolbar. The diagonal mirroring will be made in the position where the 

shape is located.  

Another way to mirror the selected design accurately is by clicking the Mirror X and Mirror Y 

buttons that you will appear on Tool options toolbar. 

To mirror the design vertically you have to select it and click on the Mirror X button. The design will 

flip and you will view its vertical mirror. 

To mirror the design horizontally you have to select it and click on the Mirror Y button. The design 

will flip and you will view its horizontal mirror. 

Use any of the above methods to mirror your designs and produce the result you 

want. 

Repeat transformation 
In Creative DRAWings you have the ability to Repeat your last transformation by using the 
respective option of the Right click menu. For example, if you have rotated an object you can 
repeat the last rotation as many times you want by selecting the Repeat last transform option from 
the right click menu or by pressing the Ctrl+R shortcut keys from the keyboard. The object will be 
rotated, by keeping the same rotation angle with the last made rotation, as many times as you 
used the Repeat last action option. This ability is available only inside Create mode of Creative 
DRAWings.  

If you want to repeat your last transformation you have to select the object you want the last 

transformation you made to be applied. Then Right click on the object and select the Repeat last 

transform option from the popup menu. The last transformation you made will be applied to the 

selected object as many times as you used the Repeat last transform option. Every time you 

make a transformation it is automatically becoming the last transformation and this one will be 

used when the Repeat last transform option will be applied. 

Clear transform 
Clear transform option of object editor context menu provides the ability to Cancel all the 
transformations that have been done to an object in object editing mode. This option of Object 
editing context menu appears when right clicking on any object that has been repositioned, 
resized, slanted, rotated or when any other transformation has been applied to it while you are in 
Object editing mode. The reverted transformations can be more than one. The object is reverted to 
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its initial state and position that it was designed. When applying Clear transform you are asked 
whether you like to keep distorted shape or not. This way you can make the present state of an 
object have no transformations. This is used when you like the current state of an object and you 
want to be able to recover this state in case you apply any transformations.  

 

Grouping objects  

Creative DRAWings includes grouping tools that are very useful in the designing face of the 

embroidery. By grouping two or more objects the software treats them as a single unit. Any 

change you make on grouped objects is automatically applied to members of the group. A group in 

reality is a way to make a multiple selection of objects to be treated as one object.  

These options are available only inside Create mode of Creative DRAWings.  

Group objects 

In order to make a group you have to select the objects you want become one group by making a 

multiple selection of objects and from the right click menu select Group option or press the Ctrl 

and G shortcut keys (Ctrl+G) together from the keyboard. The selected objects will become one 

group and will be treated as one object. 

    
Figure 7.38: Two separate objects - Select both objects and group them - Grouped objects 

Add object to a Group 

If you want, you can add more objects to a group. In order to do that you have to select the 

object(s) and then select the group of objects. From the right click menu select Group option and 

the object will be added to the group. If you want you can group multiple groups and make nested 

groups. To do that you have to select two or more groups of objects and from right click menu 

select Group option once more.  
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Figure 7.39: One group and one separate object – Add object to group - Grouped objects 

Delete an object form a Group 

To delete an object from a Group you have to ungroup it first, by selecting the respective option 

from the right click menu, delete the object you want and then re-group the objects. This is the 

standard way you can delete an object from a Group. 

Edit an object form a Group 

To edit an object from a Group you have to ungroup it first, by selecting the respective option from 

the right click menu, edit the object you want and re-group the object. This is the standard way to 

edit an object form a Group. 

Ungroup objects 

In order to Ungroup a group of objects or nested groups you have to select it and from the right 

click menu select Ungroup option or press the Ctrl and U shortcut keys (Ctrl+U) together from the 

keyboard. The group of objects will break and all objects will be handled as separate objects. The 

nested groups will be separated to its sub-groups and will be handled as separate groups. You 

can continue ungrouping the sub-groups of the nested groups until all groups become separate 

objects.  

     
Figure 7.40: Grouped objects       –       Ungroup objects             –         Ungrouped objects 

Combining and breaking apart objects  

Combining two of more objects has as a result a single object with common fill and outline 

attributes. You can combine two or more objects and create one that will have common attribute. 

If you want to separate combined objects to the objects that they consist of you can break them 

apart and edit them separately. 

These options are available only inside Create mode of Creative DRAWings.  

    
Figure 7.37: Combine overlapping objects – Combine objects that are not overlapping  

To combine two or more objects you have to select them, Right click menu and from right click 

menu select Combine option or press the Ctrl and L shortcut keys (Ctrl+L) together from the 
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keyboard. The two objects will become one with common fill and outline attributes. If the objects 

are overlapping then the shape of the object that is above will become a hole in the shape below. 

This is the way how the overlapped objects are combined. This is very useful when you want to 

create holes inside an object. If the objects are not overlapping then the objects will have the 

common attributes but the combine option will not affect the initial shape of the combined objects.  

If you want to separate a combined object to its objects you have to select the object, right click on 

it, in order the Right click menu to appear and from the right click menu select the Break apart 

option or press the Ctrl and K shortcut keys (Ctrl+K) together from the keyboard. The objects will 

be separated to its initial objects but will retain their common fill and outline attributes. If you have 

just combined the objects and you want them back as they where you have to Undo your last 

action by selecting the respective option from the Edit menu or by clicking on the Undo button 

from the standard toolbar.  

Combined objects that are not overlapping in embroidery are connected with a Jump-stitch 

between them. Therefore whenever you see two objects that are far one from the other and they 

are connected with Jump-stitch, this means that they are combined.  

Intersection and Weld 
Creative DRAWings includes two more editing tools that allow you to create irregular shapes. 

These tools are Intersection  and Weld . You can Intersect or Weld almost every object, 
including shape objects and text objects. However you cannot intersect or Weld bitmap images 
that where imported as backdrops or where filled with cross-stitch stitches.  

These options are available only inside Create mode of Creative DRAWings.  

You can Weld two or more overlapping objects by selecting them and then selecting the 

respective option from the Edit menu or by clicking on the Weld   icon from standard toolbar. 

The objects will become one with outline the perimeter of the objects that created the Weld shape.  

     
Figure 7.41: Weld overlapping objects 

If you made a multiple selection of objects by selecting one object first and then the second object 

by holding the Shift key pressed, the new object will adopt the fill and outline properties of the last 

select object.  

If you made a multiple selection of objects by making a Rectangle or Lasso selection, the new 

object will adopt the fill and outline properties of the object that is under the other objects in the 

order of objects. 

You can Weld objects regardless if they are overlapping or not. If you try to Weld objects that do 

not overlap, you will have as a result a combined object. The objects will act as one object with 

Object created 
from union tool 
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many sub objects with the same attributes. In order to separate such Weld objects to its sub-

objects you have to select the Break apart option from the right click menu.  

If you want you can, preview the Welding result by selecting the objects you want to Weld and 

then positioning the mouse over the Weld  icon. The software will preview how the objects will 

look like after applying the Weld option on them. The red line that surrounds the two objects will be 

the outline of the object after applying the Weld option.  

   
Figure 7.42: Weld Preview  

After previewing the Weld option you can decide easier if you will apply it or not. 

You can Intersect overlapping objects by selecting them and then selecting the respective option 

from the Edit menu or by clicking on the Intersection   icon from standard toolbar. Intersect 

option creates an object from the area where the objects overlap. The shape that will be created 

from the intersection depend on the shapes of the objects you intersect. 

     
Figure 7.43: Intersect overlapping objects 

If you made a multiple selection of objects by selecting one object first and then the second object 

by holding the Shift key pressed, the new object that will be created from the intersection will 

adopt the fill and outline properties of the last select object.  

If you made a multiple selection of objects by making a Rectangle or Lasso selection, the new 

object will adopt the fill and outline properties of the object that is under the other objects in the 

order of objects. 

If you want you can, preview the Intersection result by selecting the objects you want to Intersect 

and then positioning the mouse over the Intersect  icon. The software will preview how the 

objects will look like after applying the Intersect option on them. The red line that surrounds the 

object shows the object that will be produced after applying the Intersect option.  
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Figure 7.44: Intersect Preview 

After previewing the Intersect option you can decide easier if you will apply it or not. 

Both Weld and Intersect functions are helpful in the creation of irregular shapes that you can use 

to create the vector design you want.  

Remove overlaps 
It is used mainly for .draw file designs that have area fill and you have opened them inside 
BERNINA software. With BERNINA software you can only create designs with outline stitches 
(Running, Satin Serial), but this functionality exits in case you open a design that have shape 
areas filled with stitches. 

The remove overlaps option is located on the Object properties toolbar and it appears when you 
select an object filled with Satin, Step, Row Fill, Satin Serial or Running stitches.  

 

This is an automatic filter which removes all overlaps between the objects of the vector designs. 
This filter uses artificial Intelligence and it is applied only where necessary. The application of the 
filter results in the reduction of stitches that will be placed on the fabric. It is also possible to 
manually alter the overlapping status of each object. There are three possible options that you can 
apply on a specific object, Auto, Never and Always. The Auto is the default option and the one 
that Creative DRAWings uses to create the best possible results on the design. When the Never 
option is applied on an object, the specific object will never trim the objects that overlaps. This 
means that all the objects/shapes that are under the selected objects will be embroidered 
normally, placing all their stitches on the fabric. The opposite option is Always. When it is applied 
to a specific object it trims all the objects that it overlaps. This means that all the parts of 
objects/shapes that are under the selected object will not be embroidered.  

The advantage of this option is that it is applied automatically during the creation of the design 

without having to apply it manually. It will automatically decide which objects will trim and which 

not based on embroidery rules. 

Trimming objects 

With the Trim  function you can create wholes inside objects or reshape them by removing 
parts of their shape. You can trim any object you want in a vector design but you cannot trim a 
bitmap image that it is imported in the design.  

This option is available only inside Create mode of Creative DRAWings.  

You can apply the Trim function only to objects that overlap partially or entirely. First you have to 

decide which object will be the one that will be trimmed (target object) and which object you will 
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use to apply the trimming (source object). Then you have to select the source object first and then 

the target object by holding the Shift key pressed, to add it to your selection. From Edit menu or 

from the right click menu under Shaping submenu, select the Trim option to apply it on the 

selected objects. You can also apply the Trim option by pressing the  icon from standard 

toolbar. The trim will be applied on the target object and the area that was covered from the 

source object will be removed from the target object. The trimmed object will have a new shape 

but will retain its fill and outline attributes. If you make a rectangle selection the objects you want to 

trim and then apply the Trim tool, the only shape that will be trimmed is the one at the bottom in 

the overlapping order of the objects. You can make as many trims you want on overlapping 

objects to create the vector design you want.  

   
Figure 7.45: Before trim      –      Apply trim tool on overlapping objects – Trimmed object 

If you try to Trim two objects that are not overlapping, nothing will happen. Trim option it only 

applies on overlapping objects. If you want you can make a multiple trim of a target object with 

many source overlapping objects. To do that you have to select the source objects first one by one 

by holding the Shift key pressed to add them to your selection. The last object that you will add to 

your selection must be the target object that will be trimmed. After applying the Trim option all the 

source objects will trim the target object.  

If you want you can, preview the Trimming result by selecting the objects you want to Trim and 

then positioning the mouse over the Trim  icon. The software will preview how the trimmed 

object will look like after applying the Trim option. The red line that surrounds the trimmed object 

shows the object that will be produced after applying the Trim option.  

    
Figure 7.46: Trim Preview – Star trims Rectangle object 

After previewing the Intersect option you can decide easier if you will apply it or not. 

Trimming and Remove overlaps tools have similar functionality but not the same. Creative 

DRAWings with the Remove overlaps mechanism, removes the unneeded parts of the design 

from the final embroidery result but it is not removing the overlaps from the Vector artwork. 

Therefore, if you export the embroidery design to Wings‟ modular 2.50 (select File>Export>To 

editor…) you will view that the overlapping areas are removed automatically, but if you export the 

same design to SVG vector file (select File>Export>To SVG) you will view that the overlapping 
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areas are there as they were designed. On the other hand if you apply the Trimming function on 

the objects the embroidery result will be the same but the SVG vector artwork will differ. If you 

open the SVG file you will view that the objects you trimmed are remain there trimmed and not as 

they were before you apply the Trim tool. This is the main difference between Trimming and 

Remove overlaps tools. Trim tool alters the vector shape but Remove overlaps tool does not.  

Note: If you apply Trim option on two objects, it is better to set the Remove overlap value of both 

objects to Never  to ensure better embroidery results. 

Convert outline to Object  
To all fill objects (objects that are filled with Satin, Step, Row Fill or Appliqué stitch type) can be 
added an outline easily by left clicking on the top left corner of the color you want the outline to 
have. The outline will be added around the object filled with Satin serial or Running stitch type but 
it will not be a separate object. Therefore you will not be able to reshape it separately. For this 
purpose the Convert outline to Object exists. This option allows you to covert the outline/border 
that is attached on an object to a separate object and handle it as a Fill or outline/pen object. If you 
convert the outline to a Fill object, you will be able to fill it with Step, Satin, Row Fill or Appliqué 
stitch type that it is not possible to do it otherwise. Also, you will be able to apply all kind of shape 
transformations on it.  

If the outline thickness is smaller than 0.9mm and you apply the Convert outline to object option, 
the outline will be converted to Running or Satin Serial object and not to a Fill object. Therefore 
whenever you want to separate the outline from the object but keep the stitch type as Running or 
Satin Serial you have to set the outline thickness lower that 0.9mm.  

   
Figure 7.47: Apply Convert outline to object option to star object 

To apply Convert outline to object option you have to select an object that has an outline and 
from Edit menu select the respective option. You can also apply the same option by pressing the 
Ctrl, Shift and Q keys (Ctrl+Shift+Q) from the keyboard after selecting the object you want to 
apply it. The outline will be separated from the fill object and can be handled as a different object.  

Undo 
Using this option in the Edit menu, you can undo the very last action you took. You can also 

access the Undo function from the Standard toolbar by clicking on the icon. If you click the 

arrow next to the Undo  icon, Creative DRAWings displays a list of the most recent actions 
you can undo. Click the action you want to undo, to take your design back to the state you want. 
When you undo an action, you also undo all actions above it in the list. If you decide to cancel the 
undo you made, click on redo function.  

You can also change the undo level from Tools > Options in the General options tab. 

Outline  

Fill 
Outline to object 
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Redo 
Using this option from the Edit menu, you can cancel the latest undo that you have performed. 

You can also access the Redo function from the Standard toolbar by clicking on the  icon. If 

you click the arrow next to the Redo icon, Creative DRAWings displays a list of the most 
recent actions you can redo. Click the action you want to redo, to take your design to the state you 
want. When you redo an action, you also redo all actions above it in the list. 

Color management 
In the Create mode of Creative DRAWings you can define the color you want the vector artwork 
to have and not the colors of the final embroidery. The colors of the final embroidery can be 
adjusted from the Edit palette dialog. This is happening because there is no limitation to the 
colors that you can use on a vector artwork, but there are limitations to the colors you can use on 
an embroidery design. The software has a limitation of 99 colors on the embroidery designs. But 
considering the max needles that your embroidery machine can support you have to make a 
choice about the final number of colors. You must always keep in mind this limitation whenever 
you use stitch mode. If you have a design with 20 colors but in Edit palette you have defined 8 
colors (According to your embroidery machine  needle carriers). Then in stitch mode you will see 
you design changing and using only the number of colors that are selected for embroidery.  

 
Figure 7.48: Thread palette 

Thread palette toolbar 

The Thread palette toolbar is located at the bottom of the Create mode window and holds all the 
colors that you can use in the software. If it is not visible, you can make it visible by selecting the 
Thread palette option from View menu, Submenu Toolbars. The Thread palette toolbar has two 
color sections: the available colors and the colors that are currently used. 

The available colors are the colors of the color palette that is currently  selected for use. The 
available colors appear in the top area of Thread palette toolbar. By default if you haven‟t defined 
any thread manufacturer color palette, the RGB palette is loaded. You can change the default 
color palette and use a Thread manufacturer‟s color palette from the Edit palette dialog (we will 
explain it thoroughly later in this chapter). 

There is also the currently used colors area, on the bottom part, where all the colors that are 
currently used are listed. If the design has seven different colors they will be listed at the bottom of 
the Thread palette toolbar.  

 
Figure 7.49: Colors Used 

As you can see any color icon is consisted of 2 triangles , one on the upper left part and one on 
the lower right part. If you place the mouse on top of the upper left part of a color you can see a 
pen icon. This means that the selected color will be used for the outline of the object. If you place 
the mouse over the lower right part you will see a bucket icon revealing that the selected color will 
be used for the object fill.  

Currently used colors 

Available colors 
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For any object we select the colors (outline-fill) that are used for it are marked with icons in 
currently used colors are, in order to be able to see clearly the colors that are used for the object. 
If you select an object of the design the color that was used to be filled will be highlighted with a fill 

bucket  on the currently used colors area. If the object has outline, also, the color of the outline 

will be highlighted with a pen icon.  

The used colors can be reused to new created objects by selecting the object on the working area 
and then the color you want to be filed.  

At the beginning of the currently used color palette there is a square , which is the empty/none 
color. If a selected object does not have a Fill color, then the fill bucker will appear inside the 

None color  square. If the selected object does not have an Outline color then the pen icon 

will appear inside the None color square. Also, if you do not want an object to have a Fill or an 
Outline color, you have to select the object it and then click on both part of the none color square

 to remove the colors from the object.  

The Thread palette toolbar is movable and resizable. You can change its position by click and 
dragging the Title bar to a new position. The toolbar will float on the working area and become 
resizable. You can change its dimensions and position on the software. You can keep it as a 
floating toolbar or you can position it back to its initial position by click and dragging it at the 
bottom of Creative DRAWings window.    

Color palettes  

When Creative DRAWings opens the default color palette appears on the Thread palette toolbar 
in the Create mode. The default colors are RGB that can be used to color the shapes you will 
create or change the color of existing shapes.  

 
Figure 7.50: Current Color Palette 

There are more color palettes that we propose to be used when you are creating a design, which 
are the Thread manufacturer‟s color palettes and are located in the Edit palette dialog that you 

can access, if you select the respective button  from the standard toolbar.  

 
Figure 7.51: Palette drop down menu 

In the Palette drop down menu are listed the color palettes of the major thread manufacturers as 
well as the default RGB (Red Green Blue) color palette. You can select the Thread palette you are 
using (the manufacturer of the threads you are using), to create the design you want based on the 
colors that actually exist. Select a thread palette and click Ok button to apply changes. The colors 
of the selected palette will now appear on the Thread palette toolbar allowing you to use them to 
fill with color the objects you have designed or you will design. By following this procedure you can 
be sure that the color you used on the design actually exist and can be found in the market.  

Change colors 

Any object that you are creating in the Create mode of Creative DRAWings, without having 
selected a color before its creation, it is filled with a fill color and an outline color, which are the 
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default colors of the software. If you do not select any color and design an object, the created 
object will have the default Fill color and the default outline color.  

If you select an object of the design the color that was used to be filled will be highlighted with a 

Fill bucket  on the currently used colors area. If the object has outline or it is a line art design, 

the color of it will be highlighted with a Pen  icon. The used colors can be reused to new 
created objects by creating the object and then selecting the color you want to fill it. 

To change Fill color on an object you have to select it and then click on the lower right part of 
color that you like to use from the color palette or from the used colors. You can also Right click 
on the color and from the right click menu select the Set fill color option. The object will be filled 
with the selected color and the color will be added in the used colors area (if it is not already 

there). In addition, the color you have selected can be easily recognized from the Fill bucket  
icon that will have on it when it will be added in the used colors area.  

To change Outline color of an object or the color of a line art design, you have to select it, hold 
the click on the left upper part of the desired color from the color palette or from the used colors. 
Also you can Right click on the color and from the right click menu that will appear select Set pen 
color option. The color you have selected will be added in the currently used colors area (if it is 

not already there) and it will have the Pen  icon on it. The selected object will be colored with 
the new selected color.   

If you want, you can change also the default Fill and Outline (line art design) colors or set the 
colors you want to use only for the specific design. 

To change the Default Fill color you have to hold the Ctrl key pressed and click on the lower right 
corner of the color icon that you want to be the default one. The Set default fill color dialog 
appears with a fill bucket on the color you have selected. The fill bucket shows that you are 
currently adjusting the default fill color. The same dialog can be activated if you Left click on a 
color without having any object from the design selected. From the dialog you can select to make 
this color the default, for Graphic objects and for Text objects. Check the respective options and 
then select the For every new design option that will set this fill color to be the default for all the 
designs you will create from now on. Then click OK button to confirm the changes. You can 
change the default color any time you want, by followings the same steps.  

 
Figure 7.52: Set default Fill color dialog 

To change the Default Outline color you have to hold the Ctrl pressed on the keyboard and Left 
click on the upper left corner of the color you want to be the default one. The Set default pen 
color dialog appears with a Pen icon on the color you have selected. The Pen icon shows that 
you are currently adjusting the default outline color. The same dialog can be activated if you hold 
click on a color without having any object from the design selected. From the dialog you can 
select to make this color the default, for Graphic objects and for Text objects. Check the 
respective options and then select the For every new design option that will set this outline color 
to be the default for all the designs you will create from now on. On this dialog you can also select 
a default pen width, by enabling the option Set default width to and then define a value in the 
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respective field. Then click OK button to confirm the changes. You can change the default color 
any time you want, by followings the same steps.  

 
Figure 7.53: Set default Outline color dialog 

If you do not want an object to have Fill or Outline color you can click on the Empty/None color

 box that it is located in the currently used colors area. To remove the fill you must click on the 

left lower corner and the Fill  will be immediately removed and the none icon will change into . 
To remove the outline you must click on the upper left part of the none icon and the outline will be 

removed immediately. The icon of the None box will change into this .   

Editing default color palette (RGB) 

The default color palette of Creative DRAWings is the RGB (Red, Green, and Blue). This color 
palette consists of 47 colors selected from all available colors as representatives. To this color 
palette you can add new colors, change the existing ones and delete them.  

To Add a new color you have to Right click on the RGB color palette that is listed on the Thread 
palette toolbar and select the respective option. 

 
Figure 7.54: Right click menu 

The Color dialog box will appear from where you can choose the color you want the new color to 
have. There are various ways you can choose a color from the Color dialog. You can choose a 
color by clicking on the respective one from the Basic colors list, or by clicking on the color 
rectangle where all possible colors are listed, or you can type the exact code number of the color 
you want on the Red – Green – Blue / Hue – Sat – Lum fields and produce the color you want. 

 
Figure 7.55: Color dialog 
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After choosing the color, you can set the name of the color in the Color name field or leave the 
suggested name and click Ok button to confirm your selection. The color you have chosen will 
appear at the end of the existing RGB color palette. The newly added color can be used normally.  

To Edit an existing or newly added color you have to right click on the color and select the Edit 
color option from the right click menu. The Color dialog box will appear from where you can 
choose a different color or name for the color that you are editing. There are various ways you can 
change the color from the Color dialog. You can change the color by clicking on a different one 
from the Basic colors list, or by clicking on the color rectangle where all possible colors are listed, 
or you can type the exact code number of the color you want on the Red – Green – Blue / Hue – 
Sat – Lum fields and produce the color you want. If you want you can edit also the Color name by 
typing a new one in the respective field. When you finish you can click the OK button to confirm 
the changes or Cancel button if you want to discard the changes you made. The changes you 
made will be applied on the selected color and it will be ready for use.  

To Delete an existing or newly created color you have to Right click on the color and select the 
respective option from the right click menu. The color will be deleted immediately. 

Important: Be careful when you use the Delete function because you cannot Undo the deletion of 
a color. 

If you want to Reset the RGB palette to its default status you have to right click on any color and 
select the Reset palette option. The color palette will return to its default status and all the 
changes you have made will be lost. 

Important: All the above options are available only for RGB color palette.  

Selections by color 

Thread palette toolbar includes the ability to select objects by color. This option is very useful 
when you want to make a change to all objects that have the same color. You can select them and 
then make the change you want. You can change colors or stitch types to all objects, apply a 
different pattern or apply any other option you want. You can select object by Fill color, by Pen 
(outline) color or simply by color.  

To select the objects by color you have to right click on the color you want from those that are 
listed on the currently used area and from the right click menu select one of the three available 
selection options: Select by Fill, Select by Pen and Select by color.  

 
Figure 7.56: Select by color right click menu 

To select the objects by color you have to right click on the color you want from those that are 
listed on the currently used area and from the right click menu, expand the Select by submenu, 
select one of the three available selection options: Fill color, Pen color and Any color. 

If you select Fill color option, all objects that have the fill color you right clicked on will be 
selected.  

If you select Pen color option, all objects that have the Pen (outline) color you right clicked on will 
be selected.  
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If you select Any color option all objects that have Fill or Pen (outline) color you right clicked on 
will be selected.  

Any change you make on the selected objects, affects all objects.   

Imported vector designs 

When you are importing vector designs inside Creative DRAWings, in the Create mode you can 
view the colors that they are filled with.  The colors appear in the currently used colors area and 
you can change them as you wish. If the vector has many colors (over 20) they will all appear on 
the currently used colors area. As we have already mentioned, the software has a color limit of 99 
colors that can be used on each design. You will understand this better when you will click on 
stitch mode and view that the colors are automatically reduced to 99. These will be the actual 
colors that will be used to fill the embroidery design. In order to view which colors were not used 
and were replaced from other existing ones, you have to open the Edit palette dialog window by 
clicking the respective option of Tool menu. There you will view which colors were replaced with 

which color. In Edit palette dialog you can edit the colors and change their number with 
maximum limit of 20 colors. More about how to edit the color in Edit palette dialog you can read in 
the next section.  

Cross-stitch designs  

The Thread palette toolbar does not have any use on Cross-stitch designs. The colors that are 
used to fill the cross-stitch designs are listed on the Object properties toolbar. In order to make 
them appear you have to change to stitch mode, select the cross-stitch and its options will appear 
on the object properties toolbar, from where you can edit the colors of the design. More 
information on how to handle cross-stitch colors your will find in the respective section of 
Embroidery transformations chapter. 

After creating the design you want to embroider in the Create mode, you can click on the stitch 
mode and view how the final embroidery will look like. To avoid the automatic reduction of colors 
you have to reduce them yourself in the Create mode of Creative DRAWings. You have to count 
the currently used colors from the Thread palette bar and reduce them, by re-assigning colors 
to objects, to the number of Thread colors you want to use with a maximum of 20 colors. If the 
currently used colors are less than 20 then there will be no change on the colors when you will 
click on the stitch mode.   

Edit Palette 

Vector designs may have hundreds of colors, something that cannot happen in embroidery 
designs. There are limited thread colors on the market, which means that not all RGB color 
variations are available. For this reason Creative DRAWings gives you the ability to set the 
number of threads that will be used and its color. The program automatically calculates and 
produces the thread colors that will be used with a limit of 20. The limit exists because most 
embroidery machines have from 1 to 20 needle carriers.  

If your vector design has more than 20 colors when it turns to embroidery design, Creative 
DRAWings automatically reduces the colors to 20. Colors that cover the smallest area on the 
design are combined with other similar ones and replaced with the most representative one. 
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Figure 7.57: Edit palette dialog 

You can change the thread colors from the Edit palette that you can access from menu Tools > 

Edit palette, or the shortcut key Ctrl+L or the standard toolbar by clicking the edit palette  icon. 

Edit palette option displays a dialog box window where you can adjust the number of threads you 
want to use, the color palette and which design color will be correlated with which thread color. 

Threads to use 

 
Figure 7.58: Threads to use track bar 

This function has a track bar which shows the number of threads that will be used for the 
embroidery design. If you click and drag the track bar to the left side, you will reduce the number 
of threads in the design. If you do the opposite you will increase them until the initial point. The 
changes will be automatically calculated and will be previewed in the color reduction area.  

Manual changes on threads number can be made only in the color reduction area. 

 

Track bar 

 

1. Click to increase three scale units.  

2. Drag to move to the point you want.  

3. Click to decrease three scale units. 

 
Also you can change the value of the track bar by pressing the Left & Right arrows 
of the keyboard.  

Palette 



Creative DRAWings Embroidery Software Manual 
 

205 Chapter 7 - Transformations   DRAWstitch Ltd.  
  

 

Figure 7.59: Palette drop down menu 

In the drop down menu the color palettes of the major thread manufacturers are listed as well as 
the default RGB (Red Green Blue) color palette. You can choose one of them to change your 
current palette. Your changes are automatically previewed behind the dialog box for your 
convenience. For example, if you choose Sulky color palette all RGB colors will be assigned to 
their respective ones. All the changes could be viewed in the color reduction area and visualized 
behind the dialog box. Each color palette contains a number of thread colors that the specific 
manufacturer produces. In order to view those, select the manufacturer from the Palette and then 
double click on any colored square in the Thread list of the color reduction area. A dialog box 
window will appear where all colors are listed. You can also view which colors are currently used 
defined by a checkbox next to the color. 

Color reduction area 

 
Figure 7.60: Color reduction area 

The color reduction area contains all the information about the number of threads used, the vector 
design colors, the thread color used and the percentage of area that it covers. It also shows any 
changes that are made in the Palette and in Thread to use functions. In addition, you can make 
manual changes that will have an instant effect. 

If your design has more than 20 colors or you have used the Threads to use function and reduced 
the number of threads in your embroidery design, the Design colors list in the color reduction 
area, will contain more than one color in each thread. This means that colors that cover the 
smallest area on the design are automatically put together with similar ones and replaced with the 
one that represents it from the Thread list. 

Also, you can change the color position manually. Click and drag a colored square in the Design 
colors list, from one thread to another, and view how the thread color changes. Using the same 
procedure you can drag a color in the bottom of the color reduction area, where it says Drag here 
for new color, and add a new thread with the dragged color. 

When you finish setting the color groups you can change the thread color. Double click on a 
colored square in the Thread list of the color reduction area. A dialog box window will appear 
where all thread manufacturers‟ colors are listed.  

There you can choose another color and click OK. The thread color in the area changes. If you 
want to change back to the color you had before, you must double click on the color and, in the 
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dialog box, look for the color with the circle next to it. Select it and click OK to confirm your 
change. 

 

Figure 7.61: Change color dialog 

If you have set a thread manufacturers‟ color palette, in the dialog you will see the names/numbers 
of the respective threads and you can choose exactly the thread you want. You can also navigate 
in the thread list by typing the name/number of the thread. According with the typed 
letters/numbers, the respective thread will be selected from the list. In addition, when you click on 
the list headers (Thread, Color, Used), the contents of the list will be reordered according the 
type on the list. Therefore, if you click on the Color list header, the colors will be listed according 
the color tone.  

Color palettes from thread manufacturers have a fixed number of thread colors. The only palette 
that has infinite colors is the RGB palette. If you try to change any thread color in RGB palette, 
through the way we explained previously, you will see that in the color palette there are only the 
thread colors are used in the design. You can add more colors by clicking on the New color button 
and in the color dialog.  

 
Figure 7.62: Choose color 

Any changes in the Edit palette dialog box are automatically previewed in the embroidery design 
area behind the dialog box. In addition, every time you pass the mouse over a color in the dialog 
box, you can view in the design area which parts of the design this color fills. Click OK to confirm 
your changes. 
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Finally, in the Edit palette dialog, you can Undo any change you have made by clicking on the 

undo icon or click on the Redo icon to cancel the last Undo you have made.  

Change hoop 
The hoop you have selected from the starting dialog can be easily changed from the Change hoop 
option. You can select a different one from the existing hoops or create a new one with custom 
dimension that will fit your needs. It is important to select the correct hoop in order to make sure 
that your design fits in your actual hoop that you will use to embroider it. If you select a larger hoop 
from the one that you will use your needle carrier might hit the hoop you are using with a minimum 
result a broken needle. Therefore you must always select the correct hoop and double check if the 
design fits in the hoop by using the Printout of the design.  

If the hoop you have selected is not visible on the working area you have to enable it by selecting 
the Hoop option from the View menu. If the Hoop option is checked and the hoop is not visible, 
try to Zoom out with any of the available zoom tools or by using the mouse wheel.  

To change the current hoop you have to select the Change hoop option from Tools menu or 
press the Ctrl and H shortcut keys (Ctrl+H) together from the keyboard. The Change hoop dialog 
will appear from where you can select to use a predefined hoop or a custom hoop that you will 
define.  

 
Figure 7.63: Change hoop dialog 

 Select hoop 

From the Select hoop drop-down menu you can select any of the predefined hoops that 
the software includes or any of the custom hoops you have created and added to the 
software. To select the hoop you want to use you have to expand the drop down menu and 
select the hoop you want. You can select either predefined or custom hoops from the list. 
The selected hoop will be previewed on the Preview area of the dialog and will become the 
current hoop. To apply the hoop on the working area you have to press the OK button to 
confirm your selection and close the dialog. If you do not want to insert Hoop in the working 
area, you have to select the None option from the drop down menu. With the None option 
selected no hoop will be added and any existing one will be removed from the working 
area.  
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Figure 7.64: Generic Round hoop - Generic Oval hoop 

Also you can Rotate the hoop you are using by 90o degrees by checking the respective 
option from the dialog. The hoop will be rotated and appear on the working area after 
pressing OK button. The way that you will create the design inside the hoop will be the 
same with the way that will be saved on the embroidery file and embroidered.  

   

Figure 7.65: Rotated hoop – How it will be saved and embroidered 

For example, if you rotate an oblong hoop in order the design to fit inside it, the final saved 
file will have the design rotated instead, in order to fit in the hoop. 

If you want you can also remove custom hoops you have created from the Select hoop 
drop down menu by selecting it and clicking the Remove button. The hoop will be removed 
and it will no longer be available for use. The Predefined hoops cannot be removed. To add 
more customs hoops you have to click on the Add new button in the same dialog.  

After selecting the hoop that you will use you have the option to centralize the design inside 
the hoop by checking the Center design to hoop checkbox. If you do not check this option, 
the hoop will be placed at the middle of the working area and the design you have created 
will remain at the position you have placed it before changing the hoop. 

 Add New Hoop 

By clicking on the Add New button the Add new dialog will appear where you have the 
ability to define a new custom hoop with the dimensions you prefer. The hoop that you will 
create will be saved in the Select hoop drop down menu, allowing you to reuse it as many 
times as you want. The dimensions that you will enter must be the dimensions that the 
manufacturer of the hoop gives for the specific hoop.   
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Figure 7.66: Add hoop dialog 

To create a custom hoop you have to set the dimensions you want to have, the type of the 
hoop, the hoop bracing arms, the curvature of the hoop and then add it to the hoop list by 
pressing the Add button.  

o Hoop Name – Description 

The first option you have is to type the Hoop Name – Description in the respective 
field. The name-description that you will type in this field will be the name that you 
will view in the Select Hoop drop down menu. If you forget to fill this field, you will be 
asked from the software to do so. It is good practice also to add always a description 
of the hoop (Oval, Rounded rectangle etc.) and the dimensions of it in the Hoop 
Name – Description field, in order to be easier for you to decide which one you 
have to use.  

o Type  

From the Type drop down menu you can select the shape of the hoop you want to 
add. The options that you have are Rectangle and Oval. The selected shape is 
previewed in the Preview area allowing you to visualize how the hoop will look like. If 
you select the Rectangle option, the Corner curviness option will become editable 
allowing you to round the corners of the Rectangle hoop shape.  

o Corner curviness 

The Corner curviness becomes editable only if you have selected the Rectangle 
option from the Type drop down menu. Many hoops have the shape of a rectangle 
with rounded corners and for this reason the Corner curviness option exists. The 
Corner curviness consists of a track-bar and a value field. By dragging the track-bar 
to the right, the corners of the rectangle that it is previewed in the Preview area start 
to become rounded and their roundness increases as long as you continue. The 
value field shows the percentage of roundness. The 0 value means that the 
rectangle has normal corners and not rounded and the 90 value means that it has 
rounded corners to their full extend. By moving the track-bar you can create the 
rounded hoop you want.  

o Width 

In the Width value field you can insert the width of the hoop you want to use. The 
default value is 100 mm or the respective value in inches. You can change the value 
of the Width field by deleting the current value and inserting a new one. Any width 
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value change is automatically previewed in the Preview area. Check the 
manufacturer‟s dimensions, to be sure that you are entering the correct ones. The 
Width value sets the width of the sewing area that it is shown with a dashed line 
inside the hoop. 

o Height 

In the Height value field you can insert the height of the hoop you want to use. The 
default value is 100 mm or the respective value in inches. You can change the value 
of the Height field by deleting the current value and inserting a new one. Any Height 
value change is automatically previewed in the Preview area. Check the 
manufacturer‟s dimensions, to be sure that you are entering the correct ones. The 
Height value sets the height of the sewing area that it is shown with a dashed line 
inside the hoop. 

o Unit 

From the Unit drop down menu you can select the measure unit you want to use. 
The options that you have are millimeters (mm) and inches (inch). The selected Unit 
is automatically applied on the Width and Height values.  

o Hoop Bracing arms 

At the Hoop bracing arms area you can set where the bracing arms are located on 
the hoop you are adding. To do that you have to check the checkboxes (Left, Right, 
Up, Down), where the bracing arms are located. For example, if the Hoop has one 
bracing arm at the Right and one at the Left, the Right and Left checkboxes must be 
checked. The preview of selected bracing arms is shown on the Preview area 
helping you to decide the correct ones.  

After adjusting the options you can save the hoop by pressing the Add button that will add 
the hoop to the Select hoop drop down menu. After pressing the Add button a 
confirmations dialog will appear that will inform you that your hoop was saved successfully. 
Click OK to continue. To use the hoop you have created you have to expand the Select 
hoop drop down menu and press the OK button to apply it. The hoop you have created will 
become visible on the working area exactly as you designed it. The next time that your will 
open the Change hoop dialog you will find the hoop you have created selected in the  
dropdown menu with the name you gave to it. Also, it will become accessible from the hoop 
selection drop down menu of the starting dialog.  

 Edit hoop  

With the Edit button you can edit the custom hoops that you are inserting. The Edit hoop 
button is by default disabled and becomes enabled only if you select a custom hoop that 
you have added on the Select hoop drop down menu. If the hoop you want to edit is 
currently used you will not be able to edit it. You have to select a different hoop, apply it on 
the working area by clicking OK button on the Change hoop dialog and then open once 
more the Change hoop dialog to Edit the hoop you wanted.  
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Figure 7.67: Edit hoop dialog 

To edit a custom hoop you have to select it on the Select hoop drop down menu and then click 
the Edit button. The Edit hoop dialog will appear with the attributes of your hoop listed. You can 
edit the options of the hoop and save it by pressing the Apply button. A dialog will appear that 
confirms the changes you made and then you return back to Edit hoop dialog. You can continue 
editing the custom hoop or press the close dialog to end editing process.  

The options you can change in the Edit hoop dialog are the following: 

o Hoop Name – Description 

The first option you can edit the Hoop Name – Description option. You can change 
the name-description that the hoop will have by editing the respective field. The 
edited name will be added in the Select Hoop drop down menu. Do not forget to add 
a description of the hoop (Oval, Rounded rectangle etc.) and the dimensions of it in 
the Hoop Name – Description field, in order to be easier for you to decide which 
one you have to use.  

o Type  

From the Type drop down menu you can change the shape of the hoop you have 
added. The options that you have are Rectangle and Oval. The selected shape is 
previewed in the Preview area allowing you to visualize how the hoop will look like. If 
you select the Rectangle option, the Corner curviness option will become editable 
allowing you to round the corners of the Rectangle hoop shape.  

o Corner curviness 

The Corner curviness becomes editable only if you have selected the Rectangle 
option from the Type drop down menu. Many hoops have the shape of a rectangle 
with rounded corners and for this reason the Corner curviness option exists. The 
Corner curviness consists of a track-bar and a value field. By dragging the track-bar 
to the right, the corners of the rectangle that it is previewed in the Preview area start 
to become rounded and their roundness increases as long as you continue. The 
value field shows the percentage of roundness. The 0 value means that the 
rectangle has normal corners and not rounded and the 90 value means that it has 
rounded corners to their full extend. By moving the track-bar you can change the 
roundness of the hoop.  

o Width 
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In the Width value field you can change the width of the hoop. You can change the 
value of the Width field by deleting the current value and inserting a new one. Any 
width value change is automatically previewed in the Preview area. Check the 
manufacturer‟s dimensions, to be sure that you are entering the correct ones. The 
Width value sets the width of the sewing area that it is shown with a dashed line 
inside the hoop.  

o Height 

In the Height value field you can change the height of the hoop you want to use. You 
can change the value of the Height field by deleting the current value and inserting a 
new one. Any Height value change is automatically previewed in the Preview area. 
Check the manufacturer‟s dimensions, to be sure that you are entering the correct 
ones. The Height value sets the height of the sewing area that it is shown with a 
dashed line inside the hoop. 

o Unit 

From the Unit drop down menu you can change the measure unit you want to use. 
The options that you have are millimeters (mm) and inches (inch). The selected Unit 
is automatically applied on the Width and Height values.  

 Preview  

In the Preview area you can view the hoop you have selected from the Exiting hoops and 
the custom hoops you are creating. The preview helps you visualize the available hoop and 
decide which one you want to use. 
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Chapter 8 - Node editor  

Introduction 

In this chapter we will analyze all the node editing abilities that Create mode of Creative 

DRAWings has. You will learn how to select, move, add, delete and split the nodes of a vector 

design. In addition, you will learn all the terminology that will help you to understand node editing 

better and how to use the functions of the node editor‟s right click menu. 

All the options that are described in this chapter are only available inside Create mode.  

What is a node 

There are two kinds of nodes. The Smooth nodes which are indicated with  icon and the Cusp 

nodes which are shown with the  icon. During designing the nodes that you are adding can be 

Smooth nodes or Cusp nodes according the tool you are using and the design you are creating. 

You can easily convert a Smooth node, to a Cusp node by selecting the respective option from 

the right click menu in node editing mode. Even if you did not create the design you wanted with 

your first try, you can adjust the shape you created later by changing the position of the nodes and 

their segments.  

 

 

A node is the point indicated with the arrow in the drawing at the 

left. 

 

A curve can be controlled by the control handles, which are 

indicated with the arrows in the drawing at the left. 

 

The nodes are connected between them with a line that is called segment. Moving an object‟s 
segments lets you make coarse adjustments to the object‟s shape; while changing the position of 
its nodes lets you fine-tune the shape of the object. 

Cusp nodes 

Segment: The line between two nodes is called a segment. 

 

Node: The starting or connection point of a line or a curve segment. Any movement of a 
node affects the shape of the line or the curve segment. 
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Cusp nodes are called these that are shown with this icon  or with this  icon  (when the 
node is selected). Usually cusp nodes are added to the design automatically at the corners of the 
design or when the curvature is changing. With cusp nodes you can change one segment of the 
node without affecting the other. This is useful when you want to make precise adjustments on 
one part of the design without affecting another. 

Smooth nodes   

Smooth nodes are those that are shown with the  icon or with the  icon (when the node  is 
selected). Usually smooth nodes are added to the design automatically at the middle of a curve or 
on the higher point of a curve. With smooth nodes you can adjust both segments of a node by 
moving the position of the control handle and changing its length. Smooth nodes are preferred on 
designs that will be converted to stitches.  

Curve objects 

We can call a Curve object, any shape that we can draw inside Creative DRAWings. A curve 
object consists of segments and nodes that construct the shape of the each object. Most shape 
objects that are inserted (rectangles, ellipses etc.) together with the Text objects, are not curve 
object because they have special abilities when you are edit them in Edit shape nodes mode. On 
the other hand freehand lines, Bezier lines and outline lines are curve objects and their 
nodes/segments can be edited directly in Edit shape nodes mode.  

To make an object a curve object you have to select it, right click on it and from the right click 
menu select the Convert to curves option or press the Ctrl and Q shortcut keys (Ctrl+Q) together 
from the keyboard. The object will be converted to a curve object that you can edit its nodes and 
segments in Edit shape nodes mode. Every time you convert an object to curve you must know 
that you cannot convert it back to a standard object. The only way to do that is to Undo your last 
actions, if you have converted it to curves recently.  

Edit shape nodes 

Every shape that you are creating is consisted of a number of nodes and segments/lines. You can 
edit the nodes and the segments/lines to change the shape of the design you have created in 
node editing mode. The nodes of the object will become visible only if it is a curve object. To 

change to node editing mode, first you have to click on the Edit shape nodes icon  that you 
will find on the vertical toolbar (Tools toolbar) of Create mode or pressing the F10 shortcut key 
from the keyboard, which will change the mode to node editing. The outlines of the selected 
objects are highlighted and you can see all existing nodes. In node editing mode you can change 
the shape of the selected object by using the mouse and by using the available options of right 
click menu.  

Select Node(s) 

If you want to select a node, click on the node and it will become bigger and change color 
indicating that it is selected. In order to select more than one node, click and drag the mouse on 
the screen forming a rectangle or select the lasso tool and make a lasso selection. All the nodes 
contained within this rectangle will be selected.  

By holding the Ctrl key down while you selecting nodes you can reverse the current status of the 
nodes. If they were selected they will become deselected and the opposite. The same functionality 
applies either on separate node selections or on rectangle selections.   
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By holding the Shift key down you can add more nodes on the current selection or make a new 
multiple selection. You can either add nodes to the current selection by clicking on the nodes you 
want to add or by making rectangle selections.  

If you have selected more than one node you can move or delete them but you cannot change 
the tangents that are controlling them. To edit the tangents of the nodes you have to select a 
single node and adjust its tangents.   

In addition, you can use the Select All or Select polyline options of the right click menu that 
we will describe later on. 

Move node(s) 

To move specific nodes of the design you have to select them first by using any of the available 
methods (Lasso selection, Rectangle selection or single click selection). Then you have to click on 
any node that is included in the selection and drag the mouse to the point you want. The nodes 
will be moved to position you want them to be. If you want to move a single node you have to click 
and drag it to its new position with your mouse. 

 
Figure 8.1: Move multi nodes 

By moving the selected nodes all the segments that are attached to them are also changing.   

If you hold the Ctrl key pressed while moving a node, guidelines will appear on every 22.5 
degrees of the X and Y axes. While moving the node it will snap on the guidelines, allowing you to 
make accurate movements along the guidelines. The guidelines that appear have as center the 
initial position of the node.  

If you hold the Alt key pressed while moving a node, vertical and horizontal guidelines will appear 
on X and Y axes that will snap on the lineation of the Ruler when the Grid is enabled. While 
moving the node it will snap on the guidelines, allowing you to make accurate movements along 
the guidelines. When you press the Alt key the node automatically moves/snaps on the closest 
vertical and horizontal lineation of the ruler. From that point you can move the node to the position 
you want based on the ruler. The Alt key will work even if the ruler is disabled.   

Using control handles of a node 

If you want to change a curve you can move, insert or delete one or more nodes. You can also 
edit a curve using the control handles of a node. The control handles of a node appear whenever 
you select a node. You can change the position of the control handle by click and dragging the 
control point (the arrow at the end of the control handle) to the position you want. The curve from 
the side of the control handle you are moving will change accordingly. By changing the direction 
and the length of the control handle, you can make precise coarse adjustments on the curve. For 
example: 

Multi selection  
of Nodes 

 

Move nodes 
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Normal Curve 

 

By changing the length of the control handle. 

 

By changing the direction of the control handle. 

Also the control handles of a curve can be changed by clicking on this curve and drag it on 
another point, as you can see in the following draw. 

 

 
The arrow shows the movement of the temporary node. The blue line 
shows the curve prior to the movement and the green line indicates its 
shape after the changes. 

Add a node 

While shaping objects in node editing mode you will need to insert an additional node inside a 
curve that will help you re-shape it easier. To insert a new node, right click on the point where you 
wish to insert it. The right click menu will appear with all the available option. If this is not the exact 
point that you wanted to insert it, you can click on another point of the curve. By selecting the Add 
node option from the right click menu a new node will be inserted in the position you wanted. 
Another way to add a node is by double clicking on the position you want the node to be added 
or position the mouse over the point you want the node to be added and press the Num + button 
form the keyboard to insert it. The new inserted node can be edited as any existing node. The new 
node that is inserted is always a smooth node. If you want to insert a cusp node you have to insert 
a Smooth node first and by right clicking on the node select the Cusp node option. 
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You can also add automatically a node between two nodes by selecting the node and pressing the 
Num + key from the keyboard. A node will be added at the middle of the curve segment before the 
selected node.  

  
Figure 8.2: Num + adds a node at the middle of previous segment 

You can also add automatic nodes to more than one selected nodes. To do that you have to select 
the nodes that are after the segment you want the automatic node to be added and press the 
Num+ key from the keyboard. To all curve segments before the selected nodes, automatic nodes 
will be added.   

Delete a node 

If you don't need a node you can delete it. First select the node(s) that you want to delete and then 
click the Delete key on your keyboard. You can also right click on the node you want to remove 
and select the Delete node option from the right click menu. 

Note: If you delete one or more nodes of a curve, the shape of the object it might change.  

To line 

If you have a curve and you want two nodes to be connected with a straight line, you can use the 

option To line from the right click menu. First you have to select the node, from which the 
line will start. Right click on the node and from the popup menu select the To line option. You 
can apply also the same option to more than one selected nodes.  

  
Figure 8.3: Apply To line option  

This option changes the type of the selected node(s) and the next node(s) to cusp nodes.  

You can also apply the To line option directly on the curve you want to convert. Right click on the 
curve you want and from the right click menu select the To line option. The curve will be 
automatically converted to a straight line.  

To curve 

The To curve option is the opposite of the To line option. Therefore if the shape has two or more 
nodes connected with straight lines and you want to convert them to curve lines you have to use 
the To curve option from the right click menu. There are two ways to apply the To curve option. 
The first is to select the node that is before the line you want to convert to curve, right click on it 
and from the right click menu select the To curve option. The line next to the node will become a 
curve allowing you to change its shape. You can apply also the To curve option to multiple nodes, 
by following the same steps.  

Before To line 
 

After To line 
 

Added node 
with Num + 

Selected node 

menu-node-editor.htm
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The second way that you can apply the To curve option on a line is by right clicking directly on the 
line and from the right click menu that will appear select the respective option. The line will 
become a curve and allowing you to re-shape it.   

If you have applied the To curve option to multiple cusp nodes , the will automatically converted 

to smooth nodes .  

Select all and Select Polyline 

With the Select all option you can select all nodes of an object and with the Select Polyline 
option you can select all nodes of a specific curve (or line or closed shape) of a complex object 
(combined objects).  

          
Figure 8.4:  Nodes of Shape           Select all nodes       Select polyline  

If you want to use Select all nodes of the object, first you have to select the object, change to Edit 
shape nodes mode from the Tools toolbar and select a node of a curve by clicking on it. Right 
click on the selected node and from the node editing menu select the Select all option. This option 
selects all nodes of the current object. You can use the same option through the Edit menu.  

On the other hand, if you want to select all nodes of a single curve (or line or closed shape) that it 
is part of a complex object (combined objects) you have to select a node of the curve and then 
from the right click menu select the Select Polyline option. All nodes of the specific curve (or line 
or closed shape) with selected nodes will then be selected. 

Close outline 

With this option you can connect two nodes with a line or by making them one node. You can 
close an outline that belongs to the same curve object such as line art designs or shapes with 
open outlines.  

In order to close an open outline or make a line art design a closed shape you have to select the 
ending node of the object and right click on it. From the right click menu select the Close outline 
option and Creative DRAWings will connect the selected node with the starting node of the object 
with a line and make it closed shape. Then the object can be handled as a closed shape. 

Another way to create a closed shape is to select the ending/starting node of an open shape or 
line art design and move it towards to the starting/ending node. When the ending node will reach 
the starting node they will be automatically connected and make the object a closed shape.  

Join nodes 

If you want to connect the nodes of two different curves and make them a single curve you have to 
follow a different procedure.  

Polyline 
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Note: These nodes should be the first or the last node of each curve, but not necessarily the same 
type of node (curve or curve break). These nodes should be near each other and the two 
curves should be in the same section. 

   
Figure 8.5:        Join nodes  Select ending nodes and apply Join nodes  Nodes are joined  

Click on the rectangle selection tool from the Tools toolbar in order to change to Object editing 
mode and then select the two curves you want to connect. Right click on the selected curve 
objects and from the right click menu select Combine option. The two curves will become one 
object with two sub sections (the two curves). Click on the Edit shape nodes to change to Node 
editing mode. Select the ending nodes of the two curves and right click on them. From the right 
click menu select the Join nodes option. The two nodes and curves will become one. The two 
objects will become one but not a close object. In order to make it a closed object you can try any 
of the two methods we described in the Close outline section above.  

Split outline 

With this option of right click menu you can split the selected node or the current curve in two 
sections. If this function is applied on a closed shape it will become an open shape without fill 
color. If this function is applied on an open shape like a line art object it will be split in two line art 
objects.  

     

Figure 8.6  Split outline        Select node and apply split outline       Nodes are split  

In order to split a node, you have to right click on the selected node and click on Split outline 
option. The selected node will become two nodes that belong to the same object but in two 
different sections, if the object was a closed shape, or in two open objects if the shape was a line 
art object. 

In case that you have applied the Split outline option on a segment of a shape, the shape will be 
split and two separate nodes will be added. The split nodes that will be created can be joined 
again by moving the one node over the other. The two nodes will be automatically become one. 
For the same purpose you can also select both nodes and then from right click menu select Join 
nodes. 

Auto remove overlap  

 
Figure 8.7 Auto remove overlap checkbox 

The Auto remove overlap option appear on the Tools options toolbar inside Edit shape nodes 
mode, from where you can activate it. This option allows you to convert crossing curves inside an 

Ending nodes 

Select them 
and 

Join nodes 

Nodes are 
joined 

Nodes are 
joined 
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object (object that looks like the 8 shape) to separate ones that can be handled as subsections of 
the same object.  

   

Figure 8.8 Before removing overlaps – After removing overlaps – Break apart the object  

These objects can be created by editing the nodes of a shape in Edit shape nodes mode , and 
then automatically remove overlaps by simply checking the Auto remove overlap checkbox. 
Once you check the Auto remove overlap button it remains checked. Therefore if you want to 
continue editing nodes without applying the option you have to uncheck the checkbox by clicking 
on it.  
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Chapter 9 - Embroidery transformations   

Introduction 

In this chapter we will describe all the stitch transformations that Creative DRAWings can 
perform. You will learn about Object Properties toolbar functionality, how you can adjust Design 
properties, how to change Fabric and how to add Divides and Directions.  

Object properties toolbar contains all the stitch types that can be applied in the embroidery design. 
Stitch types like Satin, Step, Row Fill, Appliqué, Photo stitch, Running and Satin Serial are 
available for creating unique embroidery designs. Also, includes all the advanced stitch 
parameters that you can adjust according the needs of the embroidery design.  

In addition, you can select the fabric and its color that you want to embroider your design on, from 
a large variety of fabrics and colors. This gives you a better visualization of how your embroidered 
design will look on your garment.   

Finally, you can adjust the properties of your design by making optimization changes and adding 
useful comments. 

Stitch types – Embroidery types 
The stitch types that Creative DRAWings includes are Satin, Step, Row Fill, Running, Satin 
Serial, Photo-stitch, Cross-stitch, Appliqué and Netfil. Satin, Step and Row Fill stitch types are 
used from the software to fill vector shapes with stitches. Appliqué and Net fill embroidery types 
are special types of embroidery that are used from the software to fill vector shapes with Appliqué 
and create Nets with stitches. Running and Satin serial stitch types are used to fill vector outlines 
and line art designs. Cross-stitch and Photo-stitch are used mainly to fill bitmap images. The same 
stitch types are used with the same or different names from the embroiderers around the world. To 
understand to which stitch types we refer with the names Satin, Step etc. we will analyze them for 
you.  

Satin stitch type 

When the Satin stitch type is applied on any object, stitches are connecting two points from one 
side of the object to the other. These points are formed like closely arranged zigzag stitches along 
the shape of the object. Satin stitch type can be laid down at any angle and with varying stitch 
lengths. In Creative DRAWings small and oblong objects will be filled with Satin stitches.  

 
     Figure 9.1  Vector object                        Satin fill 

Running stitch type 

Running stitch type consists of one stitch between two points. It is used mainly for outlining, fine 
detail and complete designs. Also known as a walk stitch. In Creative DRAWings all line art 
designs and thin object outlines will be filled with Running stitches. 
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      Figure 9.2:             Thin outline object                Running fill 

Satin Serial stitch type 

Satin serial stitch type is applied on thick outline objects by forming closely placed zigzag stitches 
along it. It is generally used to fill borders and line art designs. In Creative DRAWings all thick line 
art designs and object outline will be filled with Satin Serial stitch type.   

 

   Figure 9.3:  Thick outline object              Satin serial fill 

Step stitch type 

Step stitch type (or Fill stitch type or Tatami stitch type) is a series of Running stitches commonly 
used to fill large areas. Different fill patterns can be created by altering the angle, length and 
repeat sequence of the stitches. In Creative DRAWings the large objects in the vector design 
most of the times are filled with step stitches.   

 

    Figure 9.4: Vector object            Step fill 

Row Fill  stitch type 

Row Fill stitch type is a fill stitch similar with step stitch type. It is longitudinal stitches from one 
side to the other that are vertical to the defined direction that it is automatically defined from the 
software. Row Fill stitch it is commonly used to fountain like shapes. In Creative DRAWings you 
have to select it in order to apply it on the shape you want.  

 

    Figure 9.5:                           Vector object            Row Fill fill 

Appliqué  
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Appliqué is an embroidery type that allows you to create Appliqué on fabric easily. It is a fill 
embroidery type therefore you have to draw a shape similar with the appliqué fabric you want to 
apply on the garment and fill it with a color. Then you can apply the appliqué embroidery type that 
will apply the needed sequence of actions in order the design to be embroidered properly. 
Appliqué embroidery type is a complex type that includes “Running stitches before” to mark the 
appliqué position, “Running stitches after” to hold the appliqué in place and the E-stitches or Zig-
Zag to decorate and hold the appliqué. 

  
    Figure 9.6:        Vector object                   Appliqué embroidery type  

Cross-stitch embroidery type: 

Each cross-stitch stitch consists of two running stitches that are crossed in between creating an 
„X‟. Cross-stitches of different colors are shaping the image by creating a grid. In Creative 
DRAWings every imported bitmap image can be filled with the Cross-stitch embroidery effect 
look.  

          
       Figure 9.7:                        Bitmap image                                          Cross-stitch fill 

Photo-stitch embroidery type 

Photo-stitch is an embroidery type that automatically recognizes the graduation of colors of any 
backdrop image and sets fill stitches on it. The fill stitches are satin bars that cover the backdrop 
image area. 
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                Actual Photo          Filled with Photo-stitch 

Net fill embroidery type 

The Net fill embroidery type is a special fill type that adds two scan lines that are crossing with 
parallel equidistant running stitches. These two scan lines are forming a Net that can be used to 
create Laces and fill areas. It is a very useful embroidery type. 

   
Figure 9.8:             Vector object                             Net Fill embroidery type 

Select fabric 

Fabric selection is not just an issue of previewing the design on the fabric. Creative DRAWings 
automatically adjusts, according to the selected fabric, various embroidery parameters. 
Embroidery quality depends on some of these parameters. Import quality factor is also how the 
fabric is stabilized in the frame of the embroider machine. Creative DRAWings suggests the 
appropriate backing materials for every fabric, in the printout of each design. In case that you don‟t 
want to preview the design on any fabric you can selecy the none option that exists in any of the 
fabric categories. In this case only the color that is select in fabric dialog will appear in the 
background of the created design.  

The fabrics in Creative DRAWings are categorized in groups of embroidery types with different 
preset parameters: 

Embroidery smooth, starting with Density 55 for normal thread No 40,  with lighter underlay 

Embroidery normal, starting with Density 40 for normal thread No 40 

Embroidery normal light, starting with Density 40 for normal thread No 40, with lighter underlay 

Embroidery light, starting with Density 55 for thick thread No 30.  

Embroidery Ultra light, starting with Density 85 for thick thread such as wool  

Embroidery Heavy, starting with Density 35 for thin thread such as metallic.  

Photo-stitch 
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All the designs can be previewed on different fabrics. There are various colors and types of 
fabrics. When you decide to save your design, in order to embroider it on a garment, you must be 
sure that the fabric you have chosen in Creative DRAWings is the same with the one that will be 
embroidered. Otherwise the results may not be the expected. There are 50 fabric types in any 
color spread to different categories, from which you can select the appropriate one. 

  

Figure 9.9: Select Fabric dialog box 

This option can be accessed from menu Tools > Select fabric, from the shortcut key Ctrl+F or from 

the standard toolbar by clicking the select fabric  icon. Select fabric option prompts you to a 
dialog box window where you can choose the fabric type and color by clicking on them. Your 
selection is automatically previewed in the dialog box and behind it for your convenience. The 
fabrics are under the six categories that are available In order to view it, click on the + button at the 
left side of each category to be expanded. 

The six fabric categories that are available are Embroidery smooth, Embroidery Ultra Light, 
Embroidery Light, Embroidery Normal Light, Embroidery Normal and Embroidery Heavy.  

 Embroidery smooth: In this category you can choose between any of the fabrics that are 

listed. The embroidery that will be placed on these fabrics will be light and smooth. That is 

why the embroidery on the 3D preview will appear with low density. All the fabrics have 

specific internal embroidering parameters that needed for high quality embroidering. The 

embroidering parameters are adjusted to each fabric in order the embroidery that will be 

placed on to have smooth feel and keep the fabric soft.  

 Embroidery Ultra Light: In this category you can choose between “Bridal Tulle”, “Waffle 

knit”, “Wool” and “Standard Ultra Light”. The embroidery that will be placed on these fabrics 

will be Ultra light. That is why the embroidery on the 3D preview will appear with low 

density. The first three fabrics have specific internal embroidering parameters that needed 

for high quality embroidering. The “Standard Ultra Light” fabric is not a specific fabric but 

can be used as an alternative for embroidering Ultra light on any fabric you want. The 

embroidery results of the “Standard Ultra light” settings will depend on the fabric.  

mk:@MSITStore:C:/Sources/DRAWINGS/DraWings/hlp/DRAWings.chm::/Toolbars/Toolbar_Select_Fabric.htm
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 Embroidery Light: In this category you can choose a fabric between “Lycra lame”, “Sweat 

shirt knit”, “T-shirt knit2”, “Vinyl2”, “Wool Crepe” and “Standard Light”. The embroidery that 

will be placed on these fabrics will be Light. That is why the embroidery on the 3D preview 

will appear with low density. Each of these fabrics has specific settings in order to produce 

the best possible results if you embroider the design on the respective fabric. Be sure you 

have chosen the correct fabric from the fabric list. If you want to embroider a design with 

light settings in a fabric that is not included in the list, choose the “Standard Light” fabric that 

contains those settings. The embroidery results depend on the fabric that is used.  

 Embroidery Normal Light: In this category you can choose a fabric between “Crepe 

Polyester”, “Denim1”, “Light weight bridal satin”, “Linen1”, “Panne velvet”, “Rayon”, “Rayon 

Sand washed”, “Sweater knit”, “T-shirt knit1”, “Towling”, “Vinyl1” and “Standard Normal 

Light”. The embroidery that will be placed on these fabrics will be Normal with a tension to 

Light. That is why the embroidery on the 3D preview will appear with normal density. Each 

of these fabrics has specific settings in order to produce the best possible results if you 

embroider the design on the respective fabric. Be sure you have chosen the correct fabric 

from the fabric list. If you want to embroider a design with Normal Light settings in a fabric 

that is not included in the list, choose the “Standard Normal Light” fabric that contains those 

settings. The embroidery result depend on the fabric that is used. 

 Embroidery Normal: In this category you can choose a fabric between “Berber fleece”, 

“Chiffon scarf”, “Cordoury”, “Cotton”, “Craft Fleece”, “Denim2”, “Denim3”, “Faille1”, 

“Flannel”, “Fleece”, “Heavy weight Bridal satin”, “Knit flannel1”, “knit flannel2”, “Linen3”, 

“MicroFiber”, “Nylon flag”, “Quilted cotton”, “T-shirt knit3” and “Standard Normal”. The 

embroidery that will be placed on these fabrics will be Normal. That is why the embroidery 

on the 3D preview will appear with normal density. Each of these fabrics has specific 

settings in order to produce the best possible results, if you embroider the design on the 

respective fabric. Be sure you have chosen the correct fabric from the fabric list. If you want 

to embroider a design with Normal settings in a fabric that is not included in the list, choose 

the “Standard Normal” fabric that contains those settings. The embroidery result depends 

on the fabric that is used. 

 Embroidery Heavy: In this category you can choose a fabric between “Burlap”, “Chenille”, 

“Cross-stitch cloth”, “Faille2”, “Fake fur”, “Linen2”, “Lycra bathing suit”, “Lycra workout 

clothes” and “Standard heavy”. The embroidery that will be placed on these fabrics will be 

Heavy. That is why the embroidery on the 3D preview will appear with high density. Each of 

these fabrics has specific settings in order to produce the best possible results, if you 

embroider the design on the respective fabric. Be sure that you have chosen the correct 

fabric from the fabric list. If you want to embroider a design with Heavy settings in a fabric 

that is not included in the list, choose the “Standard Heavy” fabric that contains those 

settings but the embroidery result depend on the fabric that is used. 

You can change the color of the fabric by clicking on one from the list or by double clicking on a 
color from the list and select one from the color table. By clicking the OK button the selected color 
will replace the one that you double clicked on and will be previewed on the working area. If you 
want, you can continue changing colors until you find the one that will matches the fabric color you 
want to embroider your design on. 
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Object properties     
Object properties tool pane contains every embroidery design function of the program. It has two 

tabs Fill  and Outline . If Object properties is not visible you can open it from the View 
menu or with the shortcut key Alt + Enter. You can view the Object properties tool pane both in 
Create or Stitch modes. With the options that are included you can change the stitch type of the 
design easily by just clicking on it. 

Fill 

This tab contains every function that can be applied to the fill of a design. The functions are not 
visible until you select an object from a design or the whole design. When a vector design is 
embroidered for the first time, Creative DRAWings automatically puts fill stitches on it. That is 
why the Auto checkbox, at the top of the fill tab, is checked. When a change in the fill tab is made, 
the Auto becomes unchecked. You can check it again and restore the automatic created design 
from Creative DRAWings. This is very useful when you have made many changes to a design 
and you want to cancel all the changes you made by using the tool of Object properties toolbar 
and start again from the beginning. 

 

Figure 9.10: Fill stitch type options 

For designs that have only outlines or they are line art designs, the Fill option is not available. In 
the fill tab there are eight stitch type fills: None, Satin, Step, Row Fill, Appliqué, Cross-stitch, Netfil 
and  Photo-stitch.  

None  

When this option is applied, sets the fill area to be empty. All the fill stitches are removed from the 
design and only the border remains, if one exists. Whenever you don‟t want to embroider a 
specific fill area you can set its‟ fill to None and have the stitches instantly removed.  

Satin  

This option, when applied, sets the fill area to be Satin. All the fill stitches will change to Satin, 
which is automatically calculated and produced in the program. You can change the feel of Satin 
by changing its Style and Pattern. There are many different styles and patterns that you can apply 
on any stitch design. Also, you have the ability to change Underlay, stitch Density and 
Compensation. 

Styles 

The Styles area contains all the stitch styles that can be applied on the design. Style in Creative 
DRAWings is a way of movement from one point to another, which normally can be done by one 
stitch. Some styles when applied may not look good on the design. This happens because styles 
cannot fit correctly in all possible shapes. 
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Figure 9.11 Satin Styles 

Select the style you prefer by clicking on it and viewing it in your design. The none selection will 
restore the default satin type. Your selections are instantly displayed in the design area letting you 
experiment with your design. There are 325 styles that you can use to produce unique designs. 

The styles that are in film icon (for example: ) are a series of different styles in one.  

Patterns 

The patterns area contains all the patterns that can be applied on the design. Patterns are shapes, 
created from stitches. You can make combinations between Styles and Patterns and produce your 
own designs. Some combinations when applied may not look good on the design. This happens 
because combinations do not always produce correct stitch results.  

 

Figure 9.12: Satin Patterns 

Select the pattern you prefer by clicking on it and viewing it in your design. The none selection will 
restore the default satin type. Your selections are instantly displayed in the design area letting you 
experiment with your design. There are 262 different patterns to apply to your design. If you want 
to view only the pattern you have selected and not a combination of styles, you must be sure that 
styles option is set to none. Otherwise you will view a pattern with a style in it.  

There are also two more options that are very useful in customizing the way that the software will 
be embroidered. Those are the Remove overlaps option and the Sequence option.  

Remove overlaps:  
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This is an automatic filter which removes all overlaps between the objects of the vector designs. 
This filter uses artificial Intelligence and it is applied only where necessary. The application of the 
filter results in the reduction of stitches that will be placed on the fabric. It is also possible to 
manually alter the overlapping status of each object. There are three possible options that you can 
apply on a specific object, Auto, Never and Always. The Auto is the default option and the one 
that Creative DRAWings uses to create the best possible results on the design. When the Never 
option is applied on an object, the specific object will never trim the objects that overlaps. This 
means that all the objects/shapes that are under the selected objects will be embroidered 
normally, placing all their stitches on the fabric. The opposite option is Always. When it is applied 
to a specific object it trims all the objects that it overlaps. This means that all the parts of 
objects/shapes that are under the selected object will not be embroidered.  

Creative DRAWings uses this tool to embroider your design more efficiently and effectively. But 
in order for this function to work well, avoid applying trim tool in the Create mode of Creative 
DRAWings. You must always use it with care or after the setting Remove overlaps option to 
Never.   

Sequence:  

 

With this tool it is possible to change the embroidering sequence of the design. Specific objects of 
the design can be set to be embroidered at the start or at the end of the embroidering process. 
This gives you the ability to embroider the designs in the order you prefer. More specifically, the 
Sequence drop down menu has three options Auto, To start and To end. The Auto is the default 
option and the one that Creative DRAWings uses to create the best possible embroidering 
sequence results. In order to change the embroidering sequence manually, use the other two 
options. The To start option sets the selected object to be embroidered first. This means that if it 
was to be embroidered fifth in the embroidering sequence, now will be embroidered first in the 
row. Exactly the opposite for the To end option. When this is applied on an object of the 
embroidery design, it will be immediately become the last object that will be embroidered. By using 
the To start and To end options, you can change the embroidering sequence and embroider the 
design you have created the way you prefer. This tool is really useful for embroidering hats and on 
delicate fabrics that need special care regarding the placement of objects on the fabric. 

If you have set more than one object to be embroidered To start and more than one To end, 
Creative DRAWings will decide automatically which one of those will be the first and which one 
will be last to be embroidered.  

Satin stitch type options 

Also, there are three more options that can help you adjust the embroidery parameters of the 
design. As we have already mentioned in the Select fabric section previously in this chapter, each 
fabric has different presets that affect the way the embroidery design will be placed on it and some 
of them are visible at the bottom of the Object properties toolbar. For Satin stitch type they are 
Underlay, Density and Compensation. These options can help you make useful adjustments on 
the design and produce the embroidery results you prefer.  

Underlay:  
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At the Underlay option it is shown the Underlay that it was automatically chosen from the software 
for the specific object. The underlay stitches are placed on the fabric in order to create the base for 
the cover stitches that will follow. The Underlay is important for the quality of the embroidery 
designs. 

For Satin stitch type, the following underlay patterns are available: 

 

Tacking – If tacking is selected, there will be no underlay and the software 
will make running stitches in order to go from one position to another and 
cover the area with cover stitches. 

 

Single - If single is selected, Creative DRAWings will make a single line with 
running stitches near the middle of the shape of the object and then cover this 
with cover stitches. 

 

Double - If double is selected, Creative DRAWings will make running 
stitches following the shape of the object and position Double underlay near 
the edge of the outline. 

 

ZigZag - If zigzag is selected, Creative DRAWings will create a sophisticated 
ZigZag pattern which automatically changes directions (according to the 
direction of the cover stitches) and then fill the shape with cover stitches. 

 

Cross - If cross is selected, Creative DRAWings will create a thicker 
sophisticated ZigZag pattern which automatically changes directions 
(according to the direction of the cover stitches) and then fill the shape with 
cover stitches. 

 

ZigZag+ - Is a combination of Zig-Zag and Double underlay. 

 

Cross+ - Is a combination of Cross and Double underlay 

 

Netting - If netting is selected, Creative DRAWings will cover the area of the 
object with a thicker sophisticated ZigZag pattern, which automatically 
changes directions (according to the direction of the cover stitches) two times 
and then fills the shape with cover stitches.  

 

Netting+ - Is a combination of Netting and Double underlay. 

Density:   

 

At the Density option it is shown the density that it was automatically chosen from the software for 
the specific object. The density changes according the fabric you have selected and it becomes 
visible on the preview of the design. 

Compensation:  

 

At the Compensation option it is shown the compensation that it was automatically chosen from 
the software for the specific object. The Compensation changes the width of the satin object that 
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will be embroidered to avoid shrinking. The compensation value depends on the fabric you are 
using and the shape size. If you change fabric the compensation will change also. The 
compensation becomes visible only if you export the design by using the To editor option from the 
File > Export submenu.  

Step 

This option, when applied, sets the fill area to be Step. All the fill stitches change to Step, which is 
automatically calculated. The Step type that was placed is the default. You can change Steps by 
changing its Style and Pattern. There are many different styles and patterns that you can apply on 
any stitch design. Also, you have the ability to change Underlay, stitch Density, Length and 
Compensation. 

Styles 

The Styles area contains all the stitch styles that can be applied on the design. Style in Creative 
DRAWings is a way of movement from one point to another, which normally can be done in one 
stitch. Some styles, when applied, may not look good in the design. This happens because some 
stitch styles do not fit correctly in all shapes. 

 
Figure 9.13: Step Styles 

Select the style you prefer by clicking on it and view it in your design. If do not want any select 
none. The None selection will restore the default step type. Your selections are instantly displayed 
in the design area letting you experiment with your embroidery design. There are 325 styles that 

you can use to produce unique designs. The styles that are in film icon (for example: ) are a 
serial of different styles in one.  

Patterns 

The patterns area contains all the patterns that can be applied on the design. Patterns are shapes 
created from stitches. You can make combinations between Styles and Patterns and produce your 
own designs. Some combinations when applied may not look right in the design. This happens 
because combinations do not always produce correct stitch results.  
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Figure 9.14: Step Patterns 

Select the pattern you prefer by clicking on it and view it in your design. In step type you can‟t 
have none as a selection pattern. Step is based on patterns, which means that even if you don‟t 
select a pattern, Creative DRAWings will set the default for you. Your selections are instantly 
displayed in the design area letting you experiment with your embroidery design. There are 262 
different patterns to apply in your design. If you want to view only the pattern you have selected 
and not a combination of styles, you must be sure that the Style option is set to none. Otherwise 
you will view a pattern with a style in it.  

There are also two more options that are very useful in customizing the way that the software will 
be embroidered. Those are the Remove overlaps option and the Sequence option.  

Remove overlaps:  

 

This is an automatic filter which removes all overlaps between the objects of the vector designs. 
This filter uses Artificial Intelligence and it is applied only where necessary. The application of the 
filter results in the reduction of stitches that will be placed on the fabric. It is, also, possible to 
manually alter the overlapping status of each object. There are three possible options that you can 
apply on a specific object, Auto, Never and Always. The Auto is the default option and the one 
that Creative DRAWings uses to create the best possible results on the design. When the Never 
option is applied on an object, the specific object will never trim the objects that overlaps. This 
means that all the objects/shapes that are under the selected objects will be embroidered 
normally, placing all their stitches on the fabric. The opposite option is Always, when it is applied 
on a specific object, it trims all the objects that overlaps. This means that all the parts of 
objects/shapes that are under the selected object will not be embroidered.  

Creative DRAWings uses this tool to embroider your design more efficiently and effectively. But 
in order for this function to work well, avoid applying trim tool in the Create part of Creative 
DRAWings. You must always use it with care or after the setting Remove overlaps option to 
Never.   

Sequence:  

 

With this tool it is possible to change the embroidering sequence of the design. Specific objects of 
the design can be set to be embroidered at the start or at the end of the embroidering process. 
This gives you the ability to embroider the designs in the order you prefer. The Sequence drop 
down menu has three options Auto, To start and To end. Auto is the default option and the one 
that Creative DRAWings uses to create the best possible embroidering sequence results. In 
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order to change the embroidering sequence manually you have to use the other two options. The 
To start option sets the selected object to be embroidered first.  This means that if it was to be 
embroidered fifth in the embroidering sequence, now will be embroidered first. Exactly the 
opposite for the To end option. Therefore, when it is applied on an object of the embroidery 
design, this will be immediately become the last object that will be embroidered. By using the To 
start and To end options, you can change the embroidering sequence and embroider the design 
you have created in the way you prefer. This tool is really useful for embroidering hats, or on 
delicate fabrics that need special care regarding the way that the objects will be placed on the 
fabric. 

If you have set more than one object to be embroidered To start and more than one To end, 
Creative DRAWings will decide automatically which one from those that are set To start will be 
the first to be embroidered and which one from those set To back will be the last to be 
embroidered.  

For example, if you have a design with 20 objects and you have set 5 to be embroidered To start 
and 5 other To end, Creative DRAWings will embroider those that are set To start first, deciding 
automatically their embroidering sequence, then those (10) that remained set To auto and finally 
those that set To end, deciding automatically the order of those last 5. 

Also, there are four more options that can help you adjust the embroidery parameters of the 
design. As we have already mentioned in the Select fabric section previously in this chapter, each 
fabric has different presets that affect the way the embroidery design will be placed on it and some 
of them are visible at the bottom of the Object properties toolbar. For Satin stitch type they are 
Underlay, Density, Length and Compensation. These options can help you make useful 
adjustments on the design and produce the embroidery results you prefer.  

Step stitch type options 

Also, there are four more options that can help you select the correct fabric for your embroidery 
design. As we have already mentioned in the Select fabric section previously in this chapter, each 
fabric has different presets that affect the way the embroidery design will be placed on it. These 
presets are visible at the bottom of the Object properties toolbar, and for Step stitch type they are 
Underlay, Density, Length and Compensation. The values that are shown, are there, only for 
your information and to help you decide the fabric you will use. Below we will describe what each 
option shows.  

Underlay:  

 

At the Underlay option it is shown the Underlay that it was automatically chosen from the software 
for the specific object. The underlay stitches are placed on the fabric in order to create the base for 
the cover stitches that will follow. The Underlay is important for the quality of the embroidery 
designs. 

For Step stitch type, the following underlay patterns are available:  

 

Tacking – If tacking is selected, there will be no underlay and the software will 
make running stitches in order to go from one position to another and cover the 
area with cover stitches. 

 

Edging -  If edging is selected, Creative DRAWings will make running stitches 
following the shape of the object and position Edging underlay near the edge of 
the outline. 



Creative DRAWings Embroidery Software Manual 
 

234 Chapter 9 - Embroidery transformations   DRAWstitch Ltd.  
  

 

Packing - If packing is selected, Creative DRAWings will cover the area of the 
object with vertical running stitches (according to the direction of cover stitches) 
as the icon shows. 

 

Netting - If netting is selected, Creative DRAWings will cover the area of the 
object with running stitches at 45o and -45o (according to the direction of the 
cover stitches) and then fill the shape with cover stitches. 

 

Packing + - Is a combination of Packing and Edging underlay. 

 

Netting + - Is a combination of Netting and Edging underlay 

Density: 

 

At the Density option it is shown the density that it was automatically chosen from the software for 
the specific object. The density changes according the fabric you have selected and it becomes 
visible on the preview of the design. 

Length:  

 

In the Length numeric field you can view the length of every stitch in the step. 

Compensation:  

 

At the Compensation option it is shown the compensation that it was automatically chosen from 
the software for the specific object. The Compensation changes the width of the step object that 
will be embroidered to avoid shrinking. The compensation parameter has to do with the tendency 
of a punching object to shrink in itself in the stitching direction. Also its value depends on the fabric 
you are using and the shape size. If you change fabric the compensation will change also. The 
compensation becomes visible only if you export the design by using the To editor option from the 
File > Export submenu. 

Row Fill  

This option, when applied, sets the fill area to be Row Fill. All the fill stitches are changed to Row 
Fill, which is automatically calculated and produced from the program. The Row Fill type that was 
placed is the default. You can change Row Fill’s feel by changing its Style and Pattern. There are 
many different styles and patterns that you can apply on any stitch design. Also, you have the 
ability to change the stitch Density and Length. 

Styles  

The Styles area contains all the stitch styles that can be applied on the design. Style in Creative 
DRAWings is a way of movement from one point to another, which normally can be done by one 
stitch. Some styles when applied may not look good on the design. This happens because stitch 
styles cannot fit correctly in all possible shapes. 
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Figure 9.15: Row Fill Styles 

Select the style you prefer by clicking on it and view it on your design. If do not want any select 
none. The None selection will restore the default Row Fill type. Your selections are instantly 
displayed in the design area letting you experiment with your embroidery design. There are 325 

styles that you can use to produce unique designs. The styles that are in film icon (for example: 
) are a serial of different styles in one.  

Patterns  

The patterns area contains all the patterns that can be applied on the design. Patterns are shapes, 
created from stitches. You can make combinations between Styles and Patterns and produce your 
own designs. Some combinations when applied may not look good on the design. This happens 
because combinations do not always produce correct stitch results.  

 
Figure 9.16: Row Fill Patterns 

Select the pattern you prefer by clicking on it and viewing it on your design. In Row Fill type, like 
step, you can‟t have none selected. Step is based on patterns, which means that even if you don‟t 
select a pattern, Creative DRAWings will set the default for you. Your selections are instantly 
displayed in the design area letting you experiment with your embroidery design. There are 262 
different patterns to apply in your design. If you want to view only the pattern you have selected 
and not a combination with styles, you must be sure that styles option is set to none. Otherwise 
you will view a pattern with a style in it.  

There are also two more options that are very useful in customizing the way that the software will 
be embroidered. Those are the Remove overlaps option and the Sequence option.  

Remove overlaps:  

 

This is an automatic filter which removes all overlaps between the objects of the vector designs. 
This filter uses Artificial Intelligence and it is applied only where necessary. The application of the 
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filter results in the reduction of stitches that will be placed on the fabric. It is, also, possible to 
manually alter the overlapping status of each object. There are three possible options that you can 
apply on a specific object, Auto, Never and Always. The Auto is the default option and the one 
that Creative DRAWings uses to create the best possible results on the design. When the Never 
option is applied on an object, the specific object will never trim the objects that overlaps. This 
means that all the objects/shapes that are under the selected objects will be embroidered 
normally, placing all their stitches on the fabric. The opposite option is Always, which when 
applied on a specific object, trims all the objects that overlaps. This means that all the parts of 
objects/shapes that are under the selected object will not be embroidered.  

Creative DRAWings uses this tool to embroider your design more efficiently and effectively. But in 
order for this function to work well, avoid applying trim tool in the Create part of Creative 
DRAWings. You must always use it with care or after the setting Remove overlaps option to 
Never.   

Sequence:  

 

With this tool it is possible to change the embroidering sequence of the design. Specific objects of 
the design can be set to be embroidered at the start or at the end of the embroidering process. 
This gives you the ability to embroider the designs in the order you prefer. More specifically the 
Sequence drop down menu has three options Auto, To start and To end. The Auto is the default 
option and the one that Creative DRAWings uses to create the best possible embroidering 
sequence results. In order to change the embroidering sequence manually you have to use the 
other two options. The To start option set the selected object to be embroidered first.  This means 
that if it was to be embroidered fifth in the embroidering sequence, now will be embroidered first in 
the row. Exactly the opposite for the To end option. Therefore when it is applied to an object of the 
embroidery design, this will immediately become the last object that will be embroidered. By using 
the To start and To end options you can change the embroidering sequence and embroider the 
design you have created in the way you prefer. This tool is really useful for embroidering hats or 
on delicate fabrics that need special care regarding the way that the objects will be placed on the 
fabric. 

If you have set more than one object to be embroidered To start and more than one To end, 
Creative DRAWings will decide automatically which one of those that are set To start will be the 
first to be embroidered and which one from those set To back will be the last to be embroidered.  

For example, if you have a design with 20 objects and you have set 5 to be embroidered To start 
and 5 other To end, Creative DRAWings will embroider those that set To start first, deciding 
their embroidering sequence automatically, then those (10) that remained set To auto and finally 
those that set To end, deciding automatically the order of those last 5. 

Row Fill  stitch type options 

Also, there are two more options that can help you adjust the embroidery parameters of the 
design. As we have already mentioned in the Select fabric section previously in this chapter, each 
fabric has different presets that affect the way the embroidery design will be placed on it and some 
of them are visible at the bottom of the Object properties toolbar, and for Row Fill stitch type they 
are Density and Length. These options can help you make useful adjustments on the design and 
produce the embroidery results you prefer. 

Density:  
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At the Density option it is shown the density that it was automatically chosen from the software for 
the specific object. The density changes according the fabric you have selected and it becomes 
visible on the preview of the design. 

Length:   

 

In the Length numeric field you can view the length of every stitch in objects filled with Row Fill 
stitches. 

Appliqué  

This option, when applied, sets the fill area to be Appliqué. All the area will be covered with a 
fabric, which has the same color as the one used in Create mode. The border will stay as it was 
surrounding the appliqué area. If the design does not have a border, the program will sew around 
the appliqué an E-stitch ( ) in order to hold the appliqué on the fabric. If the object that you 
applied appliqué on it has a border, you can set a running style or satin serial stitches that will 
hold the appliqué on the fabric. New zig-zag styles are added in the running stitch type that can be 
used for holding single or double laser cut appliqué.  

For example: 

Consider that we have an area (like the example in Figure 9.15) made in CorelDraw. As we can 
see, it has a Red color fill and a Black Hairline outline. When we press the stitch tab, the 
embroidery will look like Figure 9.16. Creative DRAWings will fill the area with step and the 
border with running. If the border of the object was thicker, Creative DRAWings would 
automatically decide one of the three options that it has (double, triple style (Bean Stitch) or satin 
serial) to create the border. Now, if we select the object in the stitch tab, then from the fill 
properties, select the appliqué function, the area will be covered with a fabric which has the same 
color (Red) with the one you used in Corel. The border will not change, which means that it will 
stay covered with running, as we can see in Figure 9.17. 

   

Figure 9.17 Figure 9.18 Figure 9.19 

Each time an appliqué object is created, there is a standard procedure that it is followed for each 
appliqué object in order to be embroidered correctly on the fabric. The technique that Creative 
DRAWings uses to embroider the appliqué object needs interaction from the user during the 
embroidering process. In order to understand the procedure that it is followed, we will analyze how 
an embroidery machine will react when it will try to embroider the appliqué object. 
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First it will make the shape of the applique with running showing the area where the Applique must 
be placed. After that a jump stitch on top will be made and the machine will stop in order the 
appliqué to be placed on the fabric. Then the machine starts to sew running stitches creating the 
shape of the applique. A jump stitch on top will be made and the machine will stop (again) in order 
to cut the applique according to the shape. At the end the machine will make the border of the 
appliqué (E-stitch, Satin serial or Running) as it was selected. Then the machine will continue 
embroidering the rest objects. This is mainly the way you have to embroider the appliqué designs 
that you are designing inside Creative DRAWings. The same procedure must be followed to all 
objects that were assigned to appliqué.  

You can also view/simulate the way the design will be embroidered Wings‟ modular. You can 
export the design to Wings‟ modular embroidery software by selecting the To editor option from 
the File>Export submenu. Wings‟ modular will open with the design imported. There you can view 
the exact embroidering sequence and simulate the way the design will be embroidered in the 
embroidery machine.  

Finally there is an option that is very useful in customizing the way that the software will be 
embroidered. This is the Sequence option.  

With this tool it is possible to change the embroidering sequence of the design. Specific objects of 
the design can be set to be embroidered at the start or at the end of the embroidering process. 
This gives you the ability to embroider the designs in the order you prefer. More specifically, the 
Sequence drop down menu has three options Auto, To start and To end. Auto is the default 
option and the one that Creative DRAWings uses to create the best possible embroidering 
sequence results. In order to change the embroidering sequence manually, use the other two 
options. The To start option set the selected object to be embroidered first.  This means that if it 
was to be embroidered fifth in the embroidering sequence, now will be embroidered first in the 
row. Exactly the opposite for the To end option. Therefore, when it is applied on an object in the 
embroidery design, this will immediately become the last object to be embroidered. By using the 
To start and To end options, you can change the embroidering sequence and embroider the 
design you have created in the way you prefer. This tool is really useful for embroidering hats, or 
on delicate fabrics that need special care regarding the way that the objects will be placed on the 
fabric. 

If you have set more than one object to be embroidered To start and more than one To end, 
Creative DRAWings will decide automatically, which one from those set To start will be the first 
to be embroidered and which one from those that you have set To back will be the last to be 
embroidered.  

For example, if you have a design with 20 objects and you have set 5 to be embroidered To start 
and 5 other To end, Creative DRAWings will embroider those that are set To start first, deciding 
automatically their embroidering sequence, then those (10) that remained set To auto and finally 
those that are set To end, deciding automatically the order of those last 5. 

This is very useful because you can specify when the appliqué objects will be inserted on the 
fabric. Therefore you do not have to wait over the embroidering machine until it reaches the point 
where the appliqué has to be placed. You can order it to be embroidered at the start or at the end 
of the embroidering process. This will save you time and effort. 

Cross-stitch 

Any (RGB) bitmap that is imported in Creative DRAWings can be immediately converted to a 
perfect embroidery design with cross-stitches. It is the easiest and quickest way to make cross-
stitch embroidery designs. It is also possible to make combinations between normal embroidery 
(step, satin, Row Fill and appliqué) and cross-stitches. By combining stitch-types you can end up 
with unique designs that you could never make before. Creative DRAWings automatically 
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reduces the number of colors that the bitmap has. Therefore, in the stitch mode the maximum 
number of colors that the converted bitmap will have is 20.  

In the created cross-stitch design it is possible to change the number of cross-stitch Repeats, the 
Cell size of the cross and the Background color. 

Repeats:  

 

By changing the value of this cross-stitch option you can change the number of times that each 
cross-stitch will be embroidered. The bigger the number, the thicker the cross-stitch. The default 
value is 3 and it is the most suitable in most of the cases. There is an upper limit of 10 and a lower 
limit of 1. Therefore, the number of repeats must between those two limits. 

Cell size:  

 

By changing this value you can change the size of the cross container. The value represents the 
side size of the cross container square. Each point represents one 10th of mm, therefore, if you 
insert the value 20 in the field, this will mean that the side of the cross square will be 0,20cm or 
0,082‟‟. The default value of Cell size is 20.  

Under the Cell size field there is some information about the cross-stitch grid that is useful for 
those that work with this kind of measurement. The Grid is: value shows the number of crosses 
per inch (ct). Therefore you can calculate easily the number of crosses in your design.    

Background:  

The Background list of colors contains all the colors that the bitmap has. Each time you pass the 

mouse cursor over a color, in the preview area you can view which part of the design will be filled 

with which color. This is really helpful when you do not want a color to be embroidered. This color 

might be an extensive background color of the bitmap or a thread color that is the same with the 

fabric that you will embroider on your cross-stitch design.  

 

Figure 9.23: Cross-stitch background 

For example, if you have a bitmap that has a white background and you want to embroider it on a 
white t-shirt, it would be better to check the white color‟s checkbox from the object properties 
toolbar and remove it completely.  

There is a possibility, while you are over a color from the list, for it to appear inside an object that 
is filled with totally different color. This is happening because the bitmap images contain many 
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colors and in order for Creative DRAWings to reduce the number of colors, it groups them and 
assigns one that is similar to the group. Therefore, many colors might be represented with one 
color on the design. You can edit the group colors from the Edit palette option from the Tools 
menu.  

Photo-stitch 

Any bitmap image that is imported in Creative DRAWings can be converted into Photo stitch 
design. In Photostitch embroidery type Creative DRAWings automatically recognizes the 
graduation of colors of any backdrop image and sets fill stitches on it. The fill stitches are satin 
bars that cover the backdrop image area. The parameters that you can adjust are:   

Width: With this parameter you can adjust the width of satin bars that photo-stitch consists of.  

Starting density: adjust the density of the satin bars that cover the backdrop image.  

Net Fill  

This option when applied is sets the fill area to Net Fill. The Net fill embroidery type is a special fill 
type that adds two scan lines that are crossing with parallel equidistant running stitches. These 
two scan lines are forming a Net that can be used to create Laces. It is a very useful embroidery 
type that can produce great embroidery results. The Net Fill includes some more options that allow 
us to customize the way that will be applied on the selected object. These options are the 
following: 

Cell size:  

 

With this option you can specify the size of each square side that the Net fill consists of. For 
example by setting the Cell size to be 2.0 mm all squares of the net will have 2.0 mm side size. 
The maximum value that the Cell size can have is 9.9mm and the minimum is 0.5mm. To change 
the value of the Cell size option you have to either click on the up and down arrows next to the 
field to increase or decrease its value or type the exact value you want and then press the Enter 
key from the keyboard. Another way to increase or decrease the value is by clicking inside the Cell 
size field and then by using the mouse wheel to change its value. The changes that you will make 
will be immediately applied on the design. By changing this value you can create a net with large 
squares or small squares according your preferences.  

Offset:  

 

With this option you can specify the distance, inner or outer, you want the Net fill to be moved. For 
example: if you set the Offset value to 3mm the Net fill will increase its size by 3mm to all 
directions outside its original outline. On the other hand if you set the value to -3mm the Net fill will 
decrease its size by 3mm to all direction inside its original outline.  

The maximum value that the Offset can have is 15.0mm and the minimum is -15.0mm. To change 
the Offset value you have to either click on the up and down arrows next to the field to increase or 
decrease its value or type the exact value you want and then press the Enter key from the 
keyboard. Another way to increase or decrease the value is by clicking inside the Offset field and 
use the mouse wheel to change its value. The changes that you will make will be immediately 
applied on the design. By changing this value you can make adjustments on the Net fill size, 
which is really useful when you want to cover a hole and making sure that the net will be 
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embroidered on the fabric and not inside the hole. This option is very important for creating proper 
Net fills. 

Angle: 

With this option you can change the Angle that the Net fill will be applied. For example: When the 
angle is set to 0o degrees the Net fill will be aligned on the X and Y axes creating right angles. If 
you change the Angle value to 30o degrees the Net fill will be rotated 30o degrees anticlockwise 
and change completely its direction.  

The Angle values that you can set are between 0o and 360o degrees. To change the Angle value 
you have to either click on the up and down arrows next to the field to increase or decrease its 
value or type the exact value you want and then press the Enter key from the keyboard. Another 
way to increase or decrease the value is by clicking inside the Angle field and use the mouse 
wheel to change its value. The changes that you will make will be immediately applied on the 
design.  

By changing the Angle of the Net fill you can orientate it based on the shape that it is applied on. 
This ability allows you to produce better and more beautiful embroidery results. 

There are also two more options that are very useful in customizing the way that the design will be 
embroidered. Those are the Remove overlaps option and the Sequence option.  

Remove overlaps:  

 

This is an automatic filter which removes all overlaps between the objects of the vector designs. 
This filter uses artificial Intelligence and it is applied only where necessary. The application of the 
filter results in the reduction of stitches that will be placed on the fabric. It is also possible to 
manually alter the overlapping status of each object. There are three possible options that you can 
apply on a specific object, Auto, Never and Always. The Auto is the default option and the one 
that Creative DRAWings uses to create the best possible results on the design. When the Never 
option is applied on an object, the specific object will never trim the objects that overlaps. This 
means that all the objects/shapes that are under the selected objects will be embroidered 
normally, placing all their stitches on the fabric. The opposite option is Always. When it is applied 
to a specific object it trims all the objects that it overlaps. This means that all the parts of 
objects/shapes that are under the selected object will not be embroidered.  

Creative DRAWings uses this tool to embroider your design more efficiently and effectively. But 
in order for this function to work well, avoid applying trim tool in the Create mode of Creative 
DRAWings. You must always use it with care or after the setting Remove overlaps option to 
Never.   

Sequence:  

 

With this tool it is possible to change the embroidering sequence of the design. Specific objects of 
the design can be set to be embroidered at the start or at the end of the embroidering process. 
This gives you the ability to embroider the designs in the order you prefer. More specifically, the 
Sequence drop down menu has three options Auto, To start and To end. The Auto is the default 
option and the one that Creative DRAWings uses to create the best possible embroidering 
sequence results. In order to change the embroidering sequence manually, use the other two 
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options. The To start option sets the selected object to be embroidered first. This means that if it 
was to be embroidered fifth in the embroidering sequence, now will be embroidered first in the 
row. Exactly the opposite for the To end option. When this is applied on an object of the 
embroidery design, it will be immediately become the last object that will be embroidered. By using 
the To start and To end options, you can change the embroidering sequence and embroider the 
design you have created the way you prefer. This tool is really useful for embroidering hats and on 
delicate fabrics that need special care regarding the placement of objects on the fabric. 

If you have set more than one object to be embroidered To start and more than one To end, 
Creative DRAWings will decide automatically which one of those will be the first and which one 
will be last to be embroidered.  

For example if you have a design with 20 objects and you have set 5 to be embroidered To start 
and 5 other To end, Creative DRAWings will embroider those set To start first, deciding 
automatically their embroidering sequence, then those (10) set To auto and finally those set To 
end, deciding automatically the order of the last 5. 

Outline 

This tab contains every function that can be applied to the outline of a design and in every line 
design. The functions are not visible until you select an object from a design. When a vector 
design is embroidered for the first time, Creative DRAWings automatically puts outline stitches on 
it. That is why the Auto checkbox, at the top of the outline tab, is checked. When a change in the 
outline tab is made, Auto becomes unchecked. You can check it again and restore programs initial 
outline design.  

 

Figure 9.24: Border outline stitch type options 

For designs that do not have a border the Outline option is not available. In the outline tab there 
are three embroidery type fills: None, Running and Satin Serial. Every time you select one, it is 
applied immediately to your stitch design. 

None  

This option, when applied, sets the fill area to be empty. All the fill stitches are removed from the 
design and only the border remains, if one exists. Whenever you don‟t need to embroider a 
specific fill area you can set its fill to None and have the stitches instantly removed. 

Running  

This option, when applied, sets the border outline of a design or a line design to Running. All the 
border and line stitches are changed to Running, which is automatically calculated and produced 
from the program. The Running type that was placed is the default. You can change Running’s 
feel by changing its Thickness and Style. There are different thicknesses and Styles that you can 
apply on any stitch design. Also, you have the ability to change the stitch Offset and Length. 

Passes 
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Define the number of passes that running will make to create a line or border design. This way we 
can create thickness in running stitch. The minimum value is 1 (Single pass) and the maximum is 
9 (9 passes). Any change in running thickness is not viewable in the 3D preview area but it is 
stored when the design is saved. When the design is embroidered, the option you have selected 
will be applied. You can also see the multiple passes using slow redraw.  

Styles  

The Styles area contains all the stitch styles that can be applied on the design. Style in Creative 
DRAWings is a way of movement from one point to another, which normally can be done by one 
stitch. Styles, when applied, are placed on the border one after another. Appling different styles 
you can create unique embroidery designs.  

 
Figure 9.25: Running styles 

Select the style you prefer by clicking on it and viewing it on your design. Your selections are 
instantly displayed in the design area letting you experiment with your embroidery design. 

The first three styles are automatically selected from the program and you cannot make 
any changes between them. Their selection depends on the border width and the only way to 
change them is by changing the border width of the vector design. All the other styles can be 
selected by clicking on them.  

There are 325 styles that you can use to produce unique designs. The styles that are in film icon 

(for example: ) are a serial of different styles in one. 

Also, there one more parameters such as length and offset of running stitches that you can 
change according your needs. These options are located at the bottom of the Object properties 
toolbar.  

Length:  

 

You can activate the Length option by checking the checkbox next to it. In the numeric field you 
can specify the length of stitches for the punching object that you are adding. Also you can adjust 



Creative DRAWings Embroidery Software Manual 
 

244 Chapter 9 - Embroidery transformations   DRAWstitch Ltd.  
  

length by clicking the arrows next to the value or by clicking on the value and rotating the mouse 

wheel  if there is one. Changes are instantly previewed on the design area and can be set by 
clicking outside of the length field. 

Satin Serial  

This option, when applied, sets the border outline of a design or a line design to be Satin serial. All 
the border and line stitches are changing to Satin serial, which is automatically calculated and 
produced from the program. The Satin serial type that was placed was selected from the program 
and is the default. You can change Satin Serial‟s feel by changing its Pattern. As you can see in 
the figure below, there are different Patterns that you can apply on any stitch design. Also, you 
have the ability to change Underlay, offset, stitch Density and Compensation. 

Offset: 

 

You can activate the Offset option by checking the checkbox next to it. In the numeric field you 
can enter the value of offset you want, with lowest value of -8mm and highest value 8mm. Also 
you can increase or decrease the offset value by clicking on the arrows next to the value or by 
clicking on the value and rotating the mouse wheel, if there is one. The value that you are inserting 
defines the exact distance you want the satin serial outline to have from its initial position. If the 
value is negative, satin serial object will make an inner offset and the opposite, if it is positive. The 
default offset value is zero and can be changed only from you. Any changes you are making on 
the offset value it is previewed on the design.  

The measurement system of DRAWings in all Object properties parameters can only be metric. 

Patterns  

The patterns area contains all the patterns that can be applied on the design. Patterns are shapes, 
created from stitches. You can apply patterns only in wide lines or border outlines. If you have a 
thin border, any change in patterns will not take effect.  

 

Figure 9.26: Satin serial patterns 

Select the pattern you prefer by clicking on it and viewing it in your design. If you do not want any 
select none. None will restore the default satin serial type. Your selections are instantly displayed 
in the design area letting you experiment with your embroidery design. There are 262 different 
patterns to apply in your design.  
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Also, there are four more options that can help you adjust the embroidery parameters of the 
design. All four of them are located at the bottom of the Object properties toolbar,. and for Satin 
serial stitch type they are Underlay, Density, Offset and Compensation. Below we will describe 
how its option affects the embroidery design.  

Underlay:  

 

You can activate the underlay option by checking the checkbox next to it. Click on the Underlay 
you want, and your change will be calculated and stored in the saved design. If you don‟t select an 
underlay manually, DRAWings will automatically select the appropriate one for you. Underlay is 
important for quality embroidery designs. 

For Satin serial stitch type, the following underlay patterns are available: 

 

Tacking  – If tacking is selected, there will be no underlay and the software will 
make running stitches in order to go from one position to another and cover the 
area with cover stitches. 

 

Single - If single is selected, Creative DRAWings will make a single line with 
running stitches near the middle of the shape of the object and then cover this 
with cover stitches. 

 

Double  - If double is selected, Creative DRAWings will make running stitches 
following the shape of the object and position Double underlay near the edge of 
the outline. 

 

ZigZag - If zigzag is selected, Creative DRAWings will create a sophisticated 
ZigZag pattern which automatically changes directions (according to the 
direction of the cover stitches) and then fill the shape with cover stitches. 

 

Cross - If cross is selected, Creative DRAWings will create a thicker 
sophisticated ZigZag pattern which automatically changes directions 
(according to the direction of the cover stitches) and then fill the shape with 
cover stitches. 

 

ZigZag+  - Is a combination of Zig-Zag and Double underlay. 

 

Cross+  - Is a combination of Cross and Double underlay 

 

Netting - If netting is selected, Creative DRAWings will cover the area of the 
object with a thicker sophisticated ZigZag pattern, which automatically changes 
directions (according to the direction of the cover stitches) two times and then 
fills the shape with cover stitches.  

 

Netting+ - Is a combination of Netting and Double underlay. 

Density:  

 

You can activate the Density option by checking the checkbox next to it. In the numeric field you 
can specify the density of the satin serial stitches that you are adding. Also, you can adjust density 
by clicking the arrows next to the value or by clicking on the value and rotating the mouse wheel 
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if there is one. Changes are instantly previewed on the design area and can be set by clicking 
outside the density field. 

Compensation:  

 

You can activate the Compensation option by checking the checkbox next to it. In the numeric field 
you can enter the value of compensation you want with lower bounder -0,3mm and upper bounder 
2.0mm. Also you can adjust Compensation by clicking the arrows next to the value or by clicking 
on the value and rotating the mouse wheel if there is one. The entered value changes the width of 
satin serial stitch that will be embroidered. The default compensation value depends on the fabric 
you are using. If you change fabric the compensation will adjust automatically. Changes are 
instantly previewed on the design area and can be set by clicking outside the density field. 

Divide and Directions tools 

In the Tools toolbar of Creative DRAWings when create, stitch mode is enabled, two more tools 

exist to help improve embroidery quality. These are Divide  and Directions  tools.  

Divide 

With this tool is possible to Divide Satin objects and manage the way in which the outlines are 
split into satin bars. The objects are not increased but split to internal branches. This tool gives 
you the flexibility to customize the way Satin objects will be embroidered and create exactly the 

design you wants. In order to add a Divide line, click on   icon or press the Shift + D shortcut 
keys from the keyboard. Then click on the object you wish to divide (in order to select it). Click and 
drag from one side of the object to the other in order to specify the divide line. In order to delete 
the divide line you have created, just click on the „X‟ icon in the middle of the line. You can change 
any existing divide line by clicking and dragging the points of the line. The Divide line has green 
color in order to distinguish them from the directions lines that are red. 

The Divide tool can be applied with the same procedure and on objects filled with Row Fill stitch 
type. Row Fill is a special stitch type that when you apply the Divide tool you must be careful and 
keep in mind its distinctiveness to avoid having strange embroidering results.  

It is very useful also when you want to create Text art designs and embroider the design with a 
specific way. You can divide the satin characters and define exactly the way you want to be 
embroidered.  

        
Figure 9.27: Before divide      –       Apply divide tool     –      After divide tool 

You can activate the divide tool by clicking on the  icon of the Tools toolbar or by pressing the 
Shift + D shortcut keys.  
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Directions 

With this tool it is possible to change the direction of Step, Satin and Row Fill stitches until you 

are satisfied with the embroidery results. In order to add a direction first you have to click on  
icon or press the „D‟ shortcut key form the keyboard. Then click on the object, which direction you 
wish to change (in order to select it). Click and drag in order to specify the direction of the stitches. 
To delete the direction you have created, just click on the „X‟ icon at the middle of the direction. 
You can change any existing direction by clicking and dragging the points of the direction.  

 
             Figure 9.28: Step Directions         Satin Directions 

By changing Directions in a design you can organize also the embroidery tensions in a way that 
one object will negate the tensions of the other object and produce a perfect result.  

In Satin and Row Fill objects you can have more than one stitch directions that can help you 
produce the embroidery result you prefer. On the other hand in Step objects you can have only 
one Direction of stitches. 

You can activate the directions tool by clicking on the  icon of the Tools toolbar or by pressing 
the „D‟ shortcut key.  

With the combination of Divide and Directions tools you can create unique designs that can have 
many sub-objects as brunches and specific direction of stitches for each sub-object.  

Design Properties 
Apart from the stitch changes that you can make in your embroidery designs, you can also adjust 
the properties of its design. You can add general information about the design and optimize the 
way it will be embroidered. You can access Design properties from menu File > Design properties. 
In the dialog box that will appear, you can adjust the properties in the General and Optimizer tabs.  

  
Figure 9.29: design properties 

General 
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In the general tab you can add information about the Designer‟s name, design Keywords, and any 
Remarks about the design. 

 Designer 

In the Designer text field you can add information about the designer (Name, company, 

etc.). These fields are useful for record keeping.  

 

Figure 9.30: Designer text field  

 Keywords 

In the Keywords field you can add words that describe the current design. The keywords 

can be used only if you save your design in “.NGS” or “.DRAW” format.  

 

Figure 9.31: Keywords text field 

 

The “NGS” file format can be opened from WINGS SYSTEMS Ltd digitizing programs, 
eXPerience® and Wings’ modular®. These include a browser where keywords can be 
used as a filter in search option. If you are dealing with hundreds of designs it can be a vital 
function for quickly searching your database. Many people find it easier to write down a 
fixed list of options or keywords to allow multiple users to enter data in the same style into a 
common design database.  

 Remarks 

In this text area you can add any remarks for your design. Any information about stitch type, 

color palette, fabric type and number of threads that was used in the design creation are 

useful for quick reference for anyone that might use it. Also you can add instructions 

relating to embroidery production.  

 

Figure 9.32: Remarks text area 

Any changes in the General tab can be saved as default, by clicking on the Save as default button 

, which means that every time you create a new design the already saved settings 
will be displayed.  

Optimizer 

In this tab you can adjust Appliqué frame out distance, Trimming distance between objects, 
Trimming distance in Cross-stitch and Minimizing color changes. Also, can select Optimization 
strategy, and set the options End points at closest connection even on trims, keep sequence of 
overlapped objects even if trimmed, No thread trims inside combined objects. You have also the 
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ability to disable some optimization automations of the software that have to do with the 
embroidery sequence and re-sequence the embroidery design manually. 

All options that you will find inside the Optimizer, refer to embroidery production process and are 
important for quality stitch output. The optimizer tab can be accessed, also, from Optimizer options 
of Tools menu or by pressing Ctrl+Shift+J shortcut keys (Ctrl+Shift+J) together from the keyboard.  

 
Figure 9.33: Appliqué frame out distance 

The Optimizer options that you can adjust are listed below: 

Appliqué frame out distance   

 
Figure 9.34: Appliqué frame out distance 

This setting is important for designs that include appliqué. In production of embroidery designs 
with appliqué, there is a phase where the machine will stop, bring the frame out and ask you to 
add the appliqué in the predefined area. In that phase the frame movement the embroidery 
machine makes is defined as Appliqué frame out distance. By changing the value of this field, you 
are setting the frame out movement from its current position.  

Trimming distance between objects  

 
Figure 9.35: Trimming distance between objects 

With thread trims between the objects of the embroidery design you get high quality of embroidery 
in longer time because every time the machine cuts a thread, it takes some time to start 
embroidering again. 
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On the other hand, without trims between the objects, you get high quality of embroidery in less 
production time. The jump-stitches are there to connect the object without cutting the thread. You 
can either cut the jump-stitches manually afterwards or keep them on the design. In cases where 
the objects are too close, jump-stitches are not a problem for most embroiderers but it is the best 
way of embroidering. It is also matter of embroidering style. 

This setting is important for thread trimming in the embroidery production process. Setting the 
Trimming distance between objects you are setting the distance where the machine will make a 

thread trim. More specifically, if the objects are combined in Create mode , Creative 
DRAWings, in the stitch button, will connect those objects with a jump-stitch that will be visible 
on the 3D preview area. This jump-stitch will become a thread trim when the design is saved in an 
embroidery machine format and the thread trim distance is shorter than the jump-stitch distance. If 
the objects are break apart and the distance between the objects/shapes are longer than the 
value that you have set in Trimming distance between objects field, then there will be thread 
trims between the objects.  

If the distance is shorter from the Trimming distance between objects and the objects are not 
combined there will be no thread trims in between.  

Trimming distance in Cross-stitch 

 
Figure 9.36: Trimming distance in Cross-stitch 

This option handles the trimming distance between cross-stitch objects. In Creative DRAWings 
the cross-stitch designs are treated as one object. In the cross-stitch designs we can treat the 
thread colors that are filling the design as objects. Cross-stitch designs in most of cases have 
scattered crosses with the same color that makes the trimming calculations difficult. The 
Trimming distance in Cross-Stitch option gives you the ability to define the distance that you 
want a thread trim to occur between the color objects of the design. The trimming needs are 
different in different designs therefore you must be careful with the inserted value in this option.  

End points at closest connection, even on trims 

 
Figure 9.37: Closest point checkbox 

This option is important for the way that the design will be embroidered. When the checkbox is 
checked, Creative DRAWings filters the entire design and finds the closest connection points 
between the objects, even if a trim is made. This option gives better rooting between objects and 
better flow of the embroidery. In addition, it gives fewer thread trims because the objects of the 
same color are connected from their closest point.   

 

Start / Return to center of frame 

This option is useful for some embroidery machines that don‟t support Starting from or returning to 
the center of the design.  In print preview we can see the point that the embroidery process will 
start from. When this option is enabled, this starting point isn‟t at the center of the frame.  

Auto-sequence 
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Figure 9.38: Enable auto-sequence checkbox 

With this option you can enable or disable the Auto-sequence that is responsible for producing 
automatically the embroidery sequence of the design that you are creating. It is an intelligent 
system that takes under consideration many parameters, and tries to produce the best possible 
embroidery results. It makes everything easier by saving you time and effort.  

This Auto-sequence option is enabled by default (checked). If you want to enable or disable the 
Auto-sequence the Optimizer options dialog you have to do it outside the Optimizer options 
dialog. 

On the Tools toolbar that is located in the left side of the software you will find a button with a 

lamp  on it. When this button is pressed, the Auto-sequence is enabled and the opposite when 
it is not. Therefore if you want to enable or disable the Auto-sequence you can do it directly from 
this button. The same option can be also, found under Tools menu. 

Whenever you disable the auto-sequence by clicking on the lamp  icon, the Run optimizer 
once dialog appears, that allows you to run the sequence optimizer only once or if you want not 
to run it at all and then give you the ability to re-sequence the embroidery design freely through the 
Sequence manager. 

 

Inside the Run optimizer once dialog you have three options: 

 Nothing (Leave design as is) 

By selecting this option and clicking OK button, the Optimizer will not be applied at all and 

the objects will appear on the Sequence manager exactly with the order that they have 

been designed. The Optimization strategy will not be applied and all the re-sequencing 

must be made from you though the Sequence manager. 

 Simple (Just re-arrange objects) 

By selecting this option and clicking OK button, the Optimizer will be applied once on the 

design, by making the appropriate changes and then all objects will appear on the 

Sequence manger. The produced embroidery sequence on the Sequence manager will 

depend on the settings you have selected inside the Tools>Optimizer options dialog.  

 Advanced (Re-arrange and modify objects if needed) 

By selecting this option and clicking OK button, the Optimizer will be applied once on the 

design but it will modify the objects if needed. This means that the Fills and Outlines will 

be separated and re-sequenced as different objects based on the selections of the 

Optimizer. More objects will appear on the Sequence manager that you will be able to re-

sequence freely.  
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The four options that are becoming available inside the Optimizer dialog after enabling the option 
are the Optimization strategy, the Keep sequence of overlapped objects even if trimmed, the 
No thread trims inside combined objects and the Minimize color changes. All of them affect 
the way that the embroidery design will be embroidered. For more information on how each option 
affects the embroidery sequence of the design, read below. 

Beside these options the Auto-sequence option affects also the way that the Sequence manager 
and the Sequence option are working. The Sequence option that is located at the bottom of 
Object Properties toolbar is disable automatically after disabling the Auto-sequence option and 
you cannot use it any more. 

Similarly if you disable the Auto-sequence option the Sequence manager changes completely 
and removes all the automatic optimizations of the software. The Sequence manager changes to 
manual mode and all re-sequencing must be made from you manually. More information on how 
the Sequence manager works in different modes, refer to the respective section of chapter 7.  

Optimization strategy 

 
Figure 9.39: Optimization Strategy 

This tool is available only if the Auto-sequence option is enabled. 

With this tool you can define the way that the objects of the embroidery design will be 
embroidered. It is like an automatic embroidering sequence creator. With this tool you can define 
the way/sequence in which the objects of the embroidery designs will be placed on the fabric. This 
tool is really important for embroidering hats which need to be embroidered from the center to right 
and left. Also, it is useful for delicate fabrics that need special care regarding the way that the 
objects will be placed on them. The embroidering options for defining the sequence of the objects 
are the following: 

 Top to bottom: When this option is applied the objects of the design will be embroidered 

from top to bottom. This means that Creative DRAWings will change the embroidering 

sequence and will begin embroidering the objects/shapes that are at the upper most 

position in the design and will continue with direction to those that are at the lower position 

in the design. 

 Bottom to top: This is the opposite of Top to bottom option. Therefore when it is applied 

on an embroidery design Creative DRAWings will change the embroidering sequence and 

will begin embroidering the objects/shapes from those that are located at the bottom until it 

reaches the top objects. 

 Left to right: When this option is applied the objects of the design will be embroidered from 

left to right. This means that Creative DRAWings will change the embroidering sequence 

and will begin embroidering the objects/shapes that are at the left most position in the 

design and will continue with direction to those that are at the right most position in the 

design. 

 Right to Left: This is the opposite of the Left to right option. Therefore when it is applied 

on an embroidery design Creative DRAWings will change the embroidering sequence and 

will begin embroidering the object/shapes from those that are located at the right most 

position in the design until it reaches the left objects. 
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 Small to large: When this option is applied Creative DRAWings orders the embroidering 

sequence from the smaller object of the design to the largest ones. 

 Large to small: This is the opposite option of the Small to large option. Therefore when it 

is applied on a design the objects/shapes of the design will be embroidered from the larger 

ones to the smaller ones. 

 Inside to outside: When this option is applied the objects of the design will be embroidered 

from inside to outside. This means that Creative DRAWings will change the embroidering 

sequence and will begin embroidering the objects/shapes that are at the middle of the 

design and continue with those that are at the outer positions of the design. This option is 

often used when embroidering designs on hats.  

 Outside to inside: This is the opposite option of the Inside to Outside option. Therefore, 

when it is applied on a design the objects/shapes will be embroidered from the outer to the 

inner ones. Creative DRAWings will check the current sequence of the design and will 

make recalculation in order to create one you have selected. 

Important:  Any changes on the Optimizer options dialog, affects, also, the Optimization 
strategy option. Therefore, always keep in mind that a combination of Optimizer’s options will be 
applied on the embroidery design and not only the selected Optimization strategy. With proper 
combination of options you can get the appropriate embroidery results.  

Keep sequence of overlapped objects, even if trimmed  

 
Figure 9.40: Keep sequence of overlapped objects checkbox 

This option is available only if the Auto-sequence option is enabled. 

This option is important for the embroidering sequence of the design. When this option is checked, 
all shapes of the vector design will be embroidered by keeping their overlapping order. This means 
that the order of the embroidery will follow the overlapping order of the vector design. By applying 
this option it will be possible to manage better the way that the design will be embroidered.  

Important: Changes that you make on the overlapping order of the Vector design are calculated 
accordingly by the software. The overlapping order will not be followed as it is because more filters 
are applied on the design, which affect the embroidering sequence.  

No thread trims inside combined objects  

 
Figure 9.41: No thread trims inside combined objects checkbox 

This option is available only if the Auto-sequence option is enabled and does not allow any 
thread trimming between combined objects. This option applies only to objects that are combined 
(not grouped).  

In order to use this option properly you have to go to Draw mode  of Creative DRAWings, 
select the objects you want to combine and apply the Combine option from the right click menu. 
The objects will become combined and react as one object, inheriting all the attributes of the last 

selected object. If you try to embroider the design in the stitch button , you will view the 
combined objects (like text art objects) to be connected with a jump-stitch between them. With the 
No thread trims inside combined objects option checked, all combined objects will be 
embroidered with jump-stitches between them, even if you have set Trimming distance between 
objects option to shortest distance.  
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If you leave the value of No thread trims inside combined objects unchecked, all thread trims 
will be calculated normally. 

Note: Combined object: An object created by combining two or more objects and converting them 
into a single curve object. A combined object takes on the fill and outline attributes of the last 
selected object.  

Minimize color changes 

 
Figure 9.42: Minimizing color changes 

This option is available only if the Auto-sequence option is enabled. 

This option is important for limiting color changes in the embroidery production process. Color 
changes have to do with thread changes that the embroidery machine makes in order to 
embroider each stitch design object. With more color changes the embroidery design sequence is 
followed more accurately but the production process is longer. On the other hand with fewer color 
changes, the embroidery design sequence changes to fit the Minimizing color change settings but 
gives shorter production process. The alteration in the embroidery design sequence might produce 
inaccurate embroidery results, or might not. This depends on the embroidery design, embroidery 
machine and the fabric. You can adjust color changes through the use of the track bar.  

Track bar 

 

1. Click to increase three scale units.  
2. Drag to move to the point you want.  
3. Click to decrease three scale units. 
 
Also, you can change the value of the track bar by pressing the Left & Right arrows of the 
keyboard.  

 

Any adjustments you are making are for your current design. If you want your adjustments to be 

stored as default, click on the Save as default button  in the Optimizer tab.  

In case you have changed the default Creative DRAWings settings with your own and you want 

to restore them, you can click on the Restore factory defaults button  

In case you have changed the settings of Optimizer and you want to return to your previous Saved 

as defaults settings, you have to press the  button. This function will restore the last 
saved setting that you saved by clicking on the Save as defaults button. 
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Chapter 10 - Embroidery sequence 

Introduction 
In this chapter we will analyze the tools that the software includes to adjust the embroidery 
sequence of the designs you are creating. Creative DRAWings software includes automatic and 
manual tools for producing the embroidery sequence. You can combine the different available 
tools and produce the embroidery results you prefer.  

Automatic Embroidery sequence 
Creative DRAWings embroidery software includes an automatic sequencing mechanism that 
produces great results based on the sequencing options that you have set. There are three tools 
that are responsible for adjusting the automatic embroidery sequence. These tools are the Auto-
sequence tool, the Sequence tool and the Sequence manager. With these tools you can adjust 
the automatic embroidery sequence that is produced from the software.  

Enable Auto-sequence 

The Auto sequence tool  is located at the bottom of the Tools toolbar and by default is 
enabled. This means that any design that you are converting or creating from scratch will have its 
embroidery sequence automatically produced according your preferences. The Auto sequence 
tool has some options that you can adjust through Optimizer options dialog that you will find 
under Tools menu.  

 

The Auto-sequence option is checked and all its options can be set to different values. The 
options that you can adjust are the Optimization strategy, the Keep sequence of overlapped 
objects, even if trimmed, the No thread trims inside combined objects and the Minimizing 
color changes.  

 Optimization strategy: With this option you can define the way that the objects will be 

embroidered. It is an automatic embroidering sequence creator. With this tool you can 

define how the objects of the embroidery designs will be placed on the fabric. The 

embroidering options for defining the sequence of the objects are the following: Large to 

small, Small to large, Left to right, Right to left, Top to bottom, Bottom to top, Inside 

to outside, Outside to inside. All these options do exactly what their names specify on the 

objects of the embroidery design. Therefore based on how you want your embroidery 

design to be embroidered you have to select the respective Optimization Strategy.  
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 Keep sequence of overlapped objects even if trimmed: This option is important for the 

embroidery sequence of the design. When this option is checked, all shapes of the vector 

design will be embroidered by keeping their overlapping order. This means that the order of 

the embroidery will follow the overlapping order of the vector design. This filter has effect, 

even if you have tiny areas overlapping between objects and even if the software decides to 

add thread trims between them. If this option is unchecked the software will rearrange the 

objects to match better the optimization strategy and the other optimization options you 

have selected.   

 No thread trims inside combined objects: This option, when it is checked, does not allow 

any thread trimming between combined objects. This option applies only to objects that are 

combined (not grouped) in the Designer mode  of Creative DRAWings.  

With the No thread trims inside combined objects option checked, all combined objects 

will be embroidered with jump-stitches between them, even if you have set Trimming 

distance between objects option to shortest distance.  

If you leave the value of No thread trims inside combined objects unchecked, all thread 

trims will be calculated normally and will re-sequence the objects based on the selected 

Optimization strategy and the other optimization option you have selected(like the 

Trimming distance between objects). 

 Minimize color changes: This option is important for limiting color changes in the 

embroidery production process. Color changes have to do with thread color changes that 

the embroidery machine makes in order to embroider each embroidery object. With more 

color changes the embroidery design sequence is followed more accurately but the 

production process is longer. On the other hand with fewer color changes, the embroidery 

design sequence changes to fit the Minimizing color change settings but gives shorter 

production process. This option will do its best to minimize the color changes but it cannot 

alter the overlapping order of the objects in order to make one color change for each color 

used. Also, the decisions that this option makes are related with the other optimizing tools 

such as the Optimization strategy option, trimming distance between objects option, 

the Keep sequence of overlapped objects even if trimmed option and the Sequence 

option from Object properties toolbar.  

It is important to keep in mind that all optimizing options are related and the embroidery sequence 
is calculated based on all optimizing options and not only to a specific one. Whenever you set the 
optimization settings you have to consider how the change you are making will affect the 
embroidery sequence by keeping in mind all the other optimizer settings. You can view the results 
of the changes that you are making through the slow redraw functionality (you will find in the Tool 
toolbar) which is simulating the embroidering process of the design that you are creating. 

Sequence tool 

The Sequence tool has the functionality to order specific objects or set of objects to be 
embroidered at the beginning or at the end of the embroidering process. The Sequence tool 
appears at the bottom of object properties toolbar whenever you select an object or a set of 
objects.  

The Sequence option gives you three possible abilities: To start, To end and Auto. By default the 
Auto option is selected that lets the software decide the embroidering sequence of the design. If 
you want an object to change order and be embroidered first or last in the embroidering sequence 
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you have to use, respectively, To start or To end option. In case you have selected multiple 
objects and set them To start or To end a different procedure will take place. Creative DRAWings 
will manipulate the objects that, for example, are set To start, move them to the beginning of the 
embroidering sequence and decide automatically the order of those To start objects. Therefore, 
the objects you have set to be embroidered To start will be embroidered first but with the order 
that Creative DRAWings will decide based on the other settings that you have set on the 
Optimizer options dialog. The same will happen if you set multiple objects to be embroidered To 
end. The software will manipulate those objects and move them at the end of the embroidering 
sequence but the order will be automatically decided. The objects that remained with the default 
Auto sequence option will be embroidered after the To start objects and before the To end objects 
with order automatically decided by the software. Therefore, you can re-sequence the objects of 
the design by creating three groups: Those that will be embroidered first (To start), those in the 
middle (Auto) and those that will be embroidered at the end of the object. If you do not make any 
change on the sequence option, Creative DRAWings will automatically create the best possible 
embroidery sequence for you based on the other settings that you have set on the Optimizer 
options dialog. 

Every time you want you can simulate the embroidery sequence of the design through Slow 
redraw tool and decide if you need to make more changes on the embroidery sequence. The 
Sequence manager bar cannot help you with the embroidery sequence when the Auto 

sequence  is enabled.  

Sequence manager - Auto 

The Auto-sequence, affects the way that the items of sequence manger will be viewed. When 
Auto-sequence is enabled the program automatically decides the sequence of all stitch objects, so 
you don‟t have any control of the sequence of the design items via sequence manager in this 

case. All normal stitch  objects will be shown as one object on the Sequence manager and 
there will be no separation between its sub-objects. The only items that are separated are the 

Appliqué , the Cross-stitch , the Photo-stitch  and the imported stitch file  objects. 
These objects can be re-sequenced normally by click and dragging them to a new position on the 
sequence manager. This is allowed because these kind of objects are totally different from normal 
stitch objects and they need special care when they are embroidered.  

The program is using intelligent mechanisms that automatically decide the sequence of the stitch 
objects and it does not give you any kind of control in the order that they will be embroidered 
through the Sequence manager.  

Manual Embroidery sequence 
Creative DRAWings embroidery software includes a manual sequencing mechanism that gives 
you the ability to re-sequence the design freely based on your preferences. The software by 
default uses the automatic sequencing option that is very useful for inexperienced users and for 
those who are not familiar with embroidery sequencing. To switch to manual mode you have to 

turn off the Auto-sequence  tool from Tools toolbar and the available options will appear. 

Disable Auto-sequence 

If you want to disable Auto-sequence and use the manual way of setting the embroidery sequence 

of the design you are creating you have to click on the lamp  icon or uncheck the Auto-
sequence option from the Tools>Optimizer options dialog.  
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Whenever you disable the auto-sequence by clicking on the lamp  icon, the Run optimizer 
once dialog appears, that allows you to run the sequence optimizer only once or if you want not 
to run it at all and then give you the ability to re-sequence the embroidery design freely through the 
Sequence manager. 

 

Inside the Run optimizer once dialog you have three options: 

 Nothing (Leave design as is) 

By selecting this option and clicking OK button, the Optimizer will not be applied at all and 

the objects will appear on the Sequence manager exactly with the order that they have 

been designed. The Optimization strategy will not be applied and all the re-sequencing 

must be made from you though the Sequence manager manually. Experienced users will 

find this very helpful and they will be able to do whatever they like without any automation. 

Although it is important to know that if you trace a bitmap image with many different colors 

you might end up dealing with thousands of objects that are very difficult to manage.  

 Simple (Just re-arrange objects) 

By selecting this option and clicking OK button, the Optimizer will be applied once on the 

design, by making the appropriate changes and then all objects will appear on the 

Sequence manger. The produced embroidery sequence on the Sequence manager will 

depend on the settings you have set in the Auto-sequence sub-section that you will find 

inside the Tools>Optimizer options dialog. This is very useful because the software will 

do the hard work for you by applying the Optimization strategy you prefer and leave you 

only minor sequence changes to make on the final embroidery result. 

 Advanced (Re-arrange and modify objects if needed) 

By selecting this option and clicking OK button, the Optimizer will be applied once on the 

design but it will modify the objects if needed. This means that the Fills and Outlines will 

be separated and re-sequenced separately based on the selections of the Optimizer. More 

objects will appear on the Sequence manager that you will be able to re-sequence freely. 

The produced embroidery sequence on the Sequence manager will depend on the 

settings you have set in the Auto-sequence sub-section that you will find inside the 

Tools>Optimizer options dialog. The only difference with the Simple sequence option that 

is described above is that the fill and the outline objects are manipulated and rearranged 

separately for ultimate sequencing results. The only thing that you must keep in mind is that 

more objects will be produce that will make re-sequencing more difficult, especially on 

traced bitmap objects. 
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Important: Despite switching the embroidery sequence to manual, all options inside Optimizer 
options dialog which are not listed under the Auto-sequence option, will not be calculated from 
any of the above manual sequencing options, until you save the design to stitch file(.dst,.pes, etc.) 
or export the design to Wings‟ modular or use the slow redraw functionality to simulate the final 
embroidery result. This means that Appliqué frame-out distance, the Trimming distance 
between objects, the Trimming distance in Cross-stitch and the End points at closest 
connection, even on trims options will not be calculated while enabling or disabling Auto-
sequence functionality.  

Sequence manager - Manual 

To have full control of the ordering of all stitch objects you can disable Auto-sequence. This can be 

easily done by pressing Auto-sequence icon  on Tools toolbar. The Run optimizer once 
dialog will appear allowing you to select one of the two embroidery optimizing options or not 
optimizing the design at all. By selecting any of the three options and clicking OK, the Auto-
sequence will be disabled and all design items will become separate icons on sequence manager. 
By clicking and dragging any item you can change its order. You have the full control of the 
embroidery sequence and all the intelligent mechanisms have been disabled.  

If the design is coming from a clear vector artwork the objects will be few and you will not have 
problem re-sequencing the design. On the other hand if the design is coming from a traced bitmap 
the number of objects will vary from few, up to thousands that will be difficult to manage and 
handle. Therefore, you must be cautious on how to use the manual sequencing tool and you must 
always be prepared to manage large numbers of objects. For this purpose Creative DRAWings 
has many tools that allow you to select objects by color (outline, fill, or both) or by stitch type 
and make re-sequencing easier. 

To Re-sequence objects from Sequence manager bar is very easy. The only thing you have to do 
is to select the object(s) you want to re-sequence by using any of the numerous selection methods 
that Creative DRAWings includes and then by clicking and dragging on the sequence manager 
move the object(s) to its new position. The result of the re-sequence will be visible directly on the 
working area. If you do not like the results or you think that you made a mistake, you can Undo 
(Ctrl+Z) the last action you made and try to re-sequence the objects once more.  

It is important to remember that while re-sequencing, some objects might change as a result of the 

Remove overlap functionality that is applied automatically. The Remove overlap option that is 

located on the object properties toolbar removes unneeded parts of the design that are 

positioned underneath of other objects in order to reduce the embroidery stitch count and 

thickness. It does not remove them permanently like the Trim tool does, but it holds the artwork 

information until you save the design to stitch file (.dst, .pes, etc.) or export it to Wings‟ modular. 

Therefore, you might move a large object from the bottom of the design (that looks like a 

border/outline because of the Remove overlap functionality) and place it on top, but once you do 

that you find out that it changes to a large fill object that covers all the other objects. To overcome 

that you have to use the Trim tool first from the standard toolbar, in order to trim the bottom object 

and then re-order it. All these are automatically calculated when you are enabling the Auto-

sequence functionality.   
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Chapter 11 - Settings 

Introduction 

In this chapter we will analyze all the options that Creative DRAWings have and how you can 
adjust 3D settings. In addition, you will learn about the Security key and how you can customize 
your working area.  

Options 

There are several adjustments that can be made in Creative DRAWings. Most of them are in the 
Options dialog box which can be opened from the menu Tools > Options or from the shortcut key 
Ctrl+T. In the dialog box that appears you can adjust the properties in each menu tab.  

General  

 
Figure 10.1: General options  

In the General options tab you can adjust the Undo levels the Measurement system and select the 
Language you want to Creative DRAWings menus.  

You can increase or decrease the programs Undo level according to your needs. Note that high 
undo levels acquire more systems memory.  

In addition you can change the Measurement system of the program from Metric (mm) to U.S. 
(inches) and vice versa.  

With the Autobackup steps option you can set after how many of your actions an autobackup will 
occur. For example, if Autobackup steps is set to 5, the software will take a backup every 5 
changes you are making to your design. 

Tools 
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Figure 10.2: Tools options  

In the Tools tab you can change some options of the lasso selection tool and the movement step 
of object. 

If you check the Allow polygon selection with lasso you will activate and extra feature of lasso 
tool. This feature lets you draw straight-edged segments of a selection border. To draw a straight-
edged selection border in your design, click with the lasso tool active where segments should 
begin and end trying to draw a polygon. When your last straight-edge of your selection reaches 
the beginning point then your selection polygon will be created activating all the design objects 
that surrounds.  

If you check the Make lasso default selection tool option the lasso tool will become your default 
selection tool. 

In the Selection movement step field you can specify the distance you want an object to be 
moved each time you press the arrow keys from the keyboard. The default step movement is 
1mm. 

Monitor 
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Figure 10.3: Monitor Options 

In the Monitor tab you can define the actual width of your monitor. This is important if you want to 
view your stitch designs in their actual size when 100% zoom selection is clicked from the 
standard toolbar. In order to find your monitor‟s width you can measure the visible area with a 
ruler. The result of your measurement must be entered in the text field Visible area at the right 
metric format. Another way to define your monitor‟s width is by knowing the size of your monitor in 
inches, and simply clicking on the respective monitor preset size button. The program will 
automatically set your monitor‟s width. Finally using Auto Detect option the program will try to 
detect automatically the size of your monitor. In order to activate your changes you have to click 
Ok at the Options dialog box.  

The next time you try to view your stitch design in 100% zoom, the size of your design will be the 
actual one. 

View  

 

 
Figure 10.4: View Options 

In the View tab you can adjust the way that you are viewing toolbars in Creative DRAWings. In 
the View tab you can change the Stitch type icons from the object properties toolbar and the List 
icons of styles, patterns and standard toolbar.  

Stitch type 

 Icons: From this drop down menu you can select if you want view the stitch type icons of 

the object properties toolbar small or large. In order to activate it you have to click on the 

drop down menu and select one the two options.  

 Text: From this drop down menu you can select Show text labels, Selective text on right 

and No text labels. If you select the Show text labels option you will view the name of 

each stitch type under their icons in the object properties toolbar. If you select the Selective 

text on right option you will view the name of each stitch type at the right side of their 

icons. Finally, if you select the No text labels option each stitch type name will be removed. 

Therefore by making the preferred adjustments you can view the icons and their labels in 

the way you prefer. 
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Lists 

 Styles icon size: In this numeric field you can specify the size of the Styles icons of the 

Object properties toolbar. The number of this field shows the pixel size of the icons. You 

can enter the exact size you want or you can adjust size by clicking the arrows next to the 

value or by clicking on the value and rotating the mouse wheel if there is one. The size 

of the Styles icon cannot be more than 64 pixels. 

 Patterns icon size: In this numeric field you can specify the size of the Pattern icons of the 

Object properties toolbar. The number of this field shows the pixel size of the icons. You 

can enter the exact size you want or you can adjust the size by clicking the arrows next to 

the value or by clicking on the value and rotating the mouse wheel if there is one. The 

size of the Styles icon cannot be more than 128 pixels. 

 Other icons: From this drop down menu you can view the other icons of the object 

properties toolbar Small or Large. In order to activate it you have to click on the drop down 

menu and select one the two options, click OK and restart Creative DRAWings.  

Finally, there is the Defaults button that restores the default values in the View tab. 

To apply all the adjustments you have made in the View in Creative DRAWings workspace, you 
have to click on the OK button of the Options dialog and restart Creative DRAWings. The next 
time that you will start Creative DRAWings all the changes you have made will take effect 
immediately.  

3D properties 

 
Figure 10.5: 3D properties 

In the 3D properties tab you can adjust the 3D preview of your stitch design. You can define 3D 
acceleration Driver, 3D graphics parameters and 3D graphics quality. The options of this tab are 
very technical. The best way to adjust your 3D graphics is from the three preset buttons in the 
Quality functions section. You can choose between three 3D quality options: Fast, Quality and 
Safe. 
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 If you click the Fast button, your 3D quality will be set automatically to minimum. This 

means that you lose 3D quality but gain in program‟s speed. 

 If you click the Quality button, your 3D quality will be set automatically to maximum. This 

means that you gain in 3D quality but lose in program‟s speed. 

 If you click the Safe button, your 3D quality will be set automatically in the most reliable 

way. This means that you lose 3D quality but gain in program‟s speed and reduce 

compatibility problems with your graphics card. 

In the same dialog there is also the Enable thickness view option that if is checked, activates the 
Thickness view option that can be enabled from the View menu. 

Make your selection and click Ok to confirm your changes. The changes will be applied the next 
time that the program will start.  

Printing 

 
Figure 10.6: Printing Options  

In the Printing tab you can adjust the Printout fonts, the Size of text and Printout parameters.  

In the Printout fonts option you can define which True Type font the printer will use for printing and 
which Vector font the plotter for printing. 

Also in the Size of text option you can specify the size of the fonts in the printout. Click on the drop 
down menu and select a size. 

In the Printout parameters you can define the DPI (Dots Per Inch) of your design‟s bitmap and the 
Company‟s name. Defining the DPI of the design bitmap is important for the printout‟s quality. The 
DPI‟s value that must be placed in the Design bitmap DPI field should be around half the printers 
DPI. For example, on a printer with 360 dpi, you can set the value from 120 to 180 dpi.  

In the Company‟s name field you can add the name of the company you want to view in your 
printout. 

Creative DRAWings 3D config 

Creative DRAWings uses advanced 3D graphics to preview the embroidery designs that is why a 
good graphics card is a prerequisite for running it. Before you start working with Creative 
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DRAWings you can adjust the 3D properties, to be optimized for your system. Setting the 3D of 
the software is really important because there might be a case that Creative DRAWings would 
not start because of the current 3D settings.  

Creative DRAWings 3D config can be found under Start>All programs>Creative DRAWings 
startup folder. The following dialog box will appear.  

 
Figure 10.7: Creative DRAWings 3D setup  

From the dialog you can select the Technology you want to use, optimize the 3D settings and 
view useful technical information about your graphics card.  

 Select Technology: From this part of the dialog you can select between the two 

technologies that Creative DRAWings supports. DirectX 9.0C or newer option is the 

default 3D technology that Creative DRAWings uses and requires DirectX 9.0c or newer to 

be installed to your PC in order to work properly. In most of the cases this is the option that 

must be selected in order Creative DRAWings to produce high quality 3D preview.  

The other option you have is OpenGL that can be used only in graphics cards that supports 
it. In order to find out you have to select the OpenGL option and from the Info list that 
appears when you click on the Advanced button, check if the “Supports OpenGL” option 
from the “Property” list, has the “Value” Yes. OpenGL option can be used as alternative 
way of viewing 3D in Creative DRAWings. It is an option that we suggest to use it in case 
that your graphics card has problems with Direct3D graphics. In both cases you have to 
keep always the drivers of your graphics card up to date, by downloading them from the 
official site of their manufacturer. If you have a laptop computer you have to download the 
drivers for your graphics card from the official site of the laptop manufacturer. 

 Optimize settings for: The options that are listed in this area has to do with the quality of the 

3D preview of stitches in the stitch part of Creative DRAWings. The options are Stability, 

Speed, Quality and High Quality. By selecting Stability, the 3D preview of the software 

will be set at the lowest level of quality giving priority to performance. By selecting Speed 

the 3D preview of the software will be set at medium level of quality together with good 

performance. By selecting Quality the 3D preview of the stitch part of Creative DRAWings 
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will be set at good level of quality without affecting its performance. Finally, by selecting 

High Quality the 3D preview will be set to the best possible according to your graphics 

card. 

The 3D settings that Creative DRAWings will select depend on the power of the graphics 
card you have installed in your computer. All the features of your graphics card are listed in 
the Info area that appears when you click on the Advanced button. 

 I usually open: In this section of the dialog you can define how many instances of Creative 

DRAWings you are usually create. The instances of Creative DRAWings that you have 

open are connected directly with the power of your graphics card. If you have a good 

graphics card, you can have many instances of Creative DRAWings with High quality 3D 

preview. On the other hand, if you do not have a good graphics card you can open fewer 

Creative DRAWings instances.  

The Few concurrent Creative DRAWings windows option will keep the quality of 3D 
preview high in a way to allow you to open fewer Creative DRAWings instances. In 
contrast, the Many concurrent Creative DRAWings windows option will set an average 
quality to the 3D preview but will allow you to open many instances of Creative 
DRAWings. Select the one that fits to your everyday use of the software and let it choose 
your 3D settings. 

When you finish setting 3D you have to click on the Save User settings button to confirm the 
changes you have made. By clicking on the Save User settings button, the 3D settings that you 
have selected will be applied only on the current Windows® user. If you click on the Save Global 
Settings button, the 3D settings that you have selected will be applied to all Windows® users. The 
next time that Creative DRAWings will start will have the new 3D settings running. If the software 
does not start you have to reduce the quality of 3D in Creative DRAWings 3D setup, save the 
settings and try again.  

When you click the Advanced button the Info will appear where the “Video card capabilities” are 
listed.  Those are technical information about the graphics card that is installed in your computer. 
The list with all the information can be sent via email by clicking on the Send via e-mail button. 

If your graphics card has 128 Mb RAM and above with the latest drivers and the DirectX 9.0C or 
later installed, there will be no problem in working with Creative DRAWings.   

Security Keys 

 

Figure 10.8: Security Keys dialog 

Creative DRAWings need a USB security key to run for copyright and security reasons. The key 
contains a serial number that allows the program to run in different levels and be upgraded to 
newer versions. More details about the level of the program can be found in the Security Keys 
dialog box. This shows the level of the program, the program‟s code and includes some 
functionality, which can be used for changing levels and upgrading to newer versions.  
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In the Level area you can view the available levels of the software. There are no currently 
available higher levels for Creative DRAWings. All levels are included in the package. In the Old 
code text field the security key code is displayed and in the New code text field a new code can be 
added, which will upgrade Creative DRAWings to a newer version. More specifically, if you want 
to upgrade Creative DRAWings, you can purchase an upgrade code, enter it in the field and 
Update your program by clicking on the respective button. The software will be upgraded after 
restarting the software.  

The Key form button displays all the information you will need to upgrade your software. If you 
decide to upgrade your software to a newer version you might be asked to send the Key form to 
your reseller. 
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Chapter 12 - Creating embroidery designs 

Introduction 

In this chapter you will learn all the procedures you have to follow in order to create embroidery 
designs with Creative DRAWings. We will start from setting the parameters of the software, we 
will continue analyzing how to create and edit embroidery designs, we will show you how to set 
some embroidery parameters for better embroidery results and end up by analyzing the process 
from saving the design until embroidering it. All this information will help you to understand how 
Creative DRAWings works and how easy is to create embroidery designs in matter of seconds. 
To understand better what is described in this chapter you must read the previous chapters first 
and be familiar with the tools that Creative DRAWings includes.  

Setting up the workspace  

Inside Creative DRAWings you can customize the workspace by using the tools that are provided 
for this reason. Some adjustments are needed to be made in order Creative DRAWings to fit your 
preferences and run with the best possible settings. You can change the 3D setup for better 
quality or faster response, change the size of the toolbar icons, change the measurement type and 
set the size of your monitor for actual size preview.  

Customize 3D setup  

Before even start Creative DRAWings, you can adjust the 3D preview of Creative DRAWings in 
order to work in the best possible way according your graphics card capabilities. This is an 
important tool because it allows you to customize the 3D settings according your needs and 
preferences. Therefore, if you have a fast graphics card you can set the quality of 3D in the 
highest level without losing performance when you work in multiple instances of Creative 
DRAWings. Also, you can choose to decrease the quality of graphics to increase performance. All 

these adjustments can be made from Creative DRAWings 3D Setup that can be found 
under Start>All programs>Creative DRAWings startup folder or from the 3D properties tab in 
the Tools>Options dialog.  

With Creative DRAWings 3D Setup you can change 3D settings without opening Creative 
DRAWings and you can choose between Stability, Speed, Quality and High Quality. Each 
option gives to the software the feature that is describing by taking under consideration the 
graphics card of the current system.  

Similar options you have at 3D properties tab of Tools > Options dialog where you can 
additionally change more specific 3D settings, like Antialias and Drop shadows. We recommend 
using one of the prefix settings by clicking on one of the Fast, Quality and Safe options. When 
you find the one that fits best to the way you are using Creative DRAWings, apply it and work 
with it.  

From Creative DRAWings 3D setup the settings that we propose is DirectX 9.0C or newer 
technology with Quality optimization settings and from 3D properties the Quality button settings. 
You have to use one of the two possible options to set your 3D preview in Creative DRAWings. 
The settings that you will choose will affect also the number of Creative DRAWings instances that 
you can have open at the same time.  

More about 3D setup in chapter 11. 

Change toolbar icons 



Creative DRAWings Embroidery Software Manual 
 

269 Chapter 12 - Creating embroidery designs   DRAWstitch Ltd.  
  

In the Create and stitch tab of Creative DRAWings you can change the sizes of the toolbars‟ 
icons. By changing the size of the icons you can customize the workspace you are working 
according the screen resolution of your system and your viewing preferences. You can do that 
from the View tab of Tools > Options dialog. 

From the Stitch type section you can adjust the size of the stitch type icons from Large to Small 
or the opposite. Also, you can select if you want to view text under the icons, at the right side of 
the icons or not to view any text. 

From the Lists section you can adjust the size of the rest Object properties toolbar icons. 

Select the sizes you prefer click OK and restart Creative DRAWings. You can change the size of 
icons as many times as you want until you are satisfied with the workspace you are viewing. 

More about setting the size of icons in chapter 10. 

Set monitor size 

Another important thing that you have to adjust in stitch mode of Creative DRAWings is the size 
of your monitor. If you insert the exact measure size of your monitor every time you select the 
100% zoom preset from the standard toolbar you will view the actual size of the embroidery 
design on the screen. Therefore, it would be easier for you to visualize the exact size of the 
embroidery design and change them, if needed, from the Create or stitch mode of Creative 
DRAWings.  

In order to define the size of your monitor you have to select the Monitor tab from the Tools > 
Options dialog. After that, measure the width of your monitor with a ruler to find the exact visible 
area. Enter the measure value in the Visible area field in the requested measure format and click 
„OK‟ to apply changes. The monitor will be immediately set to the right size and every time that 
you select 100% preset zoom you will view the actual size of the design. 

The other option you have in defining the size of your monitor is to choose one of the preset 
dimensions that are listed in the dialog (17”, 19”,…) or just use the Auto Detect mechanism that 
will try to find automatically the size of your monitor. 

More about setting the size of the monitor we have discussed in chapter 10. 

Set measurement system 

Creative DRAWings has metric as the default measurement system, but gives the ability to you to 
change it to inches. This is important for those who want to view the sizes in their local 
measurement system. The measurement system can be immediately changed from the General 
tab of Tool>Options dialog. From the Measurement system drop down menu you can select 
between Metric or US (inches), click „OK‟ and apply the changes.  

There are more adjustments that can be made in Creative DRAWings that we have discussed in 
Chapter 11. When you finish setting up Creative DRAWings you can continue with the creation of 
embroidery designs.  

Creating and editing embroidery designs  

Creating embroidery designs in Creative DRAWings is the easiest part. You can import a design 
from the starting dialog and the software will convert it to stitches immediately. Creative 
DRAWings analyzes the imported design and sets stitches with the appropriate stitch type on 
each object. It uses artificial intelligence and knowledge of experts in the embroidery field, and 
produces high quality embroidery results.  

To start embroidering in Creative DRAWings, import a design in Creative DRAWings from the 
starting dialog or create a design from scratch and convert it to stitches in the stitch mode. To 
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import the design in the Create mode you have to open a new instance of Creative DRAWings 
and from the starting dialog double click on Create New and then the From file option, find the 

design you want to embroider by clicking on the browse  icon, continue the dialog by selecting 
fabric and end up with your design immediately converted to an embroidery design. If the design 
that you will import is a bitmap (.jpg, .bmp, .tiff, .gif, etc.), a scanned image or a capture from the 
webcam, you can decide if you want the design to be converted to a cross-stitch design, photo-
stitch design, to be traced and filled with normal embroidery or be imported as backdrop. If it is a 
vector design (.cmx, .svg, .ai, etc.) the design will be converted to normal embroidery design with 
satin, step, Row Fill or appliqué fills and running or satin serial border outlines.    

Also, you can create the design you want from scratch by using the available tools and convert it 
to stitches. To create a design from scratch in the Create mode you have to open a new instance 
of Creative DRAWings and from the starting dialog double click on Create New and then the 
New graphic option. Follow the dialogs and the working space in Create mode will appear. Use 
the available designing tools from the Tools toolbar and create the deign you want to embroider. 
The designs that you can create are Text art designs, Line art designs and designs that are based 
on standard shapes. Generally most of the designs you can think of, can be designed in the 
Create mode of Creative DRAWings.  

Import embroidery file 

Inside Creative DRAWings you can also import embroidery files. You can import them as it is and 
if you want convert them to Vector artwork. You can import an embroidery file only from the 
starting dialog of Creative DRAWings, by selecting the design you want to import and importing it 
on the working area. With the From embroidery option you can import a stitch file format like 
“.ngs”, “.dsz”, “.pes”…and Creative DRAWings will import it as it is. With this tool you can import 
your readymade embroidery designs as they are or convert them to vector designs, make any 
changes you want and embroider them again.  

Limited changes can be made on the embroidery files, if they are not converted to artwork, but you 
will be able to draw new objects and produce a new embroidery design based on an old one. The 
imported embroidery file will not be visible in the Create mode unless the Stitches and the 3D 
preview options of the View menu are enabled. Once the embroidery file is visible in the Create 
mode you can make some limited transformations by using the available tools. You can rotate it, 
slant it, change colors, reposition its objects, add new objects or text and generally create a new 
design using an old one. On the imported file you cannot make any embroidery adjustments such 
as change stitch type, change direction of stitches or use the divide tool. Generally you cannot 
make any embroidery transformations of the design because the imported file contains only stitch 
data that are fixed and cannot be changed. The only way you can change the stitch type and edit 
the stitch objects extensively, is to convert them to vector artwork.  

To convert the embroidery file to vector artwork you have to import it first inside Creative 
DRAWings, select the objects you want to convert(or the entire design), right click on them, and 
from the right click menu select the Convert to curves option. The stitch objects will automatically 
be converted to vector objects allowing you to redesign then and create a new embroidery design 
by using the artwork of the old design. You can edit the Vector artwork that will be produced like 
any vector artwork that it is imported inside Creative DRAWings. The available editing tools 
together with your creativity will help you produce the artwork you want to embroider.  

Select hoop 

On the working area of Creative DRAWings you can view the hoop that you have selected from 
the starting dialog. If the hoop was not the one you wanted you can change it with another existing 
one or you can create a new hoop that looks like the one you willing to use. You can change the 
hoop by selecting the Change hoop option from Tools menu. From there you can select to use an 
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existing hoop or create a new one that will have the same dimensions with the one that you will 
actually use to embroider the design. If the hoop that you will use is oblong and your design too 
big to fit in the hoop horizontally, you can rotate your hoop 90o degrees from the same dialog and 
the design will fit. The software will automatically recognize the rotation and will save the design 
rotated in order to fit to your hoop. The rotation will appear also in the printout of the design.  

The hoop that you will use inside Creative DRAWings must be selected carefully because if the 
design is larger from the hoop, the needle carrier will hit the hoop and will be destroyed.  

Change fill  

Inside Creative DRAWings you can edit the embroidery design by changing fills, applying 
patterns and styles and create unique combinations. Changing the fill of an object is very simple in 
Creative DRAWings. First, you have to select the object you want to apply different fill by using 
any of the selection tools or by simply clicking on the object. The object will become selected and 
all the current properties of the embroidery design will appear on the Object properties toolbar. If 
the selected object is filled with step stitches you can change it to Row Fill or satin stitch type or 
even appliqué by simply clicking on the stitch type. The new stitch type that you have selected will 
replace the old one in the preview area and on the object properties toolbar will appear the 
properties of it. Every time you change a stitch type the properties of it are set to default. You can 
change them by applying different patterns or styles on the design that you can select from the 
respective lists. Whenever you select a pattern or style it is directly applied on the object where 
you can preview it before embroidering it.  

The big objects of the embroidery designs are usually set to step stitch type and the smaller to 
satin. You have to avoid setting satin stitch type to large objects because the embroidery result 
would not be appropriate. Satin stitches are usually placed in smaller objects and letters. Most of 
the time overlapping satin objects are not trimmed and embroidered over the objects that are 
placed on, making the embroidered design more relief and giving a 3D perspective. The way of 
embroidering style differs from embroiderer to embroiderer. You can use your own way to 
embroider your designs.  

If you want to place appliqué on an embroidery design, you have to select the object you want to 
replace with appliqué and select Appliqué from object properties toolbar. The object will be filled 
with an appliqué fabric with color same with the color of the object. If the object has a border 
outline (running, satin serial), extra holding stitches will not be added. Otherwise, the default 
holding stitches will be e-stitches. You can customize the holding stitches of appliqué by adding a 
border outline to the object, from the Create mode, that will be converted to running stitches at 
stitch mode. On running holding stitches you can apply a style you prefer and create artistic 
holding stitches that will change totally the look of the design. 

The most difficult stitch type fill to edit is cross-stitch. Creative DRAWings can convert bitmaps 
images to cross-stitch designs. If you want to set normal stitches (satin, step, Row Fill) on a 
bitmap you have to convert it first to vector graphics using a bitmap tracer that is also available. 
The bitmap tracer that you can use is automatically activated whenever you import a bitmap image 
from the starting dialog and it is one of the three import options you have. After tracing the design 
and producing a vector design with fewer objects possible, the design is imported in Create mode 
where you can export it to .svg vector file format or embroider it normally by clicking on the stitch 
mode. Whenever you try to trace a bitmap keep in mind that the image that you will produce is for 
embroidering purpose and not for screen printing. Also, not all bitmap images can be converted to 
accurate vector designs and then to normal embroidery. The only way to set stitches on a bitmap 
and embroider the actual image is by applying cross-stitches or Photo-stitch on it.  
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Cross-stitch designs can be edited inside Creative DRAWings easily. Every time you select the 
cross-stitch design, its properties appear on the object properties toolbar. There you can change 
the cell size of each cross and the number of times that the cross will be embroidered.  

In addition from the background colors list, which contains all the colors that are currently on the 
cross-stitch design, you can select which ones you do not want to be embroidered and remove 
them from the design. This ability is really helpful when you do not want to embroider the 
background color of the bitmap design you have inserted. Most of the times bitmap images are in 
rectangle shapes that are entirely filled with different colors. Some of those colors, for example the 
background of a portrait image or other environmental objects, can be easily removed from the 
cross-stitch embroidery by selecting the color that represents the specific object from the 
background list.  

In order to increase the detail of the cross-stitch design you have to either increase the size of the 
bitmap or decrease the cell size of the cross-stitch. This will have as result in the first case a big 
highly detailed cross-stitch design and in the second case a highly detailed cross-stitch design in 
the same size with the original but with smaller crosses.  

In order to change a color from a cross-stitch object you have to either change the color of the 

source bitmap, and then re-embroider it, or change it from the color palette editor  of the 
standard toolbar. In the palette editor you can view all the colors that the current bitmap contains 
and if you hold the mouse over a specific color, you can view, also, which objects are filled with 
the specific color in the preview area behind the dialog. With this ability you can decide better 
which colors you want your design to have and make the changes to create the best possible 
result.  

Cross-stitch objects can change easily to Photo-stitch by selecting the Photo options from Object 
properties toolbar. Photo-stitch is the only alternative you have when it comes to fill bitmap images 
with stitches. It consists of 4 stitch layers that have different colors. Each thread color layer is one 
of the CMYK(Cyan, Magenta, Yellow and Black) color model. First the Magenta color is 
embroidered, then the Cyan color, the Yellow color follows and finally comes the Black color. 
These colors cannot be changed and you must use them exactly as they are embroidered if you 
want to produce accurate Photo-stitch results. The photo-stitch object gives you the ability to 
adjust the satin bars width and the density of each satin bar for more accurate results. 

Change outline 

Creative DRAWings except from filing with stitches solid objects, can set stitches on the outline of 
objects and on line art designs. Every time you convert vector designs, with objects that have 
outlines to stitches, both fills and outlines are filled with respective stitches automatically decided 
from the software. In Creative DRAWings the outlines can be converted to running or satin serial 
stitches. The stitch type of the outline depends on the width of the border line. If the border line is 
thick, Creative DRAWings will use satin serial to fill it and running if it is not. This automated 

selection can be easily changed by selecting a different outline stitch type from the Outline  tab 
of the object properties toolbar. There you can change the properties of the stitch type or even the 
stitch type itself. Whenever you need to restore the default settings of a specific object you have to 
check the Auto check box of object properties toolbar and the default settings of the object will be 
restored. The default settings are those that Creative DRAWings proposes for the specific object 
or multi selection of objects.   

In Running stitch type you can decide the passes you want the running stitches to have by 
specifying how many times it will be embroidered. This option gives thicker running embroidery 
that can be useful in cases of embroidering line art design or holding appliqué on the fabric. Also, 
you can set the distance you want the outline to be shifted from its initial position by specifying the 
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Offset value. On running stitches you can apply different styles that give artistic feel to the 
embroidery design you are creating. There are many styles that you can use in order to produce 
the artistic result you want. They can be applied easily by selecting the line art or the border 

outline you want, and from the outline tab select the style you prefer. The selected style will be 
immediately applied and will be visible on the preview area. You can continue changing styles until 
you find the one that fits best to your design. 

The alternative border outline fill is satin-serial and can be accessed from the outline  tab of 
object properties toolbar. On satin-serial you can apply different patterns that will give artistic feel 
on the design. In order for the applied patterns to be visible you must increase the width of the 
outline from the Create mode.  After increasing the width of the outline you can apply the pattern 
you prefer by selecting the object and then the pattern from the patterns list. You can apply 
different patterns until you are satisfied with the embroidery result. Also, you can set the distance 
you want the outline to be shifted from its initial position by specifying the Offset value. Any 
change you are making on the outlines it is previewed on the 3D preview area.  

Remove overlaps and make Trims 

Most of the readymade vector designs that are imported in Creative DRAWings are prepared for 
screen printing and not for embroidery. Therefore, there are vector designs that their objects are 
overlapping. We have overlap when an object/shape is completely or partially over another 
object/shape. When you try to set stitches on a vector design with overlapping objects/shapes by 
clicking on the stitch mode, the software would have to embroider both overlapping objects, which 
is not the best way in most cases. There are designs that overlapping objects would give a better 
feel when they will be embroidered but this is not the standard case.  

For these reasons, Creative DRAWings includes a function that removes the areas of objects that 
are not needed and produces the best possible embroidering results. In order to do that, it uses 
the Remove overlaps filter that appears on the object properties toolbar after selecting an object. 
This filter is automatically applied in the software and you can realize that, if you try to move an 
object that is under another object.  

It is, also, possible to manually alter the overlapping status of each object. There are three 
possible options that you can apply on a specific object, Auto, Never and Always. The Auto is the 
default option and the one that Creative DRAWings uses to create the best possible results on 
the design. When the Never option is applied on an object, the specific object will never trim the 
objects that overlap. This means that all the objects/shapes that are under the selected objects will 
be embroidered normally, placing all their stitches on the fabric. The opposite option is Always. 
When it is applied to a specific object it trims all the objects that it overlaps. This means that all the 
parts of objects/shapes that are under the selected object will not be embroidered. 

This tool is really useful because it increases even more the embroidery quality, reduces the 
number of stitches that will be placed on the fabric and decreases the embroidering process time. 

Sometimes you might need to trim a part of an object in order to re-sequence it easier. For this 

purpose you can use the Trim tool. With the Trim  function you can create wholes inside 
objects or reshape them by removing parts of their shape. You can trim any object you want in a 
vector design but you cannot trim a bitmap image that it is imported in the design. You can apply 
the Trim function only to objects that overlap partially or entirely. First you have to decide which 
object will be the one that will be trimmed (target object) and which object you will use to apply the 
trimming (source object). Then you have to select the source object first and then the target object 
by holding the Shift key pressed, to add it to your selection. You can apply the Trim option by 

pressing the  icon from standard toolbar. The trim will be applied on the target object and the 
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area that was covered from the source object will be removed from the target object. This change 
is permanent in contradiction with the Remove overlap tool that it becomes permanent when 
saving the design to a stitch file(.dst, .pes, etc.) or exporting it to Wings‟ modular.  

Change direction and divide objects 

With the Directions tool you can change the direction of stitches of a specific object. This is a very 
useful tool that can be used to give a better feel to the embroidery design and negate the push 
and pull powers that are applied to the fabric from the stitches in the embroidering process. In 
objects filled with step stitches you can add only one direction by selecting the object, then 

activating the direction tool  from the Tools toolbar and by clicking and dragging with the 
mouse on the object you define the new direction of stitches. All the stitches are parallel to the 
direction you have inserted. If you want you can change the direction of the object stitches by click 
and dragging the one end, of the already inserted direction, to a new position, or by deleting the 
old one (by clicking on the X at the middle) and inserting a new one.  

If objects are filled with Row Fill or satin stitches, you can have more than one directions. In order 
to insert the directions you have to select the object, activate the directions tool from the Tools 
toolbar and add directions on the satin/Row Fill object by click and dragging from one side to the 
other of the object. You can continue inserting directions to the object until you are satisfied with 
the embroidery result. While using directions tool you will realize that it snaps on the sides of 
satin/Row Fill object showing you how to use it. If you insert an invalid direction, the fill of the 
shape will change to step. You can change it back by adding a correct direction or by clicking on 
the stitch type you want to be from the object properties toolbar. 

The other useful tool that Creative DRAWings includes is the divide tool.  With this tool you can 
divide the satin and Row Fill objects without splitting the object. It uses branches technique to 
create in the same object different sections. In order to divide a satin/Row Fill object you have to 
select the object you want to divide, click on the divide tool from the standard toolbar and with the 
green bullet on the cursor click and drag from one side of the object to the other and create the 
line that will divide the object. You can add more divide lines and create additional branches. Also 
you can use an already inserted divide line as a side of the object to create a divide line that will 
divide a sub section of the object. By inserting divide lines you can customize the way the 
embroidery design will be embroidered and give a different touch to ordinary embroidery 
techniques. It can be useful for customizing the way of embroidering characters and symbols. Until 
now this was possible only if you could create the vector design that will produce the respective 
embroidery results. With some practice you will realize the designing power that this tool gives 
you.  

Combinations of those tools can produce even better embroidering results with a touch of your 
embroidering expertise and preference.  

Setting up embroidery parameters   

After finishing with the embroidery transformation you have to set up some important embroidering 
parameters that will give the appropriate information to the software to produce the best possible 
embroidery result according to your settings. Therefore, you have to decide on which fabric you 
will embroider on, the thread manufacturer color palette that will be used, the number of colors and 
make some embroidering optimization. The options that you will choose to use will produce the 
respective result. 

Select fabric  
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The fabric that the embroidery design will be placed on is an important factor for the quality of the 
final embroidery result. Therefore, you must be precise on the fabric selection from the Select 
fabric dialog of Tools menu. From the Select fabric dialog box you can find the fabric that you will 
use to embroider your design on. The fabrics are split to six categories according the embroidery 
that have to be placed on them. Therefore if the fabric is in the Embroidery light category the 
embroidery that must be placed on it will have low density and some other specific parameters 
adjustments that differ from one fabric to the other. The same applies, also, for the other 
categories according their name. There is always a case that you might want, for a reason, to use 
different fabric embroidering setting on a different fabric. In order to do that, for example to use 
Embroidery heavy fabric parameters on a fabric that belongs to Embroidery normal category, you 
have to select the standard fabric (e.g. Standard Heavy) that exists in each category except the 
Embroidery Smooth category. Exactly the same procedure you have to use if you have a fabric 
that does not exist in any of the categories. The embroidery smooth category contains most 
available fabrics in the market allowing you to select the one that is similar with the fabric you will 
actually use. The embroidery that will be placed on the fabric will be smooth and soft.  

After selecting which fabric you will use, select the color of the fabric that you will embroider it on, 
(for better preview) and click on the OK button to apply your changes on the design. 

More information about Fabric selections can be found in chapter 9. 

Select thread colors 

Another parameter that you have to adjust before embroidering your design is the thread colors 
that will be used for embroidering the design. The colors of a vector/bitmap design that you have 
imported/created might be hundreds but not all colors have a respective thread color. The thread 
colors are limited and vary from thread manufacturer to manufacturer; therefore you have to match 
the current RGB (Red Green Blue) colors of the design with one of the thread manufacturers color 
palettes that Creative DRAWings includes. You can do that from Edit palette dialog when you 
are on the stitch mode of Creative DRAWings. After matching the colors, the software will show 
you next to the color the exact name/number of the thread that you have to use in order to 
produce the embroidery result you are viewing in the 3D preview area.  

In order to edit the thread colors you have to click on the Edit palette  function from the 
standard toolbar. It is better to do that in the stitch mode of Creative DRAWings because there 
you can see the final colors that will be used from the software to fill the design. In the dialog box 
that will appear you can change the number of threads that will be used, the thread color 
manufacturer palette, even the current color of an object that will be embroidered (read more in 
chapter 7). From the Palette drop down menu you can select the thread manufacturer color 
palette of the threads that you will use. These information will be available to you in the printout of 
the design which is needed for the embroidering process. After the selection of the color palette 
you can view the embroidery design with the new assigned thread colors behind the dialog box on 
the 3D preview area. Also, you can make more adjustments like reduce the number of colors by 
using the Thread to use track-bar or manually by moving the colors in the Design colors list. 
Finally, you can even change the current color by double clicking on the color you want to change 
from the Thread color list and in the next dialog selecting another one from the list or from the New 
color dialog. All the changes are applied immediately on the embroidery design by clicking the OK 
button. 

Instead of reducing the colors in the stitch mode you can create the design in the Create mode 
exactly with the colors you will use to embroider it. You can use the Thread palette toolbar to 
change the colors of the design and reduce them to the number of colors that your embroidery 
machine supports or the number of colors you want the design to have. If you do that you will not 
have to make any change in the Edit palette dialog in the stitch mode of Creative DRAWings.  
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Optimize the design  

There are some more settings that you have to take under consideration before embroidering the 
design you have created. These are optimization settings to adjust in order to get the embroidery 
results you want. You can find them in the Optimizer options dialog under the Tools menu. 
There you can specify the frame-out distance from the needle carrier in order to place appliqué on 
the design, the thread trimming distance between objects, the thread trimming distance between 
areas of Cross-Stitch, the insertion of end points at the closest object connection and the number 
of color changes.  

Appliqué frame-out distance: While embroidering a design that includes a shape that will be 
made with appliqué, at some point will stop and the frame will come out in order for you to place 
the appliqué on. This movement of the frame, you can specify in this field. The distance that you 
will set is important because it will give you the appropriate space to place the appliqué on the 
fabric easily. The higher the inserted value, the longer the frame out distance. There is an upper 
limit to this value 5 cm or 2 inches.   

Trimming distance between objects: This is one of the most important parameters that you 
have to adjust before embroidering your designs. Creative DRAWings will cut all the connecting 
threads between different objects that are longer of this value. Therefore, if the Trimming 
distance between objects is 2 mm and Creative DRAWings finds a connection thread between 
two objects that is longer than this value, it will cut the thread and continue embroidering the next 
object. In order to view where Creative DRAWings inserted thread cuts you have to export the 
design to Wings‟ modular and view the stitches that connect the objects. If the connection stitch is 
dashed, means that there is thread trim between the two objects. On the other hand if the stitch is 
continuous and connects the two objects, which means that there is a jump-stitch between the two 
objects. It can become easier to distinguish that by pressing the P button and 3D preview the 
design in Wings‟ modular. There, the jump-stitches between objects will be visible connecting the 
two objects with a thread. If there are jump-stitches between objects that you want to remove, you 
have to go back to Creative DRAWings, decrease the value of Trimming distance between 
objects in order to be shorter from the distance of the two objects (use the measure tool to find 
the distance between objects), click OK to apply the changes, export the design again to Wings 
modular and check if the jump stitches were converted to thread trims. The lowest trimming 
distance between objects that you can have is 0.5mm. Adjust this parameter until it meets your 
preferences. 

In addition, the combined objects of vector designs, in the stitch part of Creative DRAWings or in 
the create mode with 3D preview option of View menu enabled, will still be displayed with jump-
stitches connecting them. This does not affect the thread trims between combined objects that can 
be adjusted from the Trimming distance between objects parameter. If the Trimming distance 
between objects is shorter than the jump-stitches that connect the combined objects, then the 
thread trims will be inserted normally. In order to view the applied thread trims you have to export 
the design to Wings‟ modular. 

Trimming distance in Cross-stitch: This parameter is similar with the Trimming distance 
between objects, but it refers to cross-stitch designs. Creative DRAWings, while embroidering 
cross-stitches, moves from one cross-stitch to another using Tacking stitches. Tacking stitches 
are stitches that are placed on the fabric in order for the needle carrier to move from one object to 
another without making thread trims. These stitches are not visible because they will be covered 
from the stitches of another cross-stitch object that will be embroidered later in the embroidering 
sequence. In order for the software to make Tacking stitches instead of making thread trims, the 
value of Trimming distance in Cross-stitch must be greater than the distance between the same 
objects. For example, if the distance between two crosses of a design is 10mm, the Trimming 
distance between objects must be over 10mm in order to avoid thread trims. The default distance 
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is 20mm and is the proposed one. It is better to avoid decreasing it because the continuous thread 
trims might be annoying.  

End points at closest connection, even on trims: This option is important for the way that the 
design will be embroidered. When the checkbox is checked Creative DRAWings filters the entire 
design and finds the closest connection points between the objects even if a thread trim is made. 
This option gives better rooting between objects and better flow of the embroidery. In addition, it 
gives less thread trims because the objects of the same color are connected from their closest 
point. Furthermore in order to make the proper rooting between objects it places more stitches on 
the fabric.  

If this option is not active, Creative DRAWings will choose the best position to place the entry and 
exit points of each object and not the closest connection points. The selection depends on your 
embroidering style.  

Change Sequence 

Creative DRAWings software includes automatic and manual tools for producing the embroidery 
sequence. You can combine the different available tools and produce the embroidery results you 
prefer.  

Automatic Embroidery sequence 

Creative DRAWings embroidery software includes an automatic sequencing mechanism that 
produces great results based on the sequencing options that you have set. There are three tools 
that are responsible for adjusting the automatic embroidery sequence. These tools are the Auto-
sequence tool, the Sequence tool and the Sequence manager. With these tools you can adjust 
the automatic embroidery sequence that is produced from the software.  

The Auto sequence tool  is located at the bottom of the Tools toolbar and by default is 
enabled. This means that any design that you are converting or creating from scratch will have its 
embroidery sequence automatically produced according your preferences. The Auto sequence 
tool has some options that you can adjust through Optimizer options dialog that you will find 
under Tools menu. The Auto-sequence option is checked and all its options can be set to 
different values. The options that you can adjust are the Optimization strategy, the Keep 
sequence of overlapped objects, even if trimmed, the No thread trims inside combined 
objects and the Minimizing color changes. By adjusting these options you can manipulate the 
embroidery sequence results and bring it closer to your preferences. It is important to keep in mind 
that all optimizing options are related and the embroidery sequence is calculated based on all 
optimizing options and not only to a specific one. Whenever you set the optimization settings you 
have to consider how the change you are making will affect the embroidery sequence by keeping 
in mind all the other optimizer settings.  

Another tool to adjust the automatic embroidery mechanism is the Sequence tool. With the 
Sequence tool you can order specific objects or set of objects to be embroidered at the beginning 
or at the end of the embroidering process. The Sequence tool appears at the bottom of object 
properties toolbar whenever you select an object or a set of objects.  

The Sequence option gives you three possible abilities: To start, To end and Auto. By default the 
Auto option is selected that lets the software decide the embroidering sequence of the design. If 
you want an object to change order and be embroidered first or last in the embroidering sequence 
you have to use, respectively, To start or To end option. If you do not make any change on the 
sequence option, Creative DRAWings will automatically create the best possible embroidery 
sequence for you based on the other settings that you have set on the Optimizer options dialog. 
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Every time you want you can simulate the embroidery sequence of the design through Slow 
redraw tool and decide if you need to make more changes on the embroidery sequence.  

Finally, The Auto-sequence, affects the way that the items of Sequence manger will be viewed. 
When Auto-sequence is enabled the program automatically decides the sequence of all stitch 
objects, so you don‟t have any control of the sequence of the design items via sequence manager 

in this case. All normal stitch  objects will be shown as one object on the Sequence manager 
and there will be no separation between its sub-objects. The only items that are separated are the 

Appliqué , the Cross-stitch , the Photo-stitch  and the imported stitch file  objects. 
These objects can be re-sequenced normally by click and dragging them to a new position on the 
sequence manager. This is allowed because these kind of objects are totally different from normal 
stitch objects and they need special care when they are embroidered.  

Manual Embroidery sequence 

Creative DRAWings embroidery software includes a manual sequencing mechanism that gives 
you the ability to re-sequence the design freely based on your preferences. The software by 
default uses the automatic sequencing option that is very useful for inexperienced users and for 
those who are not familiar with embroidery sequencing. To switch to manual mode you have to 

click on the lamp  icon.  

Whenever you disable the Auto-sequence by clicking on the lamp  icon, the Run optimizer 
once dialog appears, that allows you to run the sequence optimizer only once, or if you want not 
to run it at all and then gives you the ability to re-sequence the embroidery design freely through 
the Sequence manager. Inside the Run optimizer once dialog you have three options: the 
Nothing (Leave design as is), the Simple (Just re-arrange objects) and the  Advanced (Re-
arrange and modify objects if needed). 

By selecting the Nothing (Leave design as is) option and clicking OK button, the Optimizer will 
not be applied at all and the objects will appear on the Sequence manager exactly with the order 
that they have been designed. On the other hand by selecting Simple (Just re-arrange objects) 
option and clicking OK button, the Optimizer will be applied once on the design, by making the 
appropriate changes and then all objects will appear on the Sequence manger. Finally, by 
selecting Advanced (Re-arrange and modify objects if needed) option and clicking OK button, 
the Optimizer will be applied once on the design but it will modify the objects if needed. This 
means that the Fills and Outlines will be separated and re-sequenced separately based on the 
selections of the Optimizer.  

After disabling the Auto-sequence tool, all objects will appear on the Sequence manager. By 
clicking and dragging any object from the Sequence manager you can change its order. You have 
the full control of the embroidery sequence and all the intelligent mechanisms have been disabled. 

It is important to remember that while re-sequencing, some objects might change as a result of the 
Remove overlap functionality that is applied automatically. The Remove overlap option that is 
located on the object properties toolbar removes unneeded parts of the design that are 
positioned underneath of other objects in order to reduce the embroidery stitch count and 
thickness. It does not remove them permanently like the Trim tool does, but it holds the artwork 
information until you save the design to stitch file (.dst, .pes, etc.) or export it to Wings‟ modular. 
Therefore, you might move a large object from the bottom of the design (that looks like a 
border/outline because of the Remove overlap functionality) and place it on top, but once you do 
that you find out that it changes to a large fill object that covers all the other objects. To overcome 
that you have to use the Trim tool first from the standard toolbar, in order to trim the bottom object 
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and then re-order it. All these are automatically calculated when you are enabling the Auto-
sequence functionality.  

Embroidery process  

After finishing the parameters setup you can continue with preparing the design for the 
embroidering process. You can export the design in Wings‟ modular to view the actual stitches of 
the design or use the slow redraw tool to simulate the embroidering process inside Creative 
DRAWings. In addition you have to print the design and have the printout as a guide for the 
embroidering process because it includes all the needed information. Finally you have to save the 
design to the embroidery file format of your embroidery machine in order to load the design to the 
machine. 

Export designs  

Every embroidery design that is created in Creative DRAWings can be immediately exported to 
Wings‟ modular. In order to do that select from File > Export menu and then the To Editor… 
option or press Ctrl+E shortcut key from the keyboard. The embroidery design will be exported to 
Wings‟ modular.  

Wings‟ modular Basic is included in the Creative DRAWings package. It is a full working 
Professional embroidering software split into modules. It includes 14 modules which are activated 
separately. Basic module is the first and most important module because contains the basic parts 
of the software. Basic module includes the standard interface, scaling design capabilities, simple 
design editing, fully functional stitch editor, image database management and all supported floppy 
formats. It also includes many connection abilities that allows you to connect the software with 
your embroidery machine. You can read more about Wings’ modular Basic module inside the 
Basic module manual that is also included or from the Help > Contents menu in the Basic-
Connect module Contents tab book. 

Saving designs 

The saving procedure in Creative DRAWings is similar with the saving procedures of any 
Windows® software. 

To save an embroidery design in Creative DRAWings you have to: 

1. select the File > Save option from the stitch mode  

2. select the location where you want the embroidery designs to be saved using the available 

tools,  

3. select the embroidery file format from the Save as type 

4. Insert the name of the design in the File name field  

5. Click on Save button to save the design.  

Every embroidery design must be saved first in .DRAW file format and then in any other 
embroidery machine file format. You have to do that in order to be able to open the designs you 
created again in Creative DRAWings and edit it. Creative DRAWings can open only .DRAW 
files, therefore it is better to keep a copy of your embroidery design in this file format. After saving 
the design in .DRAW file format you can save the design in any embroidery machine file format 
you want. You can do that by directly saving it from Creative DRAWings or after exporting them 
to Wings‟ modular where you can make more changes to the design.  
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To open an embroidery machine file (.dst, .pes, .jef, etc) format, you can do it by loading it in 
Wings‟ Modular or directly inside Creative DRAWings through From embroidery option of the 
starting dialog.  

If you open it inside Wings‟ modular you can make some changes and re-save the designs in the 
format you want. Embroidery machine file formats have some limitations in the information that 
they are saving in their format. Therefore you might load a design that was saved in an embroidery 
file format from Creative DRAWings and then load it in Wings‟ modular you will view that the color 
palette is not loaded correctly. This is happening because not all embroidering machine file 
formats saving the color palette in their file. In order to avoid losing useful information that was 
exported from Creative DRAWings you can save the design in .NGS file format which is Wings 
Systems‟ file format and it is holding all the needed information of the embroidery design. You 
cannot load the .ngs files in any embroidering machine but you can open them with Wings‟ 
modular or any other software that supports this file. Whenever you load an .ngs file in modular 
the design will appear exactly in the way that was exported from Creative DRAWings. Any loaded 
file in .ngs file format can be easily saved in any embroidering machine file format (.dst, .pes, .jef, 
etc) without losing embroidering quality in the transformation.  

After you finish saving the design in the format your embroidery machine supports, you can 
proceed to the embroidering process.    

Use of printout 

The printout of the embroidery design is very useful for the embroidering process. All the 
information that you might need while embroidering are listed there. You can find information of 
the embroidering sequence that is really important if you embroidering designs in .dst or .sst file 
formats, because the sequence that the printout shows must be entered, also, in the embroidering 
machine. In addition you can view the exact number of stitches of the embroidery design, the date 
that the design was created, the number of changes that will be made, the actual size of the 
design, useful information about the materials that must be used for stabilizers and which colors 
must be used. 

In order to embroider the design as you are viewing it you have to follow the steps below: 

1. Place the threads in the embroidering machine according the order that is given in the 

printout. The first color in the first needle carrier, the second in the second needle carrier 

and so forth. If the embroidering machine has only one needle carrier you have, each time 

that a color change is occurring after a thread cut, to change color to the needle carrier and 

continue embroidering.  

2. Then load the design in the embroidering machine. If the design is .dst or .sst you have to 

enter also the embroidering sequence that is listed in the printout. Otherwise you can 

proceed to the next step. 

3. Place the hoop on the machine with the fabric you want to embroider on and all the 

stabilizing materials needed, as they listed in the information section or using other that fit 

from your experience.  

4. Check if the hoop is the appropriate for the dimensions of the design. If the Scale of the 

printed design that is located under the header of the printout is 100% then the printed 

design has actual dimensions. Therefore you can check if it fits in the hoop. If the printout is 

more than one page and you are not sure if the design fits in your hoop, you have to print 

the design in multiple pages, cut the pieces of the design and connect them again to create 

the whole design from the pieces and place it in the hoop to see if it fits.  
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5. After finishing any extra adjustments that your embroidery machine needs, you can proceed 

with embroidering your design.  

The embroidering process will finish and produce the embroidery design you have created.  
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Appendix A - Creative DRAWings Tips 

Creative DRAWings Quality hints 

Creative DRAWings is a vector and embroidery designing software. It has many tools and gives 
you the ability to create the designs you want to embroider. Also, you can import readymade 
vector designs that were not designed for embroidering purposes but for printing purposes. Those 
graphic designs might include graphics and visual effects that cannot be converted to stitches and 
produce various problems during their conversion. Those designs need some editing inside the 
Create mode, to become proper for embroidering purposes. Creative DRAWings users must 
always have in mind that the designs they are creating will be embroidered with threads on a 
fabric.  

Take into consideration the following guideline that will help you create high quality embroidery 
designs using Creative DRAWings. 

● First of all embroidery machines cannot embroider in every position. The minimum distance 

between two stitches is 1/10 mm horizontal and 1/10 of mm vertical. 

● Small designs that have too many nodes in their border do not help in embroidery. 

Therefore, try to delete the nodes that do not affect the shape of the design.  

● Too small objects will not be filled with stitches and will be ignored from the software. If you 

want them to be embroidered try to enlarge them in order the software to be able to place 

stitches on them. 

● Another thing that you should avoid in your designs is to cross curves in the same objects. 

Even if we have implemented special algorithms with Artificial Intelligence for these cases, 

we cannot cover all the possible combinations. 

● Moreover, if there are borders in a design and especially in areas that are covered with 

stitches from another object, it is possible unneeded overlapping to be created that will 

decrease the quality of the embroidery. The Remove overlaps tool of Creative DRAWings 

takes care of such situations, and decides if the object below must be trimmed or not. 

Sometime decides not to trim object that are completely over other object because it 

believes that it will be embroidered better that way. If you do not want that you can force the 

tool to remove the stitches underneath.  

● Finally, if you want to create borders with satin serial, avoid acute (>15o) angles (hard 

changes of line directions), prefer to have a curve break node on the top of each angle and 

always check the distance between the nodes near the angle to be greater from the width 

of the border line. This will help Satin serial to flow better on the border and will increase 

satin serial quality. 

To summarize and add some more, the things you have to do are: 

1. Convert unnecessary Cusp Nodes to Smooth nodes.  

2. Delete unnecessary Smooth nodes. Do not put nodes very close to the other.  

3. Avoid having too small objects 

4. Avoid double outlines  

5. Avoid crossing curves in the same object.  
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6. Avoid hard changes of direction for Satin Serial outlines  

7. Use Remove overlaps function to avoid overlapping and reduce number of stitches. 

 

Those are some hints that will help you to increase even more the embroidery quality that 
Creative DRAWings produces. The produced quality is based on the quality of the used vector 
design.  

Printing and embroidering 

The procedure you have to follow in order to embroider your design correctly by using the 
information that are included in the printout are the following: 

In the following figure we have a printout of a design. 

 
Figure A.1: Printout 

In the header of the printout you can view the size, the number of color changes, the number of 
stitches on the design, the needed yarn for the current design, the colors that the current design is 
using and in which needle carrier should be. 

  

 

 

Figure A.2: Header 

If you try to embroider the specific design that has 12 colors, set each color to each needle carrier 
as they are numbered. For example, in the first needle carrier you will set the yellow color 

, in the second the Black and so forth.  If you have set thread manufacturer‟s color 
palette like Gunold, you can find the colors that you want the design to have from the number next 
to the color.  

Size Yarn 

Color changes Number of stitches 

Creation date 

Color changes 
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If you have an embroidering machine with fewer needle carriers than 12 you can either reduce the 
colors of the design or while embroidering, you have to change threads on the embroidering 
machine after stopping it each time a color change occurs, to a color that is not on the next needle 
carrier.  

When you finish setting the threads on the needle carriers you can continue by setting the 
embroidering sequence on the embroidering machine. This is not needed in all embroidery file 
formats. There are file formats that adjust color changes automatically to the embroidery machine. 
Those are: .”dsb”, “.dsz”, “.tap”, “.exp”, “.ksm”, “.hus”, “.vip”, “.pec”, “. Pes”, “.jef”, “sew”. 

On the other hand there are embroidering file formats that do not adjust the color changes 
automatically. To those (.dst, .sst) you have to insert them manually as the printout shows. The 
embroidering sequence it is shown from the color changes option and the Sequence icons. 

 
Figure A.3: Color changes 

Color changes 

The color changes list shows the number of color changes that the machine will make in order to 
embroider the design and not the number of colors that will be used. To be more specific, the 
above list shows that the machine will start [(“01)”] embroidering using the color of the first needle 
carrier (N:01 (Gunold, 502)); therefore for embroidery files that do not support color changes you 
have to manually set the embroidering machine to have as first color the one that is in the first 
needle carrier.  

Continuing, from the above list you can see that the first color change ( ‟02)‟ ) must be set to 
change the needle carrier from the “N:01” to “N:07”. The second color change from “N:07” to 
“N:04” and so forth.  

We continue setting the machine until ready. As we mentioned before, the design has 12 colors 
but 14 color changes. This means that Creative DRAWings, while producing the embroidery 
design, decided that in order to embroider some objects with the same color better, it must be 
embroidered in two or more phases. That is why we have more color changes than colors.  

It is more obvious from the Sequence icons below.  
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Figure A.4: Sequence icons 

Here you can view exactly which object will be embroidered with which color. As you can see the 
Red objects of the design will be embroidered at the 7th and 13th color change.    

In addition, most of the time more color changes produce better embroidery results, but less color 
changes are preferable for embroidering many copies of the same design. There is a way in 
Creative DRAWings that you can adjust the color changes in the designs that you are creating.  

This option can be accessed from File > Design properties in the Optimizer mode, and is called 
Minimizing color changes.  

 Minimizing color changes: This option is important for limiting color changes in the 

embroidery production process. Color changes have to do with thread changes that the 

embroidery machine makes in order to embroider each stitch design object. With more 

color changes the embroidery design sequence is followed more accurately but the 

production process is longer. On the other hand with less color changes the embroidery 

design sequence changes to fit the Minimizing color changes settings but gives shorter 

production process. The alterations in the embroidery design‟s sequence might produce 

inaccurate embroidery results or might not. This depends on the embroidery design, 

embroidery machine and the fabric. You can adjust color changes through the use of the 

track bar.  
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Appendix B - Toolbars 
 

Standard toolbar 

 
Opens the New design dialog box. 

 Opens the Open dialog box. 

 
Opens the Save As dialog box or Saves instantly an already saved design 
overwriting the previous saved file. 

 
Opens the Print Preview dialog box. 

 
Undo, cancels the latest action that was made. 

 
Redo, cancels the latest undo that was performed. 

 
Opens the Select fabric dialog box. 

 Opens the Edit palette dialog box.  

 
Using this option you can zoom-previous your view of the current design.  

 

Clicking on this button in the standard toolbar, you can view the current design in 
actual size. Also by clicking on the arrow at the right of this icon, you can select 
one of the zoom presets. 

 
Using this option you can view the whole design fitted into the visible screen.  

 
Activates the show help on help tool. 

 
The Weld tool welds two or more overlapping objects. 

 
The Trim tool can create wholes inside objects or reshape them by removing 
parts of their shape. 

 
The Intersection tool creates an object from the area where the objects overlap. 

 

Tools toolbar 

 
Activates rectangle selection. 

 Activates lasso selection. 

 
Activates Node editor where you can edit the shape of objects. 

 
Using this tool you can zoom-in your view to a part of a design.  

 
This tool Lets you move a design around in the viewable window like you would move a 

paper around on a desk with your hand. 

 

The measure tool calculates the distance between any two points in the work area. 

When you measure from one point to another, a ruler is drawn that shows the exact 

distance between the two points. 
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With the Freehand tool you can design simple lines or complete shapes. 

 

With the Bezier designing tool you can create shapes where you can handle better the 

curvature of each segment easier by adjusting the control handles of each inserted node. 

 
With the Outline tool you can draw lines and curves by specifying their nodes and 

altering the curvature of their segments by adjusting their control handles. 

 
The Create Ellipse tool allows you to design ellipses that will be filled with stitches. 

 
The Create Pie tool allows you to design ellipses and pie shapes that will be filled with 

stitches. 

 
The Create rectangle tool allows you to draw rectangle shapes that will be filled with 

stitches. 
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Appendix C - Quick reference card 
 

General 

 New document  Ctrl+N 

 Open document  Ctrl+O 

 Save document  Ctrl+S 

 Save As document Ctrl+Shift+S 

 Print document  Ctrl+P 

 Export to image Ctrl+Shift+E 

 Export to SVG Ctrl+Alt+E 

 Help  F1 

 
Show Help on…  Shift+F1 

 To Editor… Ctrl+E 

 

Selection 

 Select all  Ctrl+A 

 Invert selection  Ctrl+Shift+I 

 Default selection tool Space 

 Top object Ctrl+Home 

 Bottom object Ctrl+End 

 Next object Tab 

 Previous object Shift+Tab 

 

Modifications 

 Undo  Ctrl+Z 

 Redo  Ctrl+Shift+Z 

 Select fabric  Ctrl+F 

 Edit palette  Ctrl+Shift+L 

 Options  Ctrl+T 

 Change Hoop Ctrl+H 

 Optimizer options Ctrl+Shift+J 

 Divide Shift+D 

 Directions  D 

 Repeat last transform Ctrl+R 

 Group Ctrl+G 

 Ungroup Ctrl+U 

 Combine Ctrl+L 

 Break apart Ctrl+K 

 Convert to curves Ctrl+Q 

Order  

 To front one PgUp 

 To back one PgDn 
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 To front of design End 

 To back of design Home 

 

Designing 

 Insert symbol Ctrl+F11 

 Delete objects Delete 

 
Edit shape nodes F10 

 
Freehand F5 

 
Bezier Shift+F5 

 
Outline Ctrl+F5 

 
Rectangle F6 

 Trapezoid Shift+F6 

 
Ellipse F7 

 
Pie Shift+F7 

 
Polygon Y 

 
Star S 

 
Text F8 

Align bar  

 Align Left L 

 Align Right R 

 Align Top T 

 Align Bottom B 

 Align centers Horizontally  C 

 Align centers Vertically E 

 Same width   Shift+W 

 Same height Shift+H 

 Same Size Shift+S 

 Horizontal Spacing Shift+C 

 Vertical Spacing Shift+E 

 

View 

 Properties  Alt+Enter 

 
Zoom in  Z 

 
Zoom previous F3 

 
Zoom all  F4 

 
100% zoom Shift+1 

 
Hand tool (pan)  H 

 
Measure  F9 

 Ruler Ctrl+Shift+R 

 Grid Ctrl+Shift+G 
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Backdrop  

 Hide  Alt+1 

 Below Embroidery Alt+2 

 Washed-out Alt+3 

 After Embroidery Alt+4 
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Appendix D - Troubleshooting 

Installation problems 
Sometimes problems appear during installation procedure. If any problem appear you have to try 
the following.  

● Make sure that you have administrative right on your PC in order to be able to install the 

software. 

● Disable your antivirus or any other security software ONLY during the installation and turn 

them back on, once it is finished. Creative DRAWings installation does not include any 

malicious software.  

● Make sure that you graphics card meets system requirements, because otherwise Creative 

DRAWings might not work properly.  

CBU Failure When Launching Creative DRAWings   

When launching Creative DRAWings after installation or re-insertion of the USB Dongle, a screen 
displays for a brief moment, followed by this error message: 

 

This error is a result of a loose or improperly connected Dongle: 

1. Close the error message. 

2. Remove the Dongle, wait 10 seconds, and re-insert it, ensuring that it is securely 

connected. 

3. Load Creative DRAWings once more. 

 

Creative DRAWings Quits and Generates a Visual C++ Runtime Error  

If the Dongle is removed when using Creative DRAWings, the application will shut down and the 
following error message is generated: 

“Visual C++ Runtime Error” 

Re-insert the Dongle securely and re-start Creative DRAWings. 

Unhandled Exception  

Creative DRAWings has an extra security feature that handles exceptions that might occur while 
working with complex designs. This feature allows you to undo your last change in the design that 
made the system unstable and continue from that point.  
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Whenever the above image appears an Unhandled Exception was occurred in the system. In 
order to continue working in Creative DRAWings you have to click on „Yes‟ button. The system 
will become stable again. It is proposed, when an Exception occurs, to save changes in the 
current design and then continue working with the design.  

If you click the „No‟ button the System will crash!  

Creative DRAWings Fails to Launch 
Creative DRAWings is a demanding software in 3D graphics card. If the PC you have installed 
the software does not meet the Minimum System requirements, the software might not work 
properly.  

If the following error appears when you try to start the software, then the problem is located on the 
Graphics card of your system or to the 3D settings of the software. 

 

To overcome this issue please try the following: 

1. Download and install the latest drivers of the Graphics card and try to start Creative 

DRAWings.  

2. Try to re-install the DirectX 9.0C from the Directx9 folder that you will find inside the 

installation CD of Creative DRAWings. Run dxsetup.exe and follow the installation. Once 

it is finished try once more to open Creative DRAWings.  

3. Open Setup 3D from Start>All Programs>Creative DRAWings, set the options as they 

are shown in the screen capture below and select Save settings button.  
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Start Creative DRAWings and check if it is working properly. If this does not work open the 
Setup 3D and set the options as they were initially (as it shown in the screen capture 
below), and select Save settings. 

 

Try to open Creative DRAWings once more.  

4. If none of the above worked the problem is located in your Graphics card. It might have less 

than 64MB of Ram, or have poor 3D capabilities (usually onboard graphics cards). To fix 

that you will have to change it with any NVIDIA or ATI graphics card is available on the 

market. The software requires a good graphics card to work properly.  

Information on how to proceed with checking the Video memory of the card, updating video drivers 
or another way to install the latest DirectX, you will find below. 
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Verifying Video Card Memory 

To verify the amount of RAM on the video card, do the following: 

1. Right-click on the Desktop and select Properties. 

2. Click the Settings tab. 

3. Click the Advanced button. 

4. Click the Adapter tab. 

Memory Size should read at least 64MB.  If it is less than 64MB, you will need to upgrade the 
video card to meet or exceed the Creative DRAWings system requirements. 

Updating the Video Driver 

The two most common video chipsets are ATI and NVIDIA.  Please visit one of the following web 
sites and obtain the latest driver for your card. 

http://www.ati.com/ 
http://www.nvidia.com/ 

If your video card does not use either of these chipsets, visit the video card manufacturer's web 
site for the latest driver.  

If you have a laptop you need to search for video card drivers from the laptop manufacturer‟s web 
site.  

Installing DirectX 

DirectX can be downloaded from the Windows Update site, or from 
http://www.microsoft.com/directx.  After installing DirectX, make sure that acceleration is enabled.  
To verify this, do the following: 

1. Click Start, Run. 

2. Type dxdiag and click OK. 

3. Click on the Display tab. 

All three DirectX Features should indicate Enabled beside each feature.  If not, click the Enable 

button beside the ones that are disabled.  If the buttons are disabled, there is a problem with 

DirectX.  Consult the Microsoft knowledge base for assistance in troubleshooting DirectX, or click 

on the More Help tab and click on the Troubleshoot button 

  

http://www.ati.com/
http://www.nvidia.com/
http://www.microsoft.com/directx
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